




56 Working with the Search Service

This chapter describes how to use the features provided through the Search service.

This chapter includes the following sections:

	
Section 56.1, "What You Should Know About the Search Service"


	
Section 56.2, "Setting Preferences for WebCenter Spaces Search Results"


	
Section 56.3, "Working with Search Service Task Flows"


	
Section 56.4, "Setting Search Service Task Flow Properties"





Audience

This chapter is intended for users who want to use and manage search, as well as WebCenter Spaces administrators with the Application-Manage Configuration permission and individual Space moderators who want to configure search within their Spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."



56.1 What You Should Know About the Search Service

The Search service enables the discovery of information and people through an intuitive user interface, returning only the results you are authorized to view. With all relevant information easily navigable, you do not have to switch between applications performing multiple searches.

Use the Search service to run, refine, and save custom searches. By default, WebCenter Search looks for your search terms in every searchable service enabled in the application. You can configure the services to which a search has access with your personal preferences (see Section 56.2.1, "Selecting the Services to Search").

Information in WebCenter services is searched by name and content. When a search is run for a term that has been added as a tag to a document, the document is returned in the results, and the related tags appear in the Tag refiner section. For more information about tagging, see Chapter 57, "Working with the Tags Service."

In all cases, searches return only the results you are authorized to view. For example, if you are not a member of the Finance Space, then any search results from that Space do not display.

In addition to WebCenter Search, the Documents service provides its own search engine for file searches. This saves time and increases the relevancy of results by narrowing the scope of a search to files. The Documents service searches within a specific Space's document library. For more information, see Section 41.29, "Running Document Searches."



56.1.1 Using the Oracle Secure Enterprise Search Adapter

With WebCenter Spaces applications, internal WebCenter live search adapters are set as the default search platform; however, large-scale WebCenter implementations should be configured to use Oracle SES for best performance. Oracle SES provides unified ranking results for the following resources:

	
Documents, including wikis and blogs


	
Announcements and Discussions


	
Spaces, lists, pages, and people resources in WebCenter Spaces







	
Note:

Oracle WebCenter Spaces includes the additional Oracle SES crawler that indexes Spaces, lists, pages, and people resources in WebCenter Spaces. Oracle SES crawling of these resources supported in WebCenter Portal applications.







For example, when you run a search for a user name, most likely, you are looking for that persons's contact information (that is, the exact user name in the People Connections service), not necessarily documents that the user wrote. The unified ranking in Oracle SES enables you to see the most relevant results, across all different types of searches, without configuring Search Preferences.

Additionally, with Oracle SES as the WebCenter search engine, you can use the wildcard character [*] in the middle or end of a term for wildcard matching. For example, when you search for keywords like wiki or page, Oracle SES does not return the wiki page MyWikiPage in search results. However, My* or My*Page does return MyWikiPage.




	
Note:

The default WebCenter search adapters do not support any wildcard searching.







You can set your personal search preferences to specify which services to search and the order of services in your search results. For example, you may find that search results from the Documents service prove more useful that search results from other services. You can disable any service from which you do not want to see search results. For more information about setting search preferences, see Section 56.2, "Setting Preferences for WebCenter Spaces Search Results."

Oracle Portal applications automatically set Oracle SES as the default search crawler, but you can manually override search with Oracle SES and have WebCenter Portal applications search using the original WebCenter search adapters.




	
See Also:

"Configuring Search with WebCenter Search Adapters" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter














56.2 Setting Preferences for WebCenter Spaces Search Results

When you search content, you may find that the results from one service are more relevant to you than results from other services. You may find it useful to be able to exclude some services from a search and specify the order in which the results from selected services are listed.

Use WebCenter Spaces search preferences to choose the services to search and specify the display order for search results. This section contains the following subsections:

	
Section 56.2.1, "Selecting the Services to Search"


	
Section 56.2.2, "Specifying a Display Order for Search Results"







	
See Also:

Section 41.29, "Running Document Searches"









56.2.1 Selecting the Services to Search

Your WebCenter administrator makes services available to the application. By default, all enabled services are selected to be searched. You can disable any service from which you do not want to see search results. For example, if you frequently search for a particular type of technology, including your personal contacts in the search is probably not useful.

To specify which services should be searched:

	
Click the Preferences link at the top of the application.


	
Click Search to open the Search Preferences pane (Figure 56-1).


Figure 56-1 The Search Preferences Pane

[image: Search Preferences pane in Preferences dialog]



	
To add a service to a search, choose one or more services on the Available Services list and click the Move selected items to list icon to move them to the Selected Services list.

To remove services from search, choose one or more services on the Selected Services list and click the Remove selected items from list icon to move them to the Available Services list.




	
Note:

When Oracle SES is configured in the application, the Oracle SES service cannot be deselected, and services that do not support Oracle SES search (such as Notes) are not listed.








	
Click OK to save your changes and exit the Preferences dialog.

Alternatively, click Apply to save your changes without exiting.




The services you add to the Selected Services list are included in future WebCenter Spaces searches. The services on the Available Services list are not searched.






56.2.2 Specifying a Display Order for Search Results

Of all the services you include in a WebCenter Spaces search, you may find that some services provide more relevant results than others. For example, you may find that search results from the Documents service prove more useful that search results from other services. WebCenter Spaces Preferences provide controls for specifying the order in which services are listed in search results.

To specify a display order for search results:

	
Click the Preferences link at the top of the application.


	
Click Search to open the Search Preferences panel (Figure 56-2).


Figure 56-2 Search Preferences

[image: Search Preferences panel in Preferences dialog box]



	
Choose one or more services on the Selected Services list and click the Move icons to the right of the list to move your selections higher or lower on the list.

The order you specify here determines the order each service is listed in search results.


	
Click OK to save your changes and exit the Preferences dialog.

Alternatively, click Apply to save your changes without exiting.











56.3 Working with Search Service Task Flows

WebCenter provides search services for the application and beyond.

This section includes the following subsections:

	
Section 56.3.1, "Adding Search Service Task Flows"


	
Section 56.3.2, "Searching in a WebCenter Application"


	
Section 56.3.3, "Refining the Display of Search Results"


	
Section 56.3.4, "Saving Searches"






56.3.1 Adding Search Service Task Flows

Table 56-1 lists the Search service task flows.


Table 56-1 Search Service Task Flows

	Task Flow	Definition
	
Search 

	
This task flow provides a rich search experience with features for refining and saving search results.


	
All Saved Searches

	
This task flow enables you to create a simple launch pad for running saved searches within the application.


	
Search Preferences

	
This task flow enables users to select which WebCenter services to search.


	
Search Toolbar

	
This task flow enables users to enter simple search criteria and run the search from the application. Search results are rendered as links.








To add a Search service task flow to a page in a WebCenter Spaces application:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that provides access to the search task flows.




	
Tip:

The presence or location of this section depends on how the Resource Catalog is configured. In the default Resource Catalog, next to Tagging and Searching, click Open.








Figure 56-3 Opening the Search Section in the Resource Catalog

[image: Search Section in the Resource Catalog]



	
Click Add next to the task flow that you want to add to your page.




	
Note:

The Search, Search Preferences, and Search Toolbar task flows are not available in the default Oracle Composer Resource Catalog, so you will only see entries for these task flows if they have been added to the Resource Catalog that has been made available to the page.
For more information, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Search for a list of all available content task flows.

















56.3.2 Searching in a WebCenter Application

This section describes how to run a global search and how to run a search within a specific Space.

This section includes the following subsections:

	
Section 56.3.2.1, "Performing a Global Search"


	
Section 56.3.2.2, "Performing a Space Search"






56.3.2.1 Performing a Global Search

Global search provides an application-wide search. By default, you can perform a global search from the search field at the top-right of the application.

To perform a global search:

	
Locate the global search field and enter a search term.

For example, the search field at the top right of the WebCenter application is a global search field (Figure 56-4).


Figure 56-4 Global Search Field in WebCenter Spaces

[image: Global search field]



	
Press Enter or click the Search icon next to the global search field (Figure 56-5).


Figure 56-5 Search Icon

[image: search icon]



Results display in the search Results page (Figure 56-6).


Figure 56-6 Global Search Results

[image: search results]



	
Click a link to open a result.


	
Optionally, refine the search.

With the default WebCenter search adapters, you can refine by author or last modified date using the Refine Search section. With the Oracle SES adapter, you can refine by author, content type, last modified date, Space, and tag. For more information, see Section 56.3.3, "Refining the Display of Search Results." You can also save the search so that you can access the results later. For more information, see Section 56.3.4, "Saving Searches."

You can configure how search results are displayed. Specifically, you can control which services are included in the search and the order in which those services are listed in the results. Set this in the Search Preferences panel of the Preferences dialog (for information see Section 56.2, "Setting Preferences for WebCenter Spaces Search Results").

An estimated number of search results appears if your application is configured with the Oracle SES adapter (Figure 56-7).


Figure 56-7 Estimated Number of Search Results

[image: Description of Figure 56-7 follows]






If your application uses the WebCenter search adapters, then an estimated number of results is not included. Click the Previous and Next links to view any additional results. These links may appear even if no additional results are available.









56.3.2.2 Performing a Space Search

WebCenter search performs global (that is, application-wide) searches. 

For members of a Space to perform searches limited to that Space, the Space administrator must add the Search task flow. In most cases, this involves creating a Resource Catalog, adding the Search task flow to the catalog, and then assigning this catalog to the Space. (The Search task flow is not available in the default Resource Catalog.) For example:

	
Go to Administration - Resources - Resource Catalogs, and either click to create a new resource catalog or select an existing resource catalog and select Edit - Copy.


	
Enter a name for this new Resource Catalog (Figure 56-8).


Figure 56-8 Editing a Default Resource Catalog to Include Search

[image: Description of Figure 56-8 follows]






	
Click Edit - Edit, Add, then Add from Library.


	
Select Task Flows, then scroll down to select the Search task flow, and click Add (Figure 56-9).


Figure 56-9 Add Resource Catalog Item Dialog

[image: Description of Figure 56-9 follows]






	
You see the Search task flow added to the Resource Catalog. Optionally, you can drag and drop the task flow into a folder. With the Search task flow selected, click Edit (pencil) to add a description for this new catalog item (Figure 56-10).


Figure 56-10 New Resource Catalog with the Search Task Flow Added

[image: Description of Figure 56-10 follows]






	
On the Target tab, add a description (Figure 56-11).


Figure 56-11 Edit Resource Catalog Item - Target Tab

[image: Description of Figure 56-11 follows]






	
On the Options tab, for New Attribute Name select Icon URI, and for New Attribute Value, enter /adf/webcenter/search_qualifier.png (Figure 56-12).


Figure 56-12 Edit Resource Catalog Item - Options Tab

[image: Description of Figure 56-12 follows]






	
Click Add, then OK and OK again to close the Edit. You see the new icon and description appear in the Resource Catalog (Figure 56-13).


Figure 56-13 Search Task Flow Icon and Description

[image: Search task flow icon]



	
Back on the Administration - Resources - Resource Catalogs page, select this new Resource Catalog, and click Edit - Show to make it available.


	
Create a new Space, and display the General page of the Space administration settings.


	
For Resource Catalog for Pages, select the new Resource Catalog, and click Apply (Figure 56-14).


Figure 56-14 Space Administration Settings for New Resource Catalog

[image: Description of Figure 56-14 follows]






	
In the new Space, create a new page (Figure 56-15).


Figure 56-15 Create New Page Dialog

[image: Description of Figure 56-15 follows]






	
On the new page, click Add Content, navigate to the Search task flow, and click Add to add the Search task flow to the page. Click Close.


	
Click Save, then Close.


	
Run a search term in the Search field (Figure 56-16).


Figure 56-16 Search Task Flow in a Space

[image: Description of Figure 56-16 follows]








You can configure how the search results are displayed. Specifically, you can control which services are included in the search and the order in which those services are listed in the results. For information about setting display options for Space search results, see Section 56.2, "Setting Preferences for WebCenter Spaces Search Results."








56.3.3 Refining the Display of Search Results

Users can narrow down searches using refiners to produce a smaller set of results. For example, to see all documents that one particular person posted, rather than scrolling through pages of results to find them, you can just click that name or profile picture, and the results are filtered to show only results from that person.

With the default WebCenter search adapters, you can refine your search by specifying a time range within which the result was last modified and by limiting results to those associated with a particular user.




	
Note:

Results from people, tags, tagged items, and favorites, which do not supply refiners to the Search service, do not appear in refined searches.







With the Oracle SES adapter, you additionally can refine the search by content type, Space, and tag.

To refine the display of search results:

	
Perform a global search as described in Section 56.3.2.1, "Performing a Global Search."

Or perform a Space search as described in Section 56.3.2.2, "Performing a Space Search."

The search results display on the Search results page.


	
In the Refine Search section, choose criteria to refine the search. For example, choose a time-range limitation from the Last Modified box (Figure 56-17).


Figure 56-17 The Last Modified Refiner on the Search Results Page

[image: Last Modified Date on Search Results page]






For example, click Past 7 Days to view all results that originated in the past week. Click March 2010 to view all results that originated in March 2010.

The number next to each time range indicates the search's best guess at how many search results fall within the specified range.

Some date selections, such as years or months, provide additional refinement options when you choose them. For example, when you refine a search by all results occurring within 2007, your refined results display and additional refinements appear in the Last Modified box.

Alternatively, click Custom Date Range and enter a date in the field provided (optionally, with an end date also), or click the Select Date icon and choose a date from a date picker (Figure 56-18).


Figure 56-18 Date Picker for Custom Date Range

[image: Select Date date picker]



	
To refine the display of search results by author (that is, by the user name of the person who created, uploaded, or originated the result), choose someone from the Author box (Figure 56-19).


Figure 56-19 The Author Box on the Search Results Page

[image: Contributor box on Search Results page]






For example, click vicki to view all results contributed by the user vicki.

The number next to each user name indicates the search's best guess at how many search results are associated with the specified user.

Click More... or Less... to see more or less authors in the Author box.


	
When a refinement is selected, it appears above the Results list with a Delete icon, enabling you to remove the refinements you have applied to search results (Figure 56-20).


Figure 56-20 Delete Icon to Remove Refinement of Search Results

[image: Remove links on Search Results page]






Click the Delete icon to remove that particular search results refinement and broaden the list of displayed results.









56.3.4 Saving Searches

After you have performed a search, you can save it so that you can run it again later without having to reenter the search terms. You can also share the saved search with Spaces.




	
Note:

You can save searches only if you are logged in to the application.







This section includes the following subsections:

	
Section 56.3.4.1, "Saving a Search"


	
Section 56.3.4.2, "Running a Saved Search"


	
Section 56.3.4.3, "Sharing a Saved Search in WebCenter Spaces"


	
Section 56.3.4.4, "Customizing a Saved Search"


	
Section 56.3.4.5, "Deleting a Saved Search"






56.3.4.1 Saving a Search

Saved searches are useful for the searches you run frequently. They assist in keeping you current as new information is added to the search pool.

To save a search:

	
Perform a global search as described in Section 56.3.2.1, "Performing a Global Search."

Or perform a Space search as described in Section 56.3.2.2, "Performing a Space Search."

The search results display on the Search results page.


	
Click Save below the search field (Figure 56-21).


Figure 56-21 Save and Manage Buttons

[image: Manage button]



The Create Saved Search dialog opens (Figure 56-22).


Figure 56-22 The Create Saved Search Dialog

[image: Create New Saved Search dialog box]



	
In the Name field, enter a meaningful name for the search.

The value you enter in the Name field is the value that appears on the dropdown list of saved searches.

The search that was in the Search field is saved, no matter what name you give it. For example, if the search term was admin, but you enter jcr in the Name field. The saved search searches for the term admin and not jcr.


	
Optionally, in the Description field, enter a description of the search.


	
Select the Share in space checkbox to enable other members of the Space to see this search on the Space's dropdown list of saved searches. Only one Space can be specified.


	
Click the Spaces icon to select the spaces in which to share the saved search.


	
Click OK to save the search.









56.3.4.2 Running a Saved Search

The All Saved Searches task flow provides a quick and easy way to see all saved searches. The saved searches to which you have access depends on the location.

	
Go to your Home Space. After you have saved searches, there is a dropdown list for Saved Searches in your Home Space.


	
Go to any page containing the All Saved Searches task flow (Figure 56-23).

In a Space, the All Saved Searches task flow lists all your saved searches for the Space and all shared saved searches for the Space (made both by yourself and other users). It does not list your global saved searches or saved searches made against other Spaces. In a Home Space, the All Saved Searches task flow lists all your global saved searches.


Figure 56-23 The All Saved Searches Task Flow

[image: All Saved Searches task flow]



	
Go to any page where the saved search was placed.

The Saved Search task flow shows the results of the particular search.




To run a saved search:

	
Log in and find the saved search:

	
Locate the page containing the All Saved Searches task flow.


	
Locate the page containing the saved search. In this case, the search results are immediately visible.





	
From the All Saved Searches task flow or the Saved Search panel in the Home space, click the link for the saved search you want to run.




	
Tip:

The description is rendered as a tooltip when you move your cursor over the name of the saved search.








	
View the results on the dynamically-generated Search Results page.









56.3.4.3 Sharing a Saved Search in WebCenter Spaces

In WebCenter Spaces, you can share a saved Space search if you think the results of a search might be useful for other Space members.

To share a saved search:

	
Go to the Space where the search was performed and saved.


	
Click Manage (Figure 56-28).


Figure 56-24 Save and Manage Buttons

[image: Manage button]



The Manage Saved Searches window opens (Figure 56-29).


Figure 56-25 The Manage Saved Searches Window

[image: Manage (saved searches) window]



In the Saved searches dropdown list, select the saved search you want to share.


	
Select the Share in space checkbox, and click the Spaces icon to select the Spaces in which you want to share this saved search.

The saved search is now available for other members of the Space to run. The search is listed in the Saved Searches list for all Space members and in the All Saved Searches task flow, if one exists.


	
Click Apply, then OK.









56.3.4.4 Customizing a Saved Search

After you have added the results of a saved search to a page, you can customize it.

Click the Personalize icon (Figure 56-26) to make changes to the saved search.


Figure 56-26 Personalize Icon

[image: Personalize icon]



In the Customizing Saved Searches dialog, you can to change the search terms, add refiners, or choose the services to search (Figure 56-27).


Figure 56-27 Customizing Saved Searches Dialog

[image: Description of Figure 56-27 follows]










56.3.4.5 Deleting a Saved Search

To delete a saved search:

	
Click Manage (Figure 56-28).


Figure 56-28 Save and Manage Buttons

[image: Manage button]



The Manage Saved Searches window opens (Figure 56-29).


Figure 56-29 The Manage Saved Searches Window

[image: Manage (saved searches) window]



	
In the Saved searches dropdown list, select the saved search you want to delete.


	
Click the Delete button, then Apply and OK.













56.4 Setting Search Service Task Flow Properties

The Search service task flows have associated properties, which users with sufficient privileges can access from the Component Properties dialog in Oracle Composer (Figure 56-30).


Figure 56-30 Saved Search Task Flow Component Properties

[image: Component Properties dialog]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Search service task flows and describe the properties on the Parameters tab.

	
Section 56.4.1, "What You Should Know About the Search Service Task Flow Properties"


	
Section 56.4.2, "Search Service Task Flow Parameters"






56.4.1 What You Should Know About the Search Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 56.4.2, "Search Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So this tab may be omitted. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor.






56.4.2 Search Service Task Flow Parameters

Table 56-2 describes the parameters that are unique to Search service task flows.


Table 56-2 Search Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Services to be Excluded

	
A list of IDs of services or executors to omit when displaying search results.

This parameter is intended for internal use only. Do not change this value.

	
Search


	
Show or hide input box

	
Show or hide the input box. Set to true (default) to show the input box, or set to false to hide it.

	
Search


	
Resource ID

	
Either search keywords or the saved search GUID.

This parameter is intended for internal use only. Do not change this value unless you want coded search main views. If you do change this value, then you must also specify Resource Type.

	
Search


	
Resource Scope

	
Unique ID to limit the search scope. To limit the search to a particular Space, set this to the GUID of the Space; for example, #{spaceContext.currentSpaceGUID}.

	
Search


	
Resource Type

	
A marker specifying whether the Resource ID parameter means search keywords or saved search GUID.

This value is set automatically and is for internal use only. Do not change it unless you want coded search main views.

	
Search


	
Search Scope ID

	
Unique ID to limit the search scope. To limit the search to a particular Space, set this to the GUID of the Space; for example, #{spaceContext.currentSpaceGUID}.

	
Search Toolbar


	
Search Box Size

	
Value to limit the size of the search box. The default value is 42. Enter a lower number (for example, 30) to shorten the length of the search box. This also changes the size of the search box in the Search task flow.

	
Search Toolbar











	
Note:

The All Saved Searches and the Search Preferences task flows do not have any unique properties.













27 Working with OmniPortlet

This chapter provides an overview of OmniPortlet and explains the user interface elements associated with OmniPortlet. This chapter contains the following sections:

	
Section 27.1, "What You Should Know About OmniPortlet"


	
Section 27.2, "Working with the OmniPortlet Wizard"


	
Section 27.3, "Working with OmniPortlet Parameters"


	
Section 27.4, "Setting OmniPortlet Properties"


	
Section 27.5, "Troubleshooting OmniPortlet"




For information regarding troubleshooting OmniPortlet, see Section 27.5, "Troubleshooting OmniPortlet."


Audience

This chapter is intended for users who want to understand OmniPortlet and learn how to use its features. It introduces how to customize OmniPortlet at runtime and in Spaces, in addition to troubleshooting issues with OmniPortlet.



27.1 What You Should Know About OmniPortlet

OmniPortlet is a subcomponent of Oracle WebCenter Framework that enables developers to easily publish data from various data sources using a variety of layouts without writing any code. You can base an OmniPortlet on almost any kind of data source, including Web services, SQL databases, spreadsheets (that is, files with character-separated values), XML, and even application data from existing Web pages.




	
Note:

If your data source is a spreadsheet, the spreadsheet must be unsecured or must require only HTTP authentication; SSO authentication is not supported.







Additionally, OmniPortlet enables developers to:

	
Sort the data to display


	
Format data using a variety of layouts, including a customized layout


	
Use portlet parameters


	
Expose personalizable settings to page viewers




To display personalized data, you can refine the results returned from a data source and parameterize the credential information used to access secure data. Out of the box, OmniPortlet provides the most common layout for portlets: tabular, chart, news, bulleted list, form, HTML, and parameter form.




	
Notes:

For more information about developing different types of portlets and information about producers and other portlet technologies, see Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.
For more information about adding an instance of OmniPortlet to a page, see Section 27.2.1, "Adding an OmniPortlet Instance to a Page."














27.2 Working with the OmniPortlet Wizard

This section includes the following subsections:

	
Section 27.2.1, "Adding an OmniPortlet Instance to a Page"


	
Section 27.2.2, "Accessing the OmniPortlet Wizard"


	
Section 27.2.3, "Selecting the Data Source Type"


	
Section 27.2.4, "Identifying the Data Source"


	
Section 27.2.5, "Setting Filtering Options"


	
Section 27.2.6, "Setting View Options"


	
Section 27.2.7, "Setting Layout Options"


	
Section 27.2.8, "Customizing Your OmniPortlet"






27.2.1 Adding an OmniPortlet Instance to a Page

The steps for adding an instance of OmniPortlet to a page vary between a custom WebCenter portal application and the WebCenter Spaces application. For one thing, in a custom WebCenter portal application adding a portlet to a page is a design-time activity, carried out by the application developer. For information about adding OmniPortlet to a page in a custom WebCenter portal application, see the “Creating Portlets with OmniPortlet” chapter in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.

In WebCenter Spaces, portlets are added to pages at runtime—when you run the application. Portlets are available for dragging and dropping from the Oracle Composer Catalog by any user with sufficient privileges. For information about adding a portlet to a page in WebCenter Spaces, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Note:

In WebCenter Spaces, avoid adding a portlet to a Movable Box layout component (For information, see Section 18.2.3, "Working with the Movable Box Layout Component"). The Movable Box layout component duplicates the showDetailFrame that the portlet provides by default. Adding a portlet to a Movable Box creates an unnecessary and potentially error-prone redundancy.







When you add an instance of OmniPortlet to a page, access the portlet's Component Properties dialog and ensure that the RenderPortletInIFrame property is set to true. This displays the OmniPortlet in its own inline frame (IFRAME) in View mode.

For information about the Component Properties dialog, see Section 27.4, "Setting OmniPortlet Properties."






27.2.2 Accessing the OmniPortlet Wizard

Once you add an instance of OmniPortlet to your page, click the Customize link to start the OmniPortlet wizard.

The OmniPortlet wizard initially contains five steps:

	
Select a data source type.


	
Identify the data source.




	
Note:

If your data source is a spreadsheet, the spreadsheet must be unsecured or must require only HTTP authentication; SSO authentication is not supported.








	
Set filtering options.


	
Set view options.


	
Set layout options.




Once you complete these steps, you are done. If you want to change your initial values, you can reenter the wizard by selecting the Customize option from the portlet's Actions menu. Tabs representing the steps you took to set up OmniPortlet display. Although the data type cannot be changed, you can revise values on the Source, Filter, View, and Layout tabs.

Table 27-1 provides a high-level overview of the steps/tabs provided for configuring an OmniPortlet instance.


Table 27-1 OmniPortlet Wizard and Customize Mode

	Step/Tab	Description
	
Type

	
Provides your data source options. Displays only in the initial definition of the portlet, and is not available when customizing the portlet defaults. For more information, see Section 27.2.3, "Selecting the Data Source Type."


	
Source

	
Provides options for configuring the data source connection, such as the URL of the Web Service you want to use. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.4, "Identifying the Data Source."


	
Filter

	
Provides sorting options at the WebCenter portal application level to enable you to refine your results. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.5, "Setting Filtering Options."


	
View

	
Provides options for displaying portlet header and footer text, the layout style, and caching. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.6, "Setting View Options."


	
Layout

	
Provides detailed options for customizing the layout of content retrieved from the data source. You can change these options later when editing the portlet defaults. For more information, see Section 27.2.7, "Setting Layout Options."











	
Note:

On the IBM Linux on Power platform, if the action buttons (Next, Previous, Finish, and Cancel) are minimized to dots when defining the OmniPortlet, increase the stack size shell limit to unlimited and restart the oc4j_portlet instance. Run the following command to set the stack size shell limit to unlimited: prompt> ulimit -s unlimited.







The following sections provide more detail about the different steps/tabs in the OmniPortlet wizard.






27.2.3 Selecting the Data Source Type

When you first start OmniPortlet, the Type step displays (Figure 27-1).


Figure 27-1 Type Tab of the OmniPortlet Wizard

[image: Shows Type tab of OmniPortlet.]






Use the Type step to identify the type of data to display in your OmniPortlet instance. Table 27-2 lists and describes the data types that OmniPortlet supports out of the box.


Table 27-2 OmniPortlet Supported Data Source Types

	Data Source Type	Description
	
Spreadsheet

	
Displays data from a text file containing character-separated values (CSV).

Note: If your data source is a spreadsheet, the spreadsheet must be unsecured or must require only HTTP authentication; SSO authentication is not supported.


	
SQL

	
Displays data from a database using SQL.


	
XML

	
Displays data from an XML file.


	
Web Service

	
Displays data from a discrete business service that can be accessed over the Internet using standard protocols.


	
Web Page

	
Displays data based on existing Web content.








After you complete the OmniPortlet wizard, you cannot change the data source type.






27.2.4 Identifying the Data Source

Once you choose a data type, you are ready to identify a data source. The Source tab renders according to the data type you selected in step 1. That is, the options that display on the Source tab vary according to the selected data type.

Additionally, if the OmniPortlet producer has been configured to use a proxy server requiring authentication, the Source tab contains a Proxy Authentication section and a Connection section where you can provide the necessary information for connecting to the data source.

This section contains information about the settings common to all Source tabs, including settings specific to the selected data type. It contains the following subsections:

	
Section 27.2.4.1, "Proxy Authentication"


	
Section 27.2.4.2, "Connection and Portlet Parameters"


	
Section 27.2.4.3, "Spreadsheet"


	
Section 27.2.4.4, "SQL"


	
Section 27.2.4.5, "XML"


	
Section 27.2.4.6, "Web Service"


	
Section 27.2.4.7, "Web Page"






27.2.4.1 Proxy Authentication

If the OmniPortlet producer was set up at design time to use proxy authentication that requires login credentials, then a Proxy Authentication section displays on the Source tab where you can enter this information.

OmniPortlet's support for proxy authentication includes support for global proxy authentication and authentication for each user, which means you can specify a login scenario for your OmniPortlet instance:

	
All users automatically log in using a user name and password you provide.


	
Each user logs in using an individual user name and password.


	
All users log in using the same specified user name and password.




The Proxy Authentication section displays only for the following data types, and only when the specific data source requires a proxy server for access:

	
CSV (character-separated values)


	
XML


	
Web Page







	
Notes:

Configuring an OmniPortlet producer is a design-time activity applicable to custom applications (that is, those applications created with Oracle WebCenter Framework). For more information about configuring the OmniPortlet producer to use proxy authentication, see the Oracle WebCenter Framework online Help topic that displays when you click Help on the Edit Producers: OmniPortlet Producer page.
If the OmniPortlet producer is configured to require login for all users, then each user must set his or her own proxy login information at runtime as follows:

	
For page designers, set this on the Customize: Source tab.


	
For page viewers, set this on the Personalize page.




To access the Customize: Source tab, click the Customize link on the portlet's Actions menu. To access the Personalize page, click the Personalize link on the portlet's Actions menu.

If you are using the Web Page data source, then the Proxy Authentication section displays in the Web Clipping Studio when you click the Select Web Page button on the Source tab.

For more information about Web Clipping Studio, see Chapter 28, "Working with the Web Clipping Portlet."














27.2.4.2 Connection and Portlet Parameters

For each data source—except the Web Page data source—the Source step contains a Connection section, where you can define connection information for accessing secured data. The Source step for all data sources includes a Portlet Parameters section, where you can define portlet parameters (Figure 27-2).


Figure 27-2 Source Tab: Connection and Portlet Parameters Sections

[image: OmniPortlet. Source tab]









	
Note:

You can use the format ##ParamN## (for example, ##Param1##) for Username, Password, or Connection String. The Test button returns an error, however, even though the connection information is correct when parameter values are substituted.







Once you define the portlet parameters, you can map them to page parameters. For more information, see Section 27.3, "Working with OmniPortlet Parameters" and Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

To edit the connection information, click the Edit Connection button to open the Connection Information page (Figure 27-3).


Figure 27-3 OmniPortlet Connection Information Page for a SQL Data Source

[image: OmniPortlet Connection Information page]






On the Connection Information page, you can enter a name for the connection information, and also the user name and password. For a SQL data source, you can also enter information to specify the driver you want to use to connect to the data source. For more information, see Section 27.2.4.4, "SQL."




	
Note:

For more information about the Connection Information page, click Help on the Source tab of the OmniPortlet wizard.












27.2.4.3 Spreadsheet

Spreadsheets are a common method of storing small data sets. OmniPortlet enables you to share spreadsheets by supporting character-separated values (CSV) as a data source. Use the Source tab to specify the location of the CSV file (Figure 27-4).


Figure 27-4 Source Tab: Spreadsheet (CSV)

[image: Source tab for a spreadsheet data type]






If the file is located on a secure server, then you can specify the connection information in the Connection Information section illustrated in Figure 27-3. You can select the character set to use when WebCenter Suite reads the file, and also the delimiter and text qualifier.




	
Note:

	
As the OmniPortlet producer exists and executes in a tier different from the WebCenter portal application and does not have access to the session information, you must expose CSV files as PUBLIC for OmniPortlet to be able to access them.


	
The CSV file must be unsecured or must require only HTTP authentication; SSO authentication is not supported.

















27.2.4.4 SQL

A relational database is the most common place to store data. OmniPortlet enables you to use standard JDBC drivers and provides out-of-the-box access to Oracle and any other JDBC database. You can specify the driver type when you configure the connection information.

Figure 27-5 shows the Source tab for a SQL data source.


Figure 27-5 Source Tab: SQL

[image: Driver Name list on the Connection Information page]






You can use DataDirect JDBC drivers to access other relational databases. To do so, you must configure OmniPortlet to recognize the driver. This is a design-time activity, typically carried out by an application developer.




	
Notes:

For information about configuring OmniPortlet to use DataDirect drivers, see Appendix E, “Additional Portlet Configuration” in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.
For more information about DataDirect drivers, see the Certification Matrix for Oracle Application Server and DataDirect JDBC on the Oracle Technology Network (OTN) at http://www.oracle.com/technetwork.









Once the driver is installed, it displays in the Driver Name dropdown list on the Connection Information page (Figure 27-6).


Figure 27-6 Driver Name Dropdown List on the Connection information Page

[image: Description of Figure 27-6 follows]






When you enter a connection string for a DataDirect driver, keep in mind that you must enter a value in the Connection String field using the syntax: host_name:port. The host_name is the name of the server where the database is running. The port is the database's listening port.






27.2.4.5 XML

You can access XML data sources across an intranet or the Internet. On the Source tab, you can specify the URL of the XML file that contains your data (Figure 27-7).


Figure 27-7 Source Tab: XML

[image: Description of Figure 27-7 follows]






Use the Test buttons next to the XML URL and the XSL Filter URL fields to validate your XML data source and the XSL filter.

The specified XML file can be in a tabular (ROWSET/ROW) structure, or you can provide an XML Style Sheet (XSL) that transforms data into the ROWSET/ROW structure. Example 27-1 provides an illustration of the ROWSET/ROW structure of an XML data source.


Example 27-1 ROWSET/ROW Structure of an XML Data Source


<TEAM>
  <EMPLOYEE>
    <DEPTNO>10</DEPTNO>
    <ENAME>KING</ENAME>
    <JOB>PRESIDENT</JOB>
    <SAL>5000</SAL>
  </EMPLOYEE>
    <DEPTNO>20</DEPTNO>
    <ENAME>SCOTT</ENAME>
    <JOB>ANALYST</JOB>
    <SAL>3000</SAL>
  <EMPLOYEE>
</TEAM>




In Example 27-1, the <TEAM> tags delineate the rowset, and the <EMPLOYEE> tags delineate the rows.

Regardless of the format of the XML file, OmniPortlet automatically inspects the XML to determine the column names, which are then used to define the layout. If you want to specify this information yourself, you can supply a URL to an XML schema that describes the data.

If the XML file is located on a secured server protected by HTTP Basic Authentication, you can specify connection information on the Connection Information page.




	
Note:

Because the OmniPortlet producer exists and executes in a tier different from the WebCenter portal application and does not have access to the session information, you must expose XML files as PUBLIC in order for OmniPortlet to access them.












27.2.4.6 Web Service

A Web Service is a discrete business service that can be programmatically accessed over the Internet using standard protocols, such as SOAP and HTTP. Web Services are specific to neither platform nor language and are typically registered with a Web Service broker. When you find a Web Service you want to use, you must obtain the URL to the Web Service Description Language (WSDL) file. The WSDL file describes the Web Service and specifies the methods that can be called, including the expected parameters. It also describes the returned data.

OmniPortlet supports both types of Web Services: Document and Remote Procedure Calls (RPC). After a WSDL document/file is supplied, it is parsed, and the available methods that can be called display on the Source tab.

Similar to the XML data source, OmniPortlet expects the Web Service data in ROWSET/ROW format, though you can also use an XSL file to transform the data. OmniPortlet inspects the WSDL document/file to determine the column names, though you may also specify an XML schema to describe the returned data set.

Figure 27-8 shows the Source tab for a sample Web service.


Figure 27-8 Source Tab: Web Service

[image: Source tab when a Web Service data type is specified]










27.2.4.7 Web Page

OmniPortlet enables you to use existing Web content as a data source. It integrates the Web Clipping portlet's Web Clipping Studio to provide a means of clipping and rendering Web content within the context of an OmniPortlet instance.

OmniPortlet's Web Page data source extends the scope offered by the Web Clipping portlet to include scraping functionality. Additional features include:

	
Navigation through various login mechanisms, including form- and JavaScript-based submission, and HTTP Basic and Digest Authentication with cookie-based session management.


	
Fuzzy matching of clippings. If a Web clipping gets reordered within the source page or if its character font, size, or style changes, then it is still identified correctly by the Web page data source and delivered as the portlet content.


	
Reuse of a wide range of Web content, including basic support of pages written with HTML 4.0.1 and JavaScript, retrieved through HTTP GET and POST (form submission).




By default, all Web clipping definitions are stored persistently in Oracle Metadata Services (MDS). However, you can also use an Oracle database. Using MDS does not require any changes in the configuration files. If you use an Oracle database as the Web Clipping repository, then at design time you must update the provider.xml file.Any secure information, such as passwords, is stored in encrypted form, according to the Data Encryption Standard (DES), using Oracle Database encryption technology.

When Web Page is selected as the data type, the OmniPortlet wizard's Source tab (Figure 27-9) includes a Select Web Page button that launches Web Clipping Studio.


Figure 27-9 Source Tab: Web Page

[image: Description of Figure 27-9 follows]






Within Web Clipping Studio, the Oracle Application Server Web Clipping online Help becomes available through the Help icon at the top of the page. You can use the Help to navigate your way through the process of sectioning and saving Web content.




	
Note:

For more information about using the Web Clipping Studio or clipping content for a Web Clipping Portlet, see Chapter 28, "Working with the Web Clipping Portlet."














27.2.5 Setting Filtering Options

Once you have selected the data source and specified the data source options, you can further refine your data using OmniPortlet's filtering options. To use filtering efficiently, it is better to refine the data as much as possible at the data source level on the Source tab, then use the options on the Filter tab to streamline the data. For example, if you are using a SQL data source, then you could use a WHERE clause to return only specific data from the specified columns. In this case, you could skip the Filter tab and continue to the wizard's View tab. However, if there are no filtering options at the data source level, then you can use the options on the Filter tab to sort your data (Figure 27-10).


Figure 27-10 Filter Tab

[image: OmniPortlet Filter tab]










27.2.6 Setting View Options

Once you have specified and filtered the data, you are ready to choose view and layout options for your OmniPortlet. The View tab (Figure 27-11) provides options for adding header and footer text, enabling caching, and choosing a layout style that you can later refine on the Layout tab.


Figure 27-11 View Tab

[image: Description of Figure 27-11 follows]






On the View tab, you can choose from the following layouts:

	
Tabular


	
Chart


	
News


	
Bullet


	
Form


	
HTML


	
Parameter Form







	
Note:

For more information about the different layout styles you can use with OmniPortlet, see the next section or click Help in the OmniPortlet wizard.












27.2.7 Setting Layout Options

The Layout tab enables you to further customize the appearance of your OmniPortlet. The options on the Layout tab change according to your selection on the View tab. For example, when you select Chart Layout, options are provided for setting up chart hyperlinks. With chart hyperlinks, clicking a specific part of the chart triggers an event (for example, navigation to another URL).

For the other layout styles, you can define each column to display in a specific format, such as plain text, HTML, an image, a button, or a field. For example, suppose you selected a data source that includes a URL to an image. To see this image, you can select Image for the display of this column. Each column can also be mapped to an action, similar to the behavior of chart hyperlinks.

This section includes the following subsections that provide more detail about the layout options available on the OmniPortlet Layout tab:

	
Section 27.2.7.1, "Tabular Layout"


	
Section 27.2.7.2, "Chart Layout"


	
Section 27.2.7.3, "News Layout"


	
Section 27.2.7.4, "Bullet Layout"


	
Section 27.2.7.5, "Form Layout"


	
Section 27.2.7.6, "HTML Layout"


	
Section 27.2.7.7, "Parameter Form Layout"







	
Note:

Because events are not currently supported, selecting an action when designing your layout may produce unexpected results.









27.2.7.1 Tabular Layout

Typically, you use tabular layout when you have one or more columns of data to display in a table. You can choose Plain to display all rows in the table without any background color, or Alternating to display a background color for every other row in the table (Figure 27-12).


Figure 27-12 Layout Tab: Tabular

[image: Description of Figure 27-12 follows]









	
Note:

You can control the background color of a portlet using its style properties. Portlet style properties are exposed through the Properties panel in Oracle Composer. For more information, refer to Setting OmniPortlet Properties.







The Column Layout section provides options for selecting the data columns to display in the portlet and a display format. Additionally, you can associate a URL with a column to display column data as a hyperlink. You can also specify whether the secondary Web page displays in a new window. Figure 27-13 shows an example of an OmniPortlet using a tabular format.


Figure 27-13 Example of an OmniPortlet Using a Tabular Layout

[image: Shows example of portlet using tabular layout.]









	
Note:

For more information about using the OmniPortlet wizard, click the Help link on the Layout tab.












27.2.7.2 Chart Layout

Use the chart layout to display your data graphically, as a bar, pie, or line chart. The Layout tab (Figure 27-14) provides options for specifying the chart style to use (Chart Style) and the data source columns to display (Column Layout).


Figure 27-14 Layout Tab: Chart

[image: Layout tab when Chart is selected on View tab]






Under the Column Layout section, you can choose the data source columns to use in the chart (Group); the values to use in creating the chart legend (Category); and the relative size of the chart's bars, lines, or pie slices (Value).




	
Note:

To group the information in the chart, you must group the information at the data level (for example, in your SQL query statement). Also, if numeric values in a data source contain formatted strings, commas, or currency (for example, $32,789.00), then they are considered to be text and ignored when the chart is generated. You should remove these formatting characters if you want them to be correctly read as numeric values.







You can also select whether the sections of the chart should point to a hyperlink and whether the link target should display in a new window.

You can define chart hyperlinks so that each bar, pie section, or line links to another Web page. For example, you can place a pie chart and a report portlet on your page, then set up hyperlinks on the pie wedges. Users click a wedge to display a row in the report with detailed information about the wedge data.

Figure 27-15 displays an example of a pie chart. In this example, the Category value DEPARTMENT is used as the chart legend.


Figure 27-15 Example of an OmniPortlet Using a Pie Chart Layout

[image: Shows example of pie chart layout.]










27.2.7.3 News Layout

Use the News layout to display links to articles and brief article descriptions. You can use the News layout to publish information in standard XML formats, such as Resource Description Framework (RDF) or RSS (Really Simple Syndication).

Use the Column Layout section (Figure 27-16) to add a heading that displays at the top of the portlet, a logo, or a scrolling layout that enables users to view all the information in the portlet as it moves vertically.


Figure 27-16 Layout Tab: News

[image: News layout options on the OmniPortlet Layout tab]









	
Note:

The OmniPortlet News Layout Scroll type is supported on Microsoft Internet Explorer and Netscape 7.0.







The Layout tab also provides options for associating a URL with column data. Users click column data in the portlet to navigate to your specified target location.

Figure 27-17 shows an example OmniPortlet using a News layout.


Figure 27-17 Example of an OmniPortlet Using a News Layout

[image: Shows example of portlet in a news layout.]









	
Note:

For more information about using the OmniPortlet wizard, click the Help link on the Layout tab.












27.2.7.4 Bullet Layout

Use the Bullet layout to display your data in a bulleted or numbered list. The Layout tab (Figure 27-18) provides a variety of different bullet and numbering styles.


Figure 27-18 Layout Tab: Bullet

[image: Layout tab in the OmniPortlet Wizard]






In the Column Layout section, you can choose how the columns display in the portlet and associate a URL with column data.

Figure 27-19 shows an example of an OmniPortlet using a Bullet layout.


Figure 27-19 Example of an OmniPortlet Using a Bullet Layout

[image: Shows example of portlet with bullet style.]









	
Note:

For more information about using the OmniPortlet wizard, click the Help link in the Layout tab.












27.2.7.5 Form Layout


Figure 27-20 Layout Tab: Form

[image: Layout tab with Form layout options]






Use the Form layout when you want to display source data in a form with labeled fields, such as Name: <name>. You can then use portlet parameters to determine the data that displays.

Use the Column Label column to enter row labels and the Column column to specify which column to use from your data source. Additionally, you can specify data alignment, select a display mode (text, HTML, image, button, field, or hidden), associate a URL or an event with the column data, and specify whether to open the URL target in a new window.

Figure 27-21 shows an example of an OmniPortlet using a Form layout.


Figure 27-21 Example of an OmniPortlet Using a Form Layout

[image: Shows example of portlet using form style.]









	
Note:

For more information about using the OmniPortlet wizard, click the Help link in the upper right corner of the Layout tab.












27.2.7.6 HTML Layout

Use the HTML layout to create a customized look and feel for your OmniPortlet content. The Layout tab (Figure 27-22) provides a means of selecting a built-in HTML layout and modifying the code, or creating a new layout.


Figure 27-22 Layout Tab: HTML

[image: Description of Figure 27-22 follows]






You can hand-code your own HTML or JavaScript based on data columns that OmniPortlet has retrieved from the selected data source. By coding your own HTML and JavaScript, you have full control over the portlet's appearance, enabling you to develop a rich portlet interface.

For more information about using the fields on the Layout tab, click the Help button in the wizard. For an example of using JavaScript in the HTML layout, choose the Sortable Table layout from the Quick Start dropdown list on this tab.




	
Note:

The maximum number of characters you can enter in each of the sections (Heading, Repeating, and Footer) is 30,000 (30k).







Figure 27-23 shows an example of an OmniPortlet using the HTML layout.


Figure 27-23 Example of an OmniPortlet Using the HTML Layout

[image: Description of Figure 27-23 follows]










27.2.7.7 Parameter Form Layout

Use the Parameter Form layout to create a customized parameter form for your OmniPortlet content. The Layout tab (Figure 27-22) provides a means of selecting a built-in parameter form layout and modifying the code, or creating a new layout.


Figure 27-24 Layout Tab: Parameter Form

[image: Description of Figure 27-24 follows]






You can hand-code your own parameter form based on data columns that OmniPortlet has retrieved from the selected data source. By coding your own parameter form, you have full control over the portlet's appearance, enabling you to develop a rich portlet interface. To do so, choose the Custom style option, then use the Custom HTML field to edit the parameter form (Figure 27-25).


Figure 27-25 Layout Tab: Parameter Form Custom HTML Field

[image: Description of Figure 27-25 follows]






For more information about using the fields on the Layout tab, click the Help button in the wizard.








27.2.8 Customizing Your OmniPortlet

After you have created your OmniPortlet and returned to your application, you can select the Customize option from the portlet's Actions menu to revise your original selections. When you revise a defined OmniPortlet, tabs correspond to the different steps originally presented in the OmniPortlet wizard. An exception to this is the Type step—you cannot change the originally selected data type, and so there is no corresponding Type tab.

When you revise an OmniPortlet using customize mode, keep in mind the following notes:

	
Any modifications you make to your portlet using customize mode apply to all users, regardless of the current session language and the locale of the user's browser.


	
You can personalize the portlet at runtime by clicking the Personalize link on the portlet or by selecting the Personalize option on the portlet's Action menu. Personalizing the portlet creates a copy of the personalization object. As all properties are duplicated, subsequently modifying the portlet through Customize mode does not affect the personalized version of the portlet. To ensure the latest customizations are made to the portlet, after you make modifications in Customize mode, you must click Personalize again, and then select the Reset to Defaults option.


	
The personalization of OmniPortlet is stored in a file-preference store. For more information about configuring OmniPortlet and modifying the preference store, see Appendix E, “Additional Portlet Configuration” in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.











27.3 Working with OmniPortlet Parameters

You can define up to five portlet parameters for an OmniPortlet. You can define parameters in the following screens:

	
On the Source screen of the wizard when you define the OmniPortlet


	
On the Source tab when you select Customize for a defined OmniPortlet




Figure 27-26 shows the Portlet Parameters section on the Source tab.


Figure 27-26 Source Tab: Portlet Parameters Section

[image: Portlet Parameter section on the Source tab]






If you select any of these portlet parameters to be personalizable (by selecting the Personalizable checkbox), you can set their values on the Personalize screen.




	
Note:

You can learn more about portlet parameters in the online Help, which you can access by clicking the Help link on the Source tab in the OmniPortlet wizard. The online Help describes portlet parameters in detail, and how to set them up for your OmniPortlet.







Once you have set up portlet parameters in your OmniPortlet, you can contextually map the portlet to other portlets or components on a page. For more information about doing so, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."






27.4 Setting OmniPortlet Properties

OmniPortlet has associated properties that users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 27-27).


Figure 27-27 OmniPortlet Component Properties

[image: Component Properties dialog]



For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 27.4.1, "What You Should Know About OmniPortlet Properties"


	
Section 27.4.2, "OmniPortlet Properties"






27.4.1 What You Should Know About OmniPortlet Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 27.4.2, "OmniPortlet Properties." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






27.4.2 OmniPortlet Properties

Table 27-3 describes the properties that are unique to OmniPortlet.


Table 27-3 OmniPortlet Component Properties

	Property	Description	Location
	
Param#

	
Use to map page parameters to the parameters specified when the OmniPortlet was defined. These parameters enable you to contextually wire portlets and pages. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

	
Parameters tab


	
All Modes Shared Screen

	
For OmniPortlet, set this property to false to ensure that all portlet modes, except Show, are rendered each on their own page. Setting this property to true may prevent you from editing certain sections of your OmniPortlet in the OmniPortlet wizard.

	
Display Options tab


	
Id

	
A unique identifier for the portlet instance.

	
Display Options tab


	
Partial Triggers

	
Use to initialize a partial page refresh, which is a way of refreshing an area of a page without having to redraw the entire page.

	
Display Options tab


	
Render Portlet In I Frame

	
Use to render the portlet in an inline frame (IFRAME), omit an IFRAME, or let the portlet decide. Valid values are:

	
auto (default): The portlet tag checks the portlet response and decides if an IFRAME is required


	
true: Render the portlet instance in an IFRAME


	
false: Render the portlet instance inline




Placing a portlet inline on a page provides a better user experience as compared to placing it in an IFRAME. However, at times, it may be required to include a portlet in an IFRAME. For example:

	
The portlet is a JSF portlet


	
The portlet contains a file upload element


	
The parser throws an exception because it is not able to parse the markup




	
Display Options tab


	
Title

	
Enter a title for the OmniPortlet, to display in the portlet header.

	
Display Options tab














27.5 Troubleshooting OmniPortlet

This section provides information to help you troubleshoot problems you may encounter while using OmniPortlet.


Cannot Define OmniPortlet Using the Customize Link

You are not able to define the OmniPortlet at runtime by using the Customize link.


Problem

OmniPortlet only supports a RenderPortletInIFrame value of true, which means that OmniPortlet must be rendered within an IFRAME and therefore, the OmniPortlet property, RenderPortletInIFrame, must be set to true. At design time, the RenderPortletInIFrame property is available in the Property Inspector under Display Options. At runtime, the RenderPortletInIFrame property is available on the Properties panel in Oracle Composer.


Solution

Currently, the RenderPortletInIFrame property has a value of false and, consequently, when you click the Define link at runtime, the Type tab may not display and you cannot proceed with defining the OmniPortlet.

You can choose Customize from the Action menu to define OmniPortlet, or, for custom WebCenter applications at design time, select the OmniPortlet in the Structure window in Oracle JDeveloper, and in the Property Inspector, set RenderPortletInIFrame to true.





34 Liking, Commenting On, and Sharing Objects

Opportunities are available throughout your portal to express a favorable judgment on an application object, through liking, and associate a comment with an application object, through commenting. Opportunities to share application objects, files, and URLs are also readily available.

This chapter provides information about liking, commenting, and sharing in WebCenter Spaces. It includes the following sections:

	
Section 34.1, "Liking and Unliking Application Objects"


	
Section 34.2, "Commenting on Application Objects"


	
Section 34.3, "Sharing Files, URLs, and Streamed Items with Other Users"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission People Connections: Update People Connections Data. Users who plan to edit task flow properties must be assigned a role that also includes the permission Edit Pages. In a Space (other than the Home Space), users must be assigned a role that includes the permission Edit Page Access and Structure.



34.1 Liking and Unliking Application Objects

Liking is an accumulative rating system that enables you to see at a glance which objects are viewed most favorably by you and other users. A counter keeps track of the number of users who like the object. In a group of objects, you can determine the most favored by its number of likes (Figure 34-1).


Figure 34-1 Like Link on a Streamed Item

[image: Like link on a streamed item]



You can like streamed items that include objects. For example, you can like "Jack has updated doc.xml," but you cannot like "Jack and Jill are now connected."

You can express liking for the following types of application objects:

	
Message Board messages (for more information, see Section 33.1.1, "What You Should Know About Message Board")


	
Activity Stream items (for more information, see Section 32.1, "What You Should Know About Activity Stream")




	
Tip:

Whether you or any user can like an Activity Stream or Message Board object depends on whether the administrator has enabled liking for these features. For more information, see Section 6.4.3, "Configuring the People Connections Service for WebCenter Spaces."








	
Documents (for more information, see Section 41.27, "Liking and Unliking a File")




To like something, click the Like link or icon (a star) (Figure 34-2).


Figure 34-2 Like Icon on a Document

[image: Like icon on a document]



To remove your favorable rating (that is, unlike the object), click Unlike or click the Like icon again (Figure 34-3).


Figure 34-3 Unlike Link on a Streamed Item

[image: Unlike link on a streamed item]







34.2 Commenting on Application Objects

Commenting provides a means of adding your thoughts, opinions, and questions directly to a given application object.

You can comment on the following types of application objects:

	
Message Board messages (for more information, see Section 33.1.1, "What You Should Know About Message Board")


	
Activity Stream items (for more information, see Section 32.1, "What You Should Know About Activity Stream")




	
Tip:

You can comment on streamed items that include objects. For example, you can comment on "Jack has updated doc.xml," but you cannot comment on "Jack and Jill are now connected."








	
Documents and other types of files (for more information, see Section 41.5.2, "Menus and Actions in the Document Viewer Preview Pane or Window")




	
Tip:

When you comment on a file through the Activity Stream, the comment appears with the file in the Document Library as well as in the Activity Stream.










	
Note:

Public users viewing a public document cannot comment on the document.








	
Wikis (for more information, see Chapter 47, "Working with Wiki Documents")


	
Blogs (for more information, see Chapter 48, "Working with Blogs")




To comment on an object:

	
Click an object's associated Comment link (Figure 34-4).


Figure 34-4 Comment Link on a Streamed Item

[image: Comment link on a streamed item]



	
Fill in the resulting field (Figure 34-5)


Figure 34-5 Write a Comment Text Field

[image: Write a Comment text field]



	
Click the Comment button to save the comment.




To delete the comment, click its associated Delete icon (Figure 34-6).


Figure 34-6 Delete Icon on a Comment

[image: Delete icon on a comment]







34.3 Sharing Files, URLs, and Streamed Items with Other Users

This section provides an overview of the different types of sharing that are available through WebCenter Spaces, and steps you through each type. It includes the following subsections:

	
Section 34.3.1, "What You Should Know About Sharing"


	
Section 34.3.2, "Sharing Streamed Items with a Wider Audience"


	
Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow"






34.3.1 What You Should Know About Sharing

Sharing provides a means of on-the-spot distribution of items, files, and URLs of particular interest to a selected audience. Sharing is available in a few different forms:

	
Share an item you receive in your Activity Stream by posting it to your connections' Activity Streams (for more information, see Section 34.3.2.1, "Reposting Streamed Items").


	
Share an item you receive in your Activity Stream through email (for more information, see Section 34.3.2.2, "Emailing Streamed Items").


	
Share an item, file, or URL through the Publisher task flow (for more information, see Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow").




To share an item directly from your Activity Stream, the item must contain an object. For example, you can share "Jack has updated doc.xml," but you cannot share "Jack and Jill are now connected." Less obvious, you can share anything you post through the Publisher task flow because the post itself is an object.






34.3.2 Sharing Streamed Items with a Wider Audience

You can share items that appear in your view of the Activity Stream with a wider audience. For example, when your view of the Activity Stream reports that one of your connections updated a document of great interest to all of your connections, you can share that streamed item with all of your connections.

You can do so by posting the streamed item to all of your connections' Activity Streams or to the Activity Streams of connections who belong to a named Space. You can also share streamed items through email, enabling you to share it with users to whom you are not connected or to make use of mail distribution lists.




	
Note:

To share an item directly from your Activity Stream, the item must contain an object. For more information, see Section 34.3.1, "What You Should Know About Sharing."







This section includes the following subsections:

	
Section 34.3.2.1, "Reposting Streamed Items"


	
Section 34.3.2.2, "Emailing Streamed Items"






34.3.2.1 Reposting Streamed Items

Use the Share menu's This activity option to share a streamed item with your connections through their view of the Activity Stream.

To repost a streamed item to your connections' Activity Streams:

	
Go to the item you want to share, and from the Share menu select This activity (Figure 34-7)


Figure 34-7 This Activity Option on the Share Menu

[image: This Activity option on the Share menu]



	
In the resulting Share dialog:

	
Select Everyone to share the item with all of your connections (Figure 34-8).


Figure 34-8 Everyone Option on Share Something With Menu

[image: Everyone option on Share menu]



	
Select a Space, or select More Spaces to share the item with those of your connections who have access to the selected Space.

Selecting More Spaces opens the Select a Space dialog, from which you can choose a Space (Figure 34-9).


Figure 34-9 Select a Space Dialog

[image: Select a Space dialog]



From the Show Spaces menu:

	
Select All to show all of the Spaces to which you have access.


	
Select Joined to show all of the Spaces you have explicitly joined.


	
Select Moderated to show all of the Spaces for which you are a moderator.


	
Select Public to show all public Spaces.




Alternatively, enter the name of a Space in the Search field and execute the search. Results appear in the dialog.

Highlight a Space, and click OK.


	
Optionally, in the Share dialog, enter a message to accompany the link (Figure 34-10).


Figure 34-10 Adding a Message to a Shared Link

[image: Adding a message to a shared link]






	
Note:

When you share a message, rather than a file or a link, you cannot enter another message to accompany it.








	
Click OK.




The item is posted to the Activity Streams of the selected recipients.









34.3.2.2 Emailing Streamed Items

Use the Share menu's Send Mail option to share a streamed item through email. The Send Mail option is available on streamed items that include objects, such as a document. It is otherwise not available.

To share a streamed item through email:

	
Go to the item you want to share, and from the Share menu select Send Mail (Figure 34-11)


Figure 34-11 Send Mail Option on the Share Menu

[image: Send Mail option on the Share menu]



A mail message opens, prepopulated with a link to the selected item.


	
Address, write, and send the message as you would any other email.











34.3.3 Sharing Items, Files, and URLs Through the Publisher Task Flow

The Publisher task flow provides a means of publishing messages, files, and URLs to the Activity Streams of all of your connections or to those connections who have access to a specified Space. Publisher also has an associated property, Is Update Status, that enables users to publish a message as their Profile status message.

This section steps you through Publisher features and provides information about its associated properties. It includes the following subsections:

	
Section 34.3.3.1, "What You Should Know About the Publisher Task Flow"


	
Section 34.3.3.2, "Selecting the Recipients of a Published Message"


	
Section 34.3.3.3, "Sharing Files Through the Publisher Task Flow"


	
Section 34.3.3.4, "Sharing Links Through the Publisher Task Flow"


	
Section 34.3.3.5, "Setting Publisher Task Flow Properties"







	
See Also:

For information about Activity Stream, see Chapter 32, "Tracking Your Connections' Activities." For information about Profiles, see Chapter 30, "Managing Your Profile." For information about properties associated with the Publisher task flow, see Section 34.3.3.5, "Setting Publisher Task Flow Properties."









34.3.3.1 What You Should Know About the Publisher Task Flow

The Publisher task flow is very similar in operation to Message Board task flows (see Chapter 33, "Posting and Managing Messages and Feedback"). It differs in a few ways:

	
You can use it to send out messages, but not to receive them. It provides no feature for viewing messages.


	
It is specifically made to work in conjunction with Activity Stream, where the messages you enter are published.


	
It has its own distinct set of properties (see Section 34.3.3.5, "Setting Publisher Task Flow Properties").


	
It is not controlled by configuration settings at the application level nor through your own personal Preferences. You specify who sees your published messages through a control on the task flow itself. You can also exercise some control over the message destination through task flow properties. For example, the Publisher task flow has an associated property, Is Update Status, that enables users to publish a message as their Profile status message.




	
See Also:

For information about Profile, see Chapter 30, "Managing Your Profile."










There is one Publisher task flow (Figure 34-12).


Figure 34-12 Publisher Task Flow

[image: Publisher task flow]



In default WebCenter Spaces installations, the Publisher task flow is placed on the Activities business role page, which is provided in the Home Space for all authenticated users (that is, users who are logged in).

The default Activities business role page also contains an Activity Stream task flow where the messages you enter through the Publisher are published.




	
See Also:

For information about business role pages, see Section 7.1, "Working with Business Role Pages."












34.3.3.2 Selecting the Recipients of a Published Message

The Publisher task flow has a menu at the top where you can select who may see your message in their Activity Streams (Figure 34-13).


Figure 34-13 Share Something With Menu on Publisher Task Flow

[image: Share something with menu on Publisher]



To select the recipients of a published message:

	
Go to the Activities page in the Home Space.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through an Activities link.








	
In the Publisher task flow, select a value from the Share something with menu:

	
Select Everyone to share the item with all of your connections.


	
Select a Space, or select More Spaces to share the item with those of your connections who have access to the selected Space.

Selecting More Spaces opens the Select a Space dialog, from which you can choose a Space (Figure 34-14).


Figure 34-14 Select a Space Dialog

[image: Select a Space dialog]



From the Show Spaces menu:

	
Select All to show all of the Spaces to which you have access.


	
Select Joined to show all of the Spaces you have explicitly joined.


	
Select Moderated to show all of the Spaces for which you are a moderator.


	
Select Public to show all public Spaces.




Alternatively, enter the name of a Space in the Search field and execute the search. Results appear in the dialog.

Highlight a Space, and click OK.





	
Click in the text area, and enter your message (Figure 34-15).


Figure 34-15 Adding a Message to a Shared Link

[image: Adding a message to a shared link]






	
Note:

When you share a message, rather than a file or a link, you cannot enter another message to accompany it.








	
Click Share.

Your message appears in your view of the Activity Stream and in the Activity Streams of the selected recipients.









34.3.3.3 Sharing Files Through the Publisher Task Flow

In addition to sharing messages through the Publisher task flow, you can select to share files. When you share a file through the Publisher task flow, the uploaded file is also stored in the Public folder of your personal document library.




	
Tip:

If you prefer to have greater control over where a shared file is stored in your document library, you can upload it to the folder you prefer. Such uploads are also reported in your connection's activity streams, provided your activity stream is configured to show them. For more information, see Section 32.2, "Setting Activity Stream Preferences."







A Publisher task flow can be configured to hide the Attach: File link. If you do not see this link below the task flow, it could be because the instance is configure, through the Hide Document Uploader property, not to show it. For more information, see Section 34.3.3.5.3, "Prohibiting File Uploads Through a Publisher Task Flow Instance."

To share files through the Publisher task flow:

	
Go to an instance of the Publisher task flow, and select the recipients of your message.




	
See Also:

For more information, see Section 34.3.3.2, "Selecting the Recipients of a Published Message."








	
Optionally, click in the text area and enter the message you want to accompany the file.


	
Next to Attach, click the File link to open a file upload feature (Figure 34-16)


Figure 34-16 Attach File Field on Publisher Task Flow

[image: Attach File field on Publisher task flow]



	
Click Browse to navigate to and select the file you want to share.


	
Click Publish.

The file is streamed to your Activity Stream and to the Activity Streams of your selected recipients.




	
See Also:

Whether a file or a link to a file is shown depends on how the Activity Stream task flow instance is configured. For more information, see Section 32.5.4.2, "Hiding File Previews in Streamed Items."















34.3.3.4 Sharing Links Through the Publisher Task Flow

In addition to sharing messages through the Publisher task flow, you can select to share links.

To share links through the Publisher task flow:

	
Go to an instance of the Publisher task flow, and select the recipients of your message.




	
See Also:

For more information, see Section 34.3.3.2, "Selecting the Recipients of a Published Message."








	
Optionally, click in the text area and enter the message you want to accompany the link.


	
Next to Attach, click the Link link to open a field for entering a URL (Figure 34-17)


Figure 34-17 Attach Link Field on Publisher Task Flow

[image: Attach Link field on Publisher task flow]



	
Enter the URL you want to share, and click Attach.


	
Click Publish.

The link is streamed to your Activity Stream and to the Activity Streams of your selected recipients.









34.3.3.5 Setting Publisher Task Flow Properties

The Publisher task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 34-18).


Figure 34-18 Publisher Parameters in the Component Properties Dialog

[image: Publisher parameters in Component Properties]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with the Publisher task flow and describe the properties available on the Parameters tab:

	
Section 34.3.3.5.1, "What You Should Know About Publisher Task Flow Properties"


	
Section 34.3.3.5.2, "Publisher Task Flow Parameters"


	
Section 34.3.3.5.3, "Prohibiting File Uploads Through a Publisher Task Flow Instance"


	
Section 34.3.3.5.4, "Limiting the Scope of Recipients"


	
Section 34.3.3.5.5, "Using the Publisher as a Profile Status Updater"


	
Section 34.3.3.5.6, "Using the Publisher as a File Uploader"






34.3.3.5.1 What You Should Know About Publisher Task Flow Properties

When you set property values on the Publisher task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog can affect the default task flow content. For descriptions of the parameters on this tab, see Section 34.3.3.5.2, "Publisher Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






34.3.3.5.2 Publisher Task Flow Parameters

Table 34-1 describes the parameters that are unique to the Publisher task flow.


Table 34-1 Publisher Task Flow Parameters

	Parameter	Description
	
Hide Attach Links

	
Specifies whether the Attach: File|Link option is shown or hidden

	
Check for #{true} to hide the Attach: File|Link option.


	
Clear for #{false} to show the Attach: File|Link option.





	
Hide Document Uploader

	
Specifies whether the Share document icon is available on the task flow for uploading a document

	
Check for #{true} to hide the Share document icon


	
Clear for #{false} to show the Share document icon.





	
Hide Sharing Picker

	
Specifies whether the Share something with option is shown or hidden

	
Check for #{true} to hide the Share something with option.


	
Clear for #{false} to show the Share something with option.





	
Is Update Status

	
Indicates whether the message entered in the task flow instance should also be published as the user's Profile status message

	
Check for #{true} to publish the message as the user's Profile status message and in the selected recipients' Activity Streams.


	
Clear for #{false} to publish the message only in the selected recipients' Activity Streams.




If you attach a file or URL to a published message, then no matter what the state of Is Update Status, the message is not also used as a Profile status message.

For information about Profiles, see Chapter 30, "Managing Your Profile."


	
Keep open the Publisher after publish

	
Specifies whether the text box remains active after a user clicks the Publish button

	
Check for #{true} to keep the text box open after a message is published.


	
Clear for #{false} to close the text box after a message is published.





	
Message key of hints text

	
Specifies the resource bundle class and message key for hint text

Use the format key[,RBClass]. __EMPTY__ as the predefined key for no hint text. This is the default value.


	
Object Id

	
The ID of the object to be shared

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so using an EL expression. For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Object Type

	
The type of object to be shared

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so using an EL expression. For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Scope Id

	
The ID of the scope to which to publish

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so using an EL expression. For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Service Id

	
The service ID of the service to which the shared object belongs

This property value assists in generating a link for use in navigating to the published object. It is not necessary to provide a value, unless you plan to do so by entering a specific service ID or using an EL expression. For a list of valid service IDs, see Table B-19, "Service IDs". For information about EL expressions, see Appendix B, "Expression Language Expressions."


	
Space Name

	
The name of the Space in which to publish the messages entered in this task flow instance

Enter the Space internal name and not the Space display name. The Space internal name is the name specified by the Space URL on the General page of a Space's administration settings. The Space display name is specified by Display Name, and is the name that appears in the Space banner at the top of the Space.


	
Upload Document Only

	
Specifies that only the file upload feature is available in the task flow instance, hiding the text entry area and the Share link icon

	
Check for #{true} to show only the file upload feature and hide the text entry area and the Share link icon.


	
Clear for #{false} to show the text entry area and the Share link and Share document icons.





	
User Name

	
The name of the user who owns the current view

This value is supplied by default. We recommend that you do not change the default value, #{o_w_w_i_v_b_resourceViewerBean.username}.


	
Via User

	
The user name of the person who provided the object the current user is sharing

For example, John is sharing a document with everyone that Jane originally shared with him. In this case, Jane is the via user.












34.3.3.5.3 Prohibiting File Uploads Through a Publisher Task Flow Instance

You can use the Hide Document Uploader property to omit the display of the Share document icon on a Publisher task flow instance. Users will be able to share links but not files.

To prohibit file uploads through a Publisher task flow instance:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select the checkbox for the property Hide Document Uploader.


	
Click OK.









34.3.3.5.4 Limiting the Scope of Recipients

You can use the Space Name property to limit the scope of recipients of published messages to a user's connections in a particular Space. When you do this, the message does not even stream to your own view of the Activity Stream in the Home Space. It is streamed only to your and your connections' views of the Activity Stream in the named Space.

To limit the scope of recipients to a particular Space:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Enter the internal name of the Space in the Space Name field.




	
Tip:

The Space internal name is the name specified by the Space URL on the General page of a Space's administration settings. The Space display name is specified by Display Name, and is the name that appears in the Space banner at the top of the Space.








	
Click OK.

Messages posted through that Publisher task flow instance will be shared with only those connections who have access to the named Space.









34.3.3.5.5 Using the Publisher as a Profile Status Updater

You can use the Is Update Status property to specify that all messages without attachments are published not only to specified recipients, but also as the user's Profile status message (Figure 34-19).


Figure 34-19 Published Message Used as Profile Status

[image: Published message used as Profile status]



Messages that have an attached file or link are not simultaneously published as a Profile status message.

To specify that messages are also published as Profile status messages:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select the Is Update Status checkbox.


	
Click OK.

Messages that do not include attachments that are posted through that Publisher task flow instance are also shared as the user's personal Profile status message.









34.3.3.5.6 Using the Publisher as a File Uploader

You can use the Upload Document Only property to limit the functionality of the Publisher task flow to a file uploader (Figure 34-20).


Figure 34-20 Publisher Task Flow as Document Uploader

[image: Publisher as document uploader]



Files uploaded through the Publisher task flow are placed in the Public folder in the document library of the selected scope. That is:

	
In the Home Space:

	
Select Everyone to publish the file to the Public folder in each of your connections' personal Document Library.


	
Select a named Space to publish the file to the Public folder in the selected Space's Document Library.





	
In a Space, the file is published to the Public folder in the Space's Document Library.




To use the Publisher task flow as a file uploader:

	
Edit the properties of a Publisher task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Select the Upload Document Only checkbox.


	
Click OK.

The Publisher task flow instance renders as a file uploader (see Figure 34-20). The text area and the Share link icon are not rendered.
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	Add to Favorites Spaces component, 13.2.4
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	Allow Links column detail in lists, 64.2.3.2.2
	Allow Minimize property, 17.5.2.5
	Allow Move property, 17.5.2.5
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	Analytics service
	
	See Analytics, 55.3
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	application skins, using, 5.7
	applications, self registering to, 29.2
	Application-View permission, granting to Public-User role, 21.2.4
	authenticated-role, 20.3.1.1
	Authenticated-User role
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	Authentication Method, 6.6.2
	authentication to Microsoft Office files, 41.12.3
	automatic login for external applications, 6.6.2
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	Background Color property, 17.5.2.7.2
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	Background Image property, 17.5.2.7.2
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	See lists, color banding
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	basic display options, 18.2.3.2
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	adding to a Space, 51.13
	blog posts
	
	about, 48.3.1
	adding links, 48.3.5
	adding tags, 48.3.5
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	commenting, 34.2
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	creating, 48.2.1
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	directory structure, 48.1.2
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	Blog page style parameters, 48.2.2.3
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	subscribing, 48.2.3
	subscribing to, 36.3.3.3
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	bookmarks
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	Boolean data type in lists, 64.2.3.2.2
	Boolean values, Expression Language, B.1
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	Bottom Height property, 18.2.10.3
	Box layout component, 18.2.2, 18.2.2.2
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	display options
	
	Allow Action, 18.2.2.2
	Horizontal Alignment, 18.2.2.2
	Layout, 18.2.2.2
	Short Desc, 18.2.2.2
	Show Component, 18.2.2.2
	Show Split Action, 18.2.2.2
	Show Tab Action, 18.2.2.2
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	browser support in Web Clipping, 28.4
	bulleted layout for OmniPortlet, 27.2.7.4
	Bulleted View display template, 40.5
	Bulleted with Folder Label View display template, 40.5
	business mashups
	
	See mashups
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	choosing the default Resource Catalog, 5.10
	copying, 7.1.9
	creating, 7.1.3
	deleting, 7.1.10
	display order, 7.1.7
	editing, 7.1.8
	granting access, 7.1.4
	making public, 7.1.4.2
	revoking access, 7.1.4.1, 7.1.5
	seeded
	
	Activities, 7.1.1
	Analytics, 7.1.1
	Documents, 7.1.1
	My Profile, 7.1.1
	Space Templates, 7.1.1
	Spaces, 7.1.1
	Tag Center, 7.1.1



	setting page creation defaults, 7.1.2
	specifying a target audience, 7.1.4
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	Calendar Overlay Style property, 61.3.2
	Calendar Style Class property, 61.3.2
	Calendar Toolbox Layout property, 61.3.3
	Cancel Check Out action, 41.12.1
	Cancel Check Out menu action, 41.5.1.1
	Carousel View display template, 40.5
	Category ID property, 60.3.2
	Change Membership component, 13.2.6
	character sets, Web Clipping and, 28.4
	chart layout in OmniPortlet, 27.2.7.2
	Check Out menu action, 41.5.1.1, 41.5.2.1
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	about, 17.5.2.2, 17.5.2.6
	hiding, 17.5.2.6.1
	rearranging, 17.5.2.6.2
	showing hidden, 17.5.2.6.1



	Child Creation property, 18.2.10.4
	Chrome Style property, 17.5.2.5
	chrome, components and, 17.5.2.5
	Class URN property, 58.3.2
	Class URN Restrictions property, 58.3.2
	collaboration, documents and, 45
	collaborative services, 3
	
	about, 3.3.1
	Activity Graph and, 3.3.6
	Announcements service and, 3.3.3
	blogs and, 3.3.8
	commenting and, 3.3.4
	communities and, 3.2
	Discussions service and, 3.3.3
	Events service and, 3.3.3
	instant messaging and, 3.3.5
	liking and, 3.3.4
	Links service and, 3.3.7
	Lists service and, 3.3.9
	People Connections and, 3.3.2
	Polls service and, 3.3.6
	sharing and, 3.3.4
	Spaces and, 3.2
	Tags service and, 3.3.7
	wikis and, 3.3.8



	Collapse Tree Navigation property, 42.2.1
	color banding
	
	See lists, color banding



	Color property, 17.5.2.7.2
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	showing hidden in documents task flows, 41.6.1



	Columns menu action, 41.5.1.2
	comments
	
	application objects and, 34.2
	files and, 41.20
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	Comments menu action, 41.5.1.2, 41.5.2.2
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	portlet to task flow, 19.2.3
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	task flow to portlet, 19.2.4
	task flow to task flow, 19.2.1
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	components
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	chrome, 17.5.2.5
	collapsing and expanding, 29.4.2.4
	consumer components, 19.1
	dragging and dropping, 29.4.2.1
	producer components, 19.1
	properties
	
	See properties]



	rearranging, 17.5.2.6.2, 29.4.2.1
	removing, 29.4.2.2
	resizing, 29.4.2.3
	setting access on, 23.2
	setting properties on, 17.5.2.3
	wiring, 19



	concurrency warning, 17.3.1
	Connection List Name property, 31.5.2, 31.5.3.2
	Connection Name property, 42.2.1, 42.3.1, 42.4.1, 42.5.1, 42.6.1, 42.7.1
	Connections, 31
	
	about, 31.1
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	configuring, 6.4.3.3
	deleting users, 31.4.6
	inviting users to connect, 31.4.2
	lists
	
	adding users to, 31.4.5.2
	creating, 31.4.5, 31.4.5.1
	deleting, 31.4.5.4
	managing, 31.4.5
	removing users from, 31.4.5.3



	preferences, 31.2
	properties, 31.5
	responding to invitations, 31.4.4
	searching, 31.4.1.2
	setting up, 31.4
	subscribing to, 36.3.1
	task flows
	
	about, 31.1
	properties, 31.5, 31.5.2



	troubleshooting, 6.4.5.2
	viewing, 31.4.1.1
	
	pending invitations, 31.4.3.2
	received invitations, 31.4.3.2
	sent invitations, 31.4.3.1






	Connections - Card task flow
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	parameters
	
	Allow Remove, 31.5.2, 31.5.3.1
	Connection List Name, 31.5.2, 31.5.3.2
	Filter Pattern, 31.5.2, 31.5.3.6
	Hide Footer, 31.5.2
	Number of Columns, 31.5.2
	Number of Connections per page, 31.5.2, 31.5.3.4
	Number of Rows, 31.5.2, 31.5.3.5
	Profile Format, 31.5.2, 31.5.3.7
	Profile Launched on Selection, 31.5.2, 31.5.3.8
	Sort Criteria, 31.5.2
	User Name, 31.5.2






	Connections - Detailed View task flow
	
	about, 31.1
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	Number of Connections per page, 31.5.2, 31.5.3.4
	Sort Criteria, 31.5.2
	User Id, 31.5.2






	Connections - Quick View task flow
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	parameters
	
	Hide Footer, 31.5.2
	Hide Header, 31.5.2
	Number of Columns, 31.5.2
	Number of Connections per page, 31.5.2, 31.5.3.4
	Number of Rows, 31.5.2, 31.5.3.5
	User Id, 31.5.2






	Connections task flow
	
	about, 31.1
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	Current View, 31.5.2, 31.5.3.3
	Number of Rows (list layout), 31.5.2, 31.5.3.5
	User Name, 31.5.2






	Contact Administration Spaces component, 13.2.7
	Containing Folder Properties menu action, 41.5.1.2
	content
	
	adding, 17.5.1
	adding a content query to a navigation model, 11.2.2.1.2
	adding to a page, 39.1, 41.3
	collaborating on documents, 45
	creating and managing at runtime, 44
	including in application, 2
	setting properties on, 17.5.2
	stretching, 17.5.2.5



	content management, overview of, 2
	content orientation, 18.2.2.1
	Content page in Spaces, 51.8
	Content Presenter Configuration dialog, displaying, 40.3
	Content Presenter task flow
	
	about, 40.1
	adding to a page, 40.2
	Content Presenter Configuration dialog, 40.3
	creating Site Studio files, 40.10.3
	editing HTML files, 40.10.1
	editing Site Studio files, 40.10.2
	editing wikis, 40.10.1
	out-of-the-box display templates, 40.5
	previewing, 40.6
	properties, 40.11
	
	Data Source, 40.11.2
	Data Source Type, 40.11.2
	Maximum Results, 40.11.2
	Region Template, 40.11.2
	Task Flow Instance ID, 40.11.2
	Template Category ID, 40.11.2
	Template View ID, 40.11.2



	selecting
	
	display template, 40.5
	folder contents, 40.4.2
	results of query, 40.4.3
	results of scenario, 40.4.5
	single content item, 40.4.1






	Content Presenter templates, managing, 10.1.1
	content repositories
	
	adding content to a page, 39.1, 41.3
	adding files, 46.3.4.1
	deleting folders and files, 41.16



	content style properties
	
	about, 17.5.2.2, 17.5.2.7, 17.5.2.7.1
	properties
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	Color, 17.5.2.7.2
	Font, 17.5.2.7.2
	Font Size, 17.5.2.7.2
	Font Style, 17.5.2.7.2
	Height, 17.5.2.7.2
	Margin, 17.5.2.7.2
	Other CSS, 17.5.2.7.3, 17.5.2.7.3, 17.5.2.7.4
	Width, 17.5.2.7.2
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	content task flows
	
	See documents task flows



	Content Type, accessing properties for, 40.4.3, 41.29.2
	Content View Only property, 59.3.2
	contextual events, 17.5.2.8
	Control Panel Shown property, 30.6.2
	cookies, Web Clipping and, 28.4
	Copy menu action, 41.5.1.1
	Copyright Message Spaces component, 13.2.8
	copyright statement
	
	for a Space, 51.4.14
	for application, 5.2



	Create Page Spaces component, 13.2.9
	Create Space Spaces component, 13.2.10
	Create Subspace Spaces component, 13.2.11
	Created After property, 42.3.1
	Created Before property, 42.3.1
	Creator property, 42.3.1
	credential provisioning
	
	public credentials, 6.6.2
	shared credentials, 6.6.2



	CSS
	
	Other CSS property, 17.5.2.7.2
	pages, 17.3.4
	Web Clipping and, 28.4
	See also Other CSS property



	Current User Profile Spaces component, 13.2.12
	Current View property, 31.5.2, 31.5.3.3
	custom application roles, 20.3.1.2
	Custom Attributes page, Spaces and, 51.12
	custom attributes, Spaces and, 51.12
	Customization ID property, 61.3.2, 61.3.3
	customizations
	
	application, 17.5.2.1
	lists and, 64.2.5
	user, 17.5.2.1, 29.4.1
	Web Clipping, 28.2.2
	See also, user customizations



	Cut menu action, 41.5.1.1
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	data controls, 26.1.1
	Data Source property, 40.11.2
	Data Source Type property, 40.11.2
	data sources
	
	filtering data, 27.2.5
	using a spreadsheet, 27.2.4.3
	using an existing Web page, 27.2.4.7
	using SQL, 27.2.4.4
	using Web Services, 27.2.4.6
	using with OmniPortlet, 27.2.4
	using with portlets, 27.2.3
	using XML, 27.2.4.5



	data, filtering portlet, 27.2.5
	database connection, OmniPortlet and, 27.2.4.2
	databases, list sorting and, 64.2.5.1
	date preference, 35.3
	DateTime data type in lists, 64.2.3.2.2
	Default Current Date property, 61.3.2
	Default Document Details View display template, 40.5
	Default List Item View display template, 40.5
	default navigation model, 11.2.4
	Default Value column detail in lists, 64.2.3.2.2
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	Delete menu action, 41.5.1.1
	Delete Page permission, 23.1, 38.2.1
	Depressed Icon property, 13.2.2.1, 18.2.7.2
	Design view
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	page edit mode in, 17.3.2



	design-time defined, 19.1
	Destination property, 18.2.6.2, 18.2.7.2, 42.12.1
	Dimensions From property, 18.2.10.4
	Disable Personalize and Customize property, 61.3.2
	Disabled Icon property, 13.2.2.1, 18.2.7.2
	Disclosed property, 18.2.10.6
	discoverable Spaces, 51.14.3
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	editing replies, 60.2.4.4
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	replying to, 60.2.4.2
	view modes, 60.2.4.6
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	Display Message Size property, 33.5.2, 33.5.3.3
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	HTML Markup layout component, 18.2.4.2
	Hyperlink layout component, 18.2.6.2
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	Show Actions On Hover, 17.5.2.5
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	Source, 18.2.9.2
	Start Width, 18.2.10.3
	Stretch Content, 17.5.2.5
	Tab Removal, 18.2.10.4
	Target Frame, 18.2.7.2
	Task Flow Id, 13.2.9.1
	Text, 13.2.2.1, 17.5.2.5, 18.2.7.2, 18.2.10.6
	Text And Access Key, 18.2.7.2
	Theme, 18.2.10.2, 18.2.10.3
	Title, 18.2.6.2
	Top Height, 18.2.10.3
	Type, 13.2.3.1
	Valign, 18.2.10.2
	Value, 18.2.4.2
	Vertical Alignment, 18.2.2.2
	Width, 18.2.10.7



	separator layout component, 18.2.10.7
	showDetailFrame layout component, 18.2.10.5
	sidebarItem layout component, 18.2.10.6
	spacer layout component, 18.2.10.7
	Text layout component, 18.2.8.2
	validating expressions, B.1
	Web Page layout component, 18.2.9.2



	Display Shadow property, 17.5.2.5
	Display Style property, 11.3.2.2
	Display Tool Bar property, 51.16.2.3.1
	Display Type property, 13.2.2.1
	Display View property, 51.16.2.3.1
	Display Width column detail in lists, 64.2.3.2.2
	document components, about, 41.2
	Document Exchange template, 50.1.1
	Document Explorer task flow, 42.2.1
	
	about, 41.1.1
	parameters
	
	Collapse Tree Navigation, 42.2.1
	Connection Name, 42.2.1
	Features Off, 42.2.1
	Read Only, 42.2.1
	Resource ID, 42.2.1
	Show Documents, 42.2.1
	Show Folders, 42.2.1
	Start Folder Path, 42.2.1






	Document List Viewer task flow
	
	about, 41.1.2
	parameters
	
	Connection Name, 42.3.1
	Created After, 42.3.1
	Created Before, 42.3.1
	Creator, 42.3.1
	Last Modified After, 42.3.1
	Last Modified Before, 42.3.1
	Last Modifier, 42.3.1
	Root Folder Path, 42.3.1
	Show Folders, 42.3.1
	Task Flow Instance ID, 42.3.1






	Document Manager task flow
	
	about, 41.1.3
	parameters
	
	Connection Name, 42.4.1
	Features Off, 42.4.1
	layout, 42.4.1
	Page Size, 42.4.1
	Read Only, 42.4.1
	Resource ID, 42.4.1
	Start Folder Path, 42.4.1






	Document Mini Properties task flow
	
	about, 41.1.8
	parameters
	
	Resource ID, 42.9.1






	Document Navigator task flow
	
	about, 41.1.4
	parameters
	
	Connection Name, 42.5.1
	Page Size, 42.5.1
	Read Only, 42.5.1
	Resource ID, 42.5.1
	Show Documents, 42.5.1
	Start Folder Path, 42.5.1






	Document Properties task flow
	
	about, 41.1.9
	parameters
	
	Item ID property, 42.10.1
	Read Only, 42.10.1






	Document Version History task flow
	
	about, 41.1.10
	parameters
	
	Item ID, 42.11.1
	Read Only, 42.11.1






	Document Viewer preview pane
	
	File menu, 41.5.2.1
	menu actions, 41.5.2
	sidebar, 41.5.2.6
	View menu, 41.5.2.2



	Document Viewer task flow
	
	about, 41.1.7
	parameters
	
	Features Off, 42.8.1
	Initial Sidebar property, 42.8.1
	Item ID property, 42.8.1
	Read Only property, 42.8.1






	documents
	
	adding to navigation model, 11.2.2.1.1
	applying tags to, 57.2.3
	commenting on, 34.2
	creating links, 63.2.1.4, 63.2.2.3
	liking, 34.1
	subscribing to, 36.3.2



	Documents business role page, 7.1.1
	Documents service
	
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	blogs, subscribing to, 36.3.2
	EL expressions relating to, B.3.12
	parameters
	
	Features Off, 42.5.1
	Page Size, 42.3.1



	properties
	
	Data Source, 40.11.2
	Data Source Type, 40.11.2
	Maximum Results, 40.11.2
	Region Template, 40.11.2
	Task Flow Instance ID, 40.11.2
	Template Category ID, 40.11.2
	Template View ID, 40.11.2



	task flows
	
	Content Presenter, 40.1
	Document Explorer, 41.1.1, 42.2
	Document List Viewer, 41.1.2, 42.3
	Document Manager, 41.1.3, 42.4
	Document Mini Properties, 41.1.8, 42.9
	Document Navigator, 41.1.4, 42.5
	Document Properties, 41.1.9, 42.10
	Document Version History, 41.1.10, 42.11
	Document Viewer, 41.1.7
	Document Viewerr, 42.8
	Folder Viewer, 41.1.5, 42.6
	Recent Documents, 41.1.6, 42.7
	setting properties, 42



	wikis, subscribing to, 36.3.2



	Documents service task flows
	
	See documents task flows



	Documents system page, 7.3.1
	documents task flows
	
	about, 41.1
	adding to a page, 41.4
	cancelling file checkout, 41.12.1
	checking out files, 41.12.1
	commenting on files, 41.20
	creating files, 41.8
	creating folders, 41.7
	deleting folders and files, 41.16
	downloading files, 41.12.2
	editing files in-place, 41.12.3
	File menu, 41.5.1.1
	hiding columns, 41.6.1
	moving folders and files, 41.15
	opening files, 41.10
	opening files in PDF, 41.23
	opening folders, 41.9
	renaming folders and files, 41.13
	reordering columns, 41.6.2
	saving files in PDF, 41.23
	searching folders and files, 41.29
	setting file security, 41.25
	showing hidden columns, 41.6.1
	sorting files and folders, 41.6.3
	uploading files, 41.8.1
	uploading new version of file, 41.12.4
	URL for folders and files, 41.24
	using Rich Text Editor, 41.11
	View menu, 41.5.1.2
	viewing properties of folders and files, 41.22
	viewing version history of files, 41.21
	See also Content Presenter task flow



	Download action, 41.5.1.5, 41.5.2.5
	Download PDF menu action, 41.5.2.2
	dragging and dropping files and folders, 41.14, 41.15





E

	Edit action, 41.5.2.3
	Edit Defaults mode in OmniPortlet, 27.2.8
	Edit menu action, 41.5.1.1
	Edit Mode property, 30.6.2
	Edit Page permission, 23.1, 38.2.1
	Edit Page Spaces component, 13.2.13
	Edit Web Content, 40.6
	editors
	
	rich text, 18.2.8.1
	simple text, 18.2.4.1
	See also EL editor



	EL editor, 17.5.2.4, 17.5.2.5, B.1
	EL expressions, B
	
	application pages, B.3.7
	Documents service, B.3.12
	event contexts, B.3.9
	example, B.2
	navigation operations, B.3.4
	Oracle Composer, B.3.8
	Oracle WebCenter Spaces, B.3.2
	People Connections service, B.3.13
	Personalization Conductor, B.3.11
	Profile, B.3.13
	resources, B.3.5
	security, B.3.3
	seeded, B.3.1
	
	Application Info, B.3.1.1
	Page Info, B.3.1.2
	Page Parameter, B.3.1.3
	Resource Info, B.3.1.4
	Space Info, B.3.1.5
	Space Page Info, B.3.1.6
	System, B.3.1.7
	User Info, B.3.1.8
	WebCenter Events, B.3.1.9



	service IDs, B.3.10
	services, B.3.10
	Spaces, B.3.6
	use case, B.2
	user preferences, B.3.14
	utilitarian, B.3.15
	validating, B.1
	value formats, B.1



	Enable Action property, 17.5.2.8
	Enable Context Info property, 32.5.2
	End Date property, 33.5.2, 33.5.3.7
	End Width property, 18.2.10.3
	enterprise groups, assigning to roles, 21.1.2
	Error Encountered system page, 7.3.1
	Escape property, 18.2.4.2
	event contexts, EL expressions relating to, B.3.9
	Event Text Length property, 61.3.3
	events
	
	about, 61.1
	calendar overlay, 61.2.8
	canceling, 61.2.7
	contextual events, 17.5.2.8
	creating, 61.2.4
	creating links, 63.2.1.5, 63.2.2.4
	deleting, 61.2.7
	displaying multiple calendars, 61.2.8
	editing, 61.2.6
	Events page, 61.1.2, 61.2.3.1, 61.2.3.1
	Events tab, 17.5.2.8
	personal calendar, 61.2.2
	refreshing, 61.2.3.4
	scheduling, 61.2.4
	secondary time zone, 61.2.3.5.2
	selecting date, 61.2.3.3
	selecting display mode, 61.2.3.2
	setting display preferences, 61.2.3.5
	viewing, 61.1.2
	viewing details, 61.2.5



	Events - Mini View task flow
	
	parameters
	
	Calendar Toolbox Layout, 61.3.3
	Customization ID, 61.3.3
	Event Text Length, 61.3.3
	List Events in Number of Upcoming Days, 61.3.3
	Number of Events Per Page, 61.3.3
	Using ADF Calendar Component, 61.3.3






	Events page
	
	about, 61.1.2
	displaying, 61.2.3.1
	hiding, 61.2.3.1
	See also events



	events properties
	
	about, 17.5.2.2, 17.5.2.8
	properties
	
	Action Handlers, 17.5.2.8
	Actions, 17.5.2.8
	Enable Action property, 17.5.2.8
	Events, 17.5.2.8






	Events service
	
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	subscriptions, 36.3.2
	task flows, 61.2
	See also events



	Events system page, 7.3.1
	Events tab, 17.5.2.8
	Events task flow
	
	about, 61.1.2
	editing properties, 61.3
	parameters
	
	Calendar Overlay Style, 61.3.2
	Calendar Style Class, 61.3.2
	Customization ID, 61.3.2
	Default Current Date, 61.3.2
	Disable Personalize and Customize, 61.3.2
	Group Space, 61.3.2
	Maximum Calendars, 61.3.2
	Maximum Enabled Calendars, 61.3.2



	See also events



	Excel
	
	See Microsoft Office integration



	Exclude Object Actions property, 58.3.2
	Expand All Announcements in Extended Mini View property, 59.3.2
	Expand menu action, 41.5.1.2
	Explorer
	
	See Microsoft Explorer integration



	export and import
	
	Space templates, 53.5
	Spaces, 53.5



	Expression Language
	
	See EL expressions



	Expression Language editor
	
	See EL editor



	External Application ID property, 68.4.2
	external applications
	
	adding to a navigation model, 11.2.2.1.3
	additional login fields, 6.6.2
	deleting, 6.6.4
	launching from Applications Navigator, 6.6.3.3
	login preferences, 35.7
	registering, 6.6.2
	task flows, 6.6.3.3
	
	adding to a page, 6.6.3.1
	registering, 6.6.3.2
	required permissions, 6.6.3
	setting properties of, 6.6.3.5











F

	Favorite Title property, 13.2.4.1
	Favorite URL property, 13.2.4.1
	favorites, 37
	
	about, 37.1
	accessing, 37.2
	Add to Favorites Spaces component, 13.2.4
	adding folders, 37.4, 37.5.2
	adding links, 37.3, 37.5.1
	deleting folders, 37.5.6
	deleting links, 37.5.6
	editing folders, 37.5.3
	editing links, 37.5.3
	Favorites Menu Spaces component, 13.2.14
	making discoverable, 37.3
	managing, 37.5
	rearranging folders, 37.5.4
	rearranging links, 37.5.4
	searching, 37.5.5
	setting open behavior, 37.5.3
	sharing, 37.3



	Favorites Menu Spaces component, 13.2.14
	Features Off property, 42.2.1, 42.4.1, 42.5.1, 42.6.1, 42.8.1
	Feedback, 33
	
	about, 33.1.2
	activities tracked by Activity Stream, 6.4.3.2, 32.1
	configuring, 6.4.3.6
	deleting, 33.4.2.3
	enabling others to post, 33.3
	filtering, 33.4.2.1.2
	hiding, 33.4.2.1.3
	marking as private, 33.4.2.1.5
	posting, 33.4.2.2
	preferences, 33.2.2
	properties, 33.5, 33.5.1
	showing hidden, 33.4.2.1.4
	sorting, 33.4.2.1.2
	subscribing to, 36.3.1
	task flows
	
	about, 33.1.2
	properties, 33.5, 33.5.1, 33.5.2
	working with, 33.4.2



	troubleshooting, 6.4.5.5
	viewing, 33.4.2.1
	
	posted, 33.4.2.1.1
	received, 33.4.2.1.1






	Feedback - Quick View
	
	parameters
	
	User Id, 33.5.2






	Feedback - Quick View task flow
	
	about, 33.1.2
	parameters
	
	Display Message Size, 33.5.2, 33.5.3.3
	End Date, 33.5.2, 33.5.3.7
	Hide Actions, 33.5.2, 33.5.3.1
	Hide Footer, 33.5.2
	Hide Given, 33.5.2, 33.5.3.5
	Hide Header, 33.5.2
	No of Feedback Items, 33.5.2, 33.5.3.2
	Start Date, 33.5.2, 33.5.3.7






	Feedback task flow
	
	about, 33.1.2
	parameters
	
	End Date, 33.5.2, 33.5.3.7
	Hide Given, 33.5.2, 33.5.3.5
	Hide Header, 33.5.2
	No of Feedback Items, 33.5.2, 33.5.3.2
	Resource Id, 33.5.2
	Start Date, 33.5.2, 33.5.3.7






	File In Use dialog, 41.12.3.1
	File menu
	
	Document Viewer, 41.5.2.1
	documents task flows, 41.5.1.1



	File Now Available dialog, 41.12.3.1
	files
	
	adding tags, 41.19
	adding to a page, 41.3
	adding to Space
	
	in documents task flows, 41.8.1
	using Microsoft Office integration, 46.3.4.1



	checking in using Microsoft Office integration, 46.3.4.4
	checking out
	
	cancelling, 41.12.1, 41.12.1
	in documents task flows, 41.12.1
	using Microsoft Office integration, 46.3.4.3



	closing in Microsoft Office, 46.3.5
	commenting on in documents task flows, 41.20
	copying and pasting, 41.14
	creating, 41.8
	deleting, 41.16
	downloading, 41.12.2
	drag and drop, 41.14, 41.15
	editing and updating, 41.12
	editing in-place, 41.12.3
	liking, 41.27, 41.28
	linking to other items, 41.19
	moving, 41.15
	opening
	
	as PDF, 41.10
	in browser, 41.10
	in documents task flows, 41.10
	PDF in documents task flows, 41.23
	using Microsoft Office, 46.3.2



	recommendations to other documents, 41.19
	renaming, 41.13
	saving PDF in documents task flows, 41.23
	saving to Space, 46.3.4.1.1
	searching, 41.29
	security, 41.25
	sharing through Publisher, 34.3
	sharing through Publisher task flow, 34.3.3.3
	sorting in document task flows, 41.6.3
	subscribing to, 36.3.3.1, 41.26
	unliking, 41.27, 41.28
	uploading, 41.8.1
	uploading new version, 41.12.4
	URL to, 41.24
	viewing
	
	information using Microsoft Office, 46.3.4.9
	properties of, 41.22
	version history in documents task flows, 41.21
	version history using Microsoft Office integration, 46.3.4.10



	working with Related Items, 41.19



	Filter Pattern property, 31.5.2, 31.5.3.6
	Filter property, 51.16.2.3.1
	first page, selecting, 5.6
	Folder Viewer task flow
	
	about, 41.1.5
	parameters
	
	Connection Name, 42.6.1
	Features Off, 42.6.1
	Page Size, 42.6.1
	Read Only, 42.6.1
	Resource ID, 42.6.1
	Show Folders, 42.6.1
	Start Folder Path, 42.6.1






	folders
	
	adding to a page, 41.3
	creating
	
	in documents task flows, 41.7
	using Microsoft Office integration, 46.3.4.2



	deleting, 41.16
	drag and drop, 41.14, 41.15
	hiding and showing, 41.18
	managing using Microsoft Office, 46.3.4.7
	moving, 41.15
	opening in documents task flows, 41.9
	refreshing contents, 41.17
	renaming, 41.13
	searching, 41.29
	sorting in documents task flows, 41.6.3
	URL to, 41.24
	viewing properties of, 41.22



	folksonomies, tagging and, 57.1.1
	Font Color property, 17.5.2.5
	Font property, 17.5.2.5, 17.5.2.7.2
	Font Size property, 17.5.2.5, 17.5.2.7.2
	Font Style property, 17.5.2.5, 17.5.2.7.2
	footer, adding to a page, 17.3.5.2
	Format column detail in lists, 64.2.3.2.2
	forms layout in OmniPortlet, 27.2.7.5
	Forum ID property, 59.3.2, 60.3.2
	framesets in Web Clipping, 28.4





G

	General page in a Space, 51.4
	Get a Link menu action, 41.5.1.2, 41.5.2.2
	GET Authentication Method, 6.6.2
	Get Updates, 46.3.4
	Global Help Spaces component, 13.2.15
	Global Help URL, 5.3
	global search field, 56.3.2.1
	globalization support in Web Clipping, 28.4
	Group Space Name property, 52.4.7.2, 69.3.2
	Group Space property, 33.5.2, 33.5.3.6, 42.7.1, 61.3.2
	group spaces
	
	See Spaces



	GUID
	
	of page, 29.9.2
	of Space, 29.9.1








H

	Halign property, 18.2.10.2
	headers
	
	adding to a page, 17.3.5.2
	Display Header property, 17.5.2.5



	Height property, 17.5.2.7.2, 18.2.10.7
	help
	
	accessing online, 29.11
	Global Help Spaces component, 13.2.15
	Help link, 5.3



	Hide Actions property, 33.5.2, 33.5.3.1, 36.5.3.2, 36.5.3.3
	Hide Attach Links property, 34.3.3.5.2
	Hide Comments property, 32.5.2, 32.5.4.3
	Hide Configuration Button property, 32.5.2, 32.5.4.1
	Hide Document Uploader property, 34.3.3.5.2, 34.3.3.5.3
	Hide Folders menu action, 41.5.1.2
	Hide Footer property, 31.5.2, 32.5.2, 33.5.2
	Hide Given property, 33.5.2, 33.5.3.5
	Hide Header property, 31.5.2, 32.5.2, 33.5.2
	Hide Inline Preview property, 32.5.2, 32.5.4.2
	Hide Like property, 32.5.2, 32.5.4.4
	Hide Publisher property, 33.5.2, 33.5.3.4
	Hide Share property, 32.5.2, 32.5.4.5
	Hide Sharing Picker property, 34.3.3.5.2
	Hide Toolbar property, 59.3.2, 60.3.2
	Hint column detail in lists, 64.2.3.2.2
	History icon, 41.5.2.6
	Home Page page style, 15.1
	Home Space
	
	about, 1.1.1
	about, 29.1
	adding as Windows network place, 46.4.1
	adding Space pages to, 49.17, 51.7.10
	choosing default page template, 5.8, 5.9
	choosing default Resource Catalog template, 5.10
	clearing deleted Space page, 29.5, 49.17
	disabling the presence of, 5.12
	enabling the presence of, 5.12
	exposing Space pages in, 29.5
	in Windows Explorer, 46.4.1
	managing files using Microsoft Office, 46.3.4.6
	navigating to, 29.3.1
	pages
	
	controlling access, 38.2, 38.2.1
	copying, 38.4
	creating in, 38.1.2
	deleting, 38.5
	editing, 38.3
	page creation defaults, 38.1.1
	revoking access, 38.2.2
	securing, 38.2, 38.2.1



	pretty URLs, A.2
	printing pages, 29.8
	renaming a page, 29.6
	saving file to, 46.3.4.1.1
	user interface URLs, A.2



	Home Space Spaces component, 13.2.16
	Horizontal Alignment property, 18.2.2.2
	Hover Icon property, 13.2.2.1, 18.2.7.2
	HTML files
	
	editing in-context in Content Presenter, 40.10.1
	editing in-place, 41.12.3



	HTML Markup layout component
	
	about, 18.2.4
	display options, 18.2.4.2
	
	Escape, 18.2.4.2
	No Wrap, 18.2.4.2
	Short Desc, 18.2.4.2
	Show Component, 18.2.4.2
	Value, 18.2.4.2



	embedding media, 18.2.4.3



	Hyperlink layout component, 18.2.6.2
	
	about, 18.2.6.1
	display options
	
	Destination, 18.2.6.2
	Open in new window, 18.2.6.2
	Show Component, 18.2.6.2
	Title, 18.2.6.2











I

	Icon Position property, 13.2.2.1, 18.2.7.2
	Icon property, 13.2.2.1, 18.2.7.2, 18.2.10.6
	Icon View display template, 40.5
	icon, changing a Space, 51.4.7
	Id property, 27.4.2, 28.3.2
	IDC:GlobalProfile, 40.4.3, 41.29.2
	Image layout component, 18.2.7, 18.2.7.2
	
	about, 18.2.7
	display options
	
	Depressed Icon, 18.2.7.2
	Destination, 18.2.7.2
	Disabled Icon, 18.2.7.2
	Hover Icon, 18.2.7.2
	Icon, 18.2.7.2
	Icon Position, 18.2.7.2
	Short Desc, 18.2.7.2
	Show Component, 18.2.7.2
	Target Frame, 18.2.7.2
	Text, 18.2.7.2
	Text And Access Key, 18.2.7.2






	Image Map Type property, 42.14.1
	Image Size property, 30.6.2
	images
	
	document image component, 41.2
	document image properties, 42.14
	
	Image Map Type, 42.14.1
	Long Desc URL, 42.14.1
	Short Desc, 42.14.1
	Show Component, 42.14.1
	Source, 42.14.1



	Image layout component, 18.2.7, 18.2.7.2
	in search results, 18.2.7



	IMP service
	
	about, 62.1
	Microsoft LCS, 62.4.3
	Microsoft OCS, 62.4.3
	OWLCS, 62.4.3
	Presence icon, 62.1
	Presence icon context menu, 62.1
	presence states, 62.4.1
	sending instant messages, 62.4.3
	sending mail, 62.4.2
	starting phone conferences, 62.4.4
	status message, 62.4.1
	viewing user presence, 62.4.1



	import and export
	
	Space templates, 53.5
	Spaces, 53.5
	Subspaces, 54.7.2



	Inflexible Height property, 18.2.10.6
	Initial Sidebar property, 42.8.1
	inline frames
	
	properties
	
	Short Desc, 42.13.1
	Show Component, 42.13.1
	Source, 42.13.1






	inline frames properties, 41.2
	Inline Style property, 13.2.8.1
	Instant Messaging and Presence (IMP)
	
	See IMP



	internal ID of a Space, 49.5
	internal layout components, 18.2.10.1
	
	panelGroupLayout, 18.2.10.1, 18.2.10.2
	panelStretchLayout, 18.2.10.1, 18.2.10.3
	panelTabbed, 18.2.10.1, 18.2.10.4
	separator, 18.2.10.7
	showDetailFrame, 18.2.10.1, 18.2.10.5
	sidebarItem, 18.2.10.1, 18.2.10.6
	spacer, 18.2.10.1, 18.2.10.7



	internal name of a Space, 49.5
	Invite People as Connection Spaces component, 13.2.17
	Is Update Status property, 34.3.3.5.2, 34.3.3.5.5
	ISO-8859-1 character set, 28.4
	Item ID property, 42.8.1, 42.10.1, 42.11.1





J

	JavaBeans, Expression Language, B.1
	JavaScript
	
	HTML Markup layout component and, 18.2.4.1
	Web Clipping and, 28.4



	JAWS, 35.4
	Join Space Spaces component, 13.2.18
	JSF portlets, 25.4.2





K

	Keep open the Publisher after publish property, 34.3.3.5.2





L

	landing page, selecting, 5.6
	Landmark property, 18.2.10.2
	languages
	
	choosing the default display language, 5.4
	customizing the language list, 5.5
	setting in a Space, 51.4.15
	user preference, 35.2



	Last Modified After property, 42.3.1, 42.7.1
	Last Modified Before property, 42.3.1, 42.7.1
	Last Modifier property, 42.3.1, 42.7.1
	layout
	
	adding a page footer, 17.3.5.2
	adding a page header, 17.3.5.2
	adding page content regions, 17.3.5.4
	adding tabs, 17.3.5.5
	changing a page layout, 17.3.5.1
	changing page column widths, 17.3.5.3
	content orientation, 18.2.2.1



	layout components
	
	about, 18
	adding, 18.1
	Box, 18.2.2
	deleting in Design view, 18.3.1
	deleting in Source view, 18.3.2
	HTML Markup, 18.2.4, 18.2.4.3
	Hyperlink, 18.2.6.1
	Image, 18.2.7
	Links, 18.2.5
	
	adding, 18.2.5.2.1
	advanced search and, 18.2.5.2.2
	configuring a link, 18.2.5.2.3
	configuring the component, 18.2.5.2
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Part IX


Organizing Your Collaborative and Social Networking Environment

Part IX of the User's Guide steps through the process of setting up and managing a Home Space and creating a social network. It includes details about social networking and collaboration and personal management tasks, such as bookmarking pages and subscribing to application objects.

Part IX includes the following chapters:

	
Chapter 29, "Exploring the Home Space"


	
Chapter 30, "Managing Your Profile"


	
Chapter 31, "Creating Your Social Network"


	
Chapter 32, "Tracking Your Connections' Activities"


	
Chapter 33, "Posting and Managing Messages and Feedback"


	
Chapter 34, "Liking, Commenting On, and Sharing Objects"


	
Chapter 35, "Setting Your Personal Preferences"


	
Chapter 36, "Setting Up Your Personal Subscriptions and Notifications"


	
Chapter 37, "Creating and Managing Your Personal Favorites"


	
Chapter 38, "Creating and Managing Personal Pages"






Part IV


Building a Portal or Community

Part IV of the User's Guide introduces the resources you use to create your portal or community.

Part IV includes the following chapters:

	
Chapter 10, "Working with the Resources that Compose a Portal or Community"


	
Chapter 11, "Working with Navigation"


	
Chapter 12, "Working with Page Templates"


	
Chapter 13, "Adding Spaces Components to Your Templates"


	
Chapter 14, "Working with Skins"


	
Chapter 15, "Working with Page Styles"


	
Chapter 16, "Working with Resource Catalogs"
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51 Managing a Space

This chapter provides information about configuring and managing an environment dedicated to a group effort or an area of interest. It describes how to access Space administration pages, manage services, and perform administrative tasks for all members of a Space. It contains the following sections:

	
Section 51.1, "Who Is the Space Moderator?"


	
Section 51.2, "Creating a New Space"


	
Section 51.3, "Accessing Space Administration Pages"


	
Section 51.4, "Managing General Administration Settings for a Space"


	
Section 51.5, "Managing Space Roles"


	
Section 51.6, "Managing Space Members"


	
Section 51.7, "Creating and Managing Space Pages"


	
Section 51.8, "Managing Space Content"


	
Section 51.9, "Managing Subspaces"


	
Section 51.10, "Managing Space Services"


	
Section 51.11, "Managing Space Resources"


	
Section 51.12, "Defining Custom Attributes for a Space"


	
Section 51.13, "Adding Wikis or Blogs to a Space"


	
Section 51.14, "Making a Space Available"


	
Section 51.15, "Sending Mail to Space Members or Moderators"


	
Section 51.16, "Working with the Space Task Flows"


	
Section 51.17, "Deleting a Space"





Audience

This chapter is intended for WebCenter Spaces users assigned the Moderator role or a custom role that includes the Spaces-Manage Configuration and Spaces-Manage Membership permissions.




	
Note:

For information about Space roles, see Section 52.2.1.1, "Understanding the Default Roles for a Space".









51.1 Who Is the Space Moderator?

If you have been granted the Spaces-Create permission by the WebCenter Spaces administrator, you can create a Space. When you create a Space, you become the default Space moderator, which means that you assigned the Moderator role. In this role, you have full control over the Space presentation and content, as well as administrative responsibilities, as listed in Section 52.2.1.1, "Understanding the Default Roles for a Space".

Other users may be assigned the Moderator role, or granted the permissions to manage specific areas of the Space. For more information, see Section 52.2, "Managing Roles and Permissions for a Space"






51.2 Creating a New Space

A Space provides an environment dedicated to a group effort or an area of interest. For more information, see Section 49.1, "What You Should Know About Spaces." If you have been granted the Spaces-Create permission by the WebCenter Spaces administrator, you can create a Space in a WebCenter Spaces application.

WebCenter Spaces creates a single discussion forum for a new Space. You can modify this default setting to allocate multiple discussion forums to the Space. See Section 51.10.3, "Modifying Discussion Forum Settings for a Space."

To create a Space:

	
In the Home Space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, click Create a Space.

If you do not see this option, ask your WebCenter Spaces administrator to grant you Create Spaces permission.

The Create a Space dialog opens.


	
In the Setup step (Figure 51-1), specify a Space name and, optionally, a description and keywords for the Space. Enter any keywords related to the content of the Space to make it more easily discoverable in search results. Separate keywords with a space or comma.


Figure 51-1 Create a Space Dialog: Setup Step
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The name that you enter here displays at the top of the Space and other places where Spaces are available for selection, such as the Spaces Switcher menu and the Spaces page. Space names can contain alphanumeric characters, underscores, spaces, multibyte characters, and special characters such as & and #. The maximum allowable length is 200 characters. The following reserved keywords are not allowed as the full Space name either in upper or lowercase, or a combination of both—webcenter, pages, page, spaces, space, group, groups, Space, Spaces, webcenter space, webcenter spaces, webcenter administration, my Spaces, admin, last. These reserved words are allowable as part of a longer name (for example, Sales Group).


	
Click Next.


	
In the Access step (Figure 51-2), enter the last value of the URL for the Space. This value can be same as the Space name. The value you enter here has the same restrictions as the display name for the Space, noted above. The internal name of the Space is derived from this field.

This URL becomes the pretty URL the access the Space and must be unique.


Figure 51-2 Create a Space Dialog: Access Step

[image: Create a Space Dialog: Access Step]



	
Choose an access level for the Space:

	
Public: Anyone can visit the Space and view public information. When this setting is selected, the Public-User role in the Space is automatically granted View Pages and Content permission in the Space, which allows public users to view pages, lists, events, links and notes. To grant public users permissions to view announcements, discussions, and documents, you need to grant these permissions, as described in Section 51.14.5, "Granting Public Access to a Space."


	
Private: People can discover this Space in search results and in the list of available Spaces, and can subscribe to it if invited to join or if self-subscription is enabled.


	
Hidden: People must be invited to join this Space. The Space will not appear in search results or in the list of available Spaces.







	
Note:

To grant public access to the information in a Space, including its pages and any services you want to expose on the public pages See Section 51.14.5, "Granting Public Access to a Space."








	
Click Next.


	
In the Content step (Figure 51-3), select a Space template to use as the basis for your new Space. Use the Filter field to search for templates by name.


Figure 51-3 Create a Space Dialog: Content Step

[image: Create a Space Dialog: Content Step]






	
See Also:

For more information, see Section 50.1, "What You Should Know About Space Templates".










	
Note:

A custom Space template may include preseeded data, such as discussions, documents, lists, member information (including roles), pages, or site resources. When you select such a template, the new Space includes all the preseeded data.










	
Note:

When you select a template on which to base a new Space, then subsequently the template is made private by another user before you have completed creating the Space, the template remains valid for your use while you are still creating the Space.








	
Click Create.

The new Space opens, displaying its Home page and the default look and feel that has been defined by your WebCenter Spaces administrator for all new Spaces. As the Space creator, you are automatically granted the Moderator role for this Space, and can being to populate, customize, and manage the Space as required. Later, when you are ready, you can set up the Space membership policy. See Section 52.3, "Managing Members and Assigning Roles."




Any Space can be parent to one or more Subspaces. This allows you to develop a Space hierarchy. For more information, see Chapter 54, "Working with a Space Hierarchy."






51.3 Accessing Space Administration Pages

Space moderators (or anyone granted Manage permissions in the Space) can access the administration pages for the Space:


	Page	Description
	General	Use this page to set various Space properties. For more information, see Section 51.4, "Managing General Administration Settings for a Space."
	Roles	Use this page to manage Space roles and permissions. For more information, see Section 51.5, "Managing Space Roles."
	Members	Use this page to manage Space members and assign member roles. For more information, see Section 51.5, "Managing Space Roles."
	Pages	Use this page to manage Space pages. For more information, see Section 51.7, "Creating and Managing Space Pages."
	Content	For more information, see Section 51.8, "Managing Space Content."
	Subspaces	Use this page to manage child Spaces of the Space. For more information, see Chapter 54, "Working with a Space Hierarchy."
	Services	Use this page to enable and disable services operating in the Space; for example: Announcements, Discussions, Documents, Events, and Lists. For more information, see Section 51.10, "Managing Space Services."
	Resources	Use this page to manage the resources for the Space. For more information, see Section 51.11, "Managing Space Resources."
	Custom Attributes	Use this page to define custom attributes for the Space. For more information, see Section 51.12, "Defining Custom Attributes for a Space."






To access administration pages for a Space:

	
In the Home Space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Spaces menu.
See also Section 29.3.1, "Opening Spaces."










	
On the Spaces page, select the Space.

See also Section 49.3, "Viewing Available Spaces".


	
Display the Space administration settings pages.




	
Tip:

The way you access these pages depends on the page template in use. For example, in a side navigation template, you may access Space administration pages through a Manage menu.
You can also navigate to these pages using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."









If you do not have access to the Space administration pages, you do not have Manage permissions for this Space. See Section 49.20, "Changing Your Role in a Space".









51.4 Managing General Administration Settings for a Space

The General page of the Space administration settings provides access to the tasks described in the following sections:

	
Section 51.4.1, "Renaming a Space"


	
Section 51.4.2, "Modifying the Description or Keywords for a Space"


	
Section 51.4.3, "Taking a Space Offline"


	
Section 51.4.4, "Bringing a Space Back Online"


	
Section 51.4.5, "Closing or Reactivating a Space"


	
Section 51.4.6, "Enabling or Disabling RSS News Feeds for a Space"


	
Section 51.4.7, "Changing the Space Icon"


	
Section 51.4.8, "Changing the Space Logo"


	
Section 51.4.9, "Changing the Page Template for a Space"


	
Section 51.4.10, "Changing the Skin for a Space"


	
Section 51.4.11, "Changing the Resource Catalogs for Pages and the Page Template for a Space"


	
Section 51.4.12, "Changing the Navigation for a Space"


	
Section 51.4.13, "Displaying or Hiding a Page Footer in a Space"


	
Section 51.4.14, "Customizing the Copyright Statement and Privacy URL"


	
Section 51.4.15, "Setting a Space Display Language"


	
Section 51.4.16, "Changing the Access to a Space"






51.4.1 Renaming a Space

A Space display name appears in the top banner of the Space and in dialogs and pages where users can select the Space.




	
Note:

Changing the display name does not affect the internal name and URL for the Space. See Section 51.14.2, "Changing a Space URL".







To change the display name of a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, modify the Display Name.


Figure 51-4 Changing a Space Display Name

[image: General subtab Configure Group Space Information section]



	
Click Apply to save.









51.4.2 Modifying the Description or Keywords for a Space

A Space description appears in the listing of the Space on the Spaces page. Keywords are useful to make a Space more easily discoverable in search results.

To enter or change the description of keywords for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, enter or modify the Description. and/or Search Keywords. Separate keywords with a space or comma.


Figure 51-5 Modifying a Space Description or Keywords

[image: Modifying a Space Description or Keywords]



	
Click Apply to save.









51.4.3 Taking a Space Offline

You can take a Space temporarily offline for maintenance. For example, if you notice inappropriate content, you can take a Space offline to make required updates, then bring it back online. Only the WebCenter Spaces administrator or Space members with Manage Configuration permission can access a Space that is offline. Other members see the Space Unavailable page (see Section 7.3, "Working with System Pages.").

To permanently close down a Space that is not being used any more, see Section 51.4.5, "Closing or Reactivating a Space."

To take a Space offline:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, select Take Space Temporarily Offline (Figure 51-6).


Figure 51-6 Taking a Space Offline

[image: Take Group Space Offline enabled]






	
Click Apply to save.









51.4.4 Bringing a Space Back Online

When a Space is offline, only the WebCenter Spaces administrator or Space members with Manage Configuration permission can bring the Space back online.

To bring a Space back online:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, clear the Take Space Temporarily Offline checkbox (Figure 51-7).


Figure 51-7 Bringing a Space Back Online

[image: Take Group Space Offline disabled]






	
Click Apply to save.









51.4.5 Closing or Reactivating a Space

You can close a Space that is no longer being actively used. Closing a space archives its content. When you close a Space, it is removed from everyone's Spaces Switcher menu to avoid clutter, but it remains listed on the Spaces page. Space content remains accessible and searchable to those who still want to reference it and Space members can continue working in the Space.

To close down a Space temporarily, take the Space offline instead. See Section 51.4.3, "Taking a Space Offline."

To close a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, select the Close Space checkbox (Figure 51-8).


Figure 51-8 Closing a Space

[image: Close the Group Space enabled]






To reactivate the Space, clear the Close Space checkbox.


	
Click Apply to save.









51.4.6 Enabling or Disabling RSS News Feeds for a Space

Space members can find out what is happening in a Space through RSS news feeds. Within the context of a Space, members can:

	
Monitor recent activities.


	
Track contributions to discussion forums.


	
View announcements.


	
Watch for revisions to lists.




For more information about publishing RSS new feeds, see Chapter 68, "Working with the RSS Service".

To enable or disable RSS news feeds for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Space Options, set Publish RSS as follows:

	
To allow members access to Space information through RSS feeds, select Enable RSS Publishing (Figure 51-9).


	
To disable RSS feeds for this Space, clear Enable RSS Publishing.





Figure 51-9 Enabling and Disabling Space RSS Feeds

[image: Enable RSS Publishing on General subtab]






	
Click Apply to save.









51.4.7 Changing the Space Icon

The space icon displays alongside the Space display name in menus and smaller areas. For example, it may display on the Spaces Switcher menu (Figure 51-10) or at the top of the Space (Figure 51-11).


Figure 51-10 Space Icon in Spaces Switcher Menu

[image: Space Icon in Spaces Switcher Menu]




Figure 51-11 Space Icon at Top of Space

[image: Space Icon at Top of Space]



A default icon is provided by the template used when you create the Space, but you can assign a different icon if desired.

To change the Space icon:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, enter the location and file name of a Group Space Icon, or click Browse to select an icon. For best results, select an icon of 16 x 16 pixels.




	
Note:

The icon file can be up to 1 MB. Supported file formats are .gif or .GIF, .png or .PNG, and .jpg or .JPG.








	
Click Apply to save.









51.4.8 Changing the Space Logo

The Space logo displays alongside the Space name in larger areas. For example, it may display on the Spaces page (Figure 51-12).


Figure 51-12 Space Logo on Spaces Page

[image: Space Logo on Spaces Page]



A default logo is provided by the template used when you create the Space, but you can assign a different logo if desired.

To change the Space logo:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, enter the location and file name of a Space Logo, or click Browse to select a logo. For best results, select a logo to fit the 28 pixel height restriction.




	
Note:

The logo file can be up to 1 MB. Supported file formats are .gif or .GIF, .png or .PNG, and .jpg or .JPG.








	
Click Apply to save.









51.4.9 Changing the Page Template for a Space

A page template defines how individual pages and groups of pages display on a user's screen. For more information about page templates, see Chapter 12, "Working with Page Templates."

WebCenter Spaces provides several out-of-the-box page templates (see Section 12.1.1, "Out-of-the-Box Page Templates"). Alternatively, portal designers can create custom page templates to offer more ways to display pages on the screen, as described in Section 12.2, "Creating a Page Template." Within a Space, you can copy or customize an existing page template, as described below and in Section 51.11, "Managing Space Resources."

By default, a Space inherits the page template defined for the Space template that you choose when you create the Space.




	
Note:

If the Space template does not specify a page template, the Space uses the default page template specified by WebCenter Spaces administrator. See Section 5.8, "Choosing a Default Page Template".







You can optionally choose a different page template for the Space, overriding the Space template setting and the application setting.

To change the page template for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Page Template (Figure 51-13).


Figure 51-13 Choosing a Page Template for a Space

[image: Choosing a Page Template for a Space]



The WebCenter Spaces administrator may choose to hide one or more out-of-the-box page templates (see Section 12.5.1, "Showing and Hiding a Page Template"). The [system default] selection applies the page template specified for the application by the WebCenter Spaces administrator (see Section 5.8, "Choosing a Default Page Template"). Additional custom page templates may be listed if they have been added to the application or the Space.

You can add custom page templates for the Space to this list in two ways:

	
Copy an existing page template into a new page template, completely separate from the original, as described in Section 51.11, "Managing Space Resources."


	
Customize an application-level page template to create a new page template for the Space. Any changes that are subsequently made to the page template at the application level are automatically cascaded down to the page template at the Space level. See Section 12.4, "Customizing a Page Template for a Space."







	
Note:

If you create a new page template for a Space, the custom page template is not shown in the Page Template list for Subspaces of the Space. To set the page template for a Subspace to the same page template used by its parent Space, you must use an EL expression. To make a custom page template available in the Page Templates list for all Spaces and Subspaces, it must be created at the application-level (see Section 12.2, "Creating a Page Template").







If you want WebCenter Spaces to determine the page template dynamically based on certain criteria, click the Expression Builder icon next to the Page Template list to open the editor, and then enter an EL expression that specifies the required behavior. For example: in a Subspace, the following EL expression sets the Page Template to the same setting as the parent Space:


{srmContext.resourceType['siteTemplate'].displayName['parent_page_template'].singleResult}


	
Click Apply.









51.4.10 Changing the Skin for a Space

A skin defines the appearance and look and feel of the application or a Space. For more information about skins, see Chapter 14, "Working with Skins."

WebCenter Spaces provides several out-of-the-box skins (see Section 14.1, "What You Should Know About Skins"). Alternatively, portal designers can develop custom skins to reflect a personality, or to incorporate specific branding, as described in Section 14.2, "Creating a Skin." Within a Space, you can copy an existing skin, as described below and in Section 51.11, "Managing Space Resources."

By default, a Space inherits its skin from the application-level settings, described in Section 5.7, "Choosing a Default Skin."

You can optionally choose a different skin for the Space, overriding the application setting. When you change the skin for a Space, the skin is applied to all the pages of the Space. However, the Space administration pages are not affected. They always appear with the default skin, Fusion FX.

To change the skin for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Skin in which to wrap the Space (Figure 51-14).


Figure 51-14 Choosing a Skin for a Space

[image: Choosing a Skin for a Space]



The WebCenter Spaces administrator may choose to hide one or more out-of-the-box skins (see Section 14.4.1, "Showing and Hiding a Skin"). The [system default] selection applies the skin specified for the application by the WebCenter Spaces administrator (see Section 5.7, "Choosing a Default Skin"). Additional custom skins may be listed if they have been added to the application or the Space.

You can add custom skins for the Space to this list by copying an existing skin into a new skin. For more information, see Section 51.11, "Managing Space Resources."




	
Note:

If you create a new skin for a Space, the custom skin is not shown in the Skin list for Subspaces of the Space. To set the skin for a Subspace to the same skin used by its parent Space, you must use an EL expression. To make a custom skin available in the Skin list for all Spaces and Subspaces, it must be created at the application-level (see Section 14.2, "Creating a Skin").







If you want WebCenter Spaces to determine the skin dynamically based on certain criteria, click the Expression Builder icon next to the Skin list to open the editor, and then enter an EL expression that specifies the required behavior.


	
Click Apply to save.









51.4.11 Changing the Resource Catalogs for Pages and the Page Template for a Space

When you edit a page or page template in a Space and click Add Content, a Resource Catalog displays. A Resource Catalog lists items that users may typically want to add to the page or page template, such as page layout components, portlets, and task flows. You can select items in the Resource Catalog to add them to your page or page template. For more information about Resource Catalogs, see Chapter 16, "Working with Resource Catalogs."

WebCenter Spaces provides two out-of-the-box Resource Catalogs for pages and the page template in a Space:

	
Default Page Template Catalog for editing page templates.


	
Default Space Catalog for editing individual pages and task flows in a Space.




For more information, see Section 16.1.1, "Understanding the Out-of-the-Box Resource Catalogs."

Alternatively, portal designers can develop custom Resource Catalogs, as described in Section 16.2, "Creating Resource Catalogs." Within a Space, you can create a new Resource Catalog from scratch or copy an existing Resource Catalog into a new Resource Catalog, as described below and in Section 51.11, "Managing Space Resources."

By default, a Space inherits the Resource Catalogs for its pages and the page template from the application-level settings, described in Section 5.10, "Choosing Default Resource Catalogs."

You can optionally choose different Resource Catalogs for the Space, overriding the application settings.

To change the Resource Catalogs used to edit pages or the page template in a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Resource Catalog from the Resource Catalog for Pages or Resource Catalog for Page Templates lists (Figure 51-15).


Figure 51-15 Choosing a Resource Catalog for a Space

[image: Choosing a Resource Catalog for a Space]



The WebCenter Spaces administrator may choose to hide one or more out-of-the-box Resource Catalogs (see Section 16.4, "Showing and Hiding a Resource Catalog"). The [system default] selection applies the Resource Catalogs specified for the application by the WebCenter Spaces administrator (see Section 5.10, "Choosing Default Resource Catalogs"). Additional custom Resource Catalogs may be listed if they have been added to the application or the Space.

You can add custom Resource Catalogs for the Space to this list by creating a new Resource Catalog from scratch or by copying an existing Resource Catalog into a new Resource Catalog. For more information, see Section 51.11, "Managing Space Resources."




	
Note:

If you create a new Resource Catalog for a Space, the custom Resource Catalog is not shown in the Resource Catalog lists for Subspaces of the Space. To set the Resource Catalogs for a Subspace to the same Resource Catalogs used by its parent Space, you must use an EL expression. To make a custom Resource Catalog available in the Resource Catalog lists for all Spaces and Subspaces, it must be created at the application-level (see Section 16.2, "Creating Resource Catalogs").







If you want WebCenter Spaces to determine the Resource Catalog dynamically based on certain criteria, click the Expression Builder icon next to the Resource Catalog lists to open the editor, and then enter an EL expression that specifies the required behavior.


	
Click Apply to save.









51.4.12 Changing the Navigation for a Space

Navigation enables Space members to see what information the Space provides and to get to that information quickly and easily. For more information about navigation models, see Chapter 11, "Working with Navigation."

WebCenter Spaces provides the following out-of-the-box navigation models for a Space:

	
Spaces Administration Options contains administration options for a Space. By default, it includes a Manage dropdown menu to provide access to administration settings


	
Spaces Default Navigation Model displays links to Space pages. By default, it is positioned at the top of the sidebar on the left-hand side of a Space.


	
Spaces Navigation with Blogs/Wikis/Lists Submenus displays links to Space pages, and links to any wiki documents, blogs, and lists. By default, it is positioned at the top of the sidebar on the left-hand side of a Space.




For more information, see Section 11.1.1, "What You Should Know About Navigation Models."

Alternatively, portal designers can develop custom navigations, as described in Section 11.2, "Building a Navigation Model." Within a Space, you can create a new navigation from scratch or copy an existing navigation into a new navigation, as described below and in Section 51.11, "Managing Space Resources."

By default, a Space inherits its navigation from the application-level settings, described in Section 5.9, "Choosing a Default Navigation."

You can optionally choose a different navigation for the Space, overriding the application settings.

To change the navigation for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, choose a new Navigation (Figure 51-16).


Figure 51-16 Choosing a Navigation for a Space

[image: Choosing a Navigation for a Space]



The WebCenter Spaces administrator may choose to hide one or more out-of-the-box navigation models (see Section 10.4.3, "Showing and Hiding Resources"). The [system default] applies the navigation specified for the application by the WebCenter Spaces administrator (Section 5.9, "Choosing a Default Navigation"). Additional navigation models may be listed if they have been added to the application or the Space.

You can add custom navigations for the Space to this list by creating a new navigation from scratch or by copying an existing navigation into a new navigation. For more information, see Section 51.11, "Managing Space Resources."




	
Note:

If you create a new navigation for a Space, the custom navigation is not shown in the Navigation list for Subspaces of the Space. To set the navigation for a Subspace to the same navigation used by its parent Space, you must use an EL expression. To make a custom navigation available in the Navigation list for all Spaces and Subspaces, it must be created at the application-level (see Section 11.2.1, "Creating a Navigation Model").







If you want WebCenter Spaces to determine the navigation dynamically based on certain criteria, click the Expression Builder icon next to the Navigation list to open the editor, and then enter an EL expression that specifies the required behavior.


	
Click Apply to save.









51.4.13 Displaying or Hiding a Page Footer in a Space

A page footer can display copyright details for the Space and a link to its Privacy Statement.

To display or hide a page footer for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, select the Page Footer checkbox to display a page footer, or clear the checkbox to hide the page footer.


	
Click Apply to save.









51.4.14 Customizing the Copyright Statement and Privacy URL

When enabled, the copyright statements and URL to the privacy statement specific to the Space display in the page footer of the Space (Figure 51-17 and Figure 51-18):


Figure 51-17 WebCenter Spaces Copyright Statement

[image: WebCenter Spaces Copyright Statement]




Figure 51-18 WebCenter Spaces Privacy URL

[image: WebCenter Spaces Privacy URL]



To customize the copyright statement and privacy URL for a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, select Display Page Footer to display the area at the bottom of the Space for the copyright statement and privacy URL (Figure 51-19). Clear the checkbox to hide the page footer, including the copyright statement and privacy URL.


Figure 51-19 Customizing the Copyright Statement and Privacy URL

[image: Customizing the Copyright and Privacy URL]



	
In the Copyright and Privacy URL fields, enter appropriate values.


	
Click Apply to save.









51.4.15 Setting a Space Display Language

You can optionally set a Space display language to control the language in which the user interface (UI) elements of a particular Space render in WebCenter Spaces. UI elements include button and field labels, application links, screen text, and so on.

For more information about working with languages in WebCenter Spaces, and the different levels at which a display language can be set, see Chapter 24, "Working with Multilanguage Portals."

Within the scope of viewing a Space, the Space display language setting is given precedence over all other language settings. For example, if a Space named WebCenter Central has its display language set to German, and Monica (a member of WebCenter Central) sets her user preference language to Dutch, assuming no other language settings are in effect:

	
Monica views the WebCenter Central Space in German, and cannot change this language setting.


	
Monica views other parts of WebCenter Spaces, outside the WebCenter Central Space, in Dutch.







	
Note:

If you create a Space based on a Space template that is defined to use a specific language, that language setting is not inherited by the Space. Instead, the initial language setting for a new Space is based on the order of precedence described in Section 24.1.1, "Display Language Precedence.".







To set a Space display language:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Display Settings, select a language for the Space from the Default Language list (Figure 51-20).


Figure 51-20 Setting the Space Display Language

[image: Setting Group Space Display Language]



If you want WebCenter Spaces to determine the language dynamically based on certain criteria, click the Expression Builder icon next to the property field to open the editor, and then enter an EL expression that specifies the required behavior.


	
To customize the languages displayed in the Default Language list, click Customize. For example, your WebCenter Spaces application might be available in 27 different languages, but you might only need to display the content in your Space in three or four different languages, so you could filter the list to display only those languages.









51.4.16 Changing the Access to a Space

Access to a Space is defined when the Space is created (see Section 51.2, "Creating a New Space"). This access can be changed to make the Space more or less visible.

To change the access to a Space:

	
In the Space administration settings, display the General page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the General page, under Access, select how you want the Space to be exposed:


Figure 51-21 Space Access Settings

[image: Space Access Settings]



	
Public: Anyone can visit the Space, whether they are a registered WebCenter Spaces user or not. When this setting is selected, the Public-User role in the Space is automatically granted View Pages and Content permission in the Space, which allows public users to view pages, lists, events, links and notes. To grant public users permissions to view announcements, discussions, and documents, you need to grant these permissions, as described in Section 51.14.5, "Granting Public Access to a Space."


	
Private: To access the Space, membership is required (either through invitation or self-registration if enabled). The Space will be shown in the list of available Spaces and will appear in search results.


	
Hidden: To access the Space, membership is required (through invitation). The Space will be not shown in the list of available Spaces and will not appear in search results.





	
Click Apply to save.











51.5 Managing Space Roles

To manage the roles for assigning permissions in a Space:

	
In the Space administration settings, display the Roles page (Figure 51-22).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










Figure 51-22 Space Administration: Roles Page
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To work with Space roles, refer to Chapter 52, "Managing Space Members and Roles."









51.6 Managing Space Members

To manage the members of a Space:

	
In the Space administration settings, display the Members page (Figure 51-23).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










Figure 51-23 Space Administration: Members Page
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To work with Space members, refer to Chapter 52, "Managing Space Members and Roles."









51.7 Creating and Managing Space Pages

In a Space, members have access to member-created pages and system pages. The content on a Space page is typically targeted to a particular audience or objective.

System pages are provided to support a rapid deployment of your portal. They fulfill a range of needs, from a finished informational page (the Unauthorized page) to pages that provide content that is generated on the spot and tailored to members of the Space (the Activity Stream page). For complete information about system pages, including how to customize them, see Section 7.3, "Working with System Pages."


Figure 51-24 Space Administration: Pages Page
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The following sections describe how to create and manage pages in a Space:

	
Section 51.7.1, "Setting a Default Page Style"


	
Section 51.7.2, "Creating a Page in a Space"


	
Section 51.7.3, "Showing or Hiding Pages in a Space"


	
Section 51.7.4, "Searching for Pages in a Space"


	
Section 51.7.5, "Editing a Page in a Space"


	
Section 51.7.6, "Copying a Page in a Space"


	
Section 51.7.7, "Renaming a Page in a Space"


	
Section 51.7.8, "Changing Access Permissions on a Space Page"


	
Section 51.7.9, "Deleting a Page in a Space"


	
Section 51.7.10, "Exposing a Space Page in the Home Space"


	
Section 51.7.11, "Sending a Link to a Page in a Space"


	
Section 51.7.12, "Viewing Information About a Page in a Space"






51.7.1 Setting a Default Page Style

To specify a default style for new pages in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click Set Page Defaults to display the Set Page Defaults dialog (Figure 51-25).


Figure 51-25 Set Page Defaults Dialog
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For information about each page style, see Section 15.1, "What You Should Know About Page Styles."


	
Select an option next to Enable One-Click Page Creation:

Yes: Pages created for this Space must always use the Page Style chosen here. This enforces a common look and feel across the entire Space by skipping the Create Page dialog, and creating pages directly using this style.

No: Space members can create pages with a different style, with the default Page Style you specify displayed as the initial style in the Create Page dialog.









51.7.2 Creating a Page in a Space

To create a new page in a Space:

	
Use either of the following methods:

	
In the Space, click Create Page. This method is available to anyone granted permission to create pages in the Space (see Table 52-2, "Space Permissions - Simple Permission Model")




	
Tip:

The location of the Create Page link depends on the page template in use. For example, in a side navigation template, you may access it through an Actions menu.








	
In the Space administration settings, display the Pages page, then click Create Page. This method is available to anyone granted permission to manage pages in the Space (see Table 52-2, "Space Permissions - Simple Permission Model")




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."












WebCenter Spaces will either:

	
Open the Create Page dialog.


	
Immediately create a new page with a default style, if specified in the Set Page Defaults dialog (see Section 51.7.1, "Setting a Default Page Style").





	
If the Create Page dialog opens, specify the name and style for the new page.

For detailed information about each page style, see Section 15.1, "What You Should Know About Page Styles."




The new Space page opens in edit mode (Oracle Composer), where you can add content, then Save and Close the page.




	
See Also:

For information about adding content to a Space page, see:
	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components."


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components."

















51.7.3 Showing or Hiding Pages in a Space

You can control the display of pages in the Space in either of the following ways:

	
Define a navigation model for the Space to control what pages display and in what order and hierarchy. See Section 51.11, "Managing Space Resources" to access the Navigations resource for the Space and Chapter 11, "Working with Navigation" to build a navigation that includes the pages of the Space.


	
If the navigation used by the Space shows all pages in the Space, selectively show or hide pages in the Space administration settings on the Pages page.




To show or hide pages for all members in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, select or clear the Show Page checkbox for the pages you want to show or hide.









51.7.4 Searching for Pages in a Space

To search for pages in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, use either of the following search methods:

	
Filter search: Enter a full or partial search string in the Filter field, then click the Filter icon to refresh the list with all Space pages for which a match is found in Name or Created By. To clear the current search string and display all Space pages, click the Clear Filter icon.


	
Filter panel: Click the Show or hide the filter panel icon to display a filter panel above the page list, then enter a full or partial search string in the fields above Name and/or Created By, and press Enter to refresh the list with all Space pages that match the filtering criteria. To clear the current search string and display all Space pages, clear the filter panel fields and press Enter.







To refresh the list of pages, first ensure that any prior filter is cleared (click the Clear Filter icon), and no filter is specified in the filter panel, then click the Refresh icon.






51.7.5 Editing a Page in a Space

To edit a page in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Edit Page to display the page in edit mode (Oracle Composer).




	
See Also:

For information about adding content to a Space page, see:
	
Chapter 17, "Building Pages"


	
Chapter 18, "Adding and Configuring Page Layout Components."


	
Chapter 41, "Working with the Documents Service Task Flows and Document Components."




















51.7.6 Copying a Page in a Space

To copy a page in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Copy Page to open the Copy Page dialog.


	
Enter a name for the new page, and click OK.




	
Note:

You must have the Spaces-Manage All permission (see Table 52-2, "Space Permissions - Simple Permission Model") to copy a page that is available to all members of a Space. If you have not been granted this permission, then the Copy Page selection is not available to you.















51.7.7 Renaming a Page in a Space

When you rename a page, keep in mind that any pretty URLs that use the old name will be broken. Also note that system pages, such as the Announcements, Lists, and Events pages, do not provide the option of being renamed.




	
See Also:

For information about pretty URLs, see Appendix A, "WebCenter Spaces User Interface URLs."







To rename a page in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Rename Page to open the Rename Page dialog.


	
Enter a new name for the page, and click the Save icon.









51.7.8 Changing Access Permissions on a Space Page




	
Note:

To make an entire Space public, see Section 51.14.5, "Granting Public Access to a Space."







As the Space moderator, you are authorized to view and manage security for any page in the Space. Page owners normally determine who can see the Space pages they create (see Section 49.15, "Controlling User Access to Your Space Pages"), but, occasionally, when a page owner is not available, the Space moderator may be required to make changes.

In a public Space, public users (who are assigned the Public-User role by WebCenter Spaces) are granted View Pages and Content permission in the Space by default, which allows public users to view pages, lists, events, links and notes. If you want to restrict access to a specific page, you can remove public view access from the page. WebCenter Spaces provides a shortcut to remove and grant public read-only access to a page using the page Actions icon menu:

	
To restrict access to a specific page to Space members only, click the Actions icon for the page, and choose Remove Public Access.


	
To grant read-only access to a specific page in a public Space, click the Actions icon for the page, and choose Make Public.







	
Note:

These selections are active only if the Space is public (see Section 51.14.5, "Granting Public Access to a Space.").







To control the access to an individual page in a Space:

	
In the Space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Roles page, select the role for which you want to specify page access permissions, then click Edit Permissions (Figure 51-26). For information about the default WebCenter Spaces roles in this list, see Section 52.2.1.1, "Understanding the Default Roles for a Space."


Figure 51-26 Granting WebCenter Spaces User Access to Space

[image: Granting WebCenter Spaces User Access to Group Space]






	
In the Edit Permissions dialog, clear any checkboxes for page permissions under Basic Services, which apply to all pages in the Space. For information about the permissions listed in the Edit Permission dialog, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."


	
Click Save.


	
In the Space administration settings, display the Pages page.


	
To modify user access to a page, click the Actions icon for the page, and choose Set Page Access to open the Set Page Access dialog (Figure 51-27).


Figure 51-27 Set Page Access Dialog

[image: Set Page Access dialog box]



	
Select the Access Method:

	
To specify that the page should inherit access settings from the permissions established for the Space, select Use Application Permissions, then click OK to save your changes and exit the dialog. For information about setting global Space permissions, see Section 52.2, "Managing Roles and Permissions for a Space."


	
To set custom access on the current page, select Use Custom Access Settings, and continue with the next steps.





	
To grant page access to all authenticated users (that is, to users who are logged in to WebCenter Spaces), click Add Authenticated Access.

The role authenticated-role is added under Role or User with default Read access to the page.


	
To grant page access to all public users (that is, users who have not logged in to WebCenter Spaces), click Add Public Access.

The role anonymous-role is added under Role or User with default Read access to the page (Figure 51-28).


Figure 51-28 Authenticated and Public User Read Access to a Page

[image: Authenticated and Public User Read Access to a Page]



	
To grant page access permissions to selected users, groups, and application roles, click Add Access to open the Add Access dialog (Figure 51-29).


Figure 51-29 The Add Access Dialog

[image: Add Access dialog box]






	
In the Search field, enter a search term or the name of the user, group, or role for whom you want to enable access, and click the Search icon.




	
Tip:

Search terms must contain at least two characters.










	
Note:

In the Add Access dialog, you can add the default roles Moderator, Participant, and Viewer, and any custom roles that have been created for the Space.
For more information about Space roles, see Section 52.2, "Managing Roles and Permissions for a Space"










	
Select a user, group, or role by clicking in its row.




	
Note:

When you select a user name, the permissions you set are granted to that specific user. When you select a group or application role, the permissions you set are granted to all users who are members of that group or who are assigned that role.







Ctrl-click or Shift-click to make multiple selections.


	
Click Select to close the Add Access dialog, and populate the Set Page Access dialog with the selected users, group, or roles.





	
In the Set Page Access dialog, set the Page Access permissions as desired for each user, group, or role (Table 51-1).




	
Note:

If you set page access permissions for the anonymous-role (public users), the Space must also be made public to allow this page to be seen by public users. See Section 51.14.5, "Granting Public Access to a Space."








Table 51-1 Page Access Privileges in the Set Page Access Dialog

	Icon	Name	Description
	
[image: View Page icon]


	
View Page

	
Users can access the page for viewing, but cannot perform any other actions on the page.


	
[image: Personalize Page icon]


	
Edit Page

	
Users can edit the page using Oracle Composer. This includes adding, rearranging, and deleting content; renaming the page; and changing page properties, such as the page scheme.


	
[image: Delete Page icon]


	
Delete Page

	
Users can delete the page.


	
[image: Manage Page icon]


	
Perform All Page Actions

	
Users can perform all actions on the page.


	
[image: Edit Page icon]


	
Personalize Page

	
Users can rearrange page content and personalize his or her view of task flows, provided the task flow includes personalization settings.











	
Tip:

By default, all authenticated users and user roles that you add to the Set Page Access dialog are granted page view access. The other access privileges all require page view access.








	
Click OK to save your changes and close the Set Page Access dialog.









51.7.9 Deleting a Page in a Space

To delete a page in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Delete Page to display the Delete Page dialog.


	
Confirm deletion of the page, and click Delete.









51.7.10 Exposing a Space Page in the Home Space

To add a Space page to the list of pages in the Home Space, visible to all WebCenter Spaces users:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and select Add to Home Space.




When you add a Space page to the Home Space, the page scope remains that of the Space.






51.7.11 Sending a Link to a Page in a Space  

To send mail to Space members prepopulated with a link to a particular page:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose Send Mail to open your mail application compose window, showing a URL link to the page.









51.7.12 Viewing Information About a Page in a Space

To view information about a page in a Space:

	
In the Space administration settings, display the Pages page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Pages page, click the Actions icon for the page, and choose About This Page to open the Page Information dialog, which shows Name, Created By, Date Created, Last Modified, and Direct URL.











51.8 Managing Space Content

To manage the content in a Space in a centralized location:

	
In the Space administration settings, display the Content page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Content page (Figure 51-30), click the subtab for the service that supports the content with which you want to work:

	
Announcements. For more information, see Chapter 59, "Working with the Announcements Service."


	
Documents. For more information, see Section 41.1.1, "Understanding the Document Explorer Task Flow."


	
Discussions. For more information, see Chapter 60, "Working with the Discussions Service."


	
Events. For more information, see Chapter 61, "Working with the Events Service."


	
Lists. For more information, see Chapter 64, "Working with the Lists Service."


	
Polls. For more information, see Chapter 67, "Working with the Polls Service."





Figure 51-30 Space Administration: Content Page
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The subtabs provide quick access to creating and managing content made available through the services that are enabled in the Space:






51.9 Managing Subspaces

To manage the Subspaces of a Space:

	
In the parent Space administration settings, display the Subspaces page (Figure 51-31).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










Figure 51-31 Space Administration: Subspaces Page
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To work with Subspaces, refer to Chapter 54, "Working with a Space Hierarchy."









51.10 Managing Space Services

Most service-related configuration is the responsibility of the Fusion Middleware administrator. The administrator configures and maintains service connections, which make the services available in WebCenter Spaces. For more information, see "Managing Oracle WebCenter Services" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter. Also see Section 53.4, "Enabling and Disabling Services.".

You can check the Services page to see which services are available and can enable or disable services as required. If a service is not shown on the Services page, then the administrator has not configured that service connection.

You use the Roles page to configure role permissions for each service that is enabled in the Space. If a service is not shown on the Roles page, then the service is disabled in the Space. For more information, see Section 52.2.3, "Viewing and Editing Permissions of a Space Role".

When you enable a service in a Space, you are automatically granted Manage permissions on that service.

The following sections describe service-related configuration activities that Space moderators can perform in a Space:

	
Section 51.10.1, "Enabling and Disabling Services Available to a Space"


	
Section 51.10.2, "Configuring a Custom Space Mail Distribution List"


	
Section 51.10.3, "Modifying Discussion Forum Settings for a Space"


	
Section 51.10.4, "Publishing Space Mail in a Discussion Forum"


	
Section 51.10.5, "Configuring a Shared Mail Connection for a Space"






51.10.1 Enabling and Disabling Services Available to a Space

Most services operating within a Space are optional. Optional services include Announcements, Discussions, Documents, Space Events, Instant Messaging and Presence, and Lists.

When you disable a service, task flows associated with the service are no longer available. For example, if you disable the Discussions service:

	
The Discussions page is not shown in the Space.


	
Discussions task flows included in custom Space pages are replaced with a message Service was not enabled for this Space.


	
Discussions task flows are not offered in the Resource Catalog for Space pages.




Additionally, permissions granted for disabled services are removed, and any existing data associated with the Discussions, Announcements, Documents, Space Events, and Lists services is deleted from the Space when you disable these services.

Space members do not automatically gain access to service-related task flows when you enable them here. You must also grant appropriate usage permissions for the service on the Roles page, as described in Section 52.2.3, "Viewing and Editing Permissions of a Space Role".

To enable or disable a service in your Space:

	
In the Space administration settings, display the Services page (Figure 51-32).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










Figure 51-32 Space Administration: Services Page

[image: Space Administration: Services Page]






	
On the Services page, select or clear checkboxes to enable or disable services, respectively.




	
Note:

If you disable the Mail service, WebCenter deletes the default distribution list that was automatically created for the Space. Attempts to send mail to all members of the Space opens the mail window with the To field blank instead of pre-populated with the mail distribution list.
If you previously specified a custom distribution list (see Section 51.10.2, "Configuring a Custom Space Mail Distribution List"), then disable the Mail service, the custom distribution list is not deleted, but the relationship between the distribution list and the Space is deleted.












	
Note:

The Documents service is exposed on the Services page in a Space only with Oracle Content Server 11g. If the connected content repository is Oracle Content Server 10g, the Documents service is not available in the Space administration settings (Services and Roles). To use the Documents service functionality in 10g, you can create a page in a Space and add Documents service task flows to the page (see Section 41.4, "Adding a Documents Service Task Flow to a Page").







Refer to the online help for the Services page for more information about each of the services.


	
Click Apply to save.


	
To allow Space members to access the enabled services, you must grant appropriate permissions to the services for each member role on the Roles page. See Section 52.2.3, "Viewing and Editing Permissions of a Space Role".









51.10.2 Configuring a Custom Space Mail Distribution List

Mail distribution lists provide an efficient mechanism for Space communication. WebCenter Spaces creates a default distribution list for every Space if the Mail Server is Microsoft Exchange and active directory connection details (LDAP) are provided in the mail server connection settings. For more information, see "Managing the Mail Service" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.

A default distribution list is named as follows: space_name@mail_domain.

For example, the default distribution list for a Space named Finance Project is FinanceProject@mail_domain, where mail_domain is derived from the LDAP Domain setting in the Edit Mail Server Connection screen (accessed through Oracle Enterprise Manager). As members leave or join the Space, WebCenter Spaces updates the default distribution list.

If you disable the Mail service, WebCenter Spaces deletes the default distribution list that was automatically created for the Space. Attempts to send mail to all members of the Space (see Section 51.15, "Sending Mail to Space Members or Moderators") opens the Mail Compose dialog with the To field blank instead of prepopulated with the mail distribution list.

If you create a new custom distribution list for the Space, members of the new custom distribution list are not managed by WebCenter Spaces. As members leave or join the Space, they are not automatically removed from or added to the custom distribution list. If you create a new custom distribution list, then disable the Mail service, the custom distribution list is not deleted, but the relationship between the distribution list and the Space is deleted.

To configure a custom Space mailing list:

	
In the Space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Services page, select Mail (Figure 51-33).


Figure 51-33 Configuring the Space Mail Distribution List
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To change the current Space mail distribution list, type a new Distribution List. Allowable characters are alphanumeric, dash (-), and underscore (_). Any other character is converted to a dash (-), and spaces are removed.

If the Distribution List field is left blank, the mail window will open with the To field blank.


	
Under 'Send Mail' Options, select one, both, or neither of the checkboxes:

	
Select Include the Distribution List to populate the To field with the name of the Space distribution list.


	
Select Include the Email Addresses of Space Members to populate the To field with the individual email address of the Space members.





	
Click Apply.









51.10.3 Modifying Discussion Forum Settings for a Space

By default, WebCenter Spaces creates a single discussion forum for a new Space. You can modify this default setting to allocate multiple discussion forums to the Space.

WebCenter Spaces stores all discussion forums and categories under the application root category on the discussions server. The WebCenter Spaces administrator can change the root category, as described in Section 6.2.2, "Specifying Where Discussions and Announcements are Stored on the Discussions Server". If required, you can change the default storage location for the discussion forums for a particular Space.

For more information about the discussions server, see "Setting Up Discussions Server Connections" and "Setting Defaults for Discussion Forums" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter. For more information about the Discussions service, see Chapter 60, "Working with the Discussions Service."

To modify the discussion forum settings for a Space:

	
In the Space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Services page, select Discussions.


	
(Optional) To launch the Jive Forums Administration Console, the Web-based tool for configuring and managing discussion forums, click Forum Administration.


	
To allocate multiple discussion forums to the Space, select Support Multiple Forums for the Space (Figure 51-34).


Figure 51-34 Space Discussion Forum Settings: Single Forum
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The page refreshes to show a category, under which the multiple forums are stored.


	
To store Space discussions in a different category and discussion forum than those specified by Category Name and Forum Name, click the Find icons (Figure 51-35) to change the storage location.


Figure 51-35 Space Discussion Forum Settings: Multiple Forums

[image: Specifying Where Discussions are Stored: Multiple Forums]



	
Click Apply on to save the settings.









51.10.4 Publishing Space Mail in a Discussion Forum

Communication through the Space mail distribution list can be published as discussion forum posts. When a mail message is new, a new topic is created for it. When a mail message is a reply to an existing mail message, a topic reply is created for it.




	
Note:

WebCenter supports Microsoft Exchange server or any mail server that supports IMAP4 and SMTP. To enable WebCenter users to access mail within a WebCenter Spaces application and perform basic operations such as read, reply, and forward, you must first register the appropriate mail server with the WebCenter Spaces application. The Mail service is not configured out-of-the-box. Refer to "Setting Up Mail Server Connections" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.







To publish Space mail in a discussion forum:

	
In the Space administration settings, display the Services page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Services page, select Discussions.


	
To publish Space mail on a discussion forum of your choice, select Monitor Incoming Email (Figure 51-36)

To disable this feature so that mail is not published for any Space, clear this checkbox.


Figure 51-36 Space Discussion Forum Settings: Mail
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Enter the Space Mail Account.

This is the distribution list used to mail Space members. For details, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List".


	
In the IMAP Host field, enter the name of the computer where the IMAP (Internet Message Access Protocol) service is running; in IMAP Port, enter the port on which the IMAP service listens.


	
Select Use SSL if a secured connection (SSL) is required for incoming mail over IMAP.


	
Enter the User Name and Password of a Space member with sufficient privileges to modify these settings (Manage privilege).


	
To publish Space mail on a different discussion forum than the forum specified by Forum Name, edit the value in Forum Name or Forum ID

Click the magnifier icon to display list of available forums in the Space (Figure 51-37).


Figure 51-37 Selecting a Forum for Space Mail

[image: Available forums]






	
Single-click a forum in the list to select it.

Alternatively, create a forum from scratch. Click Create Forum, then enter a suitable name and description.




	
Note:

If you specify a mail distribution list that has been defined as the distribution list for a different Space, then the mail sent to that distribution list are by default archived in the discussion forum specified in the Mail Settings for that Space. Mail sent to a Space distribution list can only be archived one time in one forum, on a first come first served basis.








	
Click Apply to save the settings.







	
Note:

If no forum is specified for mail archiving, or the specified forum is deleted, mail sent to the distribution list is not archived anywhere.












51.10.5 Configuring a Shared Mail Connection for a Space

When a Space is configured to use a shared mail connection, users do not have to specify credentials when sending mails using the WebCenter Mail Service.

	
Confirm that WebCenter Spaces is using the WebCenter Mail service to send mail.

See also, Section 6.3.1, "Enabling Shared Mail Connections for Send Mail Notifications".


	
Ask your Fusion Middleware administrator to set up a mail connection that uses an external application configured with the shared credentials you require, and then record the name of that mail connection.

For details, see "Setting Up a Shared Mail Connection" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
In the Space administration settings, display the Custom Attributes page.


	
Add the custom attributes listed in Table 51-2 (and as shown in Figure 51-38):


Table 51-2 Custom Attributes for Shared Mail Connections

	Name	Value
	
collab.mail.compose.sharedConnectionName

	
Name of the shared mail connection. For example: MySharedMailConnection


	
notifications.use.mail.composer

	
Must be set to true.









Figure 51-38 Setting Shared Mail Connection Attributes for a Space
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(Optional). By default, Send Mail notifications are disabled for public/anonymous users. To enable them in a Space, add the following Space custom attribute:


notifications.anonymous.enabled = true











51.11 Managing Space Resources

The resources for a Space and the tasks associated with managing those resources are identical to the resources for the entire WebCenter Spaces application. For more information, see Chapter 10, "Working with the Resources that Compose a Portal or Community." Any custom resources that you create for a Space can be managed in both the Space and by the WebCenter Spaces administrator.

Table 51-3 describes the support available for creating various resources in a Space.


Table 51-3 Support for Creating Resources in a Space

	Resource	Can You Create the Resource in a Space?	How can the Resource be Created?
	
Page Templates

	
Yes

	
Only by extending another page template.


	
Navigations

	
Yes

	
From scratch or by extending another navigation


	
Resource Catalogs

	
Yes

	
From scratch or by extending another Resource Catalog


	
Skins

	
Yes

	
Only by making a copy of another skin


	
Page Styles

	
No

	
(Not applicable)


	
Content Presenter templates

	
No

	
(Not applicable)


	
Mashup Styles

	
No

	
(Not applicable)


	
Data Controls

	
Yes

	
Only from scratch


	
Task flows

	
Yes

	
Only from scratch








To view, manage, or create resources for a Space:

	
In the Space administration settings, display the Resources page (Figure 51-37).




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










Figure 51-39 Space Administration: Services Page
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On the Resources page, select the resource you want to view or manage:


	
Refer to the following sections for tasks related to working with Space resources:

	
Section 10.1.5, "Viewing Information About a Resource"


	
Section 10.2, "Creating Resources"


	
Section 10.4, "Managing Resources"












51.12 Defining Custom Attributes for a Space

Every Space includes built-in attributes such as name, description, date created, icon, and so on. In addition to these built-in attributes, you can add custom attributes that are unique to the Space and its characteristics.

Custom attributes let you specify additional Space information (metadata). Custom attributes are propagated throughout the Space. Any Space pages, task flow, or portlet that delivers customized content based on parameter values can accept custom attribute values and display content accordingly using the following Expression Language (EL) syntax to access the custom attribute value:


#{spaceContext.currentSpace.metadata.customAttributes[attributeName]} 


A custom attribute is simply a name value pair (such as customerId=400, orderId=11, or userName=Smith). The custom attribute name is unique within a Space. For example, if you build a Space for customer analysis purposes, it might contain several custom task flows that take the parameter customerId as an input: task flows such as Customer Sales History, Customer Satisfaction Rating, Future Sales Prospects, or Customer Contact Information. With a custom attribute defined named customerId with an appropriate customer value, all the task flows that can accept a customerId can display information specific to that customer.

A custom attribute can also be dynamic, using Expression Language (EL) expressions. For example, a custom attribute could use an EL expression to read a value that is passed in. A URL that displays the Space could pass the attribute value in the URL (for example, customerid=10), which would be applied to the custom attribute using the EL expression. For more information, see Section 19.4, "Passing Parameter Values Through the Page URL."

New Spaces based on a Space template that includes custom attributes will inherit the custom attributes and their values.

To add a custom attribute for a Space:

	
In the Space administration settings, display the Custom Attributes page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Custom Attributes page, click Add Attribute (Figure 51-40).


Figure 51-40 Space Administration: Custom Attributes Page
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The Add Attribute dialog opens (Figure 51-41).


Figure 51-41 Entering Custom Attribute Name and Value

[image: Add Attribute dialog]






	
Enter a unique Name for the attribute.


	
Optionally, enter a Value for the custom attribute. You can type a static value, or specify a dynamic value by entering an Expression Language (EL) expression. See Appendix B, "Expression Language Expressions."


	
Click Add to save the custom attribute and display it in the list on the Custom Attributes page.


	
To edit or delete a selected attribute, click the Actions icon for the attribute and select the desired action:

	
Edit Attribute to display the Edit Attribute dialog to modify the attribute name or value.


	
Delete Attribute to display the Delete Attribute dialog to remove the attribute from the Space.












51.13 Adding Wikis or Blogs to a Space

You can include wikis and blogs as pages in a Space.

Wiki pages are populated and monitored by a collaborative group of users with common interests and goals. Users with sufficient permission on a wiki can edit the page to add to, revise, or remove information. Everyone works together to create resource pages that are relevant, useful, and up-to-date. For more information, see Chapter 47, "Working with Wiki Documents."

Blogs, however, are more personal records of experiences and opinions. Blog pages provide a useful means of capturing and publishing the knowledge and opinions of subject matter experts who are members of the Space. For more information, see Chapter 48, "Working with Blogs."






51.14 Making a Space Available

Once you have created a Space, you probably want others to be able to use it. As the Space moderator, you can determine whether the Space should be discoverable only by other WebCenter users, or publicly available:

	
Section 51.14.1, "Publishing the Link to a Space"


	
Section 51.14.2, "Changing a Space URL"


	
Section 51.14.3, "Making a Space Known (Discoverable)"


	
Section 51.14.4, "Granting WebCenter Spaces Users Access to a Space"


	
Section 51.14.5, "Granting Public Access to a Space"






51.14.1 Publishing the Link to a Space

You can share a new Space or updates to an existing Space by publishing the link to the Space. With appropriate permissions, users can directly access a Space by clicking the link that specifies the Space display name.

To publish the direct link to a Space:

	
In the Home Space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the Space you want to share (see Section 49.3, "Viewing Available Spaces"), then right-click the Space icon or name, and choose About, then Share Link (Figure 51-42).


Figure 51-42 Space Actions Menu Selection: Share Link
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The Share Link dialog opens (Figure 51-43).


Figure 51-43 Share Link Dialog for a Space
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Optionally, enter a comment to appear with the link.


	
Click Publish.

The URL to the Space is added to the activity stream for all users or groups who have permission to access the Space, along with your comments, if entered.









51.14.2 Changing a Space URL

You can change the URL that other people use to navigate to the Space. The format of a Space pretty URL is as follows:

http://host:port/webcenter/spaces/internal_space_name

For example: http://mycompany:8888/webcenter/spaces/release_meetings.

While it is possible to change the Space URL, it is important to note that any existing bookmarks to the Space will no longer work.In most cases you need only change the display name; that is, the name displayed on the main Space tab and on dialogs and pages where users can select the Space. For more information, see Section 51.4.1, "Renaming a Space".

To change a Space URL:

	
In the Home Space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the Space that you want to rename (see Section 49.3, "Viewing Available Spaces"), then right-click the Space icon or name, and choose Rename Space URL (Figure 51-44).


Figure 51-44 Space Actions Menu Selection
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In the Rename Space URL dialog (Figure 51-45), revise the Space internal name portion of the URL as desired.


Figure 51-45 Rename Space URL Dialog
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Click OK.









51.14.3 Making a Space Known (Discoverable)

You can make a Space discoverable by other WebCenter Spaces users on their Spaces page and in search results to let them know that it exists. Making a Space discoverable does not make its content accessible. Users interested in the Space can request membership through self-service (if enabled) or by mail.

To make a Space discoverable by other WebCenter Spaces users:

	
Set general access to the Space:

	
If you are creating a new Space, select either Public or Private in the Access step of the Create a Space dialog, as described in Section 51.2, "Creating a New Space."


	
If the Space is currently Hidden, select either Public or Private on the General page of the Space administration settings, as described in Section 51.4.16, "Changing the Access to a Space."





	
(Optional) To allow users to join the Space, you can enable self-registration too (you can still retain control by requiring approval for any subscription request). See Section 52.1.1, "Managing Self-Service Membership for a Space".


	
To add or invite specific WebCenter Spaces users and groups to the Space, allow WebCenter Spaces users to self-subscripe, or invite non-WebCenter Spaces users to subscribe to the Space, see Section 52.3, "Managing Members and Assigning Roles."









51.14.4 Granting WebCenter Spaces Users Access to a Space

After making the Space discoverable (see Section 51.14.3, "Making a Space Known (Discoverable)"), the next step is to assign the permissions that you want different user roles to have in the Space, if the default permissions are not satisfactory.

WebCenter Spaces users have the default Authenticated-User role. A Space is not fully accessible until you give the Authenticated-User role permissions to access the pages of the Space:

	
To grant access to the entire Space: In the Edit Permissions dialog, under Pages, select the desired checkboxes for page permissions, which apply to all pages in the Space. See Section 52.2, "Managing Roles and Permissions for a Space." for detailed information.


	
To grant access to a limited number of individual pages in the Space, see Section 51.7.8, "Changing Access Permissions on a Space Page.".







	
Note:

To use the task pane available through the Microsoft Office shared document management functionality (while editing a Microsoft Word, Excel, or PowerPoint file in a Space) to add members to a Space, see Section 52.3.4, "Adding Members to a Space."












51.14.5 Granting Public Access to a Space

You can make a Space available to anyone with access to the WebCenter Spaces instance that contains the Space. Registering for a WebCenter Spaces account is not required.The public information provided allows the Space to be shared with non-members and people outside of the WebCenter Spaces community.

Public users who are not registered WebCenter Spaces users can access public Spaces in two ways:

	
Directly, using the Space URL provided to them.


	
From the WebCenter Spaces Welcome page, if their installation is configured to display this page (Figure 51-46).


Figure 51-46 Public Spaces Link on Welcome Page
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Public users are assigned the Public-User role, which has no access to Space information by default. To grant public access to a Space, including its pages and any content and services you want to expose on the public pages:

	
Specify the general access settings for the Space:

	
If you are creating a new Space, select Public in the Access step of the Create a Space dialog, as described in Section 51.2, "Creating a New Space."


	
If the Space is currently Hidden or Private, select Public on the General page of the Space administration settings, as described in Section 51.4.16, "Changing the Access to a Space."




When a Space is made public, the Public-User role is automatically granted View Pages and Content permission in the Space, which allows public users to view pages, lists, events, links and notes.

To see what the public view of a Space will look like, copy the Direct URL value in the About Space dialog (see Section 49.5, "Viewing Information About a Space"), log out of WebCenter Spaces, and paste the URL into your browser. Because you are logged out of WebCenter Spaces, only pages designated as public display.


	
(Optional) To allow public users to join your Space, you may want to enable self-registration too (you can still retain control by requiring approval for any subscription request). See Section 52.1.1, "Managing Self-Service Membership for a Space".


	
Now that you have made the Space public, the next step is to assign additional permissions that you want Public-User user role to have in the Space, if the default read-only View Pages and Content permission is not sufficient. You can additionally grant public users permissions to view announcements, discussions, and documents.

In the Space administration settings, display the Roles page.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Manage menu.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










	
On the Roles page, select Public-User, then click Edit Permissions (Figure 51-47).


Figure 51-47 Granting Public User Access to Space
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In the Edit Permissions dialog, select the checkboxes for the desired public permissions for the Space to view announcements, discussions, or documents. For information about the permissions listed in the Edit Permission dialog, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."

The public permissions that you grant here override the public permissions set by the administrator at the application level (see Section 21.2.4, "Granting Permissions to the Public-User").


	
If you want to restrict public access to certain pages in the Space, see Section 51.7.8, "Changing Access Permissions on a Space Page."


	
On the Roles page, click Apply to save.











51.15 Sending Mail to Space Members or Moderators

You can send mail to the members or the moderators of a Space using the default mail distribution list for the Space, and a custom distribution list. For more information, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List."




	
Note:

To use the task pane available through the Microsoft Office shared document management functionality (while editing a Microsoft Word, Excel, or PowerPoint file in a Space) to send mail to members of a Space, see Section 46.3.4.12, "Sending a Message."







To send mail to Space members or moderators:

	
In the Home Space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the Space to which the members or moderators belong (see Section 49.3, "Viewing Available Spaces"), then right-click the Space icon or name, and choose Contact, then Send Mail to Members or Send Mail to Moderators (Figure 51-48).


Figure 51-48 Space Actions Menu Selection: Send Mail
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Your mail application opens, where you can compose and send mail to all members or moderators of the Space.









51.16 Working with the Space Task Flows

WebCenter Spaces provides two Space task flows that you can add to a page (Figure 51-49):

	
Space Members: Adds an area that shows the Space members and provides controls to add new members, send a mail message to all members, filter the list by role, and search for members. For more information about this task flow, see Section 52.4, "Working with the Space Members Task Flow."


	
Spaces Browser: Adds an area that operates identically to the Spaces page, as described in Section 49.3, "Viewing Available Spaces."





Figure 51-49 Space Task Flows: Space Members and Spaces Browser
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The following sections provide information about working with the Space task flows:

	
Section 51.16.1, "Adding a Space Task Flow to a Page"


	
Section 51.16.2, "Setting Space Task Flow Properties"






51.16.1 Adding a Space Task Flow to a Page

To add a Space task flow to a page:

	
Go to the page where you want to add the task flow, and open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content to open the Resource Catalog.


	
Locate the Space Members and Spaces Browser task flows in the Resource Catalog.




	
Note:

These task flows are not available in the default Resource Catalogs provided out-of-the-box with WebCenter Spaces, so you will only see entries for the Space task flows if they have been added to the Resource Catalog that has been made available to the page.
For more information, see Chapter 16, "Working with Resource Catalogs", specifically Section 16.3.1.2, "Adding Resources" (in the Add Resource Catalog Item dialog, select Task Flows, then scroll to Spaces Browser and/or Space Members). Once you have added a task flow to a custom Resource Catalog, you need to Show that catalog, then make that Resource Catalog active for pages in the Space, as described in Section 51.4.11, "Changing the Resource Catalogs for Pages and the Page Template for a Space."










	
Click Add next to the Space task flow you want to add to the page, then Close the Resource Catalog.


	
Click Save, then Close the page.









51.16.2 Setting Space Task Flow Properties

The Space Members and Spaces Browser task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 51-50 and Figure 51-51).


Figure 51-50 Space Members Task Flow Component Properties
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Figure 51-51 Spaces Browser Task Flow Component Properties
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Spaces task flows and describe the properties on the Parameters tab for each task flow:

	
Section 51.16.2.1, "What You Should Know About the Spaces Task Flow Properties"


	
Section 51.16.2.2, "Setting Space Members Task Flow Properties"


	
Section 51.16.2.3, "Setting Spaces Browser Task Flow Properties"






51.16.2.1 What You Should Know About the Spaces Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 51.16.2.3, "Setting Spaces Browser Task Flow Properties" and Section 51.16.2.2, "Setting Space Members Task Flow Properties." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Expression Builder icon next to a property field to open the editor.

For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






51.16.2.2 Setting Space Members Task Flow Properties

See Section 52.4.7, "Setting Space Members Task Flow Properties."






51.16.2.3 Setting Spaces Browser Task Flow Properties

Properties that are unique to the Spaces Browser task flow are shown on the Parameters tab of the Component Properties dialog (Figure 51-52).


Figure 51-52 Spaces Browser Task Flow Component Properties

[image: Spaces Browser Task Flow Component Properties]



For information about the properties on the other tabs, which are common to all WebCenter components, see Section 17.5.2, "Setting Properties on Page Components."



51.16.2.3.1 Spaces Browser Task Flow Parameters

Table 51-4 describes the parameters that are unique to the Spaces Browser task flow.


Table 51-4 Spaces Browser Task Flow Parameters

	Parameter	Description
	
Advanced Query

	
Specifies an EL expression to retrieve a list of Spaces based on custom criteria. The expression may include the population from which to choose, a WHERE clause, and sort criteria. The expression must not be enclosed in #{ and }, and any backlashes and quotes must be escaped (using a backslash). For example, to display a list of publicly accessible Spaces created by user scott, sorted alphabetically by display name:

spaceContext.spacesQuery.unionOf[\'PUBLIC_ACCESSIBLE\'].whereClause[\'sp.createdBy = \\\'scott\\\'\'].sortCriteria[\'sp.displayName asc\']

For additional help with syntax, refer to the JavaDoc for oracle.webcenter.spaces.query.SpacesQueryParameters


	
Display Tool Bar

	
Specifies whether the tool bar displays:

	
#{true} (default): Display the toolbar.


	
#{false}: Hide the toolbar.





	
Display View

	
Specifies the type of layout in which to display Spaces in the Spaces Browser.

	
Card Layout: Display Spaces in a card view.


	
Tiled Layout (default): Display Spaces in a tiled view.





	
Filter

	
Specifies which Spaces should display in the Spaces Browser task flow.

	
Show All (default)


	
Show Joined


	
Show Moderated


	
Show Public


	
Show Discoverable (all Public and Private Spaces)





	
Space Launched on Selection

	
Specifies whether to navigate to a Space when selected in the Spaces Browser task flow:

	
#{true} (default): Clicking a Space opens the Space on the Home page.


	
#{false}: Clicking a Space does not navigate to the Space. Instead, allows user to select the Space, staying on the same page with the selected Space highlighted.





















51.17 Deleting a Space

When a Space has been closed or inactive for some time, you may want to remove it from WebCenter Spaces. Deleting a Space is permanent; it cannot be restored after it is deleted.

Deleting a Space means that:

	
All pages associated within the Space are deleted.


	
All Space data managed by WebCenter Spaces (links, lists, notes, tags, and Space events) is deleted.


	
All Space roles and membership is deleted.


	
Content managed by discussions and announcements is deleted when it is stored in the default forum or category created by WebCenter Spaces. However, content managed by nondefault forums or categories is not deleted (see Section 51.10.3, "Modifying Discussion Forum Settings for a Space").


	
The Space mail distribution list that is automatically created byWebCenter Spaces is deleted. However, distribution lists that are customized by the Space moderator are not deleted (see Section 51.10.2, "Configuring a Custom Space Mail Distribution List").


	
Content managed by external services, such as content repositories, mail, and so on, is removed.




To delete a Space:

	
In the Home Space, click Spaces, then choose Browse Spaces in the Spaces Switcher menu.


	
On the Spaces page, locate the Space that you want to delete (see Section 49.3, "Viewing Available Spaces"), then right-click the Space icon or name, and choose Delete the Space (Figure 51-53).


Figure 51-53 Deleting a Space
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In the confirmation prompt, click Delete to confirm or Cancel to preserve the Space








This figure shows a part of the Edit Permissions dialog for a role in a Standard Permission model. The permissions available for documents in a Space are listed. These include: Administration, Delete Documents, Create and Edit Documents, and View Documents.


This figure shows the sample banking application navigation model displayed as a tree with the List style where none of the top-level nodes are folders.


This image shows the Spaces component Favorites Menu. It is a link with the link text, "Favorites." It is flanked by separators and additional Spaces components.


This figure depicts the mail message window displayed when you click Reply. The window contains a field labelled To with a Find User icon. To and Subject fields already populated with the name of the person who sent the mail and the subject of the mail. Below the Subject field, an HTML file is listed as an attachment. A Remove Attachment icon is displayed adjacent to the file name. A text area in the lower half of the window contains the original message. Send and Close buttons are displayed at the bottom of the window.


The images shows a section titled Resources displaying six fields with dropdown menus. The first menu is for selecting the default page template. The other five are for selecting the Resource Catalogs for Spaces, Home Space, Business Role Pages, Page Templates in Spaces, and Page Templates in Home Space.


The image shows the Edit dialog with the Add menu clicked to display the Folder, Component, and Add From Library options. The Add From Library option is highlighted with a red border.


The image shows a task flow with MyInsertOrUpdate and MyQueryById buttons at the top. Below these buttons is the table displaying records from the data source. Below the table are five fields. The first field has a red border around it and has a description that says it is used to query the data source. The remaining fields are enclosed in a red border and the description for this red box says that the fields are used to update records.


This figure shows the Target tab of the Edit Navigation Item - Navigation Reference dialog.


This figure shows the selected section of a web page displayed in the Web Clipping portlet.


This figure shows the Create Group Space dialog with fields to enter Group Space Name, Description, selecting the Group Space Template.


This figure shows the Layout tab when the Bullet layout style is selected on the View tab. Here you can specify the bullet style (disc, circle, square, numerals, or none), and also the column layout.


This figure shows a preview of the main navigation model with the Human Resources and Banking navigation references expanded to show the contents of those embedded navigation models.


This figure shows the sample banking application navigation model displayed as a menu with the Bar style.


This figure depicts a list open on the List page.


This screen shot shows the Discussion Forums task flow, with one topic, and a reply to the topic. It also has links to reply more to this topic, edit this topic, delete this topic, subscribe RSS, watch this topic, or add links to this topic.


This image shows the Set Page Access dialog. It lists the page name, followed by the Add Access and Delete Access options, which are on the same line. Below these are the Add Authenticated Access and Add Public Access options, also on the same line. Below these is a small table with two columns: Role or User and Page Access. Page Access has five subcolumns, each with an icon that depicts a type of access permission: glasses for View Page, a wrench for Edit Page, an ex for Delete Page, a wrench over a cascade of pages for Perform All Page Actions, and a pencil for Personalize Page. The text, "No access defined" appears below the table. The dialog also provides a Help icon at the top and OK and Cancel buttons at the bottom.


This image shows the Edit Properties dialog. The dialog is divided into three main sections: General, Exclude Resource Usage, and Attributes. The Attributes section is called out. It is divided into two columns, Name and Value, with fields under each for providing attribute names and values. Below the two default rows is an Add More button. Below that are two more buttons: OK and Cancel.


This figure shows the Create New Navigation dialog.


This figure shows a wiki document created using the New Wiki Document action on a Wiki page. The figure shows the name of the Wiki page's folder and the newly created wiki document as highlighted. It also lists all the other wiki documents available under that folder.


This figure highlights the Show documents, Show wiki pages, Show blogs, and Show discussion topics checkboxes in the Display Options dialog for the Similar Items task flow.


This figure shows the Parameters tab open in the Component Properties dialog of a Blogs task flow. The tab contains the following properties, which are unique to a blog: Hide Comments, Number of Rows Displayed, Resource Id. The Resource Id field shows the resource ID of the folder with which the blog is associated.


This figure depicts the Display Options dialog box displayed when you click the Display Options icon in the Worklist task flow. The Display Options dialog box contains a Group By list, Sort By options, and Save and Cancel buttons.

The task flow also provides the Messaging preferences and Refresh icons.


This figure shows the Delete the Space menu item for a Space.


This figure shows a popup listing the objects that the current user has in common with one of the users listed as a recommended connection.


This figure shows the application-level Resources page open in WebCenter Spaces Administration. Under the Skins resource, the Fusion FX skin is selected.


This figure shows various blog posts available under a blog's folder in the document hierarchy. The name of the folder is shown in bold in the bread crumb. For each blog post file, details like Modified By and Last Modified are displayed.


This figure shows the home page of the AviTrust Employee Portal.


This screen shot shows the Discussions - Popular Topics task flow at run time, with 3 topics listed.


This figure depicts the service nodes in a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node. The Discussions node is expanded and a recent Discussion is displayed as a link as the mouse hovers over it.


This image shows the Spaces component Share Resource. It is a link with the link text, "Share Link." To the right of it are separators and additional Spaces components.


This image shows Box layout component display options in the Component Properties dialog. There are two tabs, Display Options and Style. The Display Options tab is forward. It contains menus and fields, including Allow Action, Horizontal Alignment, Layout, Short Desc, Show Split Action, Show Tab Action, Vertical Alignment, and Show Component. The properties Show Split Action and Show Tab Action are called out.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: For Testing." Below the status message are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, and Cut buttons. The mouse pointer hovers over the Edit button showing the hint text, "Show the properties of Box." In the hierarchical list of page components, a Box component is selected and called out.


This figure shows the Space administration Roles page, showing current roles defined for the selected Space.


This image shows an Image layout component. Its sides and bottom are bounded by a dotted line. Its header has the label, "Image," and Edit and Remove icons. Below the header is a placeholder graphic.


This figure depicts the Compose window. There are four fields labelled To, Cc, Bcc, and Subject. To the right of each of the first three fields is a Find User icon. A text area in the lower half of the window contains the actual message. An Attach Files link is displayed below the Subject filed. Send and Close buttons are displayed at the bottom-right corner.


Yahoo presence offline icon


This figure shows the Notes task flow added to a custom Resource Catalog.


This image shows a Help icon, which is a circle encircling a question mark. The mouse pointer hovers over the icon with the hint text, "Help."


This image shows the About subpage of the My Profile page. At the top, is the Summary section. Within this section, a placeholder for a user profile image appears to the right. To the left summary profile details are listed. These include About Me (value user2), Display Name (value user2), Email, Department, Designation, Manager (value manager_user), Direct Reports, Phone, and Time Zone.


This image depicts configuration settings for the People Connections service in a WebCenter Spaces application. The cursor points to the People Connections link on the Services subpage of the Configuration page in WebCenter Administration pages. To the right are five settings tabs: Activity Stream, Connections, Profile, Message Board, and Feedback. The Connections tab is forward, presenting options for specifying whom to grant view access, whether users can override this setting, and whether all invitations to connect should be accepted automatically.


This figure shows the Connection Information page for a SQL data source. Depending on the specified data type, the Connection Information page may include fields for entering the Connection Name, Username, Password, Connection String, and Driver Name for the connection. Additionally, you can use the Test button on this page to test the connection.


This figure shows a blog created using the Blog page style. The name of the blog page is listed on the top navigation bar. The blog does not contain any blog posts. The New Post link and the View all link are displayed for the blog.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. The View menu is called out. A blue dot indicates that Source view is the current selection. On the line below the View menu is a toolbar with controls for editing, deleting, cutting, and pasting page components. The toolbar is also called out.


This figure depicts the Display Options tab in the Component Properties dialog that is displayed when you edit or view the properties of a Worklist task flow.


This image shows the Spaces component Invite People as Connection. It is a link with the link text, "Invite People." It is flanked by separators and additional Spaces components.


This figure shows the Discussion Forums task flow containing a list of all discussion topics. The RSS icon is highlighted.


This image shows the Spaces component About Space. It is a link with the link text, "About Space." To the right of it are separators and additional Spaces components.


The image shows a pie graph with different colored sections representing the different page categories.


This figure shows the Source tab that displays when you select SQL on the Type tab. The Source tab includes a Statement field for entering a SQL statement. Additionally, it displays buttons for showing bind variables and testing your statement.


This figure shows a list titled ProjectSpaceIssues. The list page contains a table displaying all the list items. A header above the table displays the Actions, View, and Format menu, and the Edit, Freeze, Wrap, Filter, RSS, Links, and Refresh icons.


This figure shows the Space administration settings Services page, showing configuration options for the highlighted Discussions service.


This image shows the New Page Link dialog. The header is labeled, "New Page Link," and includes a Close icon. Below the header is the text, "Enter the name and path of the page." Below this text are two fields, Name and Path. To the right of the Path field is a Browse button. At the bottom of the dialog are OK and Cancel buttons.


This figure highlights the Do not show this item icon next to an item in the Similar Items task flow. The icon looks like a small red cross.


This figure depicts the user name and status icon highlighted in the Mail task flow. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This figure shows a part of the Edit Permissions dialog for a role in a Standard Permission model.


This image depicts configuration settings for Profile. The Profile tab is divided into three sections: Allow Password Change, Profile Access, and Profile Attributes - Edit Settings. The Allow Password Change section provides a checkbox for allowing or prohibiting individual users from changing their own application passwords. The Profile Access section provides controls for specifying who can view a given Profile data section, whether users can override this default, and whether users can edit their own views of a given section. The Profile Attributes - Edit Settings section provides checkboxes to enable or prohibit users from updating a particular attribute under a given profile section.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Separator menu option is selected.


This figure shows the Display Options tab in the Component Properties dialog that is displayed when you edit or view the properties of a Producer Registration task flow.


This image shows the New External Link dialog. Its header contains an icon with the label, "New External Link," and a Close icon. Below the header is the text, "Enter the name and URL of the external link." Below this text are two fields, Name and URL, and a checkbox, Render in page template. At the bottom of the dialog are OK and Cancel buttons.


This image shows the Expression Builder editor. The option "Type a value or expression" is selected. Under that is a text box containing the EL expression #{securityContext.userName}.


This figure shows an example of an OmniPortlet using a vertical form layout.


This image shows a Hyperlink layout component inside a Box in page edit mode. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is the link text, "Click edit icon to define hyperlink." To the right of this text is a floating tool palette with three icons. The first is a handle for grabbing and moving the component, the next is an Edit icon, the last is a Delete icon. The mouse pointer is hovering over the link text to invoke the floating palette.


This image shows a page in edit mode Source view. The component "menu:Everyone" is selected in the hierarchy of page components, and the component itself, a menu of share options, is called out in the WYSIWYG portion of the page.


This figure shows the General tab open under the application-level Configuration page. In the Global section, the Application Skin list is open, and a skin is highlighted.


This figure shows a Source tab that displays when you select XML on the Type tab. On this page, you can enter the URL to the XML, the XSL filter, and the URL to the XML Schema. Additionally, Test buttons enable you to text your XML URL and XSL Filter URL.


This figure shows the Parameters tab open in the Component Properties dialog of an RSS task flow.


This figure shows the sample banking application navigation model displayed as a tree with the start node (Current Account) displayed.


This figure shows the Space administration General page, highlighting Take Group Space Temporarily Offline checked.


This figure shows the administration pages of a Space, with the Resources page open.


This screen shot shows the Tag Center, with 3 panes: a Tag Cloud listing tags applied to the Spaces page, Refine Tag Results, and tagged items.


This image shows the Spaces component Tags. It is an icon and a link with the link text, "Tags." It is flanked by separators and additional Spaces components.


This image shows a page in edit mode Source view zoomed-in to a selected task flow. The task flow element "inputText:Find Connection" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of Find Connection," is shown.


This figure shows an example of an OmniPortlet using the tabular layout.


This figure shows the Attributes section of the Edit Properties dialog of a resource. The various attributes associated with the resource and their values are displayed.


This figure depicts the Add Attachment window. To the left of the window is the File field with the Browse and Attach buttons adjacent to it. The bottom right corner of the window contains the Send and Close buttons. The lower half of the window contains the Attachments area that displays the files that are already attached. Adjacent to each attached file name is the Remove Attachment icon.


This figure shows the Create New Navigation dialog with the fields completed as indicated in the previous steps.


This figure shows the Edit Navigation Item - Pages Query dialog with the fields completed as indicated in the previous steps.


This screen shot shows the Mail Compose window with the CC, BCC and Reply-to fields added, and the Rich Text Editor removed. The Find User icon is adjacent to the To field, the Cc field, and the Bcc field.


This image shows the Spaces component RSS. It is a link with the link text, "RSS." It is flanked by separators and additional Spaces components.


This image depicts a page in edit mode Source view. At the top is a status message, "Editing Page: For Testing," Below that are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste controls. The Add Content button is called out and the mouse pointer hovers over it, showing the tooltip, "Add content into the selected component." In the hierarchical list of page components, a Box layout component is selected. Below the list is a band illustrating the pathway to the current selection. In the WYSIWYG portion of the page, the selected Box is outlined in blue. The selected Box is called out.


This screenshot shows the External Applications > Register button in the Configuration page.


This figure shows the Edit Navigation Item - Navigation Reference dialog with the fields completed as indicated in the previous steps.


This figure shows the sample banking application navigation model displayed as a tree with the List style where the top-level nodes are folders.


This screenshot shows the Fields page in the Create Form dialog.


This image shows a page in edit mode Source view. The component "menu:Everyone" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of Everyone," is shown.


This figure depicts a forwarded mail message window. There is a field labelled To with a Find User icon. Another field below these is labelled Subject and is already populated with the subject of the mail you are forwarding. Below the Subject field, a text document is listed as an attachment. A Remove Attachment icon is displayed adjacent to the file name. A text area in the lower half of the window contains the forwarded message. The bottom-right corner contains Send and Close buttons.


This figure shows the Edit Properties dialog of an application-level task flow. The Exclude Resource Usage section is highlighted.


This image shows the Spaces component Page Links. It is an icon and a link with the link text, "Links." It is flanked by separators and additional Spaces components.


This screen shot shows the Recent Topics task flow, with the following four topics: Sales Issues, Development Issues, QA Issues, and Support Issues.


This figure shows the options that display on the Layout tab when the News layout style is selected on the View tab. Two sections display: News style (plain, logo, or scrolling) and Column Layout.


This figure shows the preview when both the Repeat Horizontally and Repeat Vertically options for the background image are selected. The selected background image is repeated across the entire Task Flow/Portlet target area.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Folder menu option is selected.


This figure shows the Recent Activity service highlighted on the RSS Manager page in WebCenter Spaces. To the right of the Recent Activity service name are the RSS 2.0 and Atom 1.0 news feed icons.


This screenshot shows the Save Download to Server dialog.


This image shows the Component Properties dialog for a Box layout component. There are three tabs, Child Components, Display Options, and Style. The Child Components tab is forward. On it is the heading, "Components," and a list of child components, including Recommended Connections, Publisher, and Announcements. To the right of each listed component is a Move icon for rearranging the order of components. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure depicts the Cancel button at the bottom of a forwarded mail message window.


This image shows the Spaces component Home Space. It is a link with the link text, "Personal Space." To the right of it are separators and additional Spaces components.


This figure highlights the Number of items field in the Display Options dialog for the Similar Items task flow.


This screen shot shows the Flat mode highlighted on the a topic in the Discussion Forums task flow, where the reply is flush under the topic.


This image shows the Component Properties dialog for a portlet. At the top is the label, "Component Properties: portlet," and Help and Close icons. Below the header are five tabs, Parameters, Display Options, Style, Content Style, and Events. The Events tab is forward. The dialog is divided in the middle by a dotted line. Above the line are two stacked fields, Events and Action. Below the dotted line are an Enable Action checkbox and the fields parameter1, parameter2, parameter 3. Next to each parameter field is a menu icon. At the bottom of the dialog are the buttons Apply, OK, and Cancel.


This image shows the Spaces component Add to Favorites. It is a link with the link text, "Add To Favorites." To the right of it are separators and additional Spaces components.


This figure depicts a Worklist notification window that displays the notification creation date and the complete message for an item selected in the Worklist task flow. An Acknowledge button is available at the top-right corner that you can use to respond to the notification.


This image shows a detail of the Spaces page. At the top is an icon labeled, "Create a Space," and a Sort By menu with the selection, "Name." Spaces are listed in columns and rows. The context menu on the Space, "Standards," is expanded, showing the options Manage Settings, Rename Space URL, Delete the Space, Contact, Membership, and About. A few options have an icon that indicates submenu items. These include Contact, Membership, and About. The About submenu is expanded to show the options About this Space, Similar Spaces, and Share Link. About this Space is called out.


This figure depicts the time-range options in a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This figure shows the Documents page of a Space, with a folder created at the root level highlighted.


This figure depicts the Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This image shows an example of a Profile Gallery page. At the top, in the application chrome, the mouse pointer hovers over the Current User Profile Spaces component with the hint text Josie Smith. This component is called out. The body of the page is divided into two columns. The left column contains Josie Smith's profile picture and job title and the subpages Activities, Connections, Documents, Organization, and About. The Activities tab is forward. It contains a Publisher task flow followed by an Activity Stream. The right column contains a Download vCard link and four categories of information, Contact Information, Location, About, and Recommended Connections.


This figure shows the permissions required in an Advanced Permission Model for creating content presenter templates in a Space. The Manage All, Manage Configuration, and Create, Edit, and Delete Content Presenter permissions are highlighted.


This image shows the Spaces component Logout. It is a link with the link text, "Logout." To the left of it are separators and additional Spaces components.


This image shows the Spaces component Copyright Message. It is the text string, "Copyright (copyright symbol) 2010, Oracle and/or its affiliates. All rights reserved."


This image shows the Copy Page dialog. It contains a Page Name field with the value, "Copy of one." It lists two Copy as options: Business Role Page and Personal Page. Two buttons appear a the bottom of the dialog: OK and Cancel.


This image depicts configuration settings for Feedback. The Feedback tab is divided into two sections. The first section (unlabeled) provides controls for specifying who can view and post Feedback and who can view Feedback left for others. The second section, Additional Access Settings, provide checkboxes for allowing or prohibiting users from deleting the Feedback they have left and changing the visibility of Feedback left for them.


This image shows the Page Properties dialog. The Parameters tab is forward and shows a newly added parameter (space) and value (#{empty navigationContext.currentNavigationModel.currentSelection.parameters.space ? 'Space_Name' : navigationContext.currentNavigationModel.currentSelection.parameters.space}).


Yahoo presence online Yahoo icon


This figure shows the Edit Source dialog of a custom skin, with the various skin selectors listed on the CSS tab.


The image shows the Add Content dialog that displays a list of all components that you can add to a page.


This screen shot shows the estimated number of results: 1 - 10 of about 344, with links to the next 10 pages of results.


This screenshot shows the Table option available on the context menu of the Add button for a data control accessor.


This figure highlights the Show spaces I have worked on before checkbox in the Display Options dialog for the Similar Spaces task flow.


This figure depicts the Group By list in the Display Options dialog box with the Category, Create Date, Due Date, Expiration Date, Not Grouped, Priority, and Worklist Server options.


This figure shows the various versions available for a wiki document. For the selected wiki document version, the Delete and Compare options are available.


This figure shows the display settings of a Space, with the page templates that can be applied to the Space listed in the Page Template list. The page template named MySpaceTemplate, which is a hidden resource, is not shown in this list.


This figure shows the Cancel Filter icon.


This figure shows the Options tab of the Edit Navigation Item dialog.


This image shows the Expression Builder editor, invoked from an icon next to a parameter in the Component Properties dialog. The editor has a Help icon on the right side of the header (followed by a Close icon), and two main options: Choose a value and Type a value or expression. A Test button is available at the bottom of the dialog to test the validity of any EL expression that appears in the text box under Type a value or expression.


This figure depicts the personalization menu in the Mail task flow. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This image shows the login detail of a Welcome page. The heading is, "Log in to WebCenter Spaces." Below that are fields labeled User Name and Password. This is followed by the Login button. Below that is the heading, "Need an account?" followed by a Register button. The mouse pointer hovers over the Register button.


This image shows the Personal Pages subpage under Pages in Spaces Administration pages. The label Personal Pages is highlighted and flanked by links to the Business Role Pages and System Pages subpages. Below this is a toolbar with controls for applying a temporary filter to the list of personal pages, creating a persisted filter, refreshing the list of personal pages, and accessing page help. Personal pages are listed in a table with four columns: Name, Created By, Last Modified, and Actions. The Actions column provides icons for accessing a menu of commands for acting on an individual personal page. A Page Actions menu is expanded, showing the options, Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The Delete Page option is called out.


The image shows the Add Content dialog displaying the contents of the EmpDetails data control. The Add button against the EmpDetails accessor is clicked to show three context menu options: Table, Form, Graph.


This screen shot shows the reply to a topic, with the breadcrumbs from spacesearch (forum) > QA Issues (topic).


This figure shows a top navigation page template dynamically applied when a Space moderator logs into WebCenter Spaces.


This figure shows the Copy dialog of a skin.


This graphic shows the Polls Manager, with the Create Poll icon and the Refresh icon highlighted.


This image shows the System Pages subpage under Pages in Spaces Administration pages. The label System Pages is highlighted and preceded by links to the Business Role Pages and Personal Pages subpages. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over a Customize link next to the Activities page, and shows the hint text, "Customize the Activities page using the Oracle Composer."


This figure depicts a mail window with the attachments highlighted. A toolbar at the top of the window contains Reply, Reply All, Forward, Compose, and Delete buttons. Below this are prepopulated rows labelled Subject, From, Date, To, and Attachment. The Attachment row contains two text files and one HTML file. A text area in the lower half of the window contains the actual mail message.


This graphic shows the Recent Activities option selected in the Add Resource Catalog Item dialog.


This graphic shows the Copy - Page Template dialog, with the Display Name and Description parameters.


This image shows a Movable Box layout component on a page in edit mode. It has a header with a collapse icon, the label, "Movable Box," an icon for accessing Movable Box properties, and a Remove icon. Inside the Movable Box is a Box, which is bounded by a dotted line. In the Box, an Add Content button is shown to the left. To the right is an icon for accessing Box properties.


This image shows the Spaces component Privacy URL. It is a link with the link text, "Privacy Statement." To the left of it are separators and additional Spaces components.


This figure shows the Download dialog containing the Download and Save to Server buttons, which you can use for downloading your resource's EAR file.


This figure shows a wiki document listed in the document hierarchy on the Documents page, and in the top navigation area.


This screenshot shows the Create new Data Control - Web Service dialog.


This image shows the Component Properties dialog for an Announcements task flow. It shows five tabs, Parameters, Display Options, Style, Content Style, and Events. The Parameters tab is forward. It contains checkboxes and fields for entering parameter values. Parameters include:

	
Expand All Announcements in Extended Mini View


	
Number of Expanded Announcements


	
Content View Only


	
Hide Toolbar


	
Navigate to Announcement Viewer


	
Number of Announcements on Extended Mini View


	
Forum ID


	
Announcement Length


	
Number of Announcements to show




At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows the User Detail popup.


This figure shows a list of all the wiki documents available under a Wiki page. The name of a newly created wiki document is highlighted.


This figure shows the panel for creating a new note.


This figure shows the User Messaging Preferences page.


This image shows the Component Properties dialog for an Announcements task flow. It shows five tabs, Parameters, Display Options, Style, Content Style, and Events. The Display Options tab is forward. It contains checkboxes, selection lists, and fields for entering parameter values. At the top are two subtabs, Basic and Advanced. The Basic tab is forward. On this tab, the following Display Options are shown:

	
Text


	
Short Desc


	
Chrome Style


	
Font Color


	
Font


	
Font Size


	
Font Style


	
Display Header


	
Allow Remove


	
Allow Resize


	
Show Component




To the right of all but the Font properties, a menu icon is shown. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This image shows a list of system pages. The Task Flow Editor system page is called out, and the mouse pointer is touching the page's associated Customize link. The hint text, "Customize the Task Flow Editor page using the Oracle Composer," is shown.


This figure shows how selecting the Personal Banking tab at the top of the page displays the rest of the navigation model (from Personal Banking down) on the side of the page.


This graphic shows the Add icon in the Polls Manager, with selections to add question, add section, or apply template.


This figure shows a page template named MySpaceTemplate marked as hidden on the Resources page. The figure also shows the Create New Page Template dialog, with the MySpaceTemplate listed in the Copy from list.


This graphic shows the Polls Manager in the page to compose or edit a section.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Content Query menu option is selected.


This figure depicts the Compose icon on a Mail task flow. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This figure shows the Setup step of the Create a Space Template dialog, displaying the Space Template Name and Description fields.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu is the link, "Sales Figures," followed by Configure and Delete icons. The mouse pointer is hovering over the Configure icon with the hint text, "Configure."


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Delete Page is called out.


This image shows the Spaces component Leave Space. It is a link with the link text, "Leave Space." It is flanked by separators and additional Spaces components.


This figure shows the sample banking application navigation model displayed as a tree with icons appearing next to each item in the tree.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Sales." Below the status message are the View menu and the Page Properties button. On the line below the View menu is a toolbar with controls for editing, deleting, cutting, and pasting page components. A mouse pointer hovers over the Delete button, showing the tooltip, "Delete Links." The Delete button is called out. In the hierarchical list of components, the component showDetailFrame:Links is selected.


This figure shows the sample banking application navigation model displayed as a tree with the start node (Current Account) displayed as the header of a box surrounding the rest of the navigation.


This figure shows an example of a portlet using the disc bullet layout.


New Forum - May Service Requests


This figure highlights the Show spaces I have visited before checkbox in the Display Options dialog for the Similar Spaces task flow.


This figure shows the Delete Note dialog.


This figure shows the Expression Builder dialog. The Type a value or expression radio button is selected and an expression builder statement for applying a page template based on the user role is shown.


This figure shows the Create and Edit Documents permission for the Documents service highlighted.


This figure depicts the highlighted Messaging Preferences icon in the Worklist task flow. The task flow also provides the Display Options and Refresh icons.


This figure shows a blog post on a blog page. The name of the blog on the top navigation bar is highlighted. The blog post can be opened by clicking the blog post title highlighted on the blog page.


This figure shows the Space administration Services page, showing a list of available services with check boxes to enable or disable.


This graphic shows the Polls Manager in the page to create or edit questions.


This image shows the Personal Pages subpage under Pages in Spaces Administration pages. The label Personal Pages is highlighted and flanked by links to the Business Role Pages and System Pages subpages. Below this is a toolbar with controls for applying a temporary filter to the list of personal pages, creating a persisted filter, refreshing the list of personal pages, and accessing page help. Personal pages are listed in a table with four columns: Name, Created By, Last Modified, and Actions. The Actions column provides icons for accessing a menu of commands for acting on an individual personal page. A Page Actions menu is expanded, showing the options, Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page.


This image shows an HTML Markup component in page edit mode. The sides and bottom are bounded by a dotted line. The component header contains the label, "HTML Markup," and Edit and Remove icons. Below the header is the text, "New HTML Markup."


Tags task flow, with the display options shown: Tag List, Tag Cloud, and Tagged Items.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu are current links, each followed by Configure and Delete icons. The Configure and Delete icons are called out.


This image shows the Spaces component User Preferences. It is a link with the link text, "Preferences." It is flanked by separators and additional Spaces components.


This figure shows Upload dialog for a resource, with the On Local File System radio button selected.


This image shows the Spaces component Spaces Switcher. It is a drop-down menu labeled, "Spaces." It is flanked by separators and additional Spaces components.


This figure shows the Parameters tab of the Component Properties dialog for the Recommended Connections task flow.


This figure shows the RSS 2.0 and Atom 1.0 news feed icons displayed against the Discussions service listed under a Space.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Link menu option is selected.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Sales." Below the message are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste buttons. In the body of the page is a hierarchical list of page components, including panelGroupLayout: scroll, Box, tableLayout, rowLayout, and the like.


This image shows the Page Properties dialog. At the top is an icon and the label, "Page Properties," with Help and Close icons. The dialog is divided into two tabs, Display Options and Parameters. The Display Options tab is forward. It contains a menu and two fields, Background Color, Background Image, and Other CSS. The Background Color menu is expanded, showing two buttons, Last Used Color and Default Color, a color palette, a row for showing previously selected colors, and another button, Custom Color. The mouse pointer is hovering over the middle color in the top row, and the resulting hint text is, "Beige (F5F5DC / 245,245,220)."


This image shows the Project Issues list in page view mode. At the top is a Collapse icon, the label, "Project Issues," a Personalize icon, and a menu icon. The mouse pointer hovers over the Personalize icon showing the tooltip, "Personalize."


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Sales." Below the status message are the View menu and the Page Properties button. The mouse pointer hovers over the Page Properties button, and the button is called out. The page body shows a Box layout component enclosing a Links layout component.


The Tags icon


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the mouse pointer is pointing to the Edit Task Flow link to the right of a component named, "region."


This image shows a page in edit mode Design view. At the top is a status message, "Editing Page: Activities." Below the status message, is the View menu, a Page Properties button, a Help icon, and Save and Close buttons. On the page body are two layout boxes, vertically aligned, each with Add Content buttons and icons for adding more layout boxes above, below, and left or right of the current layout box. Additionally, there is an icon for editing box properties. Both layout boxes contain content: the first shows the Publisher task flow; the second shows the Activity Stream.


This figure shows the contents of the Spaces Administration Options navigation model.


This figure shows the Find a Web clipping page. In the Properties section, URL Rewriting is specified to be Inline and Title is specified to be OTN Search.


This figure depicts the Refresh icon on a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This screen shot shows the Discussions - Watched Forums task flow at run time, with 7 forums listed.


This figure depicts the Advanced Search panel in a Documents service task flow. The default fields File Name, Search Content For, and Look In display on the left side of the pane. The buttons Search, Reset, Basic, and Add Fields display at the top right of the pane.


This image shows a page in edit mode Design view. The mouse pointer is depressing an Add Content button, and the resulting Resource Catalog is open. The Resource Catalog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Top"), a Search field and button, and a Refresh icon. The dialog lists various resource folders, such as Alerts and Updates, Analytics, Content Management, and so on. Each folder has an associated icon and Open link.


This image shows a detail of a page in edit mode Design view. Below the status message ("Editing Page: New Page"), View menu, and Page Properties button is a concurrency warning with a warning icon (triangle with centered exclamation point) and the text, "This page is also being edited by: vicki (7 secs ago)."


This screen shot shows the Create New Page dialog, with the Page Name parameter filled in with New Page and the Blank Page Style selected.


This figure depicts the Mail task flow in which one mail is displayed as a link as the mouse pointer hovers over it. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This figure depicts an Announcement dialog displaying the announcement title and the complete content. The dialog has a Close button at the bottom-right corner.


This figure shows the section of the Source tab where you can set the connection information and the portlet-level parameters. There is an Edit Connection button you click to specify connection information.


This figure shows the results of the search.


This figure shows the Similar Spaces task flow.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu are current links, each followed by Configure and Delete icons..


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Content Item menu option is selected.


This screenshot shows the Application Navigator option selected in the Add Content dialog.


This image shows an unpopulated page with a header and footer. The header is a horizontally aligned Image, Separator, and Text component comprising a message from the Space administrator. The footer is a Hyperlink component that provides a link for joining the Space.


This figure shows the filtering toolbar highlighted.


This image shows the Expression Editor. In the header, it is labeled Expression Editor and provides a Help icon and a Close button. Two options are listed, "Choose a value," and "Type a value or expression." Below "Choose a value," are two menus, side-by-side. The first provides a selection list of categories from which to choose EL expressions (ELs). The second provides a selection list of expressions related to the selected category. Below "Type a value or expression," is a text entry field for entering an EL. At the bottom of the dialog are Test, OK, and Cancel buttons.


This image shows the Spaces component Status Indicator. It is an animated icon of a stylized "O" that spins when the application is processing information.


This figure shows the Layout tab when an HTML layout was selected on the View tab. It includes four sections: Quick Start, Non-Repeating Heading Section, Repeating Section, and Non-Repeating Footer Section.


This image shows the Create Page dialog. It has a required field labeled "Page Name." It provides a mixed selection of page styles, in this example: Blank, Blog, Home Page, Left Narrow, Right Narrow, Three Column, Web Page, and Wiki. The bottom of the dialog shows two buttons: Create and Cancel.


This figure shows the Blog page style highlighted in the Create dialog.


This image shows a portion of the Business Role Pages subpage under Pages in Spaces Administration pages. Business role pages (BRPs) are listed in a table with five columns: Name, Reorder, Created By, Last Modified, and Actions. The Reorder column provides icons for rearranging the order of BRPs. The mouse pointer hovers over an icon, and the hint text, "Move this page after the following page," is shown.


This image shows the Expression Builder editor. The expression #{generalSettings.preferredTimeStyle} appears in the text box. The mouse pointer is depressing the Test button. A popup shows the value this EL returns: short.


This figure shows the directory structure of a blog in the document hierarchy on the Documents page. The blog's folder name is highlighted on the bread crumb, and the posts available in that folder are listed.


This figure shows the Lists news feed, which displays the list title that is hyperlinked.


This screenshot shows the expression Editor with a Personalization EL.


This image shows a page in edit mode Source view zoomed-in to a selected task flow. The hierarchical list shows the task flow's elements. The element, "inputText:Find Connection," is selected. In the WYSIWYG portion of the page, the mouse pointer is selecting the Find Connection element. The Find Connection element is called out.


This figure shows the top portion of the Space administration Custom Attributes page, showing the Add Attribute icon and link.


This figure depicts the Display Options tab in the Component Properties dialog that is displayed when you edit or view the properties of an External Application task flow.


This image shows the Select Document dialog. The header contains the label, "Select Document," and a Close icon. Below the header is a Search field and icon, followed by an Advanced link. The body of the dialog provides a list of folders, starting with the parent folder, weblogic, and continuing with all the folders the parent contains. At the bottom of the dialog are Select and Cancel buttons. The Select button is grayed out.


This image shows the Tabs tab for a Box layout component in the Component Properties dialog. The dialog has four tabs, Tabs, Child Components, Display Options, and Style. The Tabs tab is forward. The Tabs tab is divided into two columns. In the left column is the label, "Reorder the tabs," which shows a list of all tabs in the current tab set and icons (to the right) for reordering tabs. On the list are the tabs Today's Quiz, Fun Facts, and Duro. The tab, "Duro," is selected. Below the list are an Add Tab button followed by a Delete Tab button. The Delete Tab button is called out. In the right column are fields and checkboxes for configuring the tab. They include Text, Icon Location, Short Description, Stretch Contents, and Hide this tab.


This figure shows the portlet parameters section of the Source tab that displays for every data source type. The section displays five headings: Parameter Name, Default Value, Personalizable, Personalize Page Label, and Personalize Page Description.


This image shows the Spaces component About WebCenter. It is a link with the link text, "About WebCenter." It is flanked by separators and additional Spaces components.


This image shows the Source Editor. At the top, it is labeled, "Edit Source - Standards." At the bottom are two tabs, Page and Page Definition. Page is forward. The Page tab contains the style's source code. This dialog also provides OK and Cancel buttons.


This figure shows the Spaces page with the Show menu exposing the selections: All Spaces, Joined by Me, Moderated by Me.


This image shows the Activity Stream task flow. At the top, a menu is available for selecting the range of time for which to show activities. Next to it, an Options link is available for setting configuration options on the task flow instance. Additionally, a Refresh icon is visible for refreshing the task flow data. Four streamed activities are shown, each with the actor's image and a summary of the activity. Each streamed activity provides a time stamp, such as 8 minutes ago or 19 minutes ago, indicating when the activity took place, and options for adding comments, for liking the activity, and for sharing the activity with other users.


This figure depicts Due Date as selected from the Sort By options in the Display Options dialog box. Create Date, Due Date, Expiration Date, Priority, and Title are the options available.


This figure shows a default wiki document created using the Wiki page style. The New Wiki Document option is highlighted on the wiki page's menu, which is accessed by clicking the arrow next to the wiki page's name in the breadcrumbs.


This figure shows the Add Attribute dialog, displaying the Name and Value fields.


This graphic shows the General page for creating a Quick Poll, showing fields for Name, Description, and Close After.


This graphic shows the Analyze page of the Polls Manager, showing a graph of the results.


This figure shows the Layout tab that displays when the Chart layout style is specified on the View tab. Here you can specify the chart style (pie, bar, or line), the dimensions, the layout, and whether to execute an action when the chart is clicked.


This screenshot shows the Customize Search Service task flow, showing ways to edit saved searches and the ability to remove services, such as People or Personal Events, from searches.


This figure shows the Edit Navigation Item - Pages Query dialog with the fields completed as indicated in the previous steps.


This image shows properties of an HTML Markup component in the Component Properties dialog. The dialog header contains an icon with the label, "Component Properties: New HTML Markup," and Help and Close icons. The dialog presents two tabs, Display Options and Style. The Display Options tab is forward. On it are checkboxes and fields for entering property values. These include, Escape, No Wrap, Short Desc, Value, and Show Component. The Value field is called out. Each property is followed by a menu icon for accessing the Expression Editor. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows the contents of the Navigation with Blogs/Wikis/Lists navigation model.


This figure shows the preview when the Repeat Vertically option for the background image is selected. The selected background image is aligned vertically, and repeated across the vertical bar of the Task Flow/Portlet target area.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name.


This figure shows a portion of the WebCenter Spaces Welcome page, highlighting the Public Spaces link.


This image shows an Activity Stream - Quick View task flow. At the top is a header with a Collapse icon and the heading, "Activity Stream - Quick View." To the right of the heading is a Remove icon. The Remove icon is called out. The mouse pointer hovers over the Remove icon with the hint text, "Remove."


This screen shot shows the Discussion Forums task flow, with one topic and one reply to that topic.


This figure depicts an Announcements task flow, with the RSS icon appearing on the right.


This image shows the facets associated with a panelStretchLayout component. It is a rectangle divided into five labeled areas. The area Top spans the top of the rectangle. The middle area is divided into three unequal columns labeled Start, Center, End. The area Bottom spans the bottom of the rectangle.


This image shows the Set Page Access dialog. It lists the page name, followed by the Add Access and Delete Access options, which are on the same line. Below these are the Add Authenticated Access and Add Public Access options, also on the same line. Below these is a small table with two columns: Role or User and Page Access. Page Access has five subcolumns, each with an icon that depicts a type of access permission: glasses for View Page, a wrench for Edit Page, an ex for Delete Page, a wrench over a cascade of pages for Perform All Page Actions, and a pencil for Personalize Page. The dialog also provides a Help icon at the top and OK and Cancel buttons at the bottom.


This figure shows the Add Resource Catalog Item dialog, with the Task Flows option and the Notes option highlighted.


This screen shot shows the Reply Topic window, with the following reply sent to the message titled QA Issues: "For example: Each QA team should provide at least one issue they have had with Release 1.0."


This image shows the Rich Text Editor associated with the Text layout component. Its header is labeled, "Text," and contains a Done Editing link and Edit and Delete icons. Below the header is a toolbar with controls for selecting and styling fonts, adding font and background colors, formatting bullet and numbered lists, and switching between WYSIWYG and source modes. In the body of the editor is the text, "Enter your text here."


This image shows a task flow being dragged to a new position above another task flow. Below the dragged task flow is shadow, indicating an available drop location.


This image shows the Links layout component inside a Box layout component in page edit mode. The Box component is bounded by a dotted line. At the top is an Add Content button and a tool palette, with icons for adding tabs; splitting the Box top, bottom, left, or right; and editing Box properties. Below these controls is an Add Link menu. Below the menu is the link, "Sales Figures," followed by Configure and Delete icons. The mouse pointer is hovering over the Delete icon with the hint text, "Delete."


This figure shows a blog post open. At the bottom of the blog post, details such as the name of the user who last modified the post, modification date, version number, and file size are displayed. The blog also contains the following: File and View menus, Edit button, and the Related Items and Comments icons.


This figure shows the Edit Navigation Item - Spaces Query dialog with the fields completed as indicated in the previous steps.


This figure depicts the Find User icon.


This screenshot displays the new form you created in a task flow.


This figure highlights the Show items I have worked on before checkbox in the Display Options dialog for the Similar Items task flow.


This figure depicts the Announcements task flow with the RSS icon on the toolbar highlighted.


This figure shows the Add Access dialog. A search field appears at the top of the dialog, and a Search button sits to its right. Below the search field is a table with the columns Name and Type. At the bottom of the dialog are Select and Cancel buttons.


This figure shows the basic structure of a page template, with:

	
a header containing corporate branding and useful links


	
a navigation area


	
a main content area in the middle of the page, which can have its own style and structure


	
a footer containing copyright information, and so on at the bottom of the page





This image shows a page in edit mode Source view. The component "userProfile" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of userProfile," is shown.


This figure shows the sample banking application navigation model displayed as a tree with the start node not displayed.


This figure depicts the Lists task flow in WebCenter Spaces with the RSS icons being called out. The page displays a Lists pane on the left with an RSS icon in the right pane for the selected list.


This image shows the list of Spaces components that are available in the Add Resource Catalog dialog. On the left, a list of object types is shown. These include such objects as Runtime Data Controls, Business Mashups, and Spaces Components. Spaces Components is selected. On the right, a list of Spaces components are shown.


This figure shows a side navigation page template dynamically applied when any user other than a Space moderator logs into WebCenter Spaces.


This figure shows the preview when the Repeat Horizontally option for the background image is selected. The selected background image is aligned horizontally, and repeated across the horizontal bar of the Task Flow/Portlet target area.


This figure shows the contents of the Spaces Default Navigation Model.


This figure shows the Component Properties dialog for the Notes service task flow.


This image shows a Box layout component on a tab labeled, "New Tab." The Box contains a Quick Poll task flow. Above the task flow are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The new tab is called out.


This figure shows the Space administration Members page, highlighting the Membership Notification Messages section.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. A blue dot indicates that Source view is the current selection. Source Position is expanded, showing the options, Top, Left, Right, and Bottom. A check mark indicates that Right is the current selection. The hierarchy of page components is shown on the right side of the page.


This figure shows the Mail service selected and the Distribution List Settings section, with an entry field for Distribution List.


The image shows the Resource Manager with the left pane listing all the resources that you can manage. Resource Catalogs is selected in this pane. Consequently, the right pane displays the three preseeded catalogs. Above the list of resources is a header with links named Create, Upload, and Download, and dropdown menus named Edit and Info. A Filter field with a Go button and a Refresh icon are displayed on the right half of the header.


This image shows a Web Page layout component. It is bounded on the bottom and both sides with a dotted line. Its header includes the label, "Web Page," and Edit and Remove icons. The body of the component includes the text, "This is your web page," and an image of the world.


This figure depicts the Edit Event dialog. It has three sections: a section showing the meeting title, location, and calendar; a Time section showing whether this is an all-day event and the event's start and end times; and an Options section showing the priority, additional details, category (Space Events), and whether the event is private (Personal Events). Additionally, and Links icons display in the top-right corner of the dialog. At the bottom of the dialog, there are three buttons: Delete, Update, and Cancel.


This image shows the Spaces component Create Subspace. It is a link with the link text, "Create a Subspace." To the right of it are separators and the Create Space and Copyright Message components.


This image depicts the Organization subpage of a Profile page. It shows an organization flowchart, with a manager at the top of the pyramid and two direct reports immediately below. Each user is depicted in a box with a profile picture, a Go to Profile link, and additional information, including Email, Work, and Mobile. At the bottom of each box are previous (left) and next (right) icons and an indicator (center) that shows that the first of three views is selected.


This image shows a detail of a page in edit mode Design view. At the top is the status message, "Editing Page: For Testing." Below that are the View menu and Page Properties button. Below these is a Box layout component with an Add Content button and a palette of controls for adding tabs, splitting the Box above, below, left, or right, and an Edit icon for accessing Box properties. The mouse pointer hovers over the Edit icon showing the tooltip, "Edit."


This image shows a Box layout component on a page in edit mode. It is bounded on all sides by a dotted line. Inside the Box an Add Content button is shown to the left. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties.


The image shows a table with employee details. It has three columns, ENAME, EMPNO, and DEPTNO. An empty field is displayed at the top of each column.


This figure shows the Space administration General page Self-Subscription / Change Membership section, showing Do Not Allow Self-Subscription and Change Membership checked.


This image shows a Links layout component inside a Box layout component. The Box is bounded by a dotted line. At the top of the Box are an Add Content button and a tool palette with icons for adding tabs, splitting the Box, and editing Box properties. Below these is an Add Link menu followed by the link Sales Figures. To the right of the Add Link menu is a floating tool palette, with a move handle, an Edit icon, and a Remove icon. This palette is called out. The mouse pointer hovers over the Remove icon, showing the text, "Remove."


This image shows a page in edit mode. Below the page status, "Editing Page: Activities," the View menu is expanded. It shows the options Design, Source, and Source Position. The Source option is called out.


This screenshot shows the Items page in the Create Table dialog.


This image shows an HTML Markup component in page edit mode. The sides and bottom are bounded by a dotted line. The component header contains the label, "HTML Markup," and Edit and Remove icons. Below the header is the text, "New HTML Markup." The mouse pointer is hovering over the Edit icon on the header, showing the tooltip, "Edit."


This figure shows the Edit Source dialog for a page template.


This image shows a Recent Activity task flow bounded on all sides by a red broken line.


This image shows Box layout component display options in the Component Properties dialog. There are two tabs, Display Options and Style. The Display Options tab is forward. It contains menus and fields, including Allow Action, Horizontal Alignment, Layout, Short Desc, Show Split Action, Show Tab Action, Vertical Alignment, and Show Component.


This image shows the Copy Page dialog. It contains a Page Name field with the value, "Copy of pkapasiPage." It lists two Copy as options: Business Role Page and Personal Page. Two buttons appear a the bottom of the dialog: OK and Cancel.


This figure shows the Target tab of the Edit Navigation Item - Folder dialog.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Edit Page is called out.


The Similarly Tagged Items task flow Component Properties dialog, with the Resource ID and Service ID parameters.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with a Create Page link, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Discussions). It shows the options, Send Mail and About This Page. The option Send Mail is called out.


This image shows the Resources page in the Administration Pages. To the left are categorized lists of resources. The following categories are shown: Structure, Look and Layout, and Mashups. Under each category is a list of resources. The resource Page Styles is selected under the Look and Layout category. To the right, all application-level page styles are listed in a three-column table. The first column shows whether the style is hidden or shown (Available), the second column shows the page style display name and description, the third column shown the name of the user who last modified the page style and the date and time the page style was modified.


This figure shows a preview of the AviTrust Banking Navigation Model with the pages and Subspaces of the Banking Subspace listed.


This image shows a detail of a Self-Registration page. To the left is an image of a figure standing before a door. To the right of the figure is the heading, "Self-Registration," followed by these fields: Choose a User Name, which is next to the button, "Check User Name Available"; Choose Password; Re-enter Password; First Name; Last Name; and Email Address. Below the Email Address field is a Register button.


This figure shows the Edit Source dialog for a navigation model.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with a Create Page link, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Home). It shows the options, Edit Page, Reset Layout, Copy Page, Rename Page, Set Page Access, Delete Page, Add to Home Space, Send Mail, and About This Page. The option Rename Page is called out.


This image shows a Recent Activity task flow that does not display borders. That is, its left and right boundaries are not outlined, but its bottom boundary is indicated with a horizontal rule.


This image shows Movable Box layout component display options in the Component Properties dialog. There are three tabs, Display Options, Style, and Content Style. The Display Options tab is forward. It has two subtabs, Basic and Advanced. These are called out. The Basic subtab is forward. It contains menus and fields, including Text, Short Desc, Chrome Style, Font Color, and the like.


This image shows the Spaces component Create Page. It is a link with the link text, "Create Page." To the right of it are separators and additional Spaces components.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. The Design option on the View menu is called out. A blue dot indicates that Design view is the current selection. In the page body, controls for adding content, creating layout boxes, and editing layout box properties are also called out.


This image shows the Activity Stream Options dialog and the Options link one uses to open it. The dialog has three tabs: People, Spaces, and Settings. The Settings tab is forward. It is divided into three sections: People, Spaces, and Service Categories. The People section provides a menu for selecting whose activities you want to see. The Spaces section provides a menu for specifying whether to see activities from Spaces. The Service Categories section provides checkboxes for selecting the services from which to display activities.


This figure shows the Create New Page Template dialog


This figure shows the RSS task flow highlighted in a Resource Catalog.


This image shows the DIT tree in an LDAP browser. To the left, the DIT tree is expanded to show the succession of nodes described in the preceding bullet list. To the right is the detail associated with the selected user (user1). Details include an Attribute Descriptions column and a Values column.


This image shows the Spaces component Join Space. It is a link with the link text, "Join Space." It is flanked by separators and additional Spaces components.


This image shows a page in edit mode. Below the page status, "Editing Page: Task Flow Editor," the View menu is expanded. It shows the options Design, Source, and Source Position. The Source option is called out.


This figure shows the Find a Web clipping page, including the Inputs section.


This figure shows an example list of available forums that displays when you click the Find icon.


This figure shows the Edit dialog of a custom skin. The Preview pane on the right displays a preview of the skin settings selected in the fields on the left.


This figure shows the Layout tab when a Parameter Form layout was selected on the View tab. It includes three standard sections: Style, Fields, Submit Actions.


This image shows the Page Properties dialog for a page in a Space. The header contains an icon labeled, "Page Properties," and Help and Close icons. The dialog has three tabs, Display Options, Security, Parameters. The Security tab is forward. At the top of the Security tab are Access Method options, Use Application Permissions and Use Custom Access Settings. Below Access Method options are the controls Add Access and Delete Access. Delete Access is grayed out. Below these are the controls Add Authenticated Access and Add Public Access. These are followed by a two-column table, with column headings Role or User and Page Access. The Page Access column is subdivided into five columns, each headed with an icon, View Page (glasses), Edit Page (wrench), Delete Page (ex), Perform All Page Actions (cascade of pages topped with wrench), Personalize Page (pencil). The table has three rows of users, each with View Page access. At the bottom of the dialog are OK and Cancel buttons.


This image shows the Resource Catalog. The Resource Catalog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Web Development"), a Search field and button, and a Refresh icon. The dialog lists Web Development resources, such as Data Controls, Box, Change Language, HTML Markup, and the like. The Data Control folder has an associated icon and Open link. Each individual resource, such as Box, has an icon and Add link.


This image shows the Spaces component Manage Pages. It is a link with the link text, "Manage Pages." It is flanked by separators and additional Spaces components.


This figure shows the Set Page Defaults dialog, where you can set the Default Scheme, Style, Scheme Background Color, and select whether or not to Always Use Page Defaults.


This figure shows the User Detail popup with the Get Connected link highlighted.


This image shows the Spaces component Current User Profile. In this example, it is a link with the link text, "Josie Smith." To the right of it are separators and additional Spaces components.


This figure shows the New Wiki Document action highlighted on the Documents page of a Space.


This figure shows the Layout tab that displays after you have selected the Form layout style on the View tab. Here you can specify the form style (vertical or horizontal), and also the column layout.


The figure shows the custom display template selected in the Template drop down menu in the Template tab of the Content Presenter Configuration window. A Site Studio region template is selected.


This image shows a page in edit mode Source view. The mouse pointer is depressing an Add Content button, and the hint text, "Add content into the selected component," is shown. In the hierarchical list of page components, the component showDetailFrame is selected. In the WYSIWYG portion of the page, a layout box (that is, the showDetailFrame component) is outlined in dark blue.


This image shows a Box layout component. At the top are three tabs, all labeled, "New Tab." The first tab in the series is forward. Within the body of the Box are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; editing Box properties; and deleting the Box.


This figure depicts the Login to Mail link that is displayed in the Mail task flow when you add the Mail task flow to the page or use it for the first time. The task flow contains a single link with the text Login to Mail.


This screenshot displays the Register External Application page.


This graphic shows the Tags icon now available on pages.


This image shows a detail of the Resource Catalog. The menu you use to navigate up the resource hierarchy is expanded to show three levels, Personal Documents, Content Management, and Top. The Top option is selected.


This screen shot shows the Hierarchical mode highlighted on the a topic in the Discussion Forums task flow, where the reply is indented from the topic.


This figure shows the sample banking application navigation model displayed as a menu with the Tabs style.


This figure depicts the RSS Manager page of WebCenter Space. The RSS 2.0 and Atom 1.0 icons available for the Announcements service are highlighted.


This figure shows the RSS task flow containing an RSS icon and a Refresh icon on the toolbar.


This image shows a page in edit mode Source view. At the top is the status message, "Editing Page: Three Column." Below that are a View menu and the Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste controls. The mouse pointer is hovering over the Delete button with the tooltip Delete above. In the hierarchical list of page components, the component panelTabbed:above is called out. Below the hierarchical list is a hierarchical trail of breadcrumbs leading from the top component, the page (Three Column), to the selected component, panelTabbed:above.


This image shows the Spaces component Login. It is a link with the link text, "Login." To the left of it are separators, additional Spaces components, and a Search field. To the right of it is the Spaces component Self Registration (Register).


This image shows a collapsed Announcements task flow. The header contains an Expand icon, the heading, "Announcements," and a Remove icon.


This image shows the Select DN dialog. The top of the dialog provides various tools, including those for navigating and searching dialog content. The body of the dialog provides a tree of expandable nodes. Under the root, the relevant nodes expand from the parent dc=wc_domain. From there, in succession, the following nodes are expanded: ou=myrealm, ou=people. The node uid=manager_user is selected.


This figure shows a preview of the HR navigation model with the HR Subspace pages listed: Benefits, Payroll, and New Hire.


This screenshot shows the Columns page in the Create Table dialog.


This image shows the System Pages subpage under Pages in Spaces Administration pages. The label System Pages is highlighted and preceded by links to the Business Role Pages and Personal Pages subpages. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over a Customize link next to the Activities page, and shows the hint text, "Customize the Activities page using the Oracle Composer."


This figure illustrates search results displayed in the Web Clipping portlet.


This image shows a page in edit mode set to Source view. The hierarchical list of components is zoomed-in to a particular task flow, depicted by the label, "region." To the right of region is a Close link for exiting the zoomed-in view.


This image shows the Page Properties dialog. The header contains an icon labeled, "Page Properties," and Help and Close icons. The dialog has three tabs, Display Options, Security, Parameters. The Security tab is forward. At the top of the Security tab are the controls Add Access and Delete Access. Below these are the controls Add Authenticated Access and Add Public Access. These are followed by a two-column table, with column headings Role or User and Page Access. The Page Access column is subdivided into five columns, each headed with an icon, View Page (glasses), Edit Page (wrench), Delete Page (ex), Perform All Page Actions (cascade of pages topped with wrench), Personalize Page (pencil). The table shows one row. The first column has the entry, "weblogic"; the second column shows five checkboxes, with the fourth one, Perform All Page Actions, checked. At the bottom of the dialog are OK and Cancel buttons.


This image shows the Set Page Access dialog. It lists the page name, followed by the Add Access and Delete Access options, which are on the same line. Below these are the Add Authenticated Access and Add Public Access options, also on the same line. Below these is a small table with two columns: Role or User and Page Access. Page Access has five subcolumns, each with an icon that depicts a type of access permission: glasses for View Page, a wrench for Edit Page, an ex for Delete Page, a wrench over a cascade of pages for Perform All Page Actions, and a pencil for Personalize Page. The Delete Access option is called out.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Spaces Query menu option is selected.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Pages Query menu option is selected.


This figure depicts the Mail task flow where the region parameter, Tabular, is set to true. A toolbar at the top of the window contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. The table of mails below the toolbar displays the columns Subject, User Name, and Date.


This image shows a detail of WebCenter Spaces application chrome. At the top are the links Administration, Preferences, Help, and Logout. The mouse pointer hovers over the Help link with the hint text, "Help for WebCenter Spaces." The Help link is called out.


This image depicts a partial view of the WLC Administration Console. The Settings for wc_domain page is shown. On that page, the Security tab is selected, as is its Embedded LDAP subtab. The Embedded LDAP subtab contains a list of LDAP configuration settings that include Credential, Confirm Credential, Backup Hour, Backup Minute, Backup Copies, Cache Enabled, Cache Size, and Cache TTL.


This figure shows the Mode dropdown menu open in the RTE. It shows the following options: WYSIWYG, HTML Source, and Wiki Markup.


This image shows the Parameters tab of the Component Properties dialog. It lists parameters associated with the Activity Stream task flow. Parameters appear in the following order: Advanced Query, Enable Context Info, Hide Comments, Hide Configuration Button, Hide Inline Preview, Hide Like, Hide Share, No of activities to display per page, Pagination, Profile Only, Resource Id, Service Categories, and Spaces. Other tabs include Display Options, Style, Content Style, and Events. At the bottom of the dialog three buttons appear: Apply, OK, and Cancel.


This screen shot shows the Edit Resource Catalog Item dialog for the Search task flow. On the Target tab, the descriptions Search Space has been added to the Description parameter.


This figure shows a resource catalog, with the Blogs task flow highlighted.


This figure provides and overview of the structure of the navigation within the AviTrust Employee Portal.


This image shows the Select Custom Color dialog. It contains smears of graduated colors, running horizontally, bordered on the right by a slider for selecting a range of hues. Below these are fields for entering values for Hex, Red, Green, and Blue. Beside these fields are two stacked boxes, the top one showing the selected color and the bottom showing the current color. At the bottom of the dialog are the buttons OK and Cancel.


This image shows a detail of a page in edit mode Design view. At the top is the status message, "Editing Page: For Testing." Below that are the View menu and Page Properties button. Below these is a Box layout component with an Add Content button and a palette of controls for adding tabs, splitting the Box above, below, left, or right, and an Edit icon for accessing Box properties. The mouse pointer hovers over the Edit icon showing the tooltip, "Edit."


This figure shows the sample banking application navigation model displayed as a menu with the Menu style.


This image shows the Tabs tab for a Box layout component in the Component Properties dialog. The dialog has four tabs, Tabs, Child Components, Display Options, and Style. The Tabs tab is forward. The Tabs tab is divided into two columns. In the left column is the label, "Reorder the tabs," which shows a list of all tabs in the current tab set and icons (to the right) for reordering tabs. On the list is one tab, "New Tab." Below the list are an Add Tab button followed by a grayed out Delete Tab button. In the right column are fields and checkboxes for configuring the tab. They include Text, Icon Location, Short Description, Stretch Contents, and Hide this tab. In the left column, the Add Tab button is called out.


This screenshot shows the Personalize Applications dialog.


This screen shot shows the General page of Space administration settings, with the new Resource Catalog selected for the Resource Catalog for Pages parameter.


This figure shows Actions menu open, with the All Settings option highlighted on the Manage submenu.


The image shows a table with columns ENAME, EMPNO, and DEPTNO. The table displays three records. A field below the table is populated with the value MANAGER. A Go button is displayed to the right of the field.


This figure shows the Create New Skin dialog, with the Fusion FX built-in skin selected in the Copy from list.


This figure shows the application-level Resources page open in WebCenter Spaces Administration.


This image shows a Box layout component on a tab labeled, "New Tab." The Box contains a Quick Poll task flow. Above the task flow are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The Box Edit icon is called out.


This figure shows the Space administration General page Membership Self-Service section.


This figure shows the Create a new note icon highlighted in a Notes task flow.


This figure highlights the Number of people field in the Display Options dialog for the Recommended Connections task flow.


This figure shows the application-level settings specified for various resources. The Expression Builder option for the Default Page Template field is shown as highlighted.


This figure depicts the Mail task flow with the mouse hovering over the Refresh icon.


This image shows the System Pages subpage under Pages in Spaces Administration pages. The label System Pages is highlighted and preceded by links to the Business Role Pages and Personal Pages subpages. Below this is a Help icon. System pages are listed in a table with four columns: Name, Description, Last Modified, and Actions. The Actions column is divided into two subcolumns, one with a Customize link for each page and one with a Restore Default link for each page. The mouse pointer hovers over a Restore Default link next to the Activities page, and shows the hint text, "Remove all Activities page customizations."


This image shows a Box layout component. To the left is an Add Content button. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The Add Content button is called out.


This figure shows the Target tab of the Edit Navigation Item - Content Item dialog.


This task flow shows the new Resource Catalog, with the Search task flow included with the Default Resource Catalog.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Activities." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. The View menu is called out. A blue dot indicates that Design view is the current selection.


This figure shows the Edit Properties dialog of an application-level task flow.


This image shows a detail of a WebCenter Spaces page. At the top is a Search field and icon, a Current User Profile Spaces component for the user, Josie Smith, a Spaces Switcher Spaces component, and a Favorites menu. The mouse pointer hovers over the Current User Profile user's name and shows the tooltip, "Josie Smith." The user name is called out.


This figure highlights the Show items I have viewed before checkbox in the Display Options dialog for the Similar Items task flow.


This figure highlights the Do not show this Space icon next to a Space in the Similar Spaces task flow. The icon looks like a small red cross.


This image shows a Box layout component. To the left is an Add Content button. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The mouse pointer is hovering over the Add Box Below icon.


This image shows a detail of a page in edit mode Source view. At the top is the status message, "Editing Page: For Testing." Below that are the View menu and Page Properties button. Below these is a toolbar with Add Content, Edit, Delete, Cut, and Paste controls. The mouse pointer hovers over the Edit button, and the button is called out. Below the toolbar is the hierarchical list of page components. A Box layout component is selected and called out. Below the list is a breadcrumb list of page components arranged hierarchically, from the page itself down to the currently selected component. In the WYSIWYG portion of the page, the selected Box layout component is outlined in blue.


This image depicts configuration settings for Connections. The Connections tab is divided into two sections. The first section (unlabeled) provides controls for specifying who has access to a user's connections and whether this default can be overridden by individual users. The section, Other Settings, provides a checkbox for allowing or prohibiting the automatic acceptance of invitations to connect.


This figure highlights the Users I am connected with checkbox in the Display Options dialog for the Recommended Connections task flow.


This figure depicts the Upload Document pane. It contains the fields Upload Profiles, Document to Upload (with a Browse button), and Description. The pane header includes Upload and Cancel buttons.


This image shows the Personal Pages subpage under Pages in Spaces Administration pages. The label Personal Pages is highlighted and flanked by links to the Business Role Pages and System Pages subpages. Below this is a toolbar with controls for applying a temporary filter to the list of personal pages, creating a persisted filter, refreshing the list of personal pages, and accessing page help. Personal pages are listed in a table with four columns: Name, Created By, Last Modified, and Actions. The Actions column provides icons for accessing a menu of commands for acting on an individual personal page. A Page Actions menu is expanded, showing the options, Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The Copy Page option is called out.


This figure depicts the Add Attachment window. To the left of the window is the File field with the Browse and Attach buttons adjacent to it. The bottom-right corner of the window contains Send and Close buttons. The lower half of the window contains the Attachments area. This area is empty as no files are attached as yet.


This screenshot shows items under the Portlet Administration folder in the Add Content dialog.


This figure depicts the service nodes in a Recent Activities task flow. A toolbar at the top of the window contains a menu that you can use to select a time range for displayed activities, an RSS icon, and a Refresh icon. Below the toolbar is a list of service nodes with an Expand icon to the left of each node.


This figure shows an example of a portlet using the News layout.


This figure shows the target web page divided into sections. Each section contains a Choose icon in the upper-left corner.


This image shows the Spaces component Edit Page. It is a link with the link text, "Edit Page." To the right of it are separators and additional Spaces components.


This figure depicts the Worklist task flow with the Display Options, Messaging Preferences, and Refresh icons.


This image shows three tabs, Today's Quiz, Fun Facts, and Duro. The first tab, "Today's Quiz," is forward. To the left of its label is an icon of a light bulb with a question mark inside of it. On the Today's Quiz tab is a Quick Poll task flow. The Today's Quiz tab (with its icon) is called out.


This image shows a page in edit mode. The mouse pointer is depressing an Add Content button, and the resulting Add Content dialog is open. The Add Content dialog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Top"), a Search field and button, and a Refresh icon. The dialog lists various resource folders, such as Alerts and Updates, Analytics, Content Management, and so on. Each folder has an associated icon and Open link.


This figure shows the Space administration Pages page, showing a list of pages within the Space. A toolbar at the top of the window contains buttons for creating new pages, setting page defaults, a Filter field, a Filter icon, and a Refresh icon. The table of pages below the toolbar displays the columns Name, Reorder, Show Page, Created By, Last Modified, and Actions.


This figure shows the Rename Space URL dialog box, displaying a field to enter a new URL for the Space.


This image shows an Announcements task flow. The header contains a Collapse icon and the heading, "Announcements." To the right of Announcements is a Remove icon. At the bottom right edge of the task flow is a Resize handle. The handle is called out.


This image shows the Business Role Pages subpage under Pages in Spaces Administration pages. The label Business Role Pages is highlighted and followed by links to the Personal Pages and System Pages subpages. Below the subpage name is a toolbar with links for creating new business role pages (BRPs) and setting page creation defaults. The Set Page Defaults link is called out.


This figure shows a blog containing blog posts. The name of the blog is listed on the top navigation bar. The Archive pane displays that the blog contains two blog posts for the month of December. The Blog page contains the New Post link and the View all link.


This screen shot shows the Discussions - Quick View task flow with Watched Forums selected.


The image shows the Edit dialog with Add, Edit, Copy, Delete, Indent, Outdent, Up, and Down icons at the top of the dialog. The dialog lists the components in the catalog. In this image, the Portlets resource is selected. It is nested inside the Portlets folder and has an Administration resource above it, at the same level. As there is no resource below the Portlets resource, the Down option is grayed out. All other options are active.


The image shows the Options Tab on the Edit Resource Catalog Item Dialog. The dialog contains two other tabs, Target and Parameters. The Options tab displays the fields Small Icon URI, Subject and Keywords, WEBCENTER_SERVICE_ID, attr.text, attr.contentStyle, New Attribute Name, and New Attribute Value. An Add button is available next to the New Attribute Value field.


This figure shows the Security Settings dialog of a resource, with the Use Custom Permissions checkbox selected and the user named weblogic granted the Manage permission.


This image calls out the Show Hierarchy icon to the left of a zoomed-in task flow (labeled "region").


This image shows the Set Page Defaults dialog. The dialog provides a Page Style selection menu and radio buttons for specifying whether to enable one-click page creation. It also provides Save and Cancel buttons.


This image shows the Resource Catalog. The Resource Catalog has a header with an icon and the label, "Add Content." The header also includes Help and Close icons. Below the header is a toolbar with a menu with options for navigating up the resource hierarchy, a status label that indicates your location within the hierarchy (in this example, "Top"), a Search field and button, and a Refresh icon. The dialog lists various resource folders, such as Alerts and Updates, Analytics, Content Management, and so on. Each folder has an associated icon and Open link.


This figure shows the properties of a folder. The resource ID of the folder is highlighted.


This figure shows notes listed in a Notes task flow.


This image shows the New Content Link dialog. Its header contains an icon with the label, "New Content Link," and a Close icon. Below the header is the text, "Enter the name and path of the content link." Below this text are two fields, Name and Path. To the right of the Path field is a Browse button. At the bottom of the dialog are OK and Cancel buttons.


This figure depicts the Contributor box on the Search Results page. It contains a bullet list of contributors. Each contributor includes a number in parenthesis. The number indicates how many results are associated with a particular contributor.


This figure shows the sample banking application navigation model displayed as a tree with the start path set to the first level (Personal Banking) of the path to the currently selected page (Current Account).


This figure shows the Source tab that displays when you select Web Service on the Type tab. On this page, you can enter the URL for the WSDL, choose the method you want to use, and the URLs to the XSL filter and XML schema.


This image shows the Spaces component Print Preview. It is a link with the link text, "Print Preview." To the right of it are separators and additional Spaces components.


This figure depicts the Create Event dialog. It displays three sections: a section for entering the meeting title, location, and calendar; a Time section for entering start and end times or indicating this is an all-day event; and an Options section for assigning a priority, entering additional details, selecting a category (Space Events), and indicated whether the event is private (Personal Events).


This figure shows a sample navigation model based on a banking application. The top level nodes of the navigation model are Personal Banking, Private Banking, Business Banking, and Commercial Banking. Under the Personal Banking node there are four nodes: Current Account, Savings, Investments, and Loans. Under the Current Account node there are two nodes: Our Accounts and New Customers. Under the Our Accounts node there are another two nodes: Regular Current Accounts and Accounts with Extras.


The image shows a table with four columns, ENAME, EMPNO, DEPTNO, and MGR.


This image shows an expanded Page and Spaces Actions menu. The menu shows the options, Edit Page, Create, Manage, Personalize Pages, Contact, Membership, and About. Personalize Pages is called out. An icon indicates that the following options have submenus, Create, Manage, Contact, Membership, and About.


This figure shows the sample banking application navigation model displayed with vertical breadcrumbs.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. In the Name column, the page, "Documents," is called out. The mouse pointer hovers over the Documents page with the hint text, "Click to open the page."


This image shows the Spaces component Contact Administration. It is a link with the link text, "Administrator." To the left and right are separators and additional Spaces components.


This image shows the About Space dialog. It has a header with the label, "About Space," and a Close icon. It contains information labeled Name, Display Name, Internal ID, Description, Memberhship, Created By, Date Created, Explorer URL, and Direct URL.


This figure depicts the Parameters tab in the Component Properties dialog that is displayed when you edit or view the properties of a Recent Activities task flow. This tab contains the Shortest Time Period, Long Time Period in minutes, Longest Time Period in minutes, Medium Time Period, and Group Space fields in which you can enter or update parameter values. Edit icons available next to each field can be used to invoke the Edit dialog if you wish to select a listed value or construct your own value or EL expression.


This figure shows the Target tab of the Edit Navigation Item - Pages Query dialog.


This figure shows the Edit Properties dialog of a custom skin. The dialog shows various properties in the following three sections: General, Exclude Resource Usage, and Attributes.


This graphic shows the Recent Activities option selected in the Add Content dialog.


This screen shot shows a discussion forum opened from the Discussions - Quick View task flow.


This figure highlights the Number of Spaces field in the Display Options dialog for the Similar Spaces task flow.


This image shows the Template Development folder in a Resource Catalog. Along the top are controls for navigating within the Catalog and for searching and refreshing Catalog items. The body of the image shows the folders that contain Catalog items. The folders include such classifications as Alerts and Updates, Analytics, Content Management, and the like. The Template Development folder is highlighted. To the right of each folder is an Open link, which you can use to access folder content.


This graphic shows the Polls Manager Task Flow Component Properties, with the Parameters page selected.


This figure depicts the Mail task flow. A toolbar at the top of the panel contains a menu that you can use to select a cut-off point for displayed messages, a Compose icon, and a Refresh icon. Below the toolbar is the list of mails. Each mail in the list is described using the subject, the user name and status icon, and the date.


This figure shows the Spaces link highlighted on the WebCenter Spaces banner, and on the top navigation bar of Home Space.


This figure shows the Space administration General page, highlighting Enable RSS Publishing checked.


This image shows the Resource Catalog. At the top is an icon and the label, "Add Content," along with Help and Close icons. On the next line are controls for navigating up the resource hierarchy, a label that indicates the current location within that hieararchy (Content Management), a Search field and button, and a Refresh icon. In the body of the dialog, three rows are highlighted, All Content, Personal Documents, and Content Presenter. All Content has an associated Open link. Personal Documents has both Open and Add links. Content Presenter has an Add link.


This figure shows the sample banking application navigation model displayed as a tree with the start path set to the currently selected page (Current Account).


This graphic shows the Schedule page of the Polls Manager, with publish and close options.


This figure shows a Notes task flow containing various personal notes.


This figure depicts a Compose window with the Remove Attachment icon highlighted next to an attached file. It includes a To field with a Find User icon. Below the subject, a file is listed as an attachment. The Remove Attachment icon is displayed adjacent to it. A text area is in the lower half of the window.


This figure depicts the RSS Manager displaying nodes for all Spaces that have enabled RSS feeds. A Space node is expanded to display a list of all services that have RSS feeds enabled. To the right of the service names are two columns displaying corresponding RSS 2.0 and Atom 1.0 news feed icons.


This figure shows the Layout tab that displays when the Tabular layout style is selected on the View tab. Here you can specify the column labels, column data, content alignment, display mode, and an associated URL.


This figure shows the Expression Editor dialog with the path to the HR navigation model.


This figure shows the About dialog of a Space-level skin, displaying various properties in the General and Attributes sections.


This image shows a page in edit mode Design view. At the top is the status message, "Editing Page: Sales." Below the status message is the View menu, which is expanded to show the options, Design, Source, and Source Position. A blue dot indicates that Design view is the current selection. Next to the View menu is an Edit Properties button.


This figure shows an example of how a pie chart portlet may look at runtime. There are four pie wedges representing the number of employees in each department.


This image shows the Display Settings section on the General page of the Space Settings pages. This page is divided into two columns. The left column provides controls for locating and selecting a Space icon and a Space logo. Both fields show previews of the current selections. The right column provides controls for selecting a page template, a skin, Resource Catalogs for pages and page templates, and a navigation model for the Space. A checkbox is available for specifying whether to show a page footer. There are fields for entering a copyright message and specifying a URL to the Space privacy statement. Finally, there are controls for selecting a default language for the Space and customizing the list of available languages.


This figure shows the Similar Items task flow.


This figure depicts the mail message window. A toolbar at the top of the window contains Reply, Reply All, Forward, Compose, and Delete buttons. Below this are prepopulated rows labelled Subject, From, and Date. A text area in the lower half of the window contains the actual mail message.


This screenshot shows the OWSM Security page of the Create new Data Control dialog.


This image shows an expanded Spaces Switcher Spaces component. The switcher is divided into two columns, Recent Spaces and My Spaces. The Recent Spaces column is bisected, with the lower portion showing the links Home Space, Browse Spaces, and Create a Space. The Browse Spaces link is called out.


This screenshot shows a Spaces application navigation model


This image shows a detail of a page in edit mode Design view. At the top is the status message, "Editing Page: For Testing." Below the status message are the View menu and the Page Properties button. The View menu is expanded to show the options Design, Source, and Source Position. The mouse pointer is hovering over the Source option.


This figure shows a Blogs task flow added to a page, and the Edit icon highlighted. The blog does not contain any blog posts, and is not yet associated with any folder.


This image shows a Box layout component that contains a Quick Poll task flow. Above the task flow are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The mouse pointer is hovering over the Add a Tab Set or a Tab icon.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Statistics). It shows the options, Edit Page, Reset Layout, Copy Page, Rename Page, Set Page Access, Delete Page, Add to Home Space, Send Mail, and About This Page. The option Add to Home Space is called out.


This image shows a page in edit mode Design view. At the top is a status message, "Editing Page: Activities." Below the status message are the View menu, Page Properties button, and Help, Save, and Close icons. The Page Properties button is called out.


This screen shot shows the Discussions - Quick View task flow at runtime, with four topics: Sales Issues, Development Issues, QA Issues, and Support Issues.


This image shows the Add Access dialog. It contains a Search field and button, a table with two columns: Name and Type, and Select and Cancel buttons.


This figure depicts the Last Modified Date box on the Search Results page or window. It contains a list of links to assorted time ranges. These include Today, Since Yesterday, Since 7 Days Ago, and so on. Each time range includes a number in parenthesis. The number indicates how many results fall within the specified range.


This figure shows the sample banking application navigation model displayed with horizontal breadcrumbs.


This figure shows the permissions available for Resources in the Standard Permission Model. The Create, Edit, and Delete Resources permission is shown as selected.


This image shows the Spaces component Administration. It is a link with the link text, "Administration." It is flanked by separators and additional Spaces components.


This figure shows the Parameters tab open in the Component Properties dialog of a Blogs page style-based page.


The image shows the Add Resource Catalog Item dialog. This dialog has two panes. The left pane lists the various folders containing resources, for example, Business Mashups, All Documents, Spaces Components, Components, and Saved Searches. The Components folder is selected in this list to display its contents on the right pane. The dialog displays a Search field at the top right corner, a Name field at the bottom left corner, and Add and Cancel buttons at the bottom right corner.


This figure shows the View tab of the OmniPortlet wizard, where you can specify sorting options. On this page, you can choose the header, footer, and layout style for your portlet.


This image shows a Box layout component. To the left is an Add Content button. To the right is a toolbar containing icons for adding tabs; splitting the Box above, below, left, or right; and editing Box properties. The icons for splitting the Box are called out.


This image shows a Resource Catalog (labeled Add Content). Below the label is a toolbar with a navigation icon, a location label (Alerts and Updates), a Search field and icon, and a Refresh icon. Below these is a list of components, which includes Announcements. Next to the Announcements component is an Add link. The mouse pointer hovers over the Add link and shows the tooltip, "Add Announcements."


This graphic shows a sample Quick Poll, asking, "What percent complete is your project?"


This image calls out the Show Hierarchy icon to the left of a zoomed-in task flow (labeled "region").


This figure shows the Discussions page containing a list of all discussion topics. The RSS icon is highlighted.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. The Reorder column is called out.


This screen shot shows the Search task flow added to the New Page created in the space. The task flow shows the icon and description added.


This figure shows the Source tab that displays when you select the Spreadsheet (or CSV) on the Type tab. On this page, you can enter the URL to the CSV file.


This figure shows a wiki document created using the New Wiki Document action.


This figure shows the Space Browser task flow.


This screen shot shows the Copy - Default Space Catalog dialog, with parameters for Display Name and Description.


This figure shows the Recommended Connections task flow.


This figure shows the permissions that can be granted on a resource. The Create, Edit, and Delete permissions for Mashup Styles, Navigation, and Page Style resources are shown as highlighted.


The image shows the Target Tab on the Edit Resource Catalog Item Dialog. The dialog contains two other tabs, Options and Parameters. The Target tab displays the Name, Description, Visible, and Path attributes.


This figure depicts the RSS link at the bottom of a WebCenter Space application page.


This screen shot shows how topics display in the Discussions - Popular Topics task flow. This is a separate window with the topic and replies to that topic. There are no breadcrumbs. It has buttons to Maximize or Close the window.


This figure shows the Connection Information page that displays when you select the SQL on the Type tab. The Driver Name dropdown list displays the sample DataDirect Driver Oracle-thin.


This image shows a page in edit mode Source view. The component "calendar" is selected in the hierarchy of page components. Above that, in the page toolbar, the mouse pointer is depressing the Edit button, and the hint text, "Show the properties of calendar," is shown.


This screenshot displays the new graph you created in a task flow.


This figure shows a part of the Edit Permissions dialog for documents in a Space. These include: Administration Capabilities, Delete Documents, Create and Edit Documents, and View Documents.


This figure shows the Invitation Message dialog. The dialog contains a field for entering an invitation message. This field is populated by default with the text "I would like to add you as my connection." The dialog also contains a dropdown list for selecting the connection list to which to add the new connection.


This figure depicts the Remove links next to the refinement criteria in the Last Modified Date and Contributor boxes on the Search Results page.


This figure depicts the pop-up calendar displayed on clicking the Select Date icon next to the Expire on a Specific Date field. The current date is marked by a solid box. But only those dates after the publication date are enabled for selection.


This figure shows the sample banking application navigation model displayed as a menu with the List style.


This figure depicts the RSS task flow, with the mouse hovering over the Refresh icon at the top-right corner of the task flow. The Get the latest RSS data tooltip is displayed.


This image shows the Page Properties dialog for a page in a Space. The header contains an icon labeled, "Page Properties," and Help and Close icons. The dialog has three tabs, Display Options, Security, Parameters. The Security tab is forward. At the top of the Security tab are Access Method options, Use Application Permissions and Use Custom Access Settings. The Access Method options are called out. All of the controls below Access Method options are grayed out. Below Access Method options are the controls Add Access and Delete Access. Below these are the controls Add Authenticated Access and Add Public Access. These are followed by a two-column table, with column headings Role or User and Page Access. The Page Access column is subdivided into five columns, each headed with an icon, View Page (glasses), Edit Page (wrench), Delete Page (ex), Perform All Page Actions (cascade of pages topped with wrench), Personalize Page (pencil). The table shows the text, No access defined." At the bottom of the dialog are OK and Cancel buttons.


This page shows the Page Information dialog. It has a header labeled, "Page Information," and a Close icon. It provides information labeled Name, Description, Created By, Date Created, Last Modified, and Direct URL.


This image shows the Select a Page dialog. The header contains an icon with the label, "Select a page," and a Close icon. Below the header, to the right is a Search field and icon. within the body of the dialog is a list, headed, "Home Space Pages," with entries for all available pages in the Home Space. At the bottom of the dialog are Select and Cancel buttons. The Select button is grayed out.


This figure shows the sample banking application navigation model displayed as a menu with the Choice style.


This figure shows the Expand icon in the RSS Manager.


This screenshot shows the Create New Task Flow dialog.


This image shows the Component Properties dialog for an Announcements task flow. It shows five tabs, Parameters, Display Options, Style, Content Style, and Events. The Display Options tab is forward. It contains checkboxes, selection lists, and fields for entering parameter values. At the top are two subtabs, Basic and Advanced. The Basic tab is forward. On this tab, the following Display Options are shown:

	
Text


	
Short Desc


	
Chrome Style


	
Font Color


	
Font


	
Font Size


	
Font Style


	
Display Header


	
Allow Remove


	
Allow Resize


	
Show Component




To the right of all but the Font properties, there is a menu icon. The Show Component property and its associated menu icon are called out. The mouse pointer is hovering over the icon, and the tooltip, "Edit," is shown. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows the Delete note icon highlighted in a Notes task flow.


This figure shows the Source tab that displays when you select Web Page on the Type tab. From this page, you can launch Web Clipping Studio to clip data from an existing Web page.


This figure shows a comparison of two versions of a wiki document. Changes from the latest version are highlighted in green, and those from an older version are highlighted in Blue.


This image shows the Spaces component Mail Space Members. It is an icon and a link with the link text, "Send Mail to Members." To the right of it are separators and additional Spaces components.


This figure shows the Space administration General page, highlighting Take Group Space Temporarily Offline cleared.


This figure shows a section of the navigation model Edit dialog with the Add popup menu expanded. The Navigation Reference menu option is selected.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Set Page Access is called out.


This figure shows the Create dialog for a page template.


This figure shows the Notes option and the Add link next to it highlighted in the Add Content dialog.


This image shows the Add Access dialog. It contains a Search field and button, a table with two columns: Name and Type, and Select and Cancel buttons.


This figure shows the Filter notes icon highlighted.


This figure depicts the pop-up calendar displayed on clicking the Select Date icon in the Create Announcement dialog. The current date is marked by a solid box.


This image shows the Page Properties dialog. The dialog is divided into three tabs, Display Options, Security, and Parameters. The Parameters tab is forward. It has five input fields, leftWidth, centerWidth, rightWidth, showHeader, showFooter. Each field has a menu icon to its right, which you can use to open the Expression editor. Below the last field is the link, "Add a page parameter."


This image depicts configuration settings for Message Board. The Message Board tab is divided into three sections. The first section (unlabeled) provides controls for specifying who can view and post messages on a user's Message Board. The section section, Additional Access Settings, provides controls for specifying who can edit or delete the messages they leave and who can delete or change the visibility of the messages they receive. The third section, Comments and Likes, provides checkboxes for allowing or prohibiting users from liking and commenting on individual messages.


This figure shows the RSS 2.0 and Atom 1.0 news feed icons displayed against the Lists service for all lists.


This figure shows the Administration link highlighted on WebCenter Spaces banner.


This figure shows the Target tab of the Edit Navigation Item - Spaces Query dialog.


This image shows the Project Issues list in page edit mode Design view. At the top is a Collapse icon, the label, "Project Issues," an Edit icon, a menu icon, and controls for configuring the list's properties and for deleting this list instance. The mouse pointer hovers over the Edit icon showing the tooltip, "Edit."


This image shows the Spaces component Global Help. It is a link with the link text, "Help." It is flanked by separators and additional Spaces components.


This figure shows the Link to New menu open in the Links dialog of a discussion topic. The Note option is highlighted.


This image shows the Activity Stream - Quick View task flow. A pencil icon is visible (Change the source, filter, and display options), for configuring the task flow instance. Next to it, a Refresh icon is available for refreshing streamed data. Four items are streamed. Each streamed item shows an icon related to the type of streamed activity (such as a page, a photo, and a person); a summary of the activity, including where applicable a link to the object that was acted on; and a time stamp, such as 8 minutes ago, 19 minutes ago, indicating when the activity took place.


This figure shows the Edit dialog of a Resource Catalog open. The Add From Library option is highlighted on the Add menu.


This screenshot shows a page with the Application Navigator task flow added to it.


This image depicts the application-level configuration options associated with Activity Stream. The Activity Stream tab is divided into the following sections: People, Spaces, Service Categories, Privacy, and Comments and Likes. Under each section are options for specifying whose activities to stream (People), whether to stream activities from Spaces or just the Home Space (Spaces), the services from which to stream activities (Service Categories), the users who are allowed to view the current user's activities and whether it is allowed to override this setting (Privacy), and whether comments and likes are allowed on streamed activities (Comments and Likes).


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Copy Page is called out.


This figure shows the About dialog of a custom skin, with the various details about the skin listed in the General, Exclude Resource Usage, and Attributes sections.


This image shows a page template in edit mode. At the top is the status message, "Editing Page Template: WebCenter Spaces Side Navigation for testing." Below the status message, the View menu is expanded, showing the options Design, Source, and Source Position. The Source option is called out.


This image shows a page in edit mode Design view after a page header or footer is added. The page is based on the page style Three Column. Accordingly, it has three layout boxes laid out horizontally. Each layout box has its own Add Content button and icons for adding tabs and more layout boxes as well as an icon for customizing the layout box through its properties. Additionally, there is a layout box at the top for the page header and a layout box at the bottom for the page footer. These provide the same controls as the layout boxes in the body of the page.


This image shows the Spaces component Self Registration. It is a link with the link text, "Register." To the left of it are separators and additional Spaces components and a Search field and icon.


This image shows the Spaces component Create Space. It is a link with the link text, "Create a Space." It is flanked by separators and additional Spaces components.


This graphic shows the Design page of the Polls Manager, with options to Add, Save, or Close.


This figure shows the details of a note that you can update.


This figure shows the Create Role dialog box, displaying the Role Name and Template Role fields.


The image shows a table with two columns, METRIC and VALUE. The METRIC column displays the page category and the VALUE column displays the page count for each category.


This image shows the Spaces component Parent Space. It is a link with the link text, "Navigate to Parent Space." To the right of it are separators and additional Spaces components.


This figure shows the Custom HTML field of the Parameter Form Layout tab, where you can create a customized parameter form or edit an existing parameter form.


This screen shot shows an open discussion topic with the Send Mail icon highlighted.


This figure shows the Space administration General page, highlighting Close the Group Space checked.


This image shows the Business Role Pages subpage under Pages in Spaces Administration pages. The label Business Role Pages is highlighted and followed by links to the Personal Pages and System Pages subpages. Below the subpage name is a toolbar with links for creating new business role pages (BRPs) and setting page creation defaults. Next to these are controls for applying a temporary filter to the list of BRPs, creating a persisted filter, refreshing the list of BRPs and accessing page help. BRPs are listed in a table with five columns: Name, Reorder, Created By, Last Modified, and Actions. The Reorder column provides icons for rearranging the order of BRPs. The Actions column provides icons for accessing a menu of commands for acting on an individual BRP.


This figure shows a page created using the Wiki page style. The page name is highlighted on the top navigation area of the Space. The page contains a default wiki document, containing some default text related to wikis.


This figure depicts the highlighted Refresh Worklist icon in the Worklist task flow. The task flow also provides the Display Options and Messaging preferences icons.


This screen shot shows the Mail compose page, with the checkbox selected to send to all Space member. It has an empty To field, an Options dropdown list, and the Subject field is prepopulated with the discussion topic title. The mail text includes the discussion topic information.


This image shows a section of the Business Role Pages subpage. The Page Actions menu is expanded to show its various options. These include Edit Page, Copy Page, Rename Page, Set Page Access, Delete Page, Make Public, Send Mail, and About This Page. The option Make Public is called out.


This image shows the Text layout component. Its sides and bottom are bounded by a dotted line. Its header contains the label, "Text," an Edit Text link, and Edit and Delete icons. Below the header is the text, "Enter your text here."


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component, region, is called out along with the Edit Task Flow link to its right.


This figure shows the Edit Navigation Item - Link dialog with the fields completed as indicated in the previous steps.


This figure shows an example of an OmniPortlet that uses the HTML layout.


This graphic shows the Recent Activities task flow added in the custom Resource Catalog.


This figure shows the blog posts available under a blog in the document hierarchy on the Documents page. The blog post named Business Casual can be opened by clicking its title highlighted in the figure.


This image depicts the Events task flow before logging in to personal calendar with calendar overlay enabled.


This figure shows the Parameters tab of the Component Properties dialog for the Navigation Tree task flow.


This image shows the Component Properties dialog for a Box layout component. The header contains an icon labeled, "Component Properties: Box," and Help and Close icons. The dialog shows two tabs, Display Options and Style. The Display Options tab is forward. On it are fields, checkboxes, and selection lists for providing values for Display Option properties. Next to each property is a menu icon. The menu next to the property Show Component is expanded to show the option Expression Builder. The mouse pointer hovers over this option, and the Show Component property and the Expression Builder option are called out. At the bottom of the dialog are Apply, OK, and Cancel buttons.


This figure shows the default Request Membership page.


This image shows a task flow being dragged to a new position above another task flow. Below the dragged task flow is shadow, indicating an available drop location.


This image shows the Advanced Search dialog. The header contains an icon labeled, "Advanced Search," and a Close icon. Below the header is an Add Fields menu, which is expanded to show the options Dates, Users, and Filters. Below the menu are fields and selection lists labeled File Name, Keywords, Content Type, and Limit Results. At the bottom of the dialog are Search and Cancel buttons.


This figure shows a part of the Edit Permissions dialog for a role in an Advanced Permission model.


This image shows a detail of the Personalize Pages page. It is headed, "Personalize Pages." Below the heading is a toolbar with Create Page and Set Page Defaults links, a Filter field and icon, a Show or hide the filter panel icon, a Refresh icon, and a Help icon. Below the toolbar is a table with the columns, Name, Reorder, Show Page, Category, Created By, Last Modified, and Actions. Several pages are listed under Name. The Actions menu is expanded next to a selected page (Tag Center). It shows the options, Send Mail and About This Page. The option About This Page is called out.


This figure depicts the Compose window with the Attach Files link highlighted. Below is a field labelled To with a Find User icon. A text area to contain the actual message is available in the lower half of the window. Send and Close buttons are at the bottom-right corner of the window.


This figure depicts a Worklist task flow with items grouped according to the creation date. Each group has a number in parenthesis to its right. One group node is expanded to list all items in that group.


This graphic shows the Question page, with fields for "Select Type of Question," "Question," "Row Answer Choice" and options to Add a Comment Field and Require Answer to Question.


This figure depicts the External Application Login dialog. The dialog contains the User Name, Password, Email Address, Your Name, and Reply-To Address fields. Below these fields is the Remember my login information checkbox. OK and Cancel buttons are located at the bottom of the dialog.


This image shows the Resources section on the General subpage of the Administration page. It is divided into two columns of labels and pick lists. The left column provides controls for selecting the application default page template, Resource Catalog for Spaces, Resource Catalog for the Home Space, and Resource Catalog for business role pages. The right column provides controls for selecting Resource Catalog for pages in Spaces, Resource Catalog for pages in the Home Space, and Navigation for the Home Space.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component, region, is called out along with the Edit Task Flow link to its right.


This figure shows a Blogs task flow. The name of the folder with which the blog is associated is displayed as the blog title.


This figure shows the Actions>Delete Member menu item on the Members page.


This image shows the Spaces component Subscription Preferences. It is a link with the link text, "Subscribe." It is flanked by separators and additional Spaces components.


This screenshot shows the Create new Data Control dialog box for creating a SQL data control.


This image shows a Box layout component. At the top are three tabs, all labeled, "New Tab." The first tab in the series is forward. Within the body of the Box are an Add Content button and a toolbar that contains icons for adding tabs; splitting the Box above, below, left, or right; editing Box properties; and deleting the Box. The mouse pointer is hovering over the Add a Tab Set or a Tab icon.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component, region, is called out along with the Edit Task Flow link to its right.


This figure shows the default wiki document that is automatically created when a page is created using the Wiki page style. The name of the wiki document and the folder under which it is created are the same. The figure highlights the wiki document name and the folder name.


This image shows the Spaces component Search. It is a task flow with a Collapse/Expand icon and the text, "Search," in the header and a Search field and icon in the body.


This figure shows a portion of the Roles page for a Space, showing Edit Permissions and the Public-User role selected.


This figure depicts the Events page in list mode. Events page controls display above the list. The list is divided into columns, showing event day, event date, event start time, event name (linked to event details), and, if Calendar Overlay is selected, the calendar to which the event belongs.


This image shows a page in edit mode Source view. The mouse pointer is hovering over a page component, the input field in a Publisher task flow. The input field is outlined in blue. The mouse pointer is rendered as a magnifying glass.


This image shows the Layout Style section of the View page in the OmniPortlet Wizard. Down the left side are the radio buttons Tabular, Chart, News, Bullet, Form, HTML, and Parameter Form. The News radio button is selected. To the right is a depiction of the selected layout with sample data.


This image shows the Expression Builder editor. The option "Choose a value" is selected. Under that are two menus, side-by-side. "Page Info" is selected from the first menu, and "Title" is selected from the second. In the text box below "Type a value or expression," the EL expression #{pageDocBean.title} appears.


This image shows an Announcements task flow. The header contains a Collapse icon and the heading, "Announcements." The Collapse icon is called out.


This figure depicts the Worklist service task flow with a list of Worklist items. The mouse is hovering over the Details link which enables you to see the entire item.


This figure shows the icons that are located on the top right of the Web Clipping Studio banner. These are:

	
Cancel


	
Section


	
Select


	
Help




The cursor is positioned on the Section icon.


This image shows a page in edit mode set to Source view. In the hierarchical list of page components, the component, region, is called out along with the Edit Task Flow link to its right.


This image shows the Activity Stream - Quick View Configure dialog and the pencil icon one uses to open it. The dialog is divided into three sections: People, Spaces, and Service Categories. The People section provides a menu for selecting whose activities you want to see. The Spaces section provides a menu for specifying whether to see activities from Spaces. The Service Categories section provides checkboxes for selecting the services from which to display activities.


This figure shows the web page divided into sections. At the top left of each section, there is an icon labeled Choose.


This image shows the Spaces component Change Membership. It is a link with the link text, "Change Membership." To the right are separators and additional Spaces components.


This figure shows the Edit Source dialog for a skin, listing the various skin selectors.


This figure shows the dropdown menu of a Wiki page, and the name of the page highlighted.


This figure shows the Type tab of the OmniPortlet wizard. The Type tab lists the five data sources you can use with OmniPortlet: Spreadsheet (CSV), SQL, XML, Web Service, and Web Page.


This figure shows the Expression Builder dialog, with the Type a value or expression radio button selected.


This figure shows the Filter tab of the OmniPortlet wizard, where you can specify sorting options. On this page, you can sort the data you retrieved on the Source tab.


This image shows the Edit Page Link dialog. The header is labeled, "Edit Page Link," and includes a Close icon. Below the header is the text, "Enter the name and path of the page." Below this text are two fields, Name and Path. To the right of the Path field is a Browse button. At the bottom of the dialog are OK and Cancel buttons.


This figure shows the Target tab of the Edit Navigation Item - Content Query dialog.


This image shows a System page in edit mode. A task flow, labeled, "region," is selected, and the mouse pointer is depressing the Reset Task Flow button in the toolbar.


This screen shot shows a new topic in the Discussions Forum task flow titled Suggestions for New Features. The message in the topic says, "What should we focus on for Release 2.0?"


This image shows the Spaces component Mail Space Moderators. It is an icon and a link with the link text, "Send Mail to Moderators." To the right of it are separators and additional Spaces components.


This figure shows the Wiki page style highlighted in the Create dialog.


The Mail task flow Component Properties dialog, showing the Tabular parameter.


This figure shows the Parameters tab open in the Component Properties dialog of a Blogs task flow. The tab contains the following properties, which are unique to a blog: Hide Comments, Number of Rows Displayed, Resource Id.


This screenshot shows the External Application task flow in a page.


This figure shows page templates listed on the Resources page. The status of the page templates is highlighted, whether a page template is available or hidden.


This figure shows the Set Page Access dialog for a blog page, with authenticated-role granted the View Page permission.


This figure shows the page http://www.oracle.com/appserver/index.html displayed in Web Clipping Studio.


This figure provides an overview of the structure of the AviTrust Employee Portal.


This graphic shows a sample poll from the Take Polls task flow.


This figure shows the Exclude Resource Usage section of the Edit Properties dialog, with the Add/Choose link under Selected Spaces highlighted.


This figure depicts the RSS task flow in Edit mode, with the Remove icon highlighted. The tooltip on the icon reads Remove.


This screen shot shows the Add Resource Catalog Item dialog, with the Search task flow selected from the Task Flows category.


This figure shows the Add Space dialog, with the various Spaces available in WebCenter Spaces listed.


This screen shot shows "vicki" in the search area, with 2 results returned: vicki and vicki_coi. The user vicki coi is selected, so her title, business and email information is included in the page.


This figure depicts the Announcements page, with the RSS icon highlighted.


This figure highlights the Do not show this person icon next to a user in the Recommended Connections task flow. The icon looks like a small red cross.


This figure shows the WebCenter Spaces Administration, with the Roles page under the Security page as open. The Manage All permission for Application is highlighted for a role.


This image shows a page in edit mode Design view before a page header or footer is added. The page is based on the page style Three Column. Accordingly, it has three layout boxes laid out horizontally. Each layout box has its own Add Content button and icons for adding tabs and more layout boxes as well as an icon for customizing the layout box through its properties.


This figure shows a page for creating a blog post, with the various RTE icons displayed. The Publish option is selected by default for the blog post.


This figure shows a part of the Find a Web clipping page. In the URL Location field, the URL http://www.oracle.com/appserver/index.html is entered.


This figure shows the sample banking application navigation model displayed as a menu with the Buttons style.


This figure shows a portion of the Roles page, showing Edit Permissions selected for the Authenticated-User role.


This image shows a page in edit mode set to Source view. The hierarchical list of components is zoomed-in to a particular task flow, depicted by the label, "region." To the right of region is a Close link for exiting the zoomed-in view.


This screenshot shows the Add Resource Catalog Item dialog with the Application Navigator option selected.


This figure shows the RTE containing various icons that can be used for adding and formatting text, links, and images.


This screenshot shows the Enter bind parameter values dialog.


This screen shot shows the Remove Watch icon form a forum selected in the Discussions - Quick View task flow.


This image shows a page in edit mode. Below the page status, "Editing Page: Events," the View menu is expanded. It shows the options Design, Source, and Source Position. The Source option is called out.


This screen shot shows the Edit Resource Catalog Item dialog for the Search task flow. On the Options tab, the values in the text have been added to the New Attribute Name and New Attribute Value parameters


This figure shows the Target tab of the Edit Navigation Item - Link dialog.


This figure shows the Space administration General page Self-Subscription / Change Membership section, showing Select Roles Available on Self-Subscription and Change Membership checked, displaying a table of all available roles, each providing check boxes to Enable and/or specify Approval Required for Self Subscription and for Change Membership.


23 Securing Pages and Components

You are authorized to specify who can access any page on which you also have edit permission. Among those you authorize to access the page, you can assign varying levels of access, so that some users can edit the page while others can merely view it. If you prefer, you can specify that the page inherits its access settings from the application.

You may want to open a page to many users, but limit the exposure of a particular page component to a specific user, a user group, or to users who are assigned a specific application role. You can accomplish this by associating a security-related EL expression with the component instance.

This chapter provides information about securing pages and page components. It includes the following sections:

	
Section 23.1, "Setting Access on a Page"


	
Section 23.2, "Setting Access on a Page Component"





Audience

This chapter is intended for Space Moderators and Participants and for page editors with the create, edit, and delete permission on pages and on the services that provide the components to be secured. For more information about application roles and permissions, see Section 21.2, "Managing Application Roles and Permissions."



23.1 Setting Access on a Page

Page properties include a Security tab with controls for specifying who can do what to the current page (Figure 23-1).


Figure 23-1 Security Tab in Page Properties Dialog

[image: Security tab in Page Properties dialog]






In WebCenter Spaces, the options that appear on the Security tab vary according to whether you are accessing it from a Space page or a Home Space page.

Space security provides the additional options of inheriting page access permission settings from the application, enabling page access to public users (that is, users who are not logged in), and enabling page access for all authenticated users (that is, users who are logged in).

This section describes how to set page access through page properties. It is also possible to set page access through the Personalize Pages page. Setting page access through the Personalize Pages page is discussed in Section 38.2, "Controlling User Access to Your Personal Pages."




	
Note:

Page access permissions set through the Page Properties dialog in Oracle Composer are committed after you click OK on the Security tab. Closing Oracle Composer without saving does not discard such changes.
Page access permissions set through the Personalize Pages page take effect after you click OK in the Set Page Access dialog.









To access the Security tab in the Page Properties dialog:

	
Go to the page you want to secure, and open it in Oracle Composer.




	
See Also:

To open a page in edit mode, press Ctrl-Shift-E.








	
Click the Page Properties button (Figure 23-2).


Figure 23-2 Page Properties Button in Page Edit Mode

[image: Page Properties button in page edit mode]






	
In the resulting Page Properties dialog, click the Security tab to bring it forward (Figure 23-3).


Figure 23-3 Security Tab in Page Properties Dialog

[image: Security tab in Page Properties dialog]






	
Space pages only:

	
To specify that the page should inherit access settings from the permissions established for the Space, select Use Application Permissions (Figure 23-4), then click OK to save your changes and exit the dialog.




	
See Also:

For more information about setting global Space permissions, see Section 52.2, "Managing Roles and Permissions for a Space."








Figure 23-4 Security Tab for a Space Page

[image: Security tab for a Space page]






	
To set custom access on the current page, select Use Custom Access Settings.

If you select Use Custom Access Settings, continue with the next steps.





	
To grant page access permissions to all authenticated users, that is, to users who are logged in to WebCenter Spaces, click Add Authenticated Access.

The role authenticated-role is added under Role or User.


	
To grant page access permissions to all public users, that is, users who have not logged in to WebCenter Spaces, click Add Public Access.

The role anonymous-role is added under Role or User.


	
To grant page access permissions to selected users, groups, and application roles, click the Add Access button to open the Add Access dialog (Figure 23-5).


Figure 23-5 The Add Access Dialog

[image: Add Access dialog box]






	
In the Search field, enter a search term or the name of the user, group, or role for whom you want to enable access, and click the Search icon.




	
Tip:

Search terms must contain at least two characters.








	
Select a user, group, or role by clicking in its row.




	
Note:

When you select a user name, the permissions you set are granted to that specific user. When you select a group or application role, the permissions you set are granted to all users who are members of that group or who are assigned that role.







To make multiple selections:

	
Ctrl-Click to select multiple rows.


	
Shift-Click to select a range of rows.





	
Click Select.

The Add Access dialog closes, and the Set Page Access dialog populates with the selected users (Figure 23-6).


Figure 23-6 Populated Security Tab in Page Properties Dialog

[image: Populated Security tab in Page Properties dialog]






	
For each user, group, or role, grant access by selecting one or more access privileges from the Page Access columns (Table 23-1).


Table 23-1 Page Access Privileges in the Set Page Access Dialog

	Icon	Name	Description
	
[image: View Page icon]


	
View Page

	
Users can access the page for viewing, but cannot perform any other actions on the page.


	
[image: Personalize Page icon]


	
Edit Page

	
Users can edit the page using Oracle Composer. This includes adding, rearranging, and deleting content; renaming the page; and changing page properties, such as the page scheme.


	
[image: Delete Page icon]


	
Delete Page

	
Users can delete the page.


	
[image: Manage Page icon]


	
Perform All Page Actions

	
Users can perform all actions on the page.


	
[image: Edit Page icon]


	
Personalize Page

	
Users can rearrange page content and personalize his or her view of task flows, provided the task flow includes personalization settings.











	
Tip:

By default, all authenticated users and user roles that you add to the Set Page Access dialog are granted page view access. The other access privileges require page view access.








	
Click OK to save your changes and close the Set Page Access dialog.









23.2 Setting Access on a Page Component

There may be pages you want to expose to many users that have components you want only a select set of users, or even only one other user, to see. For example, imagine that you have created a Space for all sales people. The Space's home page includes two Announcements task flow instances: one for all sales people and one for sales managers only. You can secure the second Announcements instance so that only those users assigned the custom role sales_manager can see it.

Any component that has an associated Show Component property can be secured in this way. Those components that do not have an associated Show Component property can be placed inside a component that does, and in this way be secured. For example, you can place an Announcements task flow, which does not have an associated Show Component property, inside a Box layout component, which does. You can set the property on the Box, and that setting will also affect the display of Announcements.




	
See Also:

You can also set security on the custom components that you import through the Resource Manager. For more information, see Section 10.4.4, "Setting Security for a Resource."







To set access on a component instance:

	
Go to the component instance you want to secure and access its Display Options properties.




	
See Also:

For information about accessing component properties, see Section 17.5.2, "Setting Properties on Page Components."








	
Open the Expression Builder by clicking the Edit icon to the right of the Show Component property and selecting Expression Builder (Figure 23-7).


Figure 23-7 Expression Builder Option Next to Show Component

[image: Expression Builder option next to Show Component]






	
Under Type a Value or Expression, enter one of the following EL expressions:

	
To expose a component only to members of a particular scope who are assigned a particular role in that scope, enter:


#{WCSecurityContext.userInScopedRole['role']}


In lieu of role, enter the role name, for example Moderator.

The scope is implicitly resolved to be the current scope. If you use this EL in the Home Space, it resolves to Home Space GUID and roles defined at the application level. If you use this EL in a Space scope, it resolves to roles defined for the Space.


	
To expose a component only to members of a group, enter:


#{WCSecurityContext.userInGroup['group_name']}


In lieu of group_name, enter the name of the group, for example Administrators.


	
To expose a component only to a specific user, enter:


#{WCSecurityContext.currentUser['user_name']}


In lieu of user_name, enter the user name, for example jdoe.







	
See Also:

For more information about EL expressions, see Appendix B, "Expression Language Expressions." For information about EL expressions relevant to security, see Section B.3.3, "EL Expressions Relevant to Application Security."








	
Click OK to exit the Expression Builder, and click OK to save your changes and exit the Component Properties dialog.


	
Click Save and then Close to exit Oracle Composer.

The secured component appears only to those users with the name, role, or group you specified.
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16 Working with Resource Catalogs

Oracle WebCenter Spaces provides rich Resource Catalogs, also known as Business Dictionaries, which expose components and connections that WebCenter Spaces users can add to their pages. You can use a Resource Catalog to populate resources such as page templates, navigation models, pages, and task flows. WebCenter applications are preconfigured with three Resource Catalogs out-of-the-box. If these catalogs do not meet your business requirements, you can modify them or create new ones.

This chapter provides information about the default, out-of-the-box Resource Catalogs included in WebCenter Spaces, and also describes how to create and manage Resource Catalogs. It includes the following sections:


	
Section 16.1, "What You Should Know About Resource Catalogs"



	
Section 16.2, "Creating Resource Catalogs"



	
Section 16.3, "Editing a Resource Catalog"



	
Section 16.4, "Showing and Hiding a Resource Catalog"



	
Section 16.5, "Setting Properties on a Resource Catalog"



	
Section 16.6, "Setting Security on a Resource Catalog"



	
Section 16.7, "Copying a Resource Catalog"



	
Section 16.8, "Deleting a Resource Catalog"



	
Section 16.9, "Using JDeveloper to Build Your Resource Catalog"



	
Section 16.10, "Configuring Resource Catalogs in Your Application"





For generic information about adding and editing different types of resources, see Chapter 10, "Working with the Resources that Compose a Portal or Community."

[bookmark: WCSUG7283]
Audience

This chapter is intended for users who want to provide and manage Resource Catalogs in their Oracle WebCenter Spaces application. Portal designers with the application permission Application-Resource Catalogs-Create Edit Delete can manage application-level Resource Catalogs. Space moderators with the permission Space-Resources-Create Edit Delete (simple permission model) or Space-Resource Catalogs-Create Edit Delete (detailed permission model) can manage Space-level Resource Catalogs. For information about roles and permissions, see Chapter 20, "Understanding WebCenter Spaces Security."
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16.1 What You Should Know About Resource Catalogs

[bookmark: sthref1284]The Resource Catalog is displayed when you edit a page or page template in Oracle Composer and click Add Content. You can add resources from the catalog on to your page or page template.

As a WebCenter Spaces user, you can use a Resource Catalog to populate pages in Oracle Composer.

As an administrator or delegate, you can use a Resource Catalog to populate the following artifacts in the Resources Manager:


	
Page templates



	
Task flows
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16.1.1 Understanding the Out-of-the-Box Resource Catalogs

[bookmark: sthref1285]WebCenter Spaces provides the following out-of-the-box Resource Catalogs:


	
Default Home Space Catalog - The application-level Resource Catalog. You see this catalog when you edit a page or task flow in your Home space.



	
Default Space Catalog - The Space-level Resource Catalog. You see this catalog when you populate a page or task flow within a Space.



	
Default Page Template Catalog - The catalog used for page template creation in both your Home Space and other Spaces. You see this catalog when you edit a page template.





This section describes these catalogs. It includes the following subsections:


	
Section 16.1.1.1, "Default Home Space Catalog"



	
Section 16.1.1.2, "Default Space Catalog"



	
Section 16.1.1.3, "Default Page Template Catalog"
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16.1.1.1 Default Home Space Catalog

This catalog is displayed when designing pages and task flows in your application. The Default Home Space Catalog (Figure 16-1) contains items that users may typically want to add to a task flow or a business role page, such as page layout components, portlets, and WebCenter Services task flows.
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Figure 16-1 Resource Catalog Used to Populate Pages

[image: Default Resource Catalog for Pages]






Table 16-1 provides a description of each folder in the default Resource Catalog.
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Table 16-1 Resources in the Default Resource Catalog






	Folder Name
	Description





	
Alerts and Updates


	
Includes task flows from the following WebCenter Services to track alerts and notifications:


	
Activity Stream, to view activities of your connections, actions taken in Spaces, and business activities. For more information, see Chapter 32, "Tracking Your Connections' Activities."



	
Announcements, to view current announcements. For more information, see Chapter 59, "Working with the Announcements Service."



	
Discussion Forums, to list the most frequently used and most recently accessed topics. For more information, see Chapter 60, "Working with the Discussions Service."



	
Documents, to list recently created or modified documents. For more information, see Section 41.1, "What You Should Know About the Documents Service Task Flows."



	
Notifications, to view Space- and object-level subscriptions. For more information, see Section 36.5, "Working with Notifications Task Flows."



	
Polls, to view available polls. For more information, see Chapter 67, "Working with the Polls Service."



	
RSS, to view feeds from external sources and WebCenter services. For more information, see Section 68.3, "Working with the RSS Task Flow."



	
Worklist, to view all worklist items that require your attention. For more information, see Chapter 70, "Working with the Worklist Service."









	
Analytics


	
Includes the Analytics service task flows. These task flows help to track and display different metrics, such as response times and usage behavior, for the WebCenter Spaces application.

For more information, see Chapter 55, "Analyzing Usage and Performance Metrics."





	
Content Management


	
Includes the documents task flows, which can be used to access, add, and manage folders and files, or display content in a predefined template.

For more information, see Part X, "Working with Content".





	
Mash-Ups


	
Includes the following resources that enable you to create business mashups:


	
Data Controls: Folder that includes data controls created for the application at design time and runtime.

For more information about these items, see Chapter 26, "Creating Business Mashups."



	
Task Flows: Folder that includes task flows created in the Resource Manager at runtime. These are visualizations created by gathering data from various data sources and publishing to different layouts such as charts, tables, and graphs.

For more information, see Chapter 26, "Creating Business Mashups."



	
Omniportlet: A portlet to publish data from a variety of data sources (including SQL, XML, web services, spreadsheets, and web pages) to several different layouts, such as customizable charts and tables



	
Pagelet Producers: Folder that includes pagelets deployed in the pagelet producer. For more information, see Section 6.5.2.3, "Registering a Pagelet Producer."









	
Polls and Surveys


	
Includes the Polls service task flows that can be used to create, edit, and take online polls on your application pages. Polls let you survey your audience, check whether they can recall important information, and gather feedback on the efficacy of presentations.

For more information, see Chapter 67, "Working with the Polls Service."





	
Portlets


	
Includes the following resources:


	
Administrator-level tools for registering and managing external applications and portlet producers.



	
Portlets, which provide a means of presenting data from multiple sources in a meaningful and related way. Out-of-the-box, this folder contains the Omniportlet and Web Clipping portlets.





For more information, see Chapter 25, "Understanding Portlet Basics."





	
Social and Communication


	
Includes the following resources to enable social networking and communication among users:


	
Lists folder: Includes individual Space lists. The folder is displayed only if it contains resources inside it. For more information about these items, see Chapter 64, "Working with the Lists Service."



	
Message Board - Quick View: WebCenter Services task flow used for adding, viewing, updating, hiding, and deleting messages. For more information, see Section 33.4, "Working with Message Board and Feedback Task Flows."



	
Message Board: WebCenter Services task flow used for adding, viewing, updating, hiding, deleting, and managing your view of messages.



	
Organization View: WebCenter Services task flow used for adding a graphical depiction of the current user's position within the company. which provides quick access to contact and status information about you and your connections.



	
Profile - Snapshot: WebCenter Services task flow used for viewing a user photo and status message. For more information, see Chapter 30, "Managing Your Profile."



	
Profile: WebCenter Services task flow used for displaying a user's profile details and uploading a photo.



	
Profile Gallery: WebCenter Services task flow used for accessing all of your social networking information from one view.



	
Connections: WebCenter Services task flow used for viewing and managing your connections, and creating connections lists. For more information, see Section 31.1, "What You Should Know About Connections."



	
Connections - Card: WebCenter Services task flow used for photos, status messages, and instant contact options to your connections.



	
Connections - Detailed View: WebCenter Services task flow used for photos and quick access to your connections and to features for inviting new connections and organizing your connections into lists.



	
Connections - Quick View: WebCenter Services task flow used for photos and quick access to your connections.



	
Recommended Connections: WebCenter Services task flow used for viewing and connecting to people considered to be similar to you.



	
Similar Items: WebCenter Services task flow used for listing items that are similar to the currently selected item on the page. For more information, see Section 58.2, "Working with Activity Graph Service Task Flows."



	
Mail: WebCenter Services task flow used for viewing, responding to, and managing your personal mail. For more information, see Section 65.4, "Working with the Mail Service Task Flow."



	
Watched Topics: WebCenter Services task flow used for providing a cohesive view of all the topics you have selected to watch from a particular Space or from all Spaces. For more information, see Section 60.2, "Working with Discussions Service Task Flows."



	
Watched Forums: WebCenter Services task flow used for viewing all discussion forums you have selected to watch from a particular Space or from all Spaces.



	
Forums: WebCenter Services task flow used for viewing Recent Topics, Popular Topics, Watched Topics, and Watched Forums.



	
Events: WebCenter Services task flow used for adding calendars that you can use to schedule meetings, appointments, and any other type of occasion. For more information, see Section 61.1, "What You Should Know About the Events Service."



	
Blogs: WebCenter Services task flow used to expose a blog on a page along with other services instead of having a dedicated blog page. For more information, see Section 48.2.1.2, "Adding a Blogs Task Flow."



	
Publisher: WebCenter Services task flow used for publishing messages, files, and URLs to the Activity Streams of all of your connections or to those connections who have access to a specified Space. For more information, see Section 34.3.3.1, "What You Should Know About the Publisher Task Flow."









	
Tagging and Searching


	
Includes the following WebCenter Services task flows to enable effective search of WebCenter and other sources:


	
Saved Searches folder: For displaying a list of all searches saved by you or other Space members.



	
All Saved Searches: For running saved searches within the application. For more information, see Section 56.3, "Working with Search Service Task Flows."



	
Similarly Tagged Items: For displaying a list of links to other pages that have at least one tag in common with the currently-displayed page.



	
Tags: For adding a view of the tags you have added to your application and the items you have tagged. For more information, see Section 57.2, "Working with Tags Service Features and Task Flows."



	
Tag Cloud: For displaying the tags currently applied to WebCenter Spaces items. For more information, see Section 57.2, "Working with Tags Service Features and Task Flows."



	
Tag Cloud Related Resources: For displaying related resources for a selected tag. For more information, see Section 57.2, "Working with Tags Service Features and Task Flows."









	
Web Development


	
Includes the following components that you can use to design your pages:


	
Data Controls: Includes data controls created for the application at runtime.

For more information, see Chapter 26, "Creating Business Mashups."



	
Layout components such as Box, HTML Markup, Hyperlink, Image, Movable Box, Separator, Text, and Web Page.

For more information about these components, see Chapter 18, "Adding and Configuring Page Layout Components."















With the default WebCenter Spaces configuration, this Resource Catalog is displayed when you create pages at the application level.

When creating pages in a Space, the Default Space Catalog is displayed. This catalog is similar to the Default Home Space Catalog, except that its resources display content specific to the Space, where applicable.
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16.1.1.2 Default Space Catalog

The Default Space Catalog is the same as the Default Home Space Catalog, except for a few resources that display data relevant to the current Space, for example, the Personal Documents folder, which displays documents associated with the current Space. Table 16-2 describes the resources that are exclusive to the Default Space Catalog.
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Table 16-2 Resources that Are Exclusive to the Default Space Catalog






	Resource or Folder Name
	Description





	
Similar Spaces


	
This resource in the Social and Communication folder displays all Spaces that are similar to the one you are currently viewing. For more information, see Section 58.2.3, "Working with the Similar Spaces Task Flow."





	
Lists folder


	
This resource in the Social and Communication folder enables you to add lists to pages in your Space. Lists are useful for many Space activities, such as tracking issues, capturing project milestones, publishing project assignments, and much more. However, the Lists service is not available to the Home Space. For more information, see Chapter 64, "Working with the Lists Service."





	
Members


	
This resource in the Social and Communication folder lists all members in the Space. For more information, see Section 52.4, "Working with the Space Members Task Flow."





	
Spaces documents


	
This resource from the Content Management folder exposes a list of folders and files associated with the current Space. For more information, see Section 39.2, "What You Should Know About Content Management Selections in the Resource Catalog."













[bookmark: CEGJIGHI][bookmark: WCSUG6642]

16.1.1.3 Default Page Template Catalog

This catalog is displayed when designing page templates. A page template defines the layout of your portal. It defines the location of content on the page and contains artifacts that display on each page of the portal; for example, a navigation pane to the left of the page, a header or banner with the company logo at the top, and a copyright notice at the bottom of the page. When you build a page template, you should be able to add all such components to it. To address this requirement, WebCenter Spaces provides the Default Page Template Catalog to be used for page template creation. For more information about page templates, see Chapter 12, "Working with Page Templates."

In addition to all the folders available in the Default Home Space Catalog (Table 16-1), the Default Page Template Catalog also includes the Template Development folder. This folder includes a Navigations folder and all the resources that are typically used in page templates only, for example logos, navigation components, navigation models, layout components, and copyright statements.

The Navigations subfolder includes three navigation task flows. You can add these task flows, described as follows, to page templates to quickly visualize your portal navigation model:


	
Navigation Breadcrumb, to display a series of horizontal or vertical links that show users their current position in the navigation hierarchy.



	
Navigation Menu, to display navigational links as a series of tabs, menus, bars, buttons, choices, or as a list.



	
Navigation Tree, to display navigational links in a hierarchical structure.





For information about navigation structures, see Chapter 11, "Working with Navigation."

For information about the other resources in the Template Development folder, see Chapter 13, "Adding Spaces Components to Your Templates."
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16.1.2 Introducing the Resource Catalog Management Page

If the default catalogs provided in WebCenter Spaces do not meet your company's requirements, you can create custom Resource Catalogs and offer those to users. The Resource Manager, shown in Figure 16-2, provides options to create and manage custom Resource Catalogs.

Only users with permissions to create, edit, and delete Resource Catalogs can access the Resource Manager.
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Figure 16-2 Resource Catalogs Page in the Resource Manager

[image: Resource Catalogs Page in the Resource Manager]






On this page, you can create, copy, publish, edit, preview, and delete Resource Catalogs. When you publish a custom Resource Catalog, it is available for selection on the application's Configuration page or a Space's administration settings.
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16.1.3 Understanding the Resource Registry

[bookmark: sthref1291]The Resource Registry is a central repository of all the resources available to the WebCenter Spaces application. It contains all resources that you can add to Resource Catalogs in the application. In addition to the out-of-the-box resources, it is also updated dynamically to include new resources, such as task flows, data controls, and navigations, as and when they are created in the Resource Manager or deployed as shared libraries from JDeveloper. As a result, a resource that is created and published in the Resource Manager is available for consumption right away.

The Resource Registry (Figure 16-4) is displayed when you click the Add From Library option (Figure 16-3) in the Edit dialog for a Resource Catalog.
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Figure 16-3 Add From Library Option to Access the Resource Registry

[image: Add From Library Option in the Resource Catalog Editor]
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Figure 16-4 Add Resource Catalog Item Dialog (Resource Registry)

[image: Add Resource Catalog Item Dialog]






Table 16-3 describes the folders in the Resource Registry.
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Table 16-3 Folders in the Resource Registry






	Resource Folder
	Description





	
Runtime DataControls


	
Lists all data controls created at runtime. When you add these data controls in a Resource Catalog, you enable users to consume them in pages or task flows using different visualizations such as tables, graphs, buttons, and so on.

For more information, see Section 26.2, "Creating and Managing Data Controls."

This folder is empty if there are no runtime data controls in your WebCenter Spaces instance.





	
Design Time DataControls


	
Lists all data controls deployed from JDeveloper. At a minimum, it displays the WebCenter Services data controls that are available out-of-the-box. In addition, it also displays data controls that an application developer may have created in JDeveloper and deployed WebCenter Spaces.

For information about the data controls available for a WebCenter service, refer to the chapter describing that service.





	
Business Mashups


	
Lists the task flows created at runtime in the Resources Manager. For more information, see Section 26.3, "Creating and Managing Task Flows."

This folder is empty if there are no runtime task flows in your WebCenter Spaces instance.





	
Spaces Components


	
Lists components, such as menus, links, copyright message, and so on, that are typically used in page templates. These resources are available out-of-the-box in the Default Page Template Catalog, in a folder named Template Development.

For more information, see Chapter 13, "Adding Spaces Components to Your Templates."





	
Components


	
Lists a selection of layout components that you can use to design pages, templates, and task flows. For more information, see Chapter 18, "Adding and Configuring Page Layout Components."





	
All Documents


	
Lists all documents that you have access to. For more information, see Part X, "Working with Content".





	
Portlet Producers


	
Lists all registered portlet producers. For more information, see Chapter 25, "Understanding Portlet Basics."





	
Connections


	
Lists all available repository connections. Many resources, such as portlets, external applications, and some WebCenter services, require a connection to a database schema where relevant information is stored.

The chapters describing the various resources and services provide information about whether a connection is required for that resource or service.





	
Task Flows


	
Lists all task flows deployed from JDeveloper. At a minimum, it displays the WebCenter Services task flows that are available out-of-the-box. In addition, it also displays task flows that an application developer may have created in JDeveloper and deployed WebCenter Spaces.

For information about the task flows available for a WebCenter service or resource, refer to the chapter describing that service or resource.





	
Resource Catalogs


	
Lists all available Resource Catalogs. You can embed multiple Resource Catalogs inside a catalog.





	
Navigations


	
Lists all available navigations. These resources are available out-of-the-box in the Default Page Template Catalog. For more information, see Chapter 11, "Working with Navigation."





	
Lists


	
Displays all the lists created using the Lists service. For more information, see Chapter 64, "Working with the Lists Service."





	
Saved Searches


	
Displays all saved searches. For more information, see Chapter 56, "Working with the Search Service."





	
Analytics


	
Displays all the Analytics service task flows. These task flows help to track and display different metrics, such as response times and usage behavior, for the WebCenter Spaces application. For more information, see Chapter 55, "Analyzing Usage and Performance Metrics."
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16.2 Creating Resource Catalogs

[bookmark: sthref1295]You can build a custom Resource Catalog either from scratch or by extending an existing Resource Catalog. Creating a Resource Catalog follows the same procedure as any other resource. For information about creating a Resource Catalog, see Section 10.2, "Creating Resources." For information about copying an existing Resource Catalog, see Section 10.4.1, "Copying a Resource."

The new Resource Catalog is listed on the Resources - Resource Catalogs page. However, the catalog is hidden by default. To make the new Resource Catalog available to the application or Space, you must do the following:


	
Publish it in the Resource Manager. For more information, see Section 16.4, "Showing and Hiding a Resource Catalog."



	
Configure the application or Space to use the new catalog as the default one. For more information, see Section 16.10, "Configuring Resource Catalogs in Your Application."
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16.3 Editing a Resource Catalog

[bookmark: sthref1296]When you edit a Resource Catalog in the Resource Manager, you are basically managing its resources. The Resource Manager provides the following two options for editing Resource Catalogs:


	
Managing resources in the Edit dialog.



	
Editing the source code of the Resource Catalog definition file in a text editor.





This section explains both options. It includes the following sections:


	
Section 16.3.1, "Managing Resources in the Edit Dialog"



	
Section 16.3.2, "Editing the Source Code for a Resource Catalog"











	
Note:

To perform certain advanced editing tasks, you may want to download the Resource Catalog to JDeveloper, edit it, and upload it back to your WebCenter Spaces instance. For more information, see Section 16.9, "Using JDeveloper to Build Your Resource Catalog."
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16.3.1 Managing Resources in the Edit Dialog

[bookmark: sthref1297]The Edit option in the Resource Manager opens an Edit dialog (Figure 16-5), which provides various options to manage resources in the selected Resource Catalog.







	
Note:

You cannot edit out-of-the-box catalogs. The Edit option on these catalogs is grayed out.
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Figure 16-5 Edit Dialog Used to Edit a Resource Catalog

[image: Edit Resource Catalog Dialog]






You can edit a Resource Catalog to:


	
Create folders



	
Create custom components by providing the XML code



	
Add resources from the Resource Registry



	
Edit resource properties



	
Copy resources



	
Delete resources



	
Rearrange resources



	
Preview the catalog





This section describes the steps to perform these tasks. It includes the following subsections:


	
Section 16.3.1.1, "Creating a Folder"



	
Section 16.3.1.2, "Adding Resources"



	
Section 16.3.1.3, "Creating Custom Components"



	
Section 16.3.1.4, "Rearranging Resources"



	
Section 16.3.1.5, "Setting Properties on a Resource"



	
Section 16.3.1.6, "Copying a Resource"



	
Section 16.3.1.7, "Deleting a Resource"



	
Section 16.3.1.8, "Previewing the Resource Catalog"
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16.3.1.1 Creating a Folder

To organize your catalog better, you can group similar resources together; for example, group all layout components or all resources from a particular service.

To add a folder to a catalog:


	
Select the catalog in the Resource Manager and from the Edit menu, select Edit.



	
In the Edit dialog, from the Add menu, select Folder.

The Edit Resource Catalog Item dialog displays with two tabs, Target and Options. The Target tab is selected by default.



	
On the Target tab, specify a name and description for the folder, and leave the Visible option checked to ensure that the folder is displayed in the catalog.



	
Optionally, use the Options tab to define display options for the folder. For more information, see Section 16.3.1.5, "Setting Properties on a Resource."



	
Click OK.

You can now add resources inside this folder, or move resources inside it by dragging and dropping them from the top level folder.
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16.3.1.2 Adding Resources

[bookmark: sthref1299]This section describes how to populate your catalog using the Resource Registry. For more information, see Section 16.1.3, "Understanding the Resource Registry."

To add a resource:


	
Select the Resource Catalog in the Resource Manager and from the Edit menu, select Edit.



	
If you have created folders (see Section 16.3.1.1, "Creating a Folder") and want to add resources inside a particular folder, then select the folder in the Edit dialog.



	
From the Add menu, select Add From Library.



	
In the Add Resource Catalog Item dialog (Figure 16-4), select a folder name in the left pane to display its contents in the right pane, or search for a resource by specifying its name in the Search field.

For a description of the available resources, see Section 16.1.3, "Understanding the Resource Registry."



	
Select a resource.







	
Tip:

You can select multiple resources using the standard shortcut keys for selection.












	
Optionally, in the Name field, specify a different name for the resource, if required. You can skip this step to retain the default resource name.







	
Note:

If you selected multiple resources at a time, you cannot rename them at this point. However, you can edit them after adding them to the catalog. For more information, see Section 16.3.1.5, "Setting Properties on a Resource."












	
Click Add.







	
Notes:


	
The Runtime DataControls folder lists the available data controls. You can expand a data control node to display its accessors and methods. However, you can only add the data control as a whole. Adding its accessors, methods, or attributes separately is not supported. You may see catalog errors if you try to add these objects.



	
Avoid adding a data control more than once in a catalog. The data control is added to the catalog as many times, but when you use the catalog to populate a page or task flow, you will not be able to add accessors, methods, or attributes from such data control instances.



	
The Design-Time DataControls folder lists all the WebCenter Services data controls. However, adding the ConnectionsNetworkDC and KudosServiceDC data controls at runtime is not supported. Avoid adding these data controls to your page or task flow.


















	
Repeat the previous four steps to add more resources from the available folders.



	
Click OK in the Edit dialog.
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16.3.1.3 Creating Custom Components

[bookmark: sthref1300]The Resource Registry in WebCenter Spaces provides a large repository of resources that you can add to a catalog. However, if this is not sufficient and your business requires you to add other resources, such as ADF Faces components, custom JSPX, or raw HTML, you can create a custom component and specify the XML code for the component. Using a custom component is the only way to make such components available to a page in Oracle Composer.

You may want to create a custom component for the following purposes:


	
Create seeded layouts that can be added to a page. You can add a layout component and include a combination of design and container components inside it. The container components provide empty content areas that can be filled later.



	
Add external content by including the raw HTML code.



	
Define seeded layouts in which to consume data controls. You can then bind the data control to the layout.





To create a custom component:


	
Select the catalog in the Resource Manager and from the Edit menu, select Edit.



	
If you have created folders and want to add resources inside a particular folder, select the folder in the Edit dialog.



	
From the Add menu, select Component.



	
In the Edit Resource Catalog Item dialog, on the Target tab, specify a name and description for the new resource, and leave the Visible option checked to ensure that the resource is displayed in the catalog.



	
In the XML text area, enter the XML code for the component.

The following are a few examples of custom components:


	
Output Text component:


<af:outputText xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 
                 value="Weather Foercast for the Day" id="#"/>



	
Custom navigation:

[bookmark: CIHIABAC]

<af:forEach xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 
            var="level_1_menu"
             items="#{SiteStructureContext.defaultSiteStructure.listModel['startNode=/, includeStartNode=false']}">
<af:outputText id="#" 
               xmlns:af="http://xmlns.oracle.com/adf/faces/rich" 
               value="#{level_1_menu.title}"/>
</af:forEach>



	
External HTML content:
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<f:verbatim xmlns:f="http://java.sun.com/jsf/core">
Configuring Services, Portlet Producers, and External Applications








 
The script content on this page is for navigation purposes only and does not alter the content in any way.


6 Configuring Services, Portlet Producers, and External Applications

In WebCenter Spaces, a series of WebCenter services expose portal, team collaboration, and social features through various task flows. Some services, such as lists, are ready to use out-of-the-box and require no further configuration. Other services, such as discussions and mail, require connections to external back-end servers, and additional configuration within WebCenter Spaces to get things up and running.

This chapter describes how to enable, disable, and configure WebCenter services in WebCenter Spaces. It does not describe how to set up connections to back-end servers—this is a job for your Fusion Middleware Administrator. For details, see "Getting WebCenter Spaces Up and Running" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.

This chapter includes the following sections:

	
Section 6.1, "Enabling and Disabling WebCenter Services"


	
Section 6.2, "Configuring Discussion Forum Options for WebCenter Spaces"


	
Section 6.3, "Configuring Send Mail Notifications for WebCenter Spaces"


	
Section 6.4, "Configuring People Connections Defaults for WebCenter Spaces"


	
Section 6.5, "Registering Portlet Producers" *


	
Section 6.6, "Registering External Applications" *




See also, Chapter 5, "Configuring Global Defaults"


Audience

This chapter is intended for WebCenter Spaces administrators with the Manage Configuration permissions.

Additional permissions are required to manage portlet producers and external applications for WebCenters, that is, you must have the appConnectionManager role.



6.1 Enabling and Disabling WebCenter Services

In WebCenter Spaces, a series of services expose portal, team collaboration, and social features through various task flows. Some services, like tags, are available and work out-of-the-box, but other services, such as Mail, require connection to an external back-end server (Table 6-1).


Table 6-1 WebCenter Services

	Services A to M	Services N to W
	
Activity GraphFootref 1

	
NotesFootref 2


	
AnalyticsFoot 1 

	
PageFootref 2


	
AnnouncementsFootref 1

	
People ConnectionsFootref 2


	
DiscussionsFootref 1

	
PersonalizationFootref 1


	
Documents (includes Wikis and Blogs)Footref 1

	
PollsFootref 2


	
EventsFootref 1

	
RSSFootref 2


	
Instant Messaging and Presence (IMP)Footref 1

	
Recent ActivitiesFootref 2


	
LinksFoot 2 

	
SearchFootref 1


	
ListsFootref 2

	
TagsFootref 2


	
MailFootref 1

	
WorklistFootref 1








Footnote 1 Service requires a connection to external back-end server.

Footnote 2 Services, such as notes, links, pages, tags, and so on, use the same WebCenter repository and MDS repository as WebCenter Spaces to store their data.

The Fusion Middleware Administrator is responsible for managing connections to external servers and also maintains the WebCenter and MDS repositories where application data, specific to WebCenter Spaces, is stored. For details, see "Maintaining WebCenter Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.

When a valid connection exists, the associated service becomes available. If you want to verify whether a service, such as Mail, is available in WebCenter Spaces, check:

	
Associated task flows display in the resource catalog.


	
Existing task flows function as expected.


	
Space moderators can choose whether to enable or disable that service in their Space—through Space Administration Settings




When a back-end server is not configured, intentionally or otherwise, WebCenter Spaces cannot offer features or functionality related to that service:

	
Associated task flows are not available in the resource catalog.


	
Existing task flows display a message indicating that the service is currently unavailable.


	
Service is not listed, as available, to Space moderators—through Space Administration Settings





Reporting Temporary Issues with WebCenter Services

When a service is temporarily unavailable, report the issue to the Fusion Middleware Administrator. The Fusion Middleware Administrator can use Enterprise Manager to investigate, diagnose, and solve issues with WebCenter Spaces services. See also, "Navigating to the Home Page for WebCenter Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


Hiding Task Flows When Services Unavailable

Most WebCenter services are optional. If you decide not to offer a particular service in WebCenter Spaces, temporarily or permanently, consider removing any associated task flows that display, by default, out-of-the-box.


Enabling and Disabling Services for a Particular Space

Moderators can enable or disable available WebCenter services within their Space. See, Section 51.10, "Managing Space Services".






6.2 Configuring Discussion Forum Options for WebCenter Spaces

Discussion forums allow members to capture, share, and preserve content that is relevant to their project or community goals.

As WebCenter Spaces administrator, you are responsible for setting discussion forum options for the entire application through WebCenter Spaces Administration pages (Figure 6-1).


Figure 6-1 Setting Discussion Forum Options

[image: Setting Discussion Forum Options]



From here you configure discussion-related setting, as well as access discussions server administration pages:

	
Section 6.2.1, "Accessing the Discussions Server Admin Console"


	
Section 6.2.2, "Specifying Where Discussions and Announcements are Stored on the Discussions Server"


	
Section 6.2.3, "Choosing How Many Discussion Topics to Save In Space Templates"







	
Note:

The Fusion Middleware administrator maintains the connection between WebCenter Spaces and the discussions server. If you are experiencing issues with this connection, report the problem to the Fusion Middleware Administrator. See also, "Registering Discussions Servers" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.









6.2.1 Accessing the Discussions Server Admin Console

For convenience, you can access the discussions server's Admin Console, a Web-based tool for configuring and managing discussion forums, from WebCenter Spaces Administration. From the Admin Console, you can navigate all categories and forums and edit their properties, create new categories and forums, as well as set cache, security, and various other properties for the discussions server.

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, Services, and then select Discussions.


	
Click Forum Administration.


	
Enter your discussions server administrator Username and Password.









6.2.2 Specifying Where Discussions and Announcements are Stored on the Discussions Server

Administrators can change the root category (on the discussions server) under which all WebCenter Spaces discussions and announcements are stored.

The default system root category is suitable in most cases but you can choose a different location. This might be useful when WebCenter Spaces is connected to a discussions server that is hosting discussion forums for multiple applications.

Oracle recommendations:

	
Choose a category that is dedicated to this WebCenter Spaces application. There may be conflicts when multiple WebCenter Spaces applications share the same root category.


	
Do not switch the root category after WebCenter Spaces is up and running. If you change the root category, then all the discussion forums under the old root continue to work, but you cannot use the Links service to create links to discussions or announcements stored in the old category.




You can retain existing discussions in a Space template saved with the data copy option. For example, on the Administration - Configuration - Services - Discussions page, enter the number (between 1 and 25) of most recent topics and replies to be copied over to the template.

Space templates support single or multiple forums under the root category that you specify. With Communities of Interest templates and Group Project templates, one forum is created automatically under the root category for each new Space based on that template.

To specify where WebCenter Spaces discussion forums are stored:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, Services, and then select Discussions.


	
Specify an appropriate Root Category for storing WebCenter Spaces discussions.

Click the Find icon to view the categories available and then select the most appropriate location.

To create a new category especially for this WebCenter Spaces application, click Create Category. You must have system administrator permissions on the Discussions server to create new categories.


	
Click Apply to save the settings.









6.2.3 Choosing How Many Discussion Topics to Save In Space Templates

WebCenter Spaces administrators can limit how many recent topics and replies are copied to Space templates. As copying large amounts of data has performance implications, there is an upper limit of 25 topics/replies.

Some of you may prefer not to include any recent topics/replies in Space templates, in which case you can specify zero.

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, Services, and then select Discussions.


	
Specify an appropriate number of Topics and Replies to save in Space templates.


	
Click Apply to save the settings.











6.3 Configuring Send Mail Notifications for WebCenter Spaces

WebCenter Spaces administrators are responsible for setting mail options through WebCenter Spaces administration (Figure 6-2).


Figure 6-2 Setting Mail Options

[image: Setting Mail Options]



From this page, you can assign the mail client for the "Send Mail" feature. This feature allows application resources to send mail directly from them, with the Send Mail icon (Figure 6-3).


Figure 6-3 Send Mail Icon

[image: Send Mail icon]



For example, from an announcement, users can click the Send Mail icon to open a mail window prepopulated with information including the announcement text, author, date created, and location. They can edit and add to the mail, as necessary. The way the mail window is prepopulated depends on the resource sending it. For example, from a wiki, Send Mail opens a mail window prepopulated with the name of the wiki, the size, who created it and when, who modified it and when, and a URL link to the wiki.

Within a Space, the mail can be addressed to all members of the Space. Space moderators (and anyone granted the Manage Configuration permission on the Space) set this through the Services page in the Space administration settings See Section 51.10.2, "Configuring a Custom Space Mail Distribution List".

If the number of recipients is so large that the mail cannot be prepopulated with the addresses, then you must either enter the addresses manually or set up a distribution list for the Space.

For all Send Mail notifications throughout WebCenter, you can choose to use the local mail client, such as Microsoft Outlook or Mozilla Thunderbird, or the WebCenter Mail service. The local mail client is the default. The Send Mail feature does not require the Mail service, that is, if the Mail service is not yet configured, you can still use the Send Mail feature with your local mail client.

As administrator you can also specify whether users may override the default mail client setting.




	
Note:

The Fusion Middleware administrator maintains the connection between WebCenter Spaces and the mail server. If you are experiencing issues with this connection, report the problem to the Fusion Middleware Administrator. See, "Registering Mail Servers" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.









6.3.1 Enabling Shared Mail Connections for Send Mail Notifications

Users do not need to specify credentials when sending mails using the WebCenter Mail service when shared credentials are configured for the external application that is associated with the mail server connection.

To enable shared mail connections in WebCenter Spaces.

	
Confirm that WebCenter Spaces is using the WebCenter Mail service to send mail.

	
Open WebCenter Spaces Administration.


	
Click Configuration, Services, and then select Mail.


	
Ensure that Default Mail Client for 'Send Mail' is set to WebCenter Mail Service.




See also, Section 6.3, "Configuring Send Mail Notifications for WebCenter Spaces".


	
Ask the Fusion Middleware administrator to set up a mail connection that uses an external application configured with the shared credentials and record the mail connection name.

For details, see "Setting Up a Shared Mail Connection" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
Open the Space where shared mail credentials are required and specify the name of the shared mail connection.

For details, see Section 51.10.5, "Configuring a Shared Mail Connection for a Space".











6.4 Configuring People Connections Defaults for WebCenter Spaces

This section describes how to set application defaults for the People Connections service in WebCenter Spaces. You must be a WebCenter Spaces administrator or granted Application-Configure and Manage People Connections permissions to set any of the application-wide properties described here.

This section includes the following subsections:

	
Section 6.4.1, "What You Should Know About Administering the People Connections Service"


	
Section 6.4.2, "People Connections Prerequisites"


	
Section 6.4.3, "Configuring the People Connections Service for WebCenter Spaces"


	
Section 6.4.4, "Archiving the Activity Stream Schema"


	
Section 6.4.5, "Troubleshooting Issues with the People Connections Service"






6.4.1 What You Should Know About Administering the People Connections Service

People Connections administrative settings are useful for controlling all users' initial views of People Connections features, including:

	
Activity Stream—A streaming view of user activity


	
Connections—An organically formed community of users who share a greater level of information with each other than with the unconnected


	
Profile—A summary of user information, such as contact information, job position, chain of management, and the like


	
Message Board—A feature for posting and receiving messages


	
Feedback—A feature for posting and receiving feedback




Use the People Connections administrative settings to enforce the values you specify or to enable users to override these values with their own People Connections Preferences (for more information, see the chapters covering specific features of the People Connections service, available in Part IX, "Organizing Your Collaborative and Social Networking Environment").

Setting default values on the WebCenter Administration page affects all users' views of People Connections features. There are a few levels at which these values can be set, and they are subject to an order of precedence:

	
Administrative settings affect all users' views of People Connections features.


	
Preferences settings affect the view of the user who sets them, and they override administrative settings.


	
Settings on a particular task flow affect just that task flow instance, and they override Preference settings:

	
Values set in edit mode (application customization) affect all users' views of the task flow instance.


	
Values set in view mode (user customization) affect only that user's view of the task flow instance, and they override application customizations in that user's view.












6.4.2 People Connections Prerequisites

No special set up is required to enable users to access People Connections services. The People Connections service uses the WebCenter Repository, installed with WebCenter Spaces, to store information.

For Profile information, all but three attributes are stored and read from the LDAP identity store that is configured for WebCenter Spaces. There are three exceptions: the Profile photo, expertise, and the Publisher status message. These are stored with other WebCenter data in the WebCenter Repository.




	
See Also:

For information about WebCenter Spaces and the LDAP identity store, see "Configuring the Identity Store" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.












6.4.3 Configuring the People Connections Service for WebCenter Spaces

This section steps you through the process of setting application-wide values for People Connections features. It includes the following subsections:

	
Section 6.4.3.1, "Accessing People Connections Administrative Settings"


	
Section 6.4.3.2, "Configuring Activity Stream"


	
Section 6.4.3.3, "Configuring Connections"


	
Section 6.4.3.4, "Configuring Profile"


	
Section 6.4.3.5, "Configuring Message Board"


	
Section 6.4.3.6, "Configuring Feedback"






6.4.3.1 Accessing People Connections Administrative Settings

To access People Connections administrative settings:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, Services, and then select People Connections.

Alternatively, use the following URL, and then select People Connections:


http://host:port/webcenter/spaces/admin/services


Tabs with the names of People Connections features appear to the right (Figure 6-4).


Figure 6-4 Configuration Settings for the People Connections Service

[image: Configuration settings for People Connections service]













6.4.3.2 Configuring Activity Stream

Activity Stream provides a means of publishing and tracking users' application activity. Activity Stream configuration settings specify from which users and services activities are streamed, who can see a user's streamed activities, and whether liking and commenting is available on each streamed activity (Figure 6-5).


Figure 6-5 Configuration Options for Activity Stream

[image: Configuration options for Activity Stream]






Who can view a user's activities and the types of activities tracked depend on Activity Stream configuration. Table 6-2 lists the types of activities that may be tracked by Activity Stream.


Table 6-2 Activities Tracked by Activity Stream

	Service	Tracked Activities	Scope	Activities Shared or Private
	
Announcements

	
	
Create announcement


	
Edit announcement




	
Space


	
Shared with other Space members


	
Blogs

	
	
Create blog


	
Update blog




	
	
Space


	
Home Space





	
	
Activities on Space blogs are shared with other Space members.


	
Activities on Home Space blogs are shared with the blogger's connections.





	
Connections

	
	
Invitations to connect


	
People are connected




	
Home Space


	
Shared with invitor and invitee's connections


	
Discussions

	
	
Create forum


	
Create topic


	
Reply to topic




	
Space


	
Shared with other Space members


	
Documents

	
	
Create document


	
Edit document


	
Add tag


	
Remove tag




	
	
Space


	
Home Space





	
	
Activities on Space documents are shared with other Space members.


	
Activities on Home Space documents are private to user.





	
Feedback

	
	
Feedback left


	
Feedback received




	
Home Space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 33.2, "Setting Message Board and Feedback Preferences."


	
Lists

	
	
Create a list


	
Add a row to a list


	
Edit a list row




	
Space


	
Shared with other Space members


	
Message Board

	
	
Message left


	
Message received




	
Home Space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 33.2, "Setting Message Board and Feedback Preferences."


	
Pages

	
	
Create page


	
Edit page


	
Add tag


	
Remove tag




	
	
Space


	
Home Space





	
	
Activities on Space pages are shared with other Space members.


	
Activities on Home Space pages are private to user.





	
Profiles

	
	
Photo updated


	
Profile updated


	
Personal status note updated




	
Home Space


	
Shared with whomever is permitted to view such activities (for more information, see this section and Section 30.3, "Setting Profile Preferences."


	
Space Events

	
	
Create an event


	
Edit an Event




	
Space


	
Shared with other Space members


	
Spaces Management

	
	
Create Space


	
Join Space




	
Space


	
Shared with other Space members


	
Tagging

	
	
Add tag


	
Remove tag




	
Space


	
	
Activities in a Space are shared with all Space members.


	
Activities in a Home Space are shared with whomever is permitted to view such activities (for more information, see Section 6.4.3.2, "Configuring Activity Stream," and Section 32.2, "Setting Activity Stream Preferences").











Activity Stream configuration falls under the following categories:

	
People—For determining whose activities to show, either the current user's or both the current user and the user's connections.


	
Spaces—For determining whether to show activities from all available Spaces or just the Home Space.


	
Service Categories—For selecting the services from which to report activities and enabling users to override these default selections in their personal preferences or preventing users from overriding.


	
Privacy—For selecting who may see the current user's activities.


	
Comments and Likes—For enabling users to comment on a posted activity and express a liking for a posted activity




To configure Activity Stream for all users:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Activity Stream tab to bring it forward.


	
Expand the People node, and select whose activities to show:

	
Only Me—Show only the current user's activities in his or her view of the Activity Stream.


	
Me and My Connections—Show the current user's activities and the activities of that user's connections in his or her view of the Activity Stream.


	
No Personal—Omit all activities streamed from Home Spaces in the current user's view of his Activity Stream.





	
Expand the Spaces node, and select to show activities from all available Spaces (All Spaces) or just the user's Home Space (No Spaces).


	
Expand the Service Categories node, and select the services from which to publish activity.




	
Note:

The activities of services that are not selected are still tracked, but they do not appear in the Activity Stream. If you select to show the service activities at some later point, all of the activities that occurred when the service was not selected now appear in the Activity Stream.







Table 6-2 lists the activities tracked by the Activity Stream.


	
Optionally, select Allow Owner Override to enable users to override a setting for a given service through their personal preferences.

Clear this checkbox to prevent users from overriding the application defaults you set here.


	
Expand the Privacy node, and specify who can view the current user's activities as well as whether the user can override this setting in their personal preferences.

Table 6-3 lists and describes each option.


Table 6-3 Activity Stream Privacy Options

	Option	Description
	
Allow all of my activities to be viewed by

	
Specify who can view another user's activities

Choose from:

	
Everyone—Any user, whether logged in or not, can view other users' activities.


	
Authenticated Users—Users who have logged in can view other users' activities.


	
My Connections—User A can view user B's activities if user B has accepted user A as a connection. User A can also view user A's activities.


	
Myself—Only user A can view user A's activities.





	
Allow Owner Override

	
Enable users to override the application default settings using their own People Connections Preferences (for more information, see Section 32.2, "Setting Activity Stream Preferences").








	
Expand the Likes and Comments node, and specify whether liking and commenting are allowed:

	
Select Enable comments on objects in the Activity Stream to enable users to comment on a given Activity Stream item. Clear the checkbox to prevent users from commenting.


	
Select Enable others to like objects in the Activity Stream to enable users to express a liking for an Activity Stream item. Clear the checkbox to prevent users from commenting.







	
Tip:

Users can like and comment on streamed items that include objects. For example, users can like or comment on "Jack has updated doc.xml," but cannot like or comment on "Jack and Jill are now connected."
For additional information about liking and commenting, see Chapter 34, "Liking, Commenting On, and Sharing Objects."










	
Click Apply to save your configuration settings.









6.4.3.3 Configuring Connections

Connections configuration involves specifying who can view another user's connections and whether users accept invitations to connect automatically (Figure 6-6).


Figure 6-6 Configuration Settings for Connections

[image: Configuration settings for Connections]






To configure Connections:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Connections tab to bring it forward.

Table 6-4 lists and describes each option.


Table 6-4 Connections Configuration Options

	Option	Description
	
Grant View Access to

	
Classes of users to whom to grant automatic view access to a user's connections

The users you select can view and interact with another user's connections.

Choose from:

	
Everyone—All users, including users who are not logged in, can see other users' connections.


	
Authenticated users—Only users who are logged in can see other users' connections.


	
User's Connections—Only the user and the user's connections can see the user's connections.


	
User Only—Only a user can see his or her own connections.





	
Allow Owner Override

	
Option to allow or prohibit users from overriding the administrator View access setting:

	
Select to allow users to override the administrative View access setting specified here using their personal Preferences (for more information, see the "Setting People Connections Preferences" section in the Oracle Fusion Middleware User's Guide for Oracle WebCenter Spaces).


	
Clear to prohibit users from overriding the administrative View access setting.





	
Accept Invitations Automatically

	
	
Select to specify that, by default, all invitations to connect are accepted automatically.


	
Clear to specify that, by default, a user must explicitly accept or reject invitations to connect.











	
Click Apply to save your configuration settings.









6.4.3.4 Configuring Profile

Every authenticated WebCenter user has a profile that displays personal information, such as the user's email address, phone number, office location, department, manager, direct reports, and so on. All but three attributes are stored and read from the LDAP identity store that is configured against WebCenter Spaces. The three exceptions include the Profile photo and expertise and Publisher status messages.

Use administrative configuration settings for Profile to specify whether users are allowed to change their application passwords, which profile sections display, whether users are allowed to update their profile details, and the profile attributes that users may update (Figure 6-7).


Figure 6-7 Configuration Settings for Profile
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Personal profiles are presented in four sections: Summary, Employee, Business Contact, Personal Information. Each section provides information related to the section heading. For example, Summary includes a collection of basic details, such as the user's name, email address, and office location.

In configuration settings, the access setting for the Summary section controls who can search for the user in WebCenter Spaces (for example, through global search, people pickers, and the searches one uses to find and invite other users to connect). For example, if Everyone is allowed to view the Summary section, then the user can be searched for by unauthenticated (public) users. If only Authenticated Users can view another user's Summary section, then only logged in users can search for the user. If None is the selected value for Who can view this section, then the user will not appear in search results.

The Summary section is the only Profile section for which the privacy setting cannot be changed by the end-user through Preferences (for more information, see Section 30.3, "Setting Profile Preferences"). It is controlled at a global level for all users through the settings described in this section.

It is the administrator's job to specify the information to show in each section and determine whether users are allowed to edit their profile data and their application password within WebCenter Spaces.




	
Note:

Whether users can enter edit mode in the Profile task flow is affected by administrative settings (Can Edit); however, whether users can enter edit mode on the About subpage of the My Profile page is not affected. The Edit button is always available on the default version of the About subpage.
Note also that Administrative settings do affect which sections appear on the About subpage (and in the Profile task flow) and whether users can change given details in each section.









To configure Profile:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Profile tab to bring it forward.

Table 6-5 lists and describes each option.


Table 6-5 Profile Configuration Options

	Option	Description
	
Allow Password Change

	
Specify whether users are allowed to change their application password

	
Select to enable users to change their application password.


	
Clear to prevent users from changing their application password. This option is useful when your organization provides a single, separate application for managing user credentials and, consequently, prefers not to offer password management through each application.





	
Profile Access

	
Specify which Profile sections to show and whether users are allowed to update their profile details

Set application defaults in the following table columns:

Profile Section—Identifies the groups of information shown in a user profile.

View Settings—Specify which users can view a particular profile section, and indicate whether users can change these defaults in their personal Preferences.

View Settings for the Summary section control not only who can view summary details but also for whom the user appears in people search results.

Set values for:

	
Who can view this section—Specify which class of users can view the associated profile section by default. Choose from:

User's Connections—The users to whom the current user is connected can see the associated profile section in other users' profiles. This option is available for all sections except Summary.

Everyone—All users, including users who are not logged in, can see the associated profile section in other users' profiles.

Authenticated users—Only users who are logged in can see the associated profile section in other users' profiles.

User Only—Only the user can see his or her own details in the associated profile section.

None—The section is hidden from all users.


	
Allow Owner Override—Enable or disable users' from overriding the default application settings you specify here. Select to enable; clear to disable.




Can Edit—Select to enable users to edit the associated profile section of their own personal profiles; clear to prohibit users from editing the associated profile section.

This setting also controls whether an Edit link appears in the Profile task flow, but it does not affect the appearance of the Edit button on the default version of the My Profile About subpage. On the default version of the About subpage, the Edit button always appears, though you can use the other Profile administrative settings to prohibit users from actually changing any Profile details.


	
Profile Attributes - Edit Settings

	
Indicate the section attributes that users are allowed to edit by default

Under Allow Update:

	
Select an attribute to enable users to edit its value in their own profiles.


	
Clear an attribute to prohibit users from editing it in their own profiles.











	
Click Apply to save your configuration settings.









6.4.3.5 Configuring Message Board

Message Boards provide users with a means of viewing and posting messages to their connections. Configuration settings for Message Board provide controls for who can view and post messages, who can edit and delete the messages they leave, who can delete and change the visibility of messages they receive, and whether commenting and liking are available on each message (Figure 6-8).


Figure 6-8 Configuration Settings for Message Board
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See Also:

For information about likes and comments, see Chapter 34, "Liking, Commenting On, and Sharing Objects."







To configure Message Board:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Message Board tab to bring it forward.

Table 6-6 lists and describes each option.


Table 6-6 Message Board Configuration Options

	Option	Description
	
Grant View Access to

	
Specify who can view Message Board messages.

	
Everyone—All users, whether logged in or not, can see users' Message Board messages.


	
Authenticated Users—Only logged in users can see users' Message Board messages.


	
User's Connections—Only the user and the user's connections can view the user's Message Board.


	
User Only—Only the user can see the messages on his or her Message Board.





	
Grant Post Access to

	
Specify who can post Message Board Messages.

	
Everyone—All users, whether logged in or not, can post Message Board messages.


	
Authenticated Users—Only logged in users can post messages to Message Boards.


	
User's Connections—Only the user and the user's connections can post messages to the user's Message Board.


	
User Only—Only the user can post messages to his or her Message Board.





	
Allow Owner Override

	
Specify whether users can override these administrative defaults.

	
Select to enable users to edit the default settings through user Preferences (for more information, see the "Setting People Connections Preferences" section in the Oracle Fusion Middleware User's Guide for Oracle WebCenter Spaces).


	
Clear to enforce the administrator default application settings.





	
Enable users to act on messages they post on other Message Boards

	
Specify whether users are allowed to act on the messages they post.

	
Edit message—Select to enable users to edit their own Message Board posts; clear to prohibit users from editing the messages they post.


	
Delete message—Select to enable users to delete their own Message Board posts; clear to prohibit users from deleting the messages they post.





	
Enable users to act on messages they receive from others

	
Specify whether users can act on messages they receive from others

	
Delete message—Select to enable users to delete messages they receive from other users; clear to prohibit users from deleting the messages they receive.


	
Change the visibility of the message—Select to enable users to hide or show the messages from a given user; clear to prohibit users from hiding or showing messages.





	
Enable commenting on messages from Message Board

	
Specify whether users can comment on messages that are posted on a Message Board.

	
Select to permit users to so comment. A Comment link appears below each message. Users click this to enter a comment. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Clear to prohibit commenting.





	
Enable liking of messages from Message Board

	
Specify whether to enable users to indicate that they like a message.

	
Select to permit users to click a Like link on a given message. For more information, see Chapter 34, "Liking, Commenting On, and Sharing Objects."


	
Clear to prohibit liking.











	
Click Apply to save your configuration settings.









6.4.3.6 Configuring Feedback

Feedback provides a means of viewing and posting user feedback for other application users. Configuration settings for Feedback (Figure 6-9).


Figure 6-9 Configuration Settings for Feedback
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Feedback configuration settings offer controls for identifying who can view, post, and delete feedback.

To configure Feedback:

	
Access People Connections administrative settings as described in Section 6.4.3.1, "Accessing People Connections Administrative Settings."


	
Click the Feedback tab to bring it forward.

Table 6-7 lists and describes each option.


Table 6-7 Feedback Configuration Options

	Option	Description
	
Grant View Access to

	
Specifies who can view the current user's Feedback

	
Everyone—All users, whether logged in or not, can see a given user's Feedback.


	
Authenticated Users—Only users who are logged in can see a given user's Feedback.


	
User's Connections—Only the user and the user's connections can see a given user's Feedback.


	
User Only—Disables other users from viewing a given user's Feedback.





	
Grant Post Access to

	
Specifies who can post user Feedback

	
Everyone—All users, whether logged in or not, can post Feedback for a given user.


	
Authenticated Users—Only logged in users can post Feedback for a given user.


	
User's Connections—Only the user and the user's connections can post Feedback for a given user.


	
User Only—Users can post Feedback only for themselves. Effectively disables Feedback.





	
Grant View Feedback Given Access to

	
Specifies who can see the View menu to switch between Feedback Given and Feedback Received in a Feedback task flow

	
Everyone—All users, whether logged in or not, can see the options on the View menu.


	
Authenticated Users—Only logged in users can see the options on the View menu.


	
User's Connections—Only the user and the user's connections can see the View menu.


	
User Only—Disables the View menu for all but the current user. When users visit the current user's Feedback task flow, they can view only the Feedback the current user has received.





	
Allow Owner Override

	
Specifies whether users can override these administrative defaults

	
Select to enable users to revise application default settings through user Preferences (for more information, see Section 33.2, "Setting Message Board and Feedback Preferences").


	
Clear to prevent users from altering administrator settings for Feedback.





	
Enable users to act on the feedback given to others

	
Indicates whether users can delete the Feedback they post

	
Select Delete Feedback to enable users to delete the Feedback they post.


	
Clear Delete Feedback to prohibit users from deleting the Feedback they post.





	
Enable owner of the feedback to act on feedback posted by others

	
Indicate whether to enable users to hide or show Feedback from another user.

	
Select Change the visibility of the feedback to enable users to hide or show the Feedback from another user.


	
Clear Change the visibility of the feedback to prohibit users from hiding or showing Feedback left by others.











	
Click Apply to save your configuration settings.











6.4.4 Archiving the Activity Stream Schema

As the application administrator, you can use WLST commands to archive and restore data in the Activity Stream schema. The following commands are available:

	
archiveASByDate—Archive activity stream data that is older than a specified date.


	
archiveASByDeletedObjects—Archive activity stream data associated with deleted objects.


	
archiveASByClosedSpaces—Archive activity stream data associated with Spaces that are currently closed.


	
archiveASByInactiveSpaces—Archive activity stream data associated with Spaces that have been inactive since a specified date.


	
restoreASByDate—Restore archived activity stream data from a specified date into production tables.




For more information, see the section, "Activity Stream," in Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.






6.4.5 Troubleshooting Issues with the People Connections Service

This section identifies the types of problems that may occur with each People Connections feature and provides suggestions for how to respond to them. It includes the following subsections:

	
Section 6.4.5.1, "Troubleshooting Activity Stream"


	
Section 6.4.5.2, "Troubleshooting Connections"


	
Section 6.4.5.3, "Troubleshooting Profile"


	
Section 6.4.5.4, "Troubleshooting Message Board"


	
Section 6.4.5.5, "Troubleshooting Feedback"






6.4.5.1 Troubleshooting Activity Stream

Table 6-8 lists problems and responses for troubleshooting Activity Stream in WebCenter Spaces.


Table 6-8 Activity Stream Errors and Responses

	Problem	Response
	
Unexpected error or exception

	
Contact Oracle Support Services.


	
Connections exception is thrown

	
Check the exception's detail for an explanation of the exception.


	
Service Framework exception is thrown

	
Check the exception's detail for an explanation of the exception.


	
Settings exception is thrown

	
Check the exception's detail for an explanation of the exception.


	
Property value entered is not reflected in task flow

	
An invalid value may have been entered for the task flow property. In such cases, the default value is used. Ensure that task flow properties have valid values. For more information, see the chapters covering features associated with the People Connections service in Part IX, "Organizing Your Collaborative and Social Networking Environment".


	
Database exception in EclipseLink module

	
Contact Oracle Support Services.


	
Query exception in EclipseLink module

	
Contact Oracle Support Services.


	
Unable to publish analytics event

	
Contact Oracle Support Services.


	
Operation not supported

	
Contact Oracle Support Services.


	
Cannot retrieve user Profile information

	
Contact Oracle Support Services.


	
Check for valid repository failed

	
Either the database is down or the WebCenter repository is not installed. Check the exception's detail for an explanation of the exception, and respond accordingly.


	
Activity exception during bulk publish

	
Check the individual activity exception's detail for an explanation of the exception.












6.4.5.2 Troubleshooting Connections

Table 6-9 lists problems and responses for troubleshooting Connections in WebCenter Spaces.


Table 6-9 Connections Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
User name null or blank

	
Supply a valid user name.


	
Could not find user name

	
Supply a valid user name.


	
Connection list name not specified

	
An invalid value may have been entered for the task flow property. Ensure that task flow properties have valid values. For more information, see the chapters covering features associated with the People Connections service in Part IX, "Organizing Your Collaborative and Social Networking Environment".


	
Insufficient privileges

	
Contact the WebCenter Spaces administrator, and request the required permission.


	
Cannot invite oneself as a connection

	
Supply a user name other than your own.


	
Cannot invite a user who has been invited

	
Wait for the invited user to act on your invitation.


	
Cannot invite a user who has invited you

	
Accept the invitation you have received from the user.


	
Cannot invite a user to whom you are connected

	
Supply a user name other than that of your existing connection.












6.4.5.3 Troubleshooting Profile

Table 6-10 lists problems and responses for troubleshooting Profile in WebCenter Spaces.


Table 6-10 Profile Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
Personal status message cannot be changed

	
Only you can change your personal status message.


	
User cannot view Profile.

	
Contact the WebCenter Spaces administrator, and request the required permission.


	
User cannot edit Profile.

	
Contact the WebCenter Spaces administrator, and request the required permission.


	
User was not specified

	
The supplied user name was null or blank. Enter a valid user name.


	
Modifying property is not allowed

	
The task flow property may be read-only. In this case, you cannot supply a value.


	
Error getting an Instant Message address

	
Contact the WebCenter Spaces administrator.


	
Error getting tag data

	
Contact the WebCenter Spaces administrator.


	
Tried to upload an invalid image

	
Try again with a valid image type. The file must have the mime-type image, and cannot have the extension *.ico.


	
Error instantiating object

	
Contact the WebCenter Spaces administrator.


	
Error instantiating Profile

	
Contact Oracle Support Services.












6.4.5.4 Troubleshooting Message Board

Table 6-11 lists problems and responses for troubleshooting Message Board in WebCenter Spaces.


Table 6-11 Message Board Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
Failed to create an instance of Message Board

	
Make sure the user is logged in.


	
Failed to persist Message Board message

	
Contact Oracle Support Services.


	
Failed to publish Message Board activity

	
Verify the reason for the failure in the Activity Stream subsystem.


	
Message Board message cannot be deleted

	
The WebCenter Spaces administrator must explicitly allow users to delete the messages they send. Contact the application administrator, and request the required permission. For more information, see Section 6.4.3.5, "Configuring Message Board."


	
Message Board message cannot be updated

	
Contact the WebCenter Spaces administrator, and request the required permission.


	
Message Board message cannot be added

	
Message content is empty. Enter message content, and try again. Otherwise, contact Oracle Support Services.


	
Message Board message cannot be hidden

	
User does not have permission to hide the message. You can hide only those messages you receive, and not the ones you send.


	
Failed to query preferences for Message Board

	
Contact Oracle Support Services.












6.4.5.5 Troubleshooting Feedback

Table 6-12 lists problems and responses for troubleshooting Feedback in WebCenter Spaces.


Table 6-12 Feedback Errors and Responses

	Problem	Response
	
Unexpected errors or exceptions

	
Contact Oracle Support Services.


	
Failed to create an instance of Feedback

	
Make sure the user is logged in.


	
Failed to persist Feedback message

	
Contact Oracle Support Services.


	
Failed to publish Feedback activity

	
Verify the reason for the failure in the Activity Stream subsystem.


	
Feedback cannot be deleted

	
The WebCenter Spaces administrator must explicitly allow users to delete the Feedback they post. Contact the application administrator, and request the required permission. For more information, see Section 6.4.3.6, "Configuring Feedback."

Otherwise, contact Oracle Support Services.


	
Feedback cannot be updated

	
Contact the WebCenter Spaces administrator, and request the required permission.


	
Feedback cannot be added

	
Feedback content is empty. Enter Feedback content, and try again. Otherwise, contact Oracle Support Services.


	
Feedback cannot be hidden

	
User does not have permission to hide the Feedback. You can hide only the Feedback you receive; you cannot hide the Feedback you give.


	
Failed to query preferences for Feedback

	
Contact Oracle Support Services.
















6.5 Registering Portlet Producers

A portlet producer is the object that owns portlets and makes them available to applications. To make a portlet available in WebCenter Spaces, you must register the portlet's producer with WebCenter Spaces.

This section includes the following subsections:

	
Section 6.5.1, "What You Should Know About Registering Portlet Producers"


	
Section 6.5.2, "Registering Portlet Producers Through WebCenter Administration"


	
Section 6.5.3, "Working with the Producer Registration Task Flow"


	
Section 6.5.4, "Deregistering Portlet Producers"






6.5.1 What You Should Know About Registering Portlet Producers

To be able to register and manage portlet producers in WebCenter Spaces, a user must be assigned the AppConnectionManager role. By default, users with the WebCenter Spaces Administrator role are assigned this role; and therefore, WebCenter Spaces administrators can configure portlet producers.

You can grant any other user this capability through Fusion Middleware Control or using the WLST command grantAppRole. For example, the following grantAppRole WLST command grants the AppConnectionManager role to the user monty.


grantAppRole(appStripe='webcenter', appRoleName='AppConnectionManager',  principalClass='weblogic.security.principal.WLSUserImpl', principalName='monty')


For more information about this command, see the section "grantAppRole" in the Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.




	
See Also:

"Granting Application Roles Using Fusion Middleware Control" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.












6.5.2 Registering Portlet Producers Through WebCenter Administration

To register portlet producers through WebCenter Administration, you must have the following roles and permissions:

	
AppConnectionManager role—Enables you to manage portlet producers. See the section "Granting Application Roles Using Fusion Middleware Control" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
Application - Manage Configuration permission—Enables access to the WebCenter Administration page. See Chapter 21, "Managing Users, Roles, and Permissions."




You can register portlet producers in WebCenter Spaces using WebCenter Spaces Administration. You can also add the Portlet Producer task flow to any page in WebCenter Spaces to enable users with administration privileges to register portlet producers.

This section includes the following subsection:

	
Section 6.5.2.1, "Registering a WSRP Producer."


	
Section 6.5.2.2, "Registering an Oracle PDK-Java Producer."


	
Section 6.5.2.3, "Registering a Pagelet Producer."






6.5.2.1 Registering a WSRP Producer

When you register a WSRP portlet producer, you provide basic information that describes the producer's operational parameters. This information is used by WebCenter Spaces to communicate with the producer and with the portlets through the producer.

Oracle WebCenter Framework supports both WSRP 1.0 and WSRP 2.0 producers. The WSRP 2.0 standard, among others, provides support for inter-portlet communication and export and import of portlet customizations. You can leverage the benefits of WSRP 2.0 while building standards-based JSR 286 portlets.

To register a WSRP producer with WebCenter Spaces:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
From the menu bar, click Register.


	
In the Register Portlet Producer page, in the Name and Type section, enter basic information for the portlet producer. See Table 6-13.


Table 6-13 WSRP Producer Registration - Name and Type

	Field	Description
	
Producer Name

	
Enter a unique name to identify this portlet producer registration within WebCenter Spaces. The name must be unique across all connection types within the WebCenter application.


	
Producer Type

	
Select WSRP Producer.








	
In the Portlet Producer URL section, enter connection details for the WSRP producer. See Table 6-14.


Table 6-14 WSRP Portlet Producer Registration - Portlet Producer URL

	Field	Description
	
WSDL URL

	
Enter the registration URL for the WSRP portlet producer.

The syntax varies according to your WSRP implementation. For example, possible URL formats for a portlet deployed to the Oracle WSRP container include:


http://host:port/context_root/portlets/wsrp2?WDSL
http://host:port/context_root/portlets/wsrp1?WSDL
http://host:port/context_root/portlets/?WSDL


where:

	
host is the server where the producer is deployed


	
port is the HTTP Listener port


	
context_root is the Web application's context root




In WebCenter Spaces, only v2 WSDLs are supported for Oracle WebLogic Portal Producers.


	
Use Proxy?

	
Select if WebCenter Spaces and the remote portlet producer are separated by a firewall and must use an HTTP proxy for communication. If selected, enter values for Proxy Host and Proxy Port.


	
Proxy Host

	
Enter the address for the proxy server.

Do not prefix http:// to the proxy server name.


	
Proxy Port

	
Enter the port number on which the proxy server listens. The default port is 80.








	
In the Advanced Configuration section, specify additional information for the WSRP producer. See Table 6-15.


Table 6-15 WSRP Portlet Producer Registration - Advanced Configuration

	Field	Description
	
Default Execution Timeout

	
Enter a suitable timeout for design time operations. For example, the maximum time the producer may take to register, deregister, or display portlets on WebCenter pages. The default is 30 seconds.

Individual portlets may define their own timeout period, which takes precedence over the value specified here.








	
In the Security section, from the Token Profile dropdown list, select the type of security token to use for the identity propagation/assertion. The other fields in this section vary depending on the security token selected. See Table 6-16.

The security token with the propagated or asserted user information is represented as an XML element in the SOAP header. The security token and the SOAP message body are then digitally signed to prove the authenticity of the SOAP message origin from the WebCenter application. WebCenter Spaces supports six types of security tokens: WSS 1.0 Username Token Without Password, WSS 1.0 Username Token With Password, WSS 1.0 SAML Token, WSS 1.0 SAML Token With Message Integrity, WSS 1.0 SAML Token With Message Protection, and WSS 1.1 SAML Token With Message Protection.


Table 6-16 WSRP Portlet Producer Registration - Security

	Field	Description
	
Token Profile

	
Select the type of token profile to use for authentication with this WSRP producer:

	
None—No security on this connection. If you select None, no WS-Security header is attached to the SOAP message.


	
WSS 1.0 SAML Token—This policy provides SAML-based authentication for outbound SOAP request messages in accordance with the WS-Security 1.0 standard. The policy propagates user identity and is typically used in intra departmental deployments where message protection and integrity checks are not required.

This policy does not require any keystore configuration.


	
WSS 1.0 SAML Token with Message Integrity—This policy provides message-level integrity protection and SAML-based authentication for outbound SOAP requests in accordance with the WS-Security 1.0 standard. A SAML token, included in the SOAP message, is used in SAML-based authentication with sender vouches confirmation. This policy uses WS-Security's Basic 128 suite of asymmetric key technologies and SHA-1 hashing algorithm for message integrity.


	
WSS 1.0 SAML Token with Message Protection—This policy provides message-level protection (integrity and confidentiality) and SAML-based authentication for outbound SOAP requests in accordance with the WS-Security 1.0 standard. The Web service consumer includes a SAML token in the SOAP header and the confirmation type is sender-vouches. This policy uses WS-Security's Basic 128 suite of asymmetric key technologies. Specifically, RSA key mechanisms for message confidentiality, SHA-1 hashing algorithm for message integrity, and AES-128 bit encryption.

When you select this policy, you must also specify the Recipient Alias.


	
WSS 1.0 Username Token with Password—This policy provides username (with password) token profile based identity propagation with certificate based message protection for outbound SOAP requests in accordance with the WS-Security v1.0 standard. Both plain text and digest mechanisms are supported. This policy uses WS-Security's Basic128 suite of asymmetric key technologies. Specifically, RSA key mechanism for message confidentiality, SHA-1 hashing algorithm for message integrity, and AES-128 bit encryption.

Use this token profile if the WSRP producer has a different identity store. You must define an external application pertaining to the producer and associate the external application with this producer. The external application defined here is used to retrieve and propagate the user credentials to the producer. The producer verifies this against the identity store configured for the external application.

When you select this policy, you must also specify the Recipient Alias.





	
Token Profile (Cont.)

	
	
WSS 1.0 Username Token without Password—This policy provides username (with password) token profile based identity propagation with certificate based message protection for outbound SOAP requests in accordance with the WS-Security 1.0 standard. Credentials (username only) are included in outbound SOAP request messages through a WS-Security UsernameToken header. No password is included. Message protection is provided using WS-Security 1.0's Basic128 suite of asymmetric key technologies. Specifically, RSA key mechanisms for message confidentiality, SHA-1 hashing algorithm for message integrity, and AES-128 bit encryption.

When you select this policy, you must also specify the Recipient Alias.


	
WSS 1.1 SAML Token with Message Protection—This policy provides message-level protection (integrity and confidentiality) and SAML token population for outbound SOAP requests in accordance with the WS-Security 1.1 standard. A SAML token, included in the SOAP message, is used in SAML-based authentication with sender vouches confirmation. This policy uses the symmetric key technology for signing and encryption, and WS-Security's Basic128 suite of asymmetric key technologies for endorsing signatures.





	
Recipient Alias

	
Specify the key store alias that is associated with the producer's certificate.

This certificate is used to encrypt the message to the producer.

Valid for: WSS 1.0 SAML Token With Message Protection, WSS 1.1 SAML Token with Message Protection and WSS 1.0 Username Without Password.


	
Default User

	
Enter a user name to assert to the remote producer when the user is not authenticated with WebCenter Spaces.

When unauthenticated, the identity anonymous is associated with the application user. OWSM does not currently support the propagation of an anonymous identity, so you must specify an alternative identity here. Keep in mind though, that in this case, the WebCenter Spaces application has not authenticated the user so the default user you specify should be a low privileged user in the remote producer that is an appropriate identity to use for showing public content. For example, you may want to create a guest account in the identity store for this purpose. If the user has authenticated to the application, then the user's identity is asserted rather than the default user.

The remote WSRP producer must be set up to accept this information. You must also add a grant to the policy store as described in the section "Adding a Grant to the Policy Store for a Mapped User Identity" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.

Valid for: WSS 1.0 SAML Token With Message Integrity, WSS 1.0 SAML Token With Message Protection, WSS 1.0 SAML Token, WSS 1.1 SAML Token with Message Protection and WSS 1.0 Username Without Password.


	
Associated External Application

	
If this producer uses an external application for authentication, use the Associated External Application dropdown list to identify the application.

An external application is required to support producers using the security option WSS 1.0 Username Token With Password. The external application stores and supplies the user credentials. See also Section 6.6, "Registering External Applications."

Valid for: WSS 1.0 Username With Password only.








	
Click Test to test the registration.


	
Click Ok.









6.5.2.2 Registering an Oracle PDK-Java Producer

When you register a PDK-Java portlet producer, you provide basic information that describes the producer's operational parameters. This information is used by WebCenter Spaces to communicate with the producer and with the portlets through the producer.

To register an Oracle PDK-Java portlet producer with WebCenter Spaces:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
From the menu bar, click Register.


	
In the Register Portlet Producer page, in the Name and Type section, enter basic information for the portlet producer. See Table 6-17.


Table 6-17 PDK-Java Portlet Producer Registration - Name and Type

	Field	Description
	
Producer Name

	
Enter a unique name to identify this portlet producer registration within WebCenter Spaces. The name must be unique across all connection types within the WebCenter application.


	
Producer Type

	
Select Oracle PDK-Java Producer.








	
In the Portlet Producer URL section, enter connection details for the Oracle PDK-Java producer. See Table 6-18.


Table 6-18 PDK-Java Portlet Producer Registration - Portlet Producer URL

	Field	Description
	
URL Endpoint

	
Enter the Oracle PDK-Java producer's URL using the following syntax:


http://host:port/context_root/providers


where:

	
host is the server where the producer is deployed


	
port is the HTTP Listener port number


	
context_root is the Web application's context root





	
Service ID

	
Enter the unique identifier for this producer.

PDK-Java enables you to deploy multiple producers under a single adapter servlet. Producers are identified by their unique service ID. A service ID is required only if the service ID is not appended to the URL Endpoint.

The service ID is used to look up a file called serviceId.properties, which defines the characteristics of the portlet producer, such as whether to display its test page. If you do not specify a service ID, the _default.properties file is used instead.


	
Use Proxy?

	
Select if the WebCenter application and the remote portlet producer are separated by a firewall and must use an HTTP proxy for communication. If selected, enter values for Proxy Host and Proxy Port.


	
Proxy Host

	
Enter the address for the proxy server.

Do not prefix http:// to the proxy server name.


	
Proxy Port

	
Enter the port number on which the proxy server listens. The default port is 80.


	
Associated External Application

	
Select the relevant external application if one of this producer's portlets requires authentication.

See also Section 6.6, "Registering External Applications."


	
Establish Session?

	
Select to enable a user session when executing portlets from this producer. When sessions are enabled, they are maintained on the producer server. This allows the portlet code to maintain information in the session.

Message authentication uses sessions, so if you specify a shared key, you must also select this option.

For sessionless communication between the producer and the server, do not select this option.








	
In the Advanced Configuration section, specify additional information for the PDK-Java producer. See Table 6-19.


Table 6-19 PDK-Java Portlet Producer Registration - Advanced Configuration

	Field	Description
	
Default Execution Timeout

	
Enter a suitable timeout for communications with the producer, in seconds. For example, the maximum time the producer may take to register, deregister, or display portlets on WebCenter pages. The default is 30 seconds.

Individual portlets may define their own timeout period, which takes precedence over the value specified here.


	
Subscriber ID

	
Enter a string to identify the consumer of the producer being registered.

When a producer is registered with an application, a call is made to the producer. During the call, the consumer (WebCenter Spaces in this instance) passes the value for Subscriber ID to the producer. If the producer does not see the expected value for Subscriber ID, it might reject the registration call.


	
Shared Key

	
Enter a shared key to use for producers that are set up to handle encryption.

The shared key is used by the encryption algorithm to generate a message signature for message authentication. Note that producer registration fails if the producer is set up with a shared key and you enter an incorrect shared key here. The shared key can contain between 10 and 20 alphanumeric characters.

This key is also used when registering a producer using the Federated Portal Adapter (FPA). The Shared Key is also known as the HMAC key.








	
Click Test to test the registration.


	
Click Ok.









6.5.2.3 Registering a Pagelet Producer

This section describes how to register a Pagelet Producer using WebCenter Spaces Administration.

To register a pagelet producer with WebCenter Spaces:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
From the menu bar, click Register.


	
In the Register Portlet Producer page, in the Name and Type section, enter basic information for the pagelet producer. See Table 6-20.


Table 6-20 Pagelet Producer Registration - Name and Type

	Field	Description
	
Producer Name

	
Enter a unique name to identify this pagelet producer registration within WebCenter Spaces. The name must be unique across all connection types within the WebCenter application.


	
Producer Type

	
Select Pagelet Producer.








	
In the Portlet Producer URL section, enter connection details for the pagelet producer. See Table 6-21.


Table 6-21 Pagelet Producer Registration - Portlet Producer URL

	Field	Description	Producer Type
	
Server URL

	
Enter the URL of the WebCenter Pagelet Producer. The URL must include a fully-qualified domain name. Use the following syntax:


protocol://host:port


For example:http://myhost.example.com:7778/ If pagelets carry secure data, the URL registered must use the HTPPS protocol. For example:https://myhost.com:7779/

In WebCenter Spaces, if the Pagelet Producer URL is protected by OAM, the URL to the pagelet catalog must be excluded (mapped directly without access control), or the catalog will appear to be empty when using REST. The pagelet catalog URL is http://proxy_host:proxy_port/api/v2/ensemble/pagelets.

	
Pagelet








	
Click Test to test the registration.


	
Click Ok.











6.5.3 Working with the Producer Registration Task Flow

To manage portlet producers through the Producer Registration task flow, you must have the following roles and permissions:

	
AppConnectionManager role—Enables you to manage portlet producers.


	
View Page permission—Enables access to the page containing the task flow. See Section 23.1, "Setting Access on a Page."




This section includes the following subsections:

	
Section 6.5.3.1, "Adding the Producer Registration Task Flow to a Page"


	
Section 6.5.3.2, "Registering Producers Through the Producer Administration Task Flow."


	
Section 6.5.3.3, "Setting Producer Task Flow Properties."






6.5.3.1 Adding the Producer Registration Task Flow to a Page

To add a Producer Registration task flow:

	
Go to the page where you want to add the task flow, and open it in Oracle Composer.

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Oracle Composer, click the Add Content button to open the Add Content dialog.


	
In the Add Content dialog, open Portlets.


	
In the Portlets folder, open Administration.


	
In the Administration folder, click the Add link next to the Producer Registration task flow. This adds the task flow to the page.


	
Click Close to exit Add Content dialog.









6.5.3.2 Registering Producers Through the Producer Administration Task Flow

When you have added the Producer Administration task flow to your page, you can register any portlet producer as described in the following tables in Section 6.5.2, "Registering Portlet Producers Through WebCenter Administration":

	
WSRP Producers

	
Table 6-13, "WSRP Producer Registration - Name and Type"


	
Table 6-14, "WSRP Portlet Producer Registration - Portlet Producer URL"


	
Table 6-15, "WSRP Portlet Producer Registration - Advanced Configuration"


	
Table 6-16, "WSRP Portlet Producer Registration - Security"





	
Oracle PDK-Java Producers

	
Table 6-17, "PDK-Java Portlet Producer Registration - Name and Type"


	
Table 6-18, "PDK-Java Portlet Producer Registration - Portlet Producer URL"


	
Table 6-19, "PDK-Java Portlet Producer Registration - Advanced Configuration"





	
Pagelet Producers

	
Table 6-20, "Pagelet Producer Registration - Name and Type"


	
Table 6-21, "Pagelet Producer Registration - Portlet Producer URL"







See also, Section 6.5.4, "Deregistering Portlet Producers."






6.5.3.3 Setting Producer Task Flow Properties

The Producer Registration task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 6-10).

Most properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components".


Figure 6-10 Producer Registration Task Flow Component Properties

[image: Description of Figure 6-10 follows]






Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties".

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events".

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components".

All properties on Display Options tab provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions".








6.5.4 Deregistering Portlet Producers

If you no longer want to use a particular producer in WebCenter Spaces, you can deregister the producer. When you deregister a producer, registration data is removed from both WebCenter Spaces and the remote producer:

	
WebCenter Spaces - The producer connection is deleted and producer metadata is also deleted.


	
Remote producer - Portlet instances are deleted (not the portlets themselves).




Portlet instances are not removed from WebCenter Spaces pages. In place of the portlet, WebCenter users see a "Portlet unavailable" message.

To deregister a portlet producer:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, click Portlet Producers.


	
Select the portlet producer that you want to remove.


	
From the menu bar, click Deregister.











6.6 Registering External Applications

An external application is any application that implements its own authentication process. Specifically, it is an application that does not take part in your WebCenter Spaces's single sign-on process. If WebCenter Spaces interacts with an application that handles its own authentication, you can associate WebCenter Spaces with an external application definition to allow for credential provisioning. In doing so, you use an external application definition to provide a means of accessing content from these independently authenticated applications. The WebCenter services such as, Mail, IMP, Documents, portlet producers associate external applications with their connections to use the user credential management feature and to connect and access content from these independently authenticated applications.

You can manage external applications through the Services tab in the WebCenter Administration page, the External Application task flow, and the Application Navigator task flow. These features are discussed in details in the following subsections:

	
Section 6.6.1, "What You Should Know About External Applications"


	
Section 6.6.2, "Registering External Applications Through WebCenter Administration"


	
Section 6.6.3, "Working with Task Flows for External Applications"


	
Section 6.6.4, "Deleting External Applications"






6.6.1 What You Should Know About External Applications

To be able to register and manage external applications in WebCenter Spaces, a user be assigned the AppConnectionManager role. By default, users with the WebCenter Spaces Administrator role are assigned this role; and therefore, WebCenter Spaces administrators can configure external applications.

You can grant any other user this capability through Fusion Middleware Control or WLST command grantAppRole. For example, the following grantAppRole WLST command grants the AppConnectionManager role to the user monty.


grantAppRole(appStripe='webcenter', appRoleName='AppConnectionManager',
principalClass='weblogic.security.principal.WLSUserImpl', principalName='monty')


For more information about this command, see the section "grantAppRole" in the Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.

See also, "Granting Application Roles Through Fusion Middleware Control" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.






6.6.2 Registering External Applications Through WebCenter Administration

To register external applications through WebCenter Administration you must have the following roles and permissions:

	
AppConnectionManager role - Enables you to manage external applications. See also, "Granting Application Roles Through Fusion Middleware Control" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
Application - Manage Configuration permission - Enables access to the WebCenter Administration page.




To register an external application for WebCenter Spaces:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages."


	
Click Configuration, then Services.


	
Under Services & Providers, select External Applications.


	
To register a new external application, click Register (Figure 6-11).


Figure 6-11 Registering External Applications

[image: Configuring External Applications]






External application options display (Figure 6-12).


Figure 6-12 Configuring External Application Connections

[image: Configuring External Application Connections]






	
Enter a unique name for the external application and a display name that WebCenter users working with this external application will see.

See also, Table 6-22.


Table 6-22 External Application Connection - Name

	Field	Description
	
Application Name

	
Enter a name to identify the application within WebCenter Spaces. The name must be unique (across all connection types) within the WebCenter application.

For example: yahoo

Note: Once registered, you cannot edit the Application Name.


	
Display Name

	
Enter a user friendly name for the application that WebCenter users will recognize. WebCenter end-users working with this external application will see the display name you specify here.

The display name must be unique across all external applications within WebCenter Spaces.

For example: My Yahoo

If you leave this field blank, the Application Name is used.








	
Enter login details for the external application.

For details, see Table 6-23.


Table 6-23 External Application Connection - Login Details

	Field	Description
	
Enable Automatic Login

	
Select to allow automatically log users in to this application. Choosing this option requires you to complete the Login URL, HTML User ID Field Name, and HTML User Password Field Name fields

With automated single sign-on, the user directly links to the application and is authenticated automatically, as their credentials are retrieved from the credential store. Selecting this option provides the end user with a seamless single sign-on experience.

Note: Automated login is not supported for:

	
External applications using BASIC authentication.


	
External applications configured for SSO.


	
External applications with a customized login form (built using ADF Faces) that does not implement the J2EE security container login method j_security_check for authentication.


	
External sites that do not support UTF8 encoding.





	
Login URL

	
Enter the login URL for the external application.

To determine the URL, navigate to the application's login page and record the URL.

For example: http://login.yahoo.com/config/login

Note: A login URL is not required if the sole purpose of this external application is to store and supply user credentials on behalf of another service.


	
HTML User ID Field Name

	
Enter the name that identifies the "user name" or "user ID" field on the login form.

Tip: To find this name, look at the HTML source for the login page.

This property does not specify user credentials.

Note: Mandatory if the Authentication Method is GET or POST and a Login URL is specified. Leave this field blank if the application uses the basic authentication.


	
HTML User Password Field Name

	
Enter the name that identifies the "password" field on the login form.

Tip: To find this name, look at the HTML source for the login page.

Note: You must complete this field if the Authentication Method is GET or POST. Leave this field blank if the application uses basic authentication (see Authentication Method).








	
Select the authentication method used by the external application.

For details, see Table 6-24.


Table 6-24 External Application Connection - Authentication Details

	Field	Description
	
Authentication Method

	
Select the form submission method used by the external application. Choose from one of the following:

	
GET: Presents a page request to a server, submitting the login credentials as part of the login URL. This authentication method may pose a security risk because the user name and password are exposed in the URL.


	
POST: Submits login credentials within the body of the form. This is the default.


	
BASIC: Submits login credentials to the server as an authentication header in the request. This authentication method may pose a security risk because the credentials can be intercepted easily and this scheme also provides no protection for the information passed back from the server. The assumption is that the connection between the client and server computers is secure and can be trusted.




The Authentication Method specifies how message data is sent by the browser. You can find this value by viewing the HTML source for the external application's login form, for example, <form method="POST" action="https://login.yahoo.com/config/login?" AutoComplete="off">








	
Specify additional login fields and details, if required.

For details, see Table 6-25.


Table 6-25 External Application Connection - Additional Login Fields

	Field	Description
	
Additional Login Fields

	
If your application requires additional login criteria, expand Additional Login Fields.

For example, in addition to user name and password, the Lotus Notes application requires two additional fields - Host and MailFilename.

Click Add to specify an additional field for the login form. For each new field, do the following:

	
Name - Enter the name that identifies the field on the HTML login form that may require user input to log in. This field is not applicable if the application uses basic authentication.


	
Value - Enter a default value for the field or leave blank for a user to specify. This field is not applicable if the application uses basic authentication.


	
Display to User - Select to display the field on the external application login screen. If the field is not displayed (unchecked), then a default Value must be specified.




Click Delete to remove a login field.








	
Specify shared and public user credentials, if required.

For details, see Table 6-26.


Table 6-26 External Application Connection - Shared User and Public User Credentials

	Field	Description
	
Enable Shared Credentials

	
Indicate whether this external application enables shared user credentials, and specify the credentials. Select Enable Shared Credentials, and then enter User Name and Password credentials for the shared user.

When shared credentials are specified, every user accessing this external application, through WebCenter Spaces, is authenticated using the user name and password defined here. WebCenter users are not presented with a login form.

Because WebCenter users do not need to define personal credentials of their own, external applications with shared credentials are not listed in the external application's change password task flows such as My Accounts (see also Section 35.7, "Providing Login Information for External Applications".)


	
Enable Public Credentials

	
Indicate whether unauthenticated users (public users) may access this external application. Select Enable Public Credentials, and then enter User Name and Password credentials for the public user.

When public credentials are specified, public users accessing this external application through WebCenter Spaces public pages are logged in using the user name and password defined here. If public credentials are not specified, public users will see an authorization error indicating this external application is not accessible to public users.








	
Click OK to register the application.









6.6.3 Working with Task Flows for External Applications

To register external applications through an external application task flow you must have the following roles and permissions:

	
AppConnectionManager role - Enables you to manage external applications. See also, "Granting Application Roles Through Fusion Middleware Control" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
View Page permission - Enables access to the page containing the task flow. See also, Section 23.1, "Setting Access on a Page."




This section includes the following subsections:

	
Section 6.6.3.1, "Adding an External Application Task Flow to a Page"


	
Section 6.6.3.2, "Registering External Applications Through the External Application Task Flow"


	
Section 6.6.3.3, "Adding an Application Navigator Task Flow to a Page"


	
Section 6.6.3.4, "Making External Applications Available through the Application Navigator Task Flow"


	
Section 6.6.3.5, "Setting External Application Task Flow Properties"






6.6.3.1 Adding an External Application Task Flow to a Page




	
Note:

External applications links exposed in the Application Navigator task flow are not automatically removed when an external application is deleted. To prevent unsuccessful access attempts, administrators are advised to remove links to unavailable applications.







To add an External Application task flow:

	
Go to the page where you want to add a task flow, and open it in Oracle Composer.

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Oracle Composer, click the Add Content button to open the Add Content dialog.


	
In the Add Content dialog, open Portlet Administration, as shown in Figure 6-13.


Figure 6-13 Add Content dialog - Portlet Administration

[image: Add Content dialog - Portlet Administration]






	
In the Portlet Administration folder, click the Add link next to the External Application task flow.


	
In the Add Content dialog, click Close. This adds the task flow to the page, as shown in Figure 6-14.


Figure 6-14 External Application Task Flow in a Page

[image: External Application Task Flow in a Page]













6.6.3.2 Registering External Applications Through the External Application Task Flow

Once you have added the External Application task flow to your page, you can register any external application as described in the following tables in Section 6.6.2, "Registering External Applications Through WebCenter Administration":

	
Table 6-22, "External Application Connection - Name"


	
Table 6-23, "External Application Connection - Login Details"


	
Table 6-24, "External Application Connection - Authentication Details"


	
Table 6-25, "External Application Connection - Additional Login Fields"


	
Table 6-26, "External Application Connection - Shared User and Public User Credentials"




See also, Section 6.6.4, "Deleting External Applications."






6.6.3.3 Adding an Application Navigator Task Flow to a Page

The Application Navigator task flow enables centralized access to frequently used Web applications. Once links to your applications are set up, you simply click links to launch your day-to-day applications, and if necessary, supply your user name and password information.

Other WebCenter users may not want to see all the applications offered through the Applications Navigator. If this is the case, individuals may personalize their view to show only those applications they want to access.

The Applications Navigator can launch different types of application:

	
External Applications - Web-based, external applications that perform their own user authentication.


	
WebCenter Task Flows - Built-in task flows specific to WebCenter Spaces. Any of these can be launched directly from the Applications Navigator.





Before You Begin:

	
Ensure that the Application Navigator task flow is included in the Resource Catalog you will use for your page. The Application Navigator task flow is not available in the Resource Catalog by default. To add this task flow to your Resource Catalog, follow the steps described in Section 16.3.1.2, "Adding Resources" and select Task Flows from the library. The Task Flows option in the Add Resource Catalog Item dialog includes the Application Navigator task flow, as shown in Figure 6-15.


Figure 6-15 Add Resource Catalog Item

[image: Description of Figure 6-15 follows]






	
Consider the points described in Section 6.6.1, "What You Should Know About External Applications."




To add an Application Navigator task flow:

	
Go to the page in which you want to add a task flow, and open it in Oracle Composer.

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."


	
In Oracle Composer, click the Add Content button to open the Add Content dialog.


	
In the Add Content dialog, select Application Navigator, as shown in Figure 6-16, and click the Add link.


Figure 6-16 Add Content - Application Navigator

[image: Description of Figure 6-16 follows]






	
In the Add Content dialog, click Close.

This adds the task flow to the page, as shown in Figure 6-17.


Figure 6-17 Application Navigator Task Flow in a Page

[image: Description of Figure 6-17 follows]






Section 6.6.3.4, "Making External Applications Available through the Application Navigator Task Flow" describes how to add links to frequently used applications or task flows.









6.6.3.4 Making External Applications Available through the Application Navigator Task Flow

Use the Application Navigator to display links to external applications registered with WebCenter Spaces and also links to any of the built-in WebCenter task flows.

Some WebCenter users may not want to see all the applications offered through the Applications Navigator. If this is the case, individuals may personalize their view to show only those applications they want to access.

To expose an application or task flows through the Applications Navigator:

	
In the page in which you added the Application Navigator task flow, click Edit applications (spanner icon) available for the task flow.

If you do not have edit privileges you will not see this icon.


	
To add a link to an application, select the folder where you want the link to appear, and then click the green Add icon.

To add a new folder, click the New icon. To create a subfolder, expand the parent folder first.


	
Navigate to the external application or task flow you require, and click its associated Add link.

	
To navigate to a previously registered external application, expand the External Applications node, and then expand the required application.

Only registered external applications which have a Login URL defined appear in this list. If the application you want is not listed, ask your WebCenter administrator to register the application for you. See also Section 6.6.3.2, "Registering External Applications Through the External Application Task Flow".


	
To navigate to a task flow, expand the WebCenter Task Flows node. If necessary, expand one or more subfolders to access the required task flow.




If you are not sure of the exact name, enter a full or partial search term in the Search box, and then click Find to search for the application. Application names matching your search criteria are displayed.

An information message displays indicating whether the application link was successful.


	
Click OK to dismiss the message box.


	
To add another application, repeat steps 4 and 5.


	
Click OK to return to the Edit Applications dialog.

The selected application(s) appears within your chosen folder. From here, you can change the display name for the application link and set other display-related properties.


	
To edit link details for an application, highlight the row in the table and then click the Edit icon.

The Edit Application Link dialog opens.


	
Edit the link display properties, as required.

For details, see Table 6-27, "Application Link Properties":


Table 6-27 Application Link Properties

	Property	Description
	
Name

	
Enter the link text that WebCenter users will click to launch the application.


	
Location

	
(Read-only) Displays the internal name for the application or task flow.


	
Open Behavior

	
Choose how the application displays when users click the link:

	
WebCenter Tab - Application displays as a tab in WebCenter Spaces, and the application displays there. The current WebCenter Spaces context is maintained.


	
New Window - Application opens in a new browser window. The current WebCenter Spaces context is maintained. This is the default selection.


	
Current Window - Application opens in the current browser window (in place of WebCenter Spaces).





	
Type

	
(Read-only) Displays the link type: EXTAPP - External application or TASKFLOW - WebCenter task flow


	
Icon

	
Associate an icon with the application. Enter a full qualified URL or a relative URL that specifies the location of a valid icon.

The icon displays alongside the link in the Application Navigator. For best results, choose an icon that is 16 x 16 pixels.


	
Created On

	
Shows when the link was created.


	
Last Visited On

	
Shows the last time a user clicked the link.

If a link is not used very often or at all, you might consider removing it from the Application Navigator.


	
Locked

	
Indicate whether WebCenter users are allowed to show/hide the link.

Select Locked to prevent users from showing/hiding the link. Deselect Locked to let the user decide whether the link displays in their personal view. Individuals users can show or hide the link depending of whether they need access to the application from the Sidebar.


	
Visible

	
Indicate whether WebCenter users see a link to this application in the Applications pane.

Select Visible to show the link. Deselect Visible to hide the link.








	
Click OK to save.


	
Click Close to dismiss the Edit Application Link dialog.




If you choose not to lock application links, other users, including yourself, can hide/show links in the Application Navigator task flow by clicking Personalize applications (pencil icon), as shown in Figure 6-18.


Figure 6-18 Personalize Applications

[image: Description of Figure 6-18 follows]










6.6.3.5 Setting External Application Task Flow Properties

The External Application task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 6-19).

The properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components".


Figure 6-19 External Application Task Flow Component Properties

[image: Recent Activity task flow properties]






Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties".

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events".

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components".

All properties on Display Options tab provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions".








6.6.4 Deleting External Applications

To delete an external application:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages.".


	
Click Configuration, then Services.


	
Under Services & Providers, select External Applications.


	
Select the name of the external application you want to remove, and click Deregister.







	
Note:

If you also manage external applications through the Application Navigator task flow, ensure that you manually remove the external applications links added through this task flow, to prevent unsuccessful access attempts.


















Exploring the Home Space
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29 Exploring the Home Space

This chapter provides basic information to get you started in the WebCenter Spaces Home Space. It includes the following sections:


	
Section 29.1, "What You Can Do In the Home Space"



	
Section 29.2, "Registering Yourself with WebCenter Spaces"



	
Section 29.3, "Hiding, Opening, and Rearranging Pages"



	
Section 29.4, "Adjusting Your Page View"



	
Section 29.5, "Exposing a Space Page in Your View of the Home Space"



	
Section 29.6, "Renaming a Page"



	
Section 29.7, "Sending a Link to a Page"



	
Section 29.8, "Previewing and Printing an Application Page"



	
Section 29.9, "Viewing Space and Page Information"



	
Section 29.10, "Viewing Your Personal Profile Gallery"



	
Section 29.11, "Accessing WebCenter Spaces Online Help"





[bookmark: WCSUG1901]
Audience

This chapter is intended for users minimally assigned the role Authenticated-User, that is, any user who is logged in, who wants to understand basic information about WebCenter Spaces self-registration, Home Spaces, page access, and online help. To create and manage pages in a Home Space, you must be granted, minimally, Pages: Create, Edit, and Delete Pages.







	
Tip:

You can initiate many of the actions described in this chapter from a context menu that is available when pages are rendered as tabs. To access this menu, click the menu icon on the active tab (the one that is forward) or right-click an inactive tab. Options vary according to your permissions on the page; whether the page is active or inactive; whether the page is a custom, system, or business role page; and whether the page is in a Space or your Home Space.
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29.1 What You Can Do In the Home Space

[bookmark: sthref2515]Provided your portal administrator has granted you the privileges to do so, you can create pages in the Home Space, edit those pages, rename them, rearrange them, and add content to them. Such pages are for your view only, unless you specifically share them with other users.

To have page create and manage privileges in the Home Space makes almost all of the information in this guide useful to you, no matter your position in your company's hierarchy. For example, you can use the information in Chapter 38, "Creating and Managing Personal Pages," to create and manage your personal pages and to share such pages with the users you specify.







	
Note:

Application administrators may choose to prohibit the creation of personal pages in the Home Space, allowing only the display of business role pages and system pages, over which you have less control.










You can use the information in Chapter 17, "Building Pages," to add content to your pages and to configure that content.

You can use the information in Part X, "Working with Content", Part XIII, "Searching WebCenter and Other Sources", Part XV, "Services: Announcements through Links", and Part XVI, "Services: Lists through Worklist" to take advantage of the many services and their associated task flows provided out of the box.







	
Tip:

Some services are active only in Spaces other than the Home Space. These include such services as Events, Announcements, Lists, and the like.










This chapter provides a basic orientation to the types of actions you can take in the Home Space. Note that the actions discussed here and in the chapters cited earlier apply primarily to the personal pages you create in the Home Space. There are other types of pages, too, over which you have fewer default permissions.

For example, the Home Space may contain business role pages, that are provided to you by your application administrator. Business role pages are pushed to your view of the Home Space based on your assigned application role. For example, if you are part of the Sales team, there may be a business role page in your view of the Home Space that you and all the members of the Sales team can access.







	
See Also:

Section 7.1, "Working with Business Role Pages."










Additionally, there are system pages. System pages are typically utility pages that, in the Home Space, either expose your personal view onto a given service, such as the Documents page or the Activity Stream page, or provide an application-wide function, such as the Self-Registration page.







	
See Also:

Section 7.3, "Working with System Pages."










Keep in mind, though you own and operate your personal pages in the Home Space, your application administrator sees all, and can access anyone's personal pages, no matter the security settings you put in place.




[bookmark: BCGBHCFC][bookmark: WCSUG1084]

29.2 Registering Yourself with WebCenter Spaces

[bookmark: sthref2516][bookmark: sthref2517][bookmark: sthref2518][bookmark: sthref2519][bookmark: sthref2520]Your WebCenter Spaces administrator may provide the opportunity to self-register to WebCenter Spaces. Self-registration enables you to create your own login credentials and enter WebCenter Spaces from there forward as an authenticated user. The privileges of authentication are many: your own view of the Home Space, access to other features based on your assigned user role, a broader range of available interactive features, and the like.







	
Note:

Whether self-registration is available depends on how your WebCenter Spaces administrator configures your WebCenter application.










To register yourself as a WebCenter Spaces user:


	
Open the WebCenter Spaces application.

For example:


[bookmark: sthref2521][bookmark: sthref2522]http://host:port/webcenter


Where <host>:<port> refers to the host name and port number of the system where Oracle WebCenter is installed. By default, Oracle WebCenter is installed on port 8888.



	
Click the Register button on the application Welcome page (Figure 29-1).







	
Note:

Your WebCenter Spaces administrator can customize the look and feel of the Login dialog, but the information depicted in Figure 29-1 is essentially the same whatever the customization.
















	
See Also:

Advanced users can extend WebCenter Spaces by customizing, for example, where the Login dialog appears. For more information, see Section 7.3.2, "Customizing System Pages."










[bookmark: BCGEJGIH][bookmark: WCSUG1902]
Figure 29-1 The Register Button on the Welcome Page

[image: Register button on Welcome page]







	
On the resulting Self-Registration page (Figure 29-2), enter your user information:

Note that fields marked with an asterisk require a value.







	
Tip:

Your application administrator can customize the Self-Registration page, so it may not appear as depicted in Figure 29-2.










[bookmark: BCGDCGHB][bookmark: WCSUG1903]
Figure 29-2 WebCenter Spaces Self-Registration Page

[image: Self-Registration page]






[bookmark: sthref2525][bookmark: sthref2526]Before [bookmark: sthref2527][bookmark: sthref2528]you begin, you should know that the user name and password policy is set by the underlying identity store. Your application administrator may customize the Self-Registration page to include information that explains your organization's user name and password policy.


	
Enter your preferred user name in the Choose User Name field.



	
Click the Check User Name Available button to ensure the uniqueness of your chosen user name.

If the name you entered is in use, provide another user name and test that. Continue this cycle until the check assures you that your entry is unique.



	
Provide a password in the Choose Password field.



	
Reenter the password in the Re-enter Password field.



	
Enter your first name in the First Name field.



	
Enter your last name (that is, your surname) in the Last Name field.



	
Enter your company email address in the Email Address field.







	
Note:

[bookmark: sthref2529]You can create only one user account per email address.
















	
Click the Register button.

If the data you entered is accepted, a log-in dialog opens, enabling you to log in to WebCenter Spaces.







	
Note:

[bookmark: sthref2530]By default, if a user name with the same mail ID exists, when you click Register, a dialog opens informing you that the mail ID exists. The dialog includes a button for sending a message to the mail ID associated with the existing user name.
Because you are not yet authenticated, your message is sent to a public mail box, provided your application administrator has configured [bookmark: sthref2531]public mail credentials.

Note that this default behavior may be overridden by customizations provided by your portal developers.
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29.3 Hiding, Opening, and Rearranging Pages

Showing and hiding pages is a user customization. That is, such changes affect only your view of the application. Pages are not simultaneously shown or hidden in other users' application views.

The type of navigation that is in place in a given Space affects which steps you take to hide, show, open, and close that Space and its pages. Administrators and Space moderators can set up navigation as they choose. The procedures in this section are offered as examples of how to hide, show, open, and close Spaces and pages and how to rearrange page order. Your methods may differ based on your portal's navigation.

This section includes the following subsections:


	
Section 29.3.1, "Opening Spaces"



	
Section 29.3.2, "Opening Pages"



	
Section 29.3.3, "Hiding Pages"



	
Section 29.3.4, "Showing Hidden Pages"



	
Section 29.3.5, "Rearranging Page Order"





[bookmark: BCGDABFC][bookmark: WCSUG1093]

29.3.1 Opening Spaces

[bookmark: sthref2532][bookmark: sthref2533][bookmark: sthref2534][bookmark: sthref2535]Two types of Spaces may be available to you in your WebCenter Spaces portal: a Space, which is exposed to a group of users who are working toward a common goal, and a Home Space, which is for everyone (the application administrator may also provide you with options for creating and managing your own personal pages in the Home Space). This section provides examples of how to open both types of Space. It includes the following subsections:


	
Section 29.3.1.1, "Accessing the Home Space"



	
Section 29.3.1.2, "Accessing a Space"





[bookmark: BCGJGEHG][bookmark: WCSUG8236]

29.3.1.1 Accessing the Home Space

This section provides examples of how to access the Home Space. Your portal navigation may differ, and may therefore not respond to these approaches. These examples should, nonetheless, provide some ideas for how to go about this action in your own portal.

Examples of ways to access the Home Space:


	
Use the following URL:


http://host:port/webcenter/spaces/home



	
Click your user name where it appears as a link in the application, for example, Figure 29-3.

[bookmark: BCGJAFAA][bookmark: WCSUG10095]
Figure 29-3 Example of a User Name as a Link

[image: Example of user name as link]






This takes you to the My Profile page in the Home Space.
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29.3.1.2 Accessing a Space

This section provides examples of how you can access Spaces other than the Home Space. Your portal navigation may differ, and may therefore not respond to all of these approaches. These examples should, nonetheless, provide some ideas for how to go about accessing a Space in your own portal.

Examples of ways to access Spaces other than the Home Space:


	
Use the following URL:


http://host:port/webcenter/spaces/spaceName


In lieu of spaceName, enter the name of the Space.







	
See Also:

For additional URLs to use in navigating to pages, see Appendix A, "WebCenter Spaces User Interface URLs."












	
In any Space, open the Spaces Switcher menu and click the name of the destination Space, or click Browse Spaces to access the Spaces page (Figure 29-4).

[bookmark: BCGGHIBA][bookmark: WCSUG10096]
Figure 29-4 Browse Spaces Option on Spaces Switcher Menu

[image: Browse Spaces option on Spaces Switcher menu]






You can use the Search feature on this page to locate a specific Space.







	
Note:

The way that you open the Spaces Switcher menu depends on the page template in use. For example, you may open it by clicking a menu icon to the right of the Space name.



















[bookmark: BCGFBBHH][bookmark: WCSUG1090]

29.3.2 Opening Pages

[bookmark: sthref2538][bookmark: sthref2539]You have a few options for opening pages. How you proceed depends on the controls your application administrator or Space moderator has made available to you and the navigation model in use. In all configurations, however, you can open pages using a pretty URL or through the Personalize Pages page (Figure 29-5).

[bookmark: BCGGGJHG][bookmark: WCSUG10097]
Figure 29-5 Personalize Pages Page

[image: Personalize Pages page]






To open pages:


	
To open pages in the Home Space, use the following URL:


http://host:port/webcenter/spaces/page/escapedPageDisplayName








	
Tip:

The variable escapedPageDisplayName indicates the use of an escaped version of the page display name. For example, when you create a page with the name My Page, the URL to this page ends with My+Page.












	
To open pages in a Space, use the following URL:


http://host:port/webcenter/spaces/spaceName/page/escapedPageDisplayName



	
Open the Personalize Pages page, and click the name of the page you want to open (Figure 29-6).

[bookmark: BCGJHDHJ][bookmark: WCSUG10098]
Figure 29-6 Opening a Page through the Personalize Pages Page

[image: Opening a page through Personalize Pages]












[bookmark: CHDCFJBE][bookmark: WCSUG1091]

29.3.3 Hiding Pages

[bookmark: sthref2542]As you add pages to Spaces, it may become useful to hide some less-frequently-used pages. Once a page is hidden, it is easy to restore it to view (see Section 29.3.4, "Showing Hidden Pages").

To hide a page:


	
Go to the Space with pages you want to hide, and open the Personalize Pages page.







	
See Also:

For more information, see Section 29.3.2, "Opening Pages."












	
Clear the Show Page checkbox for each page you want to hide.







	
Note:

If you clear the Show Page checkbox for the current page, the Personalize Pages page closes and the current page is hidden.
Within a particular scope, such as a Space or the Home Space, one page must always be shown; therefore, you cannot use this method to hide all pages within a particular scope.



















[bookmark: CHDJHGGG][bookmark: WCSUG1092]

29.3.4 Showing Hidden Pages

[bookmark: sthref2543]To show a hidden page:


	
Go to the Space with pages you want to show, and open the Personalize Pages page.







	
See Also:

For more information, see Section 29.3.2, "Opening Pages."












	
Select the Show Page checkbox for each page you want to show.








[bookmark: BCGBHHIH][bookmark: WCSUG8765]

29.3.5 Rearranging Page Order

[bookmark: sthref2544][bookmark: sthref2545][bookmark: sthref2546]In a Space, you can use the Personalize Pages page to change the order in which pages are listed or arranged. When you change page order on the Personalize Pages page, you are doing so in your own view only. That is, it is a user customization that affects only your view of the page.







	
Note:

There are two ways of defining the order and the visibility of pages in a Space: from the Administration pages (described in Section 7.1.7, "Setting a Default Display Order for Business Role Pages") and from the Personalize Pages page (described here). The difference between the two is that the Administration change is an application customization and the Personalize Pages change is a user customization. Keep in mind that user customizations override application customizations in a given user's view.
















	
See Also:

F or more information about user customization, see Section 29.4.1, "What You Should Know About User Customizations on a Page."










To rearrange page order:


	
Go to the Space with pages you want to rearrange, and open the Personalize Pages page.







	
See Also:

For more information, see Section 29.3.2, "Opening Pages."












	
Use the icons in the Reorder column to rearrange page order (Figure 29-7).

[bookmark: BCGFGFDG][bookmark: WCSUG10099]
Figure 29-7 Reorder Icons on the Personalize Pages Page

[image: Reorder icon on the Personalize Pages page]









Pages are now arranged in the order you specified.






[bookmark: BCGICHFB][bookmark: WCSUG8238]

29.4 Adjusting Your Page View

The WebCenter Spaces application provides many opportunities for changing your view of a given page. This includes rearranging your view of page content, hiding components, changing your page layout, and the like. All of these options are user customizations, that is, they affect only your view of the application. All other users' views remain unchanged.







	
See Also:

For information about the difference between user- and application-level customizations, see Section 17.5.2.1, "What You Should Know About Customizing Page Components."










This section steps you through the process of adjusting your own page view through user customization. It includes the following subsections:


	
Section 29.4.1, "What You Should Know About User Customizations on a Page"



	
Section 29.4.2, "Performing User Customizations on Your Page View"





[bookmark: CACDCBEF][bookmark: WCSUG1097]

29.4.1 What You Should Know About User Customizations on a Page

[bookmark: sthref2548][bookmark: sthref2549][bookmark: sthref2550]You can customize the way pages appear in many ways without opening the page editor (Oracle Composer). For example, you can reposition components, remove components from your view of a page, resize a component's height, and collapse components to display just their headers.

User customizations are yours and yours alone. That is, the changes you make through the procedures described in the following sections affect only your view of WebCenter Spaces. No other users are affected by your changes.

For example, when you reposition page components in page view mode, that change applies only to your view of the application. Other users may reorganize their own views of pages, and their changes do not affect your viewonly their own.







	
Note:

When you revise a component in page view mode while another user deletes the same component in page edit mode, a WebCenter error page opens. Simply navigate back to the original page. The deleted component does not appear, and you can continue working on other components.
















	
See Also:

Advanced users with sufficient permission can change everyone's view of a page. For more information, see Section 17.3, "Editing Pages."













[bookmark: CHDJFBEC][bookmark: WCSUG1121]

29.4.2 Performing User Customizations on Your Page View

[bookmark: ABC4887481][bookmark: ABC4887481SRI1]Whether you can customize a page depends on permissions granted to you or your application role and on how user customizations are configured. You can tell if you have such permission by the presence or absence of the controls discussed in this section. If you do not see these controls, contact your application administrator to ask for a higher-level of access or for a configuration change.







	
Tip:

An Administrator link for contacting your application administrator may be available to you, depending on the design of your portal.










This section describes how to perform the user customizations rearrange, resize, minimize, and maximize. It includes the following subsections:


	
Section 29.4.2.1, "Rearranging Page Content"



	
Section 29.4.2.2, "Removing Components from Your View of a Page"



	
Section 29.4.2.3, "Resizing Components"



	
Section 29.4.2.4, "Collapsing and Expanding Components"





[bookmark: CHDHDEHC][bookmark: WCSUG1122]

29.4.2.1 Rearranging Page Content

[bookmark: sthref2551][bookmark: sthref2552][bookmark: sthref2553][bookmark: sthref2554]Use drag-and-drop to rearrange the position of a component on a page. Components moved by drag-and-drop can be moved into any open position on a page.

[bookmark: sthref2555][bookmark: sthref2556][bookmark: sthref2557]Dragging and dropping is arguably the easiest and least restricted way to rearrange components on a page. Simply drag the component over the spot you want to place it. A shadow indicates a receptive drop location (Figure 29-8).

[bookmark: CACCCDEF][bookmark: WCSUG2001]
Figure 29-8 Shadow Indicating a Receptive Drop Location

[image: Solid box indicating a receptive drop location]






To rearrange components by dragging and dropping:


	
Go to the page where you want to rearrange components by dragging and dropping.







	
See Also:

For more information, see Section 29.3.2, "Opening Pages."












	
Click and hold the header of the component you want rearrange, drag it to its target position, and drop it onto the page.

A shadow indicates where the component is placed when you drop it (Figure 29-9).

[bookmark: CACBJIBA][bookmark: WCSUG2002]
Figure 29-9 Dragging an Issues List Above an Events Task Flow

[image: Dragging to reposition a Task Flow]












[bookmark: CCAICAFE][bookmark: WCSUG1125]

29.4.2.2 Removing Components from Your View of a Page

[bookmark: sthref2560][bookmark: sthref2561][bookmark: sthref2562][bookmark: sthref2563]If you find that a component, such as a task flow or portlet, is not useful to you and the component displays a Remove icon (Figure 29-10), you can remove it from your view of the page.

[bookmark: BCGDDAAC][bookmark: WCSUG10100]
Figure 29-10 Remove Icon on a Task Flow

[image: Remove icon on a task flow]






To remove a component from your view of a page:


	
Go to the page where you want to remove a component from your page view.







	
See Also:

For more information, see Section 29.3.2, "Opening Pages."












	
Click the Remove icon on the component header (see Figure 29-10).

The component is removed from your view of the page.











	
Tip:

You can restore a removed component only by editing the page and adding a new component instance (for more information, see Section 17.5, "Adding Resource Catalog Components to Pages").













[bookmark: CCAJHIAB][bookmark: WCSUG1126]

29.4.2.3 Resizing Components

[bookmark: sthref2565][bookmark: sthref2566][bookmark: sthref2567][bookmark: sthref2568]The border and header surrounding a component, such as a task flow or a portlet, is also known as chrome. Chrome not only clarifies the boundaries of the component, but also provides an access point for component actions, such as those on the Actions menu and those embedded in the chrome itself. In the latter case, the chrome may include a Resize handle that you can use to increase or decrease the height of the component (Figure 29-11).

[bookmark: BCGFDGIB][bookmark: WCSUG10101]
Figure 29-11 Resize Handle on a Task Flow

[image: Resize handle on a task flow]












	
Note:

The position of the resize handle differs for bidirectionally displayed components. Those components displayed in a right-to-left orientation display the resize handle on the left side.










To use this feature, click and hold the Resize handle and drag it up to decrease the height of the component or down to increase the height of the component.




[bookmark: CHDGAGII][bookmark: WCSUG1128]

29.4.2.4 Collapsing and Expanding Components

[bookmark: sthref2570][bookmark: sthref2571][bookmark: sthref2572][bookmark: sthref2573]With one click, you can collapse some components, such as task flows or portlets, so that they roll up like a window shade, leaving only their headers on view (Figure 29-12).

[bookmark: BCGGDICG][bookmark: WCSUG10102]
Figure 29-12 Collapse/Expand Icon on a Task Flow

[image: Collapse/Expand icon on a task flow]






With another click, you can expand a collapsed component.

Collapsing is useful for removing the visual noise of an unused component from your application view. Collapse is available when a component shows a header.

To collapse and expand components:


	
Go to the page you want to customize.







	
See Also:

For more information, see Section 29.3.2, "Opening Pages."












	
Click the Collapse icon on the component header to roll the component up like a window shade (Figure 29-13).

[bookmark: BCGFAABG][bookmark: WCSUG10103]
Figure 29-13 Collapsed Task Flow

[image: Collapsed task flow]







	
Click the Expand icon on the component header to restore the full component to view (see Figure 29-12).[bookmark: sthref2576][bookmark: sthref2577]












[bookmark: BCGCDEDC][bookmark: WCSUG1864]

29.5 Exposing a Space Page in Your View of the Home Space

[bookmark: sthref2578][bookmark: sthref2579][bookmark: sthref2580]You can expose some Space pages within your view of the Home Space. For example, if you would like to keep close track of a Space page named Sales Results, you can specify that the Sales Results page should be available in your view of the Home Space.







	
Note:

System pages that are exposed in a Space, such as Events, Lists, and Announcements, do not provide the option of being exposed in the Home Space. For information about System pages, see Section 7.3, "Working with System Pages."










The page is available for viewing and revising from within your view of the Home Space according to your permissions on the page. The Space name is prepended to the page name, so the Sales Results page in the Space Finance becomes Finance - Sales Results in your view of the Home Space.

[bookmark: sthref2581][bookmark: sthref2582]If you delete such a page from your view of the Home Space, it remains a part of its original Space. In other words, deleting it simply removes it from your view of the Home Space; it does not actually delete the page. If the page is deleted from its parent Space, it is unavailable in your view of the Home Space. To clear it from your view, you must refresh the page list in the Home Space's Personalize Pages page.







	
Tip:

Personalize Pages is an option on the Page and Spaces Actions menu. How you access this menu depends on your portal design. [image: Page and Spaces Actions menu]
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30 Managing Your Profile

In WebCenter Spaces, your Profile is a collection of useful data about you. It can include contact information, a photo, your location within the company hierarchy, and so on. The social networking capabilities in WebCenter Spaces enable you to view and manage your own Profile and to view the Profiles of others if they have made them available to you.

This chapter provides an overview of Profile-related features and steps you through the process of Profile viewing and managing. It includes the following sections:

	
Section 30.1, "What You Should Know About Profile"


	
Section 30.2, "Specifying a Management Chain for Organization View"


	
Section 30.3, "Setting Profile Preferences"


	
Section 30.4, "Adding a Profile Task Flow to a Page"


	
Section 30.5, "Viewing and Editing Personal Profiles"


	
Section 30.6, "Setting Profile Task Flow Properties"





Audience

This chapter is intended for users assigned an application role that includes, minimally, the permission Update People Connections Data. Users who plan to edit task flow properties must be assigned a role that also includes the permission Pages: Edit Pages. In a Space (other than the Home Space), users must be assigned a role that includes the permission Edit Page Access and Structure.



30.1 What You Should Know About Profile

Profile provides a variety of views into your own and other users' personal profile information. Such information can include your mail address, phone number, office location, department, manager, direct reports, and so on. In a typical WebCenter Spaces installation, Profile takes the bulk of its information from the back-end identity store that provides your WebCenter application with its users (for more information, see Section 30.2, "Specifying a Management Chain for Organization View"). Additionally, Profile may offer opportunities for altering some of this information and for providing additional data not included in the identity store.

When you connect with other users, you give them access to your Profile, and gain access to theirs. You can control how much of your Profile a connection can view through Profile Preferences. For information about setting your Profile Preferences, see Section 30.3, "Setting Profile Preferences."

Before you access your Profile or Profile Preferences, your application administrator can set global application defaults that affect what all users may see and do with their own and other users' Profiles. For more information, see Section 6.4, "Configuring People Connections Defaults for WebCenter Spaces."

You can access a view of a Profile, including your own, by clicking a user name wherever you see it in WebCenter Spaces. In addition to brief, popup views of user Profiles, you can see a full view of your Profile on the WebCenter Spaces Profile page. The Profile page is a business role page that is pushed to all authenticated users' views of the Home Space (Figure 30-1).


Figure 30-1 Profile Page

[image: Profile page]






	
Tip:

Authenticated users are users who are logged in to WebCenter Spaces.










	
See Also:

For information about business role pages, see Section 7.1, "Working with Business Role Pages."







By default, the Profile page presents a series of subpages that include your view of the Activity Stream (Activities), a detailed view of your connections (Connections), a view of the documents and folders in the Public folder of your personal document library (Documents), a chart view of your location within the organization (Organization), and a view of your full Profile (About).

Of all of these subpages, only Organization and About pull their content from the identity store and belong to the Profile family of task flows. The other subpages pull their content from other features and services as follows:

	
Activities comes from the Activity Stream feature of the People Connections service (for more information, see Chapter 32, "Tracking Your Connections' Activities")


	
Connections comes from the Connections feature of the People Connections service (for more information, see Chapter 31, "Creating Your Social Network")


	
Documents comes from the Documents service (for more information, see Part X, "Working with Content".




Your portal designer can revise the default Profile business role pages to include additional components, remove existing components, and revise the page look and feel. Consequently, the page described here may finally have little to do with the final Profile page that you see.




	
See Also:

For information about revising business role pages, see Section 7.1, "Working with Business Role Pages."







In addition to Profile business role pages, Profile provides several task flows that each offer a unique view of a user's Profile information. Provided you have edit permission on a page, you can place a Profile task flow wherever you find it of use.

Profile provides the following task flows:

	
Organization View for a graphical depiction of the current user's position within the company—that is, a detail of the overall organization chart. In Organization View, you can cycle through three views of the current user's Profile information, including contact information; the user's address and the current time in the user's locale; and a summary About Me statement. It also provides a link to a full-blown profile of the current user (Figure 30-2).


Figure 30-2 Organization View Task Flow

[image: Organization View task flow]






	
See Also:

For information about enabling a hierarchical view of your organization, as depicted in Figure 30-2, see Section 30.2, "Specifying a Management Chain for Organization View."








	
Profile for displaying a user's profile details, uploading a photo, and (if enabled) editing Profile details (Figure 30-3)


Figure 30-3 Profile Task Flow

[image: Profile task flow]



	
Profile Gallery for accessing all of your social networking information from one view (Figure 30-4)


Figure 30-4 Profile Gallery Task Flow

[image: Profile Gallery task flow]



	
Profile - Snapshot for viewing a user photo and status message (Figure 30-5)


Figure 30-5 Profile - Snapshot Task Flow

[image: Profile Snapshot task flow]








	
See Also:

For information about working with Profile task flow features, see Section 30.5, "Viewing and Editing Personal Profiles."







Profile task flows have associated properties that you can use to control the appearance and behavior of a task flow instance. For example, you can use Profile properties to specify that the statements you enter into a Publisher task flow (see Section 33.1.1, "What You Should Know About Message Board") are included in those Profile views that provide a status message. You can control whether a Profile allows the display of a photo and whether the photo can be updated in page view mode.




	
See Also:

For more information about Profile properties, see Section 30.6, "Setting Profile Task Flow Properties."







For information about using Profile features, see Section 30.5, "Viewing and Editing Personal Profiles."






30.2 Specifying a Management Chain for Organization View

The Organization View task flow and the Organization subpage on a Profile page can provide a visualization of your management chain, that is, they can render a view of a manager and the manager's direct reports (Figure 30-6).


Figure 30-6 Organization View of a Manager and the Manager's Direct Reports

[image: Organization view of manager and direct reports]






Organization views of a user profile are available on a user's Profile page—on the Organization subpage—and through the Organization View task flow. By default, the values that define the management chain for these organization views are blank. This means that managers are not automatically specified for users in the back-end identity store that provides user details.




	
Tip:

The value for Manager on the Profile page's About subpage is also defined by the methods suggested in this section.







For the management chain to be rendered in organization views, the back-end identity store that is used for WebCenter Spaces authentication must be set up in such a way that direct report users have a manager attribute. And the manager attribute must be defined as the Distinguished Name (DN) of their manager user (see "Example Embedded LDAP Configuration").




	
Tip:

In an LDAP environment, a user can be managed by only one person; in the same environment, a user can manage many people.








Example Embedded LDAP Configuration

You can specify a management chain within the Oracle WebLogic Server (WLS) embedded LDAP or within an external LDAP, such as Oracle Internet Directory (OID). Note, however, that the management chain you define through the embedded LDAP is for testing or proof of concept and not for production. For production, you must use an external LDAP, such as OID, for the identity store for WebCenter Spaces authentication.




	
See Also:

For more information, see the chapter "Configuring the Identity Store," in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter, or refer to the documentation provided with your LDAP implementation.







This example describes how to define a management chain within the embedded LDAP in WebLogic Server for testing or proof of concept.




	
Note:

The steps provided in this example are similar to those you take for an external LDAP. That is, you create an attribute (manager) and set a value on the attribute for each user. For this value, enter the DN of the selected user's manager.







In this example, there are three users:

	
user1


	
user2


	
manager_user




To define a management chain with these users:

	
Enable browsing of the embedded LDAP using an external viewer, such as Apache Directory Studio:

	
Go to the WLS Administration Console, and log in as the administrator user.


	
Click your domain, for example, wc_domain, then open the Security Tab and then the Embedded LDAP Sub-tab (Figure 30-7).


Figure 30-7 Oracle WebLogic Server Administration Console

[image: Partial view of the WLS Administration Console]






	
Enter a value in the Credential field, and then reenter that value in the Confirm Credential field.




	
Tip:

The default credential is a randomly generated password. Set it to something memorable.








	
Restart your administration and managed servers.





	
Start up the LDAP viewer you selected in Step 1, and create a connection using the following details:

	
hostname (for example, example.com)


	
port (the WLS administration port, for example 7001)


	
Bind DN (cn=Admin)


	
Password (that is, the credential you set in Step 1c)





	
Navigate to user1 by finding the users within the DIT tree (Figure 30-8).

For example, click in succession:

	
dc=wc_domain


	
ou=myrealm


	
ou=people


	
uid=user1





Figure 30-8 Selecting a User in the DIT Tree of an LDAP Browser

[image: DIT tree in an LDAP browser]






	
In the Attribute Description column, add a new attribute of type manager.




	
Tip:

Press Ctrl-Shift-+ to open the New Attribute dialog.








	
For the attribute value, choose the DN for manager_user (Figure 30-9).

For example, under the root choose in succession:

	
dc=wc_domain


	
ou=myrealm


	
ou=people


	
uid=manager_user





Figure 30-9 Select DN Dialog

[image: Select DN dialog]






	
Repeat Steps 3 through 5 for user2.




Now user1 and user2 are managed by manager_user. You can check this by logging in to WebCenter Spaces as user1 and navigating to the About subpage of the My Profile page. The user manager_user is displayed as the manager (Figure 30-10).


Figure 30-10 About Subpage of the My Profile Page

[image: About subpage of the My Profile page]









	
Tip:

Click the value for Manager (in this example, manager_user) to view the manager's profile. Access the Organization subpage to see the organization view associated with the currently viewed profile (see Figure 30-6).












30.3 Setting Profile Preferences

The Profile details that are affected by your Preferences settings appear in your full Profile view, for example, in the Profile task flow and on the About subpage of the default My Profile business role page (Figure 30-11).


Figure 30-11 About Subpage on Profile Page

[image: About subpage on Profile page]



Full profiles are presented in four sections: Summary, Employee, Business Contact, Personal Information. Each section provides information related to the section heading. For example, Summary includes a collection of basic details, such as your user name, mail address, and office location.




	
Note:

Your portal administrator can control every users' access to their own Profile information. For example, the administrator can control whether a Profile section is shown, whether a given section is editable, and who can see what Profile information. Consequently, the control you can exercise over your own Profile preferences is determined by the actions of your administrator. For more information, see Section 6.4, "Configuring People Connections Defaults for WebCenter Spaces."
Only the administrator can control access to the Summary section. For more information, see Section 6.4.3.4, "Configuring Profile."









Use Profile preferences to specify who can view different types of information associated with your personal profile.

To set Profile preferences:

	
Open the Preferences dialog.


	
Click People Connections to display People Connections preferences.


	
Click the Profile tab to bring it forward (Figure 30-12).


Figure 30-12 Profile Preferences

[image: Profile Preferences]



For each section of your personal profile, specify the users who can view it:

	
Everyone—All users, including users who are not logged in, can view the associated section of your Profile.


	
Authenticated Users—Only users who are logged in can view the associated section of your Profile.


	
User's Connections—Only you and your connections can view the associated section of your Profile.


	
User Only—Only you can view the associated section of your Profile.





	
Click OK.









30.4 Adding a Profile Task Flow to a Page

For the steps to add a Profile task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






30.5 Viewing and Editing Personal Profiles

Profile task flows provide quick access to contact and status information about you and your connections. This section describes how to use the features offered through Profile task flows. It includes the following subsections:

	
Section 30.5.1, "Viewing Profile Details"


	
Section 30.5.2, "Editing Your Personal Profile"


	
Section 30.5.3, "Uploading and Updating a Personal Profile Picture"







	
See Also:

Advanced users can extend WebCenter Spaces by customizing user Profile attributes. For more information, read the white paper, "Using WebCenter Spaces Extension Samples (11.1.1.5.0)," available on the Oracle Technology Network at http://www.oracle.com/technetwork/index.htm.









30.5.1 Viewing Profile Details

You can view your full profile details by clicking your user name, provided it appears in the application chrome. For example, in Figure 30-13 the user name Josie Smith appears at the top of the application.


Figure 30-13 User Name at Top of Application

[image: User name at top of application]



On the resulting page, click the About tab to view your full profile details (Figure 30-14).


Figure 30-14 About Subpage on Profile Page

[image: About subpage on Profile page]



You can view summary profile details for yourself, all of your connections, and all of the members of the Spaces for which you have access (through the Members task flow) simply by clicking a user name wherever it appears in the application context. Clicking a name opens a Profile popup (Figure 30-15).


Figure 30-15 Profile Popup

[image: Profile popup]



In some application contexts, such as in a Document Library or on an announcement, a context menu opens in lieu of a Profile popup. Click the user name and select View Profile Gallery from the resulting context menu (Figure 30-16) to access a view of the user's profile gallery.


Figure 30-16 View Profile Gallery Option on the Documents Page

[image: View Profile Gallery option on Documents page]







30.5.2 Editing Your Personal Profile

Your application administrator determines how much of your personal profile you may revise (for more information, see Section 6.4, "Configuring People Connections Defaults for WebCenter Spaces."). When you have permission to revise your Profile, an Edit link is shown on the Profile page (Figure 30-17).


Figure 30-17 Edit Button on a Profile

[image: Edit button on a Profile]



Click the Edit button to open an edit view of your personal profile.




	
Note:

Even when your application administrator has enabled the editing of a particular Profile section, all fields in that section may not be editable.







To edit your personal profile:

	
Open your Profile page.




	
See Also:

For more information, see Section 30.5.1, "Viewing Profile Details."








	
Click Edit to open your Profile in edit mode (Figure 30-18).


Figure 30-18 Profile in Edit Mode

[image: Profile in edit mode]



	
Make your changes, and click Save.









30.5.3 Uploading and Updating a Personal Profile Picture

Provided the Profile task flow is configured to allow it, users with a personal Profile can upload or update their Profile image.




	
Note:

The file must have the mime-type image, and cannot have the extension *.ico.
The task flow property Allow photo upload must be set to #{true}. For more information, see Section 30.6, "Setting Profile Task Flow Properties."









To upload or update your profile image:

	
Open your Profile page.




	
See Also:

For more information, see Section 30.5.1, "Viewing Profile Details."








	
Click the Change Photo link to open the Upload Photo dialog (Figure 30-19).


Figure 30-19 Change Photo Link and Upload Photo Dialog

[image: Change Photo link and Upload Photo dialog]



	
Click Browse to locate and select a photo.


	
Click OK to complete the upload.




When you update your profile photo (as opposed to providing a new one), additional dialogs may come into play. When you click the Change Photo link, the Upload Photo dialog opens, displaying the name of the current file along with an Update button (Figure 30-20).


Figure 30-20 Upload Photo Dialog (Update Photo)

[image: Upload Photo dialog for updating a photo]



Click Update to open the Upload Photo dialog depicted in Figure 30-19, and complete the process as described in this section.








30.6 Setting Profile Task Flow Properties

Profile task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 30-21).


Figure 30-21 Profile Task Flow Component Properties Dialog

[image: Profile task flow Component Properties dialog]






	
See Also:

For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."







The following sections provide information about properties associated with Profile task flows and describe the properties available on the Parameters tab:

	
Section 30.6.1, "What You Should Know About Profile Task Flow Properties"


	
Section 30.6.2, "Profile Task Flow Parameters"


	
Section 30.6.3, "Using Properties to Configure a Profile Task Flow Instance"






30.6.1 What You Should Know About Profile Task Flow Properties

When you set property values on a Profile task flow, you are affecting only the task flow instance on which the value is set. Other instances of the same task flow are not affected by such changes.

The properties on the Parameters tab of the Component Properties dialog can affect the default task flow content. For descriptions of the parameters on this tab, see Section 30.6.2, "Profile Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






30.6.2 Profile Task Flow Parameters

Table 30-1 describes the parameters that are unique to Profile task flows.


Table 30-1 Profile Task Flow Parameters

	Parameter	Description
	
Allow photo upload

	
A Boolean value representing whether the task flow exposes a means of uploading a profile photo

Check for #{true}, clear for #{false}.

This parameter is associated with the Profile - Snapshot task flow.


	
Allow status update

	
A Boolean value representing whether the Profile - Snapshot task flow exposes a means of entering a personal status message

Check for #{true}, clear for #{false}.

If status updates are enabled (#{true}), users can enter updates through an embedded Publisher task flow. For information about the Publisher task flow, see Section 34.3.3, "Sharing Items, Files, and URLs Through the Publisher Task Flow."

This parameter is associated with the Profile – Snapshot task flow.


	
Control Panel Shown

	
A Boolean value representing whether a control panel for manipulating the style, alignment, and size of the content is available on the runtime task flow instance

Check for #{true}, clear for #{false}.

This parameter is associated with the Organization View task flow.


	
Edit Mode

	
A means of determining whether to display Profile details as editable without requiring specific navigation to an editable view

	
Enter #{true} to always show Profile details in edit mode.


	
Enter #{false} to show Profile details as read-only.




When the value is set to #{false}, users click an Edit button to take Profile details into edit mode. Note that this parameter is recognized only if the parameter sectionWiseEditEnabled is set to #{false}.

This parameter is associated with the Profile task flow.


	
Image Size

	
The size of the Profile photo to show

Values can be one of: ORIGINAL, LARGE, MEDIUM, SMALL.

This parameter is associated with the Profile – Snapshot task flow.


	
Org Bread Crumbs Shown

	
A Boolean value representing whether a breadcrumbs component delineating the user's upward path in the organization hierarchy is shown

Check for #{true}, clear for #{false}.

This parameter is associated with the Profile - Snapshot task flow.


	
Profile Edit Link Shown

	
A Boolean value representing whether a link to edit the user Profile is shown

Check for #{true}, clear for #{false}.

This link does not perform any operation, but instead leads to a region navigation event (to the same view), which the consumer can listen to and perform navigation appropriately.

Out of the box, the My Profile business role page, which contains the Profile - Snapshot task flow, is wired to the Profile task flow on the About subpage. Upon receiving a region navigation event from the Profile - Snapshot task flow, clicking the Edit link switches the Edit Mode parameter of the Profile task flow on the About subpage, effectively toggling the mode. Because of this out-of-the-box wiring, the Edit link works on the My Profile business role page. If you plan to expose the Profile Edit link, you must retain the code to listen to the region navigation event and provide the same type of wiring to the target task flow.

This parameter is associated with the Profile - Snapshot task flow.


	
Profile ID

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Profile task flow.


	
Resource Id

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Profile Gallery task flow.


	
Section-Wise Edit Enabled

	
A means of enabling or disabling section-by-section edit capability on the task flow

	
Enter #{true} to enable section-by-section editing. An Edit button is shown on each editable Profile section.


	
Enter #{false} to disable section-by-section editing. One Edit button is shown for the whole task flow.




This parameter is associated with the Profile task flow.


	
User Id

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Organization View task flow.


	
User Name

	
The ID of the user to display in the task flow

The value for this parameter, #{securityContext.userName}, is set automatically. The value is an Expression Language expression that returns the name of the current user.

For information about Expression Language expressions, see Appendix B, "Expression Language Expressions."

This parameter is associated with the Profile - Snapshot task flow.












30.6.3 Using Properties to Configure a Profile Task Flow Instance

This section provides examples of how you use property values to affect the behavior of a given task flow instance. It includes the following subsections:

	
Section 30.6.3.1, "Change Profile Photo in Profile - Snapshot Task Flow"


	
Section 30.6.3.2, "Post a Status Update"


	
Section 30.6.3.3, "Expose Additional Controls in Organization View"


	
Section 30.6.3.4, "Enable Continuous Edits of Profile Details"


	
Section 30.6.3.5, "Setting Size of Profile Images in Profile - Snapshot Task Flow"


	
Section 30.6.3.6, "Exposing Navigational Breadcrumbs in Profile - Snapshot"


	
Section 30.6.3.7, "Enabling Section-By-Section Profile Editing"






30.6.3.1 Change Profile Photo in Profile - Snapshot Task Flow

Use the property Allow photo upload to enable users to upload their own Profile photos in an instance of the Profile - Snapshot task flow. Photos uploaded to Profile - Snapshot are persisted to all other Profile task flows that expose a photo.

To enable users to change their Profile photo in the Profile - Snapshot task flow:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Allow photo upload:

	
Select the checkbox (#{true}) to enable users to change their Profile photo on the task flow instance. When you apply this change, Upload and Refresh controls appear close to the photo display area (Figure 30-22).


Figure 30-22 Upload and Refresh Icons on Profile - Snapshot Task Flow

[image: Upload and Refresh icons on task flow]



	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









30.6.3.2 Post a Status Update

Use the property Allow Status Update to show or hide a means of entering a personal status message in the Profile - Snapshot task flow. If status updates are enabled, users can enter their status messages through an embedded Publisher task flow (Figure 30-23).


Figure 30-23 Publisher Task Flow in Profile - Snapshot

[image: Publisher task flow in Profile - Snapshot]






	
See Also:

For information about the Publisher task flow, see Section 34.3.3.1, "What You Should Know About the Publisher Task Flow."







When this property is enabled, whenever the current user posts a status message using the Publisher task flow, it is also posted as a Profile status message to Profile - Snapshot, Profile Gallery, and Profile task flows.

To enable users to post a status update to their Profile:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Allow Status Update:

	
Select the checkbox (#{true}) to expose controls for updating Profile status in the Profile - Snapshot task flow.


	
Clear the checkbox (#{false}) to hide this feature.





	
Click OK.









30.6.3.3 Expose Additional Controls in Organization View

The Organization View task flow provides additional controls for manipulating your view of task flow content (Figure 30-24).


Figure 30-24 Control Panel Shown in Organization View

[image: Control panel shown in Organization View]



Use additional controls to zoom in and out and select a display format.

Use the property Control Panel Shown to expose these controls in an instance of the Organization View task flow.

To expose additional controls in an Organization View task flow:

	
Edit the properties of an Organization View task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Control Panel Shown:

	
Select the checkbox (#{true}) to expose the Organization View control panel.


	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









30.6.3.4 Enable Continuous Edits of Profile Details

Use the property Edit Mode to enable users to edit Profile details without having to specifically enter an edit mode. Users navigate to the task flow instance and make changes to editable fields without having to first click an Edit button or link.




	
Note:

This parameter is recognized only if the parameter sectionWiseEditEnabled is set to #{false}. For more information, see Section 30.6.3.7, "Enabling Section-By-Section Profile Editing."







To enable continuous edits of Profile details:

	
Edit the properties of a Profile task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Provide a value for the property Edit Mode:

	
Enter #{true} to always show Profile details in edit mode.


	
Enter #{false} to disable this feature. When the value is set to #{false}, users click an Edit button to take Profile details into edit mode.





	
Click OK.









30.6.3.5 Setting Size of Profile Images in Profile - Snapshot Task Flow

Use the property Image Size to specify the display size of images that are uploaded through a Profile - Snapshot task flow. The value you enter affects the size of the photo in only the given task flow instance. No other types of Profile task flows and no other task flow instances are affected.

To set the size of a Profile image in the Profile - Snapshot task flow:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Enter a value for the property Image Size:

	
ORIGINAL (Figure 30-25)


Figure 30-25 Image Size Set to ORIGINAL

[image: Image Size set to ORIGINAL]



	
SMALL (Figure 30-26)


Figure 30-26 Image Size Set to SMALL

[image: Image Size set to SMALL]



	
MEDIUM (Figure 30-27)


Figure 30-27 Image Size Set to MEDIUM

[image: Image Size set to MEDIUM]



	
LARGE (Figure 30-28)


Figure 30-28 Image Size Set to LARGE

[image: Image Size set to LARGE]






	
Click OK.









30.6.3.6 Exposing Navigational Breadcrumbs in Profile - Snapshot

Use the property Org Bread Crumbs Shown to enable the display of breadcrumbs that visualize the current users position in the organization hierarchy (Figure 30-29).


Figure 30-29 Breadcrumbs in Profile - Snapshot Task Flow

[image: Breadcrumbs in Profile - Snapshot task flow]



Users can click a name in the hierarchy to navigate to a view of that user's Profile.

To expose navigational breadcrumbs in a Profile - Snapshot task flow:

	
Edit the properties of a Profile - Snapshot task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Set a value for Org Bread Crumbs Shown:

	
Select the checkbox (#{true}) to expose hierarchical breadcrumbs.


	
Clear the checkbox (#{false}) to disable this feature.





	
Click OK.









30.6.3.7 Enabling Section-By-Section Profile Editing

Use the Section-Wise Edit Enabled property to specify whether section-by-section editing is enabled, exposing Edit buttons on each editable section of a Profile task flow instance, or disabled, exposing only a single Edit button for the entire Profile (Figure 30-30).


Figure 30-30 Section-Wise Edit Enabled Parameter Enabled

[image: Enabled Section-Wise Edit Enabled parameter]






	
Note:

Whether Profile details are editable in all Profile task flow instances is determined by your application administrator. For more information, see Section 6.4, "Configuring People Connections Defaults for WebCenter Spaces."







To enable section-by-section editing in a Profile task flow instance:

	
Edit the properties of a Profile task flow instance.




	
See Also:

For information about editing task flow properties, see Section 17.5.2, "Setting Properties on Page Components."








	
In the Component Properties dialog, bring the Parameters tab forward.


	
Set a value for Section-Wise Edit Enabled:

	
Enter (#{true}) to enable section-by-section editing of the Profile task flow instance. Edit buttons are shown on each details section.


	
Clear the checkbox (#{false}) to disable section-by-section editing of the Profile task flow instance. One Edit button is shown for all Profile details.





	
Click OK.











Expression Language Expressions






B Expression Language Expressions

When configuring page components, you can express values as variables that take advantage of the current application context by grabbing information that happens to be true at the moment. For example, you can use variables to obtain the name of the current user, the user's assigned role, the state of the current page, and the like.

Such flexibility is made possible through the Expression Builder that is provided with each Parameter and Display Option property.

This appendix provides information about the editor and useful EL expressions. It includes the following subsections:

	
Section B.1, "Introducing the Expression Builder"


	
Section B.2, "Expression Language Example Use Case"


	
Section B.3, "Expression Language Expressions"







	
See Also:

For additional information about EL APIs, see Oracle Fusion Middleware Java API Reference for Oracle WebCenter.









B.1 Introducing the Expression Builder

All properties on the Parameters and Display Options tabs provide an Expression Builder icon that opens a simple Expression Language (EL) editor, called the Expression Builder. Use the Expression Builder when you want to formulate a dynamic computation for an otherwise unknown property value, for example, to specify the current user, the current page mode, and the like.

Click the Expression Builder icon next to a property to open the editor. (Figure B-1).


Figure B-1 Expression Builder Icon Next to a Parameter Value Field and the Resulting Editor

[image: Edit icon next to a parameter value field]









	
See Also:

For information about accessing component properties, see Section 17.5.2, "Setting Properties on Page Components."







The Expression Builder is particularly useful when you want a value that is retrievable but otherwise unknown, for example, when you want a value to be the name of the current user or the current application skin.

The Expression Builder provides two options for entering expressions:

	
Choose a value, for selecting a seeded EL expression


	
Type a value or expression, for entering an expression manually




The options under Choose a value are categorized according to the type of information an expression returns. Select a category from the first menu, and then select the type of value you want returned from the second menu (Figure B-2).


Figure B-2 Options Under Choose a value in the Expression Builder

[image: Options under Choose a value in the Expression Builder]









	
See Also:

For information about seeded EL expressions, see Section B.3.1, "Seeded Expressions in the Expression Builder."







The option Type a value or expression is followed by a text box, which you can use to manually enter the expression you intend (Figure B-3).


Figure B-3 Text Box Under Type a value or expression in the Expression Builder

[image: Text box under Type a value or expression]






Many expressions in the tables in this appendix are building blocks for narrowing down the object or objects you want returned. That is, they are not necessarily meant to be used by themselves, but rather in an assembly of ELs to form the desired query.

For example, the following expression uses three resource-related ELs to form a single query that returns a particular Space template. It retrieves the template storesMasterTemplate from the parent Space stores:


#{srmContext.resourceScope['stores'].resourceType['siteTemplate'].displayName['storesMasterTemplate'].singleResult}


In the Expression Builder, select predefined values, under Choose a value, or enter a value or an Expression Language expression, under Type a value or expression.

Use the following formats to enter values:

	
a literal number: #{123}


	
a literal string: #{'string'}


	
a literal Boolean: #{true}


	
a Java Bean called to return a value: #{generalSettings.preferredTimeStyle}




The editor provides a Test button for validating your EL entry. The Test button is available for expressions entered in the text box under Type a value or expression.

Validation checks the EL syntax and evaluates the expression. Because expression values vary according to the context in which they are executed, the resulting value that appears in the editor may differ from the value returned during actual use.

Note, however, that only EL is validated when you click Test; other types of values are not validated.

Test results are shown in a popup (Figure B-4).


Figure B-4 Test Result in EL Editor

[image: Test result in EL Editor]










B.2 Expression Language Example Use Case

This section provides an example of using EL expressions to display something based on a user's role, permissions, and the like.

In this example, we will use Expression Language to reveal or hide an item in the navigation model based on the user's role. Because there is Expression Language for almost every piece of metadata maintained by WebCenter Spaces, using ELs to personalize the user's experience is an extremely powerful tool.

You can use the following EL to determine a user's role:


#{WCSecurityContext.userInScopedRole['Role 1'] or   WCSecurityContext.userInScopedRole['Role 2']}


This EL compares the current user's credentials (in this case, the role), against what is specified in the EL. If the result is true, that is, if the user is assigned one of the specified roles then the navigation item is visible to the user. If the result is false, the navigation item is hidden from the user.

The roles referred to in the EL can be a system role, such as Administrator, Moderator, Participant, or a custom role.

Notice that this EL joins two conditions with the use of an OR clause; that is, the user must have either Role 1 OR Role 2 to be able to see the navigational item.

These steps demonstrate how to add a navigational item (a page query for another Space) that is visible only to user assigned the role Moderator.




	
Note:

This exercise assumes you have applied a custom navigation model to your Space. You cannot edit a seeded navigation model.







To personalize navigation:

	
Go to Space Settings, and access the Navigations panel under Resources.

You can use the following URL to navigate to the Resources subpage, from there, click Navigations:


http://host:port/webcenter/spaces/spaceName/admin/resources


	
Select the navigation model that the Space is using.




	
Tip:

To find out which navigation model the current Space is using, go to the General subpage under Space Settings, and look for the value in the Navigation field.








	
From the Edit menu, select Edit.


	
In the Edit - navigation model dialog, expand the Add menu, and select Pages Query.


	
Bring the Target tab forward:

	
In the Name field, enter a name for your query, for example, moderatorQuery.


	
Next to Find Page in, select Space, and ensure that the current Space name appears in the field.


	
Click the icon to the right of the Visible checkbox, and select Expression Builder.





	
Select Choose a value, and then select Space Info from the first dropdown and CurrentSpace Role - Moderator from the second.

The expression #{WCSecurityContext.userInScopedRole['Moderator']} appears in the text field.




	
Tip:

If you are working with a custom role, you choose CurrentSpace Role - Custom from the dropdown. In the text area, highlight CustomRole, then type in the name of your custom role.








	
Click OK until you return to the Resources tab.




To test this, add a member to the Space, and assign this user any role other than Moderator. Log off and log back in as that user. You should not see the Pages Query navigational item.






B.3 Expression Language Expressions

This section provides a series of tables that list and describe useful EL expressions. Tables are grouped according to the context in which the expressions they contain apply.

This section includes the following subsections:

	
Section B.3.1, "Seeded Expressions in the Expression Builder"


	
Section B.3.2, "EL Expressions Relevant to the WebCenter Spaces Application"


	
Section B.3.3, "EL Expressions Relevant to Application Security"


	
Section B.3.4, "EL Expressions Relevant to Application Navigation"


	
Section B.3.5, "EL Expressions Relevant to Resources"


	
Section B.3.6, "EL Expressions Relevant to Specific Spaces"


	
Section B.3.7, "EL Expressions Relevant to Specific Pages"


	
Section B.3.8, "EL Expressions Relevant to Oracle Composer"


	
Section B.3.9, "EL Expressions Relevant to Event Contexts"


	
Section B.3.10, "EL Expressions Relevant to Services"


	
Section B.3.11, "EL Expressions Relevant to the Personalization Conductor"


	
Section B.3.12, "EL Expressions Relevant to the Documents Service"


	
Section B.3.13, "EL Expressions Relevant to the People Connections Service"


	
Section B.3.14, "EL Expressions Relevant to User Preferences"


	
Section B.3.15, "Utilitarian EL Expressions"






B.3.1 Seeded Expressions in the Expression Builder

In the Expression Builder editor, when you select the option Choose a value you can populate the text box in the dialog with a seeded EL expression. First, select an expression category, and then select the type of information you want the expression to return. Your selection's associated EL appears in the text box at the bottom of the dialog (Figure B-5).


Figure B-5 Options Under Choose a value in the Expression Builder

[image: Options under Choose a value in the Expression Builder]






This section is broken into subsections for each category. Each subsection lists and describes the ELs associated with that category.

This section includes the following subsections:

	
Section B.3.1.1, "Application Info Seeded ELs"


	
Section B.3.1.2, "Page Info Seeded ELs"


	
Section B.3.1.3, "Page Parameter Seeded ELs"


	
Section B.3.1.4, "Resource Info Seeded ELs"


	
Section B.3.1.5, "Space Info Seeded ELs"


	
Section B.3.1.6, "Space Page Info Seeded Paths"


	
Section B.3.1.7, "System Seeded ELs"


	
Section B.3.1.8, "User Info Seeded ELs"


	
Section B.3.1.9, "WebCenter Events Seeded ELs"






B.3.1.1 Application Info Seeded ELs

Application Info seeded EL expressions return values related to the WebCenter Spaces application. For example, the expression #{WCAppContext.application.applicationConfig.title}, returns the application title that is specified on the Configuration page in the WebCenter Administration pages.




	
See Also:

For additional EL expressions related to the application, see Section B.3.2, "EL Expressions Relevant to the WebCenter Spaces Application."







Table B-1 lists the seeded EL expressions available under the category Application Info and provides an example of the types of values each returns.


Table B-1 Seeded EL Expressions Under Application Info

	Option	Expression	Example of Returned Value
	
Current Scope

	
#{serviceCtx.scope}

	
Scope[name=standards, guid=sa78185d3_9d65_49ab_ac1d_4809380d0b30]


	
Current Page Template Scope

	
#{WCAppContext.currentScope}

	
Scope[name=standards, guid=sa78185d3_9d65_49ab_ac1d_4809380d0b30]


	
Previously Set Page Template

	
#{WCAppContext.previouslySetPageTemplate}

	
Fusion Side Navigation


	
Application

	
#{WCAppContext.application}

	
oracle.webcenter.webcenterapp.internal.view.shell.WCApplication


	
Application URL

	
#{WCAppContext.applicationURL}

	
http://host:port/webcenter


	
Current WebCenter URL

	
#{WCAppContext.currentWebCenterURI}

	
/oracle/webcenter/page/scopedMD/GUID/businessRolePages/Page3.jspx?wc.contextURL=%2Fspaces


	
Application Config

	
#{WCAppContext.application.applicationConfig}

	
oracle.webcenter.webcenterapp.beans.WebCenterMetadataImpl@123db9d


	
Application Config Title

	
#{WCAppContext.application.applicationConfig.title}

	
WebCenter


	
Application Config Logo

	
#{WCAppContext.application.applicationConfig.logo}

	
/oracle/webcenter/webcenterapp/metadata/images/logo.gif


	
Application Config HelpPage

	
#{WCAppContext.application.applicationConfig.helpPage}

	
/webcenterhelp/spaces?topic=welcome_main


	
Application Config CopyrightMessage CustomValue

	
#{WCAppContext.application.applicationConfig.copyrightMessage.customValue}

	
http://www.oracle.com/html/copyright.html


	
Application Config Privacy Policy URL

	
#{WCAppContext.application.applicationConfig.privacyPolicyUrl}

	
http://www.oracle.com/html/privacy.html


	
Application Config Skin

	
#{WCAppContext.application.applicationConfig.skin}

	
webcenterfx












B.3.1.2 Page Info Seeded ELs

Page Info seeded EL expressions return values related to WebCenter Spaces pages. For example, the expression #{pageDocBean.createdBy}, returns the user name of the person who created the current page.

Table B-2 lists the seeded EL expressions available under the category Page Info and provides an example of the types of values each returns.


Table B-2 Seeded EL Expressions Under Page Info

	Option	Expression	Example of Returned Value
	
Title

	
#{pageDocBean.title}

	
Welcome Page (BRP)


	
Created By

	
#{pageDocBean.createdBy}

	
j.doe


	
Create Date String

	
#{pageDocBean.createDateString}

	
2010-11-17T13:27:52


	
Last Updated By

	
#{pageDocBean.lastUpdatedBy}

	
j.smith


	
Last Update Date String

	
#{pageDocBean.lastUpdateDateString}

	
2010-11-17T13:27:52


	
Page Path

	
#{pageDocBean.pagePath}

	
/oracle/webcenter/page/scopedMD/GUID/businessRolePages/Page3.jspx


	
Name

	
#{pageDocBean.name}

	
Page3.jspx


	
UI CSS Style

	
#{pageDocBean.UICSSStyle}

	
WCSchemeCustom


	
UI Scheme BG Image

	
#{pageDocBean.UISchemeBGImage}

	
#{facesContext.externalContext.requestContextPath}/adf/oracle/webcenter/page/images/clouds.png


	
UI BG String Color Scheme

	
#{pageDocBean.UISchemeBGColorString}

	
null


	
Page Permission

	
#{pageDocBean.pagePermission}

	
oracle.webcenter.page.model.security.CustomPagePermission


	
Page Security Target

	
#{pageDocBean.pageSecurityTarget}

	
oracle_webcenter_page_scopedMD_sa78185d3_9d65_49ab_ac1d_4809380d0b30_COIHomePageDef












B.3.1.3 Page Parameter Seeded ELs

Page Parameter seeded EL expressions return values related to WebCenter Spaces page parameters. The editor lists all parameters that are defined for the current page. If no parameters are defined, the Page Parameter category is not available.

For example, the seeded page style Three Column provides five seeded page parameters (see Table B-3). The width parameters describe the percentage of total width allotted to each column. The show parameters specify whether a page header and footer are rendered. Of the seeded page styles, Blank, Home Page, Left Narrow, and Right Narrow all provide the same seeded page parameters (see Table B-3). Additionally, any page may have its own custom page parameters.

Whether seeded or custom, available page parameters are exposed in the Expression Builder editor under the Page Parameter category.




	
See Also:

For more information about creating and using page parameters, see Section 19.3, "Wiring Components and Page Parameters."







Table B-3 lists the EL expressions available under the Page Parameter category for pages based on the styles Three Column, Blank, Home Page, Left Narrow, and Right Narrow. It provides an example of the types of values each returns.


Table B-3 Seeded EL Expressions Under Page Parameter

	Option	Expression	Example of Returned Value
	
leftWidth

	
#{bindings.leftWidth}

	
25%


	
centerWidth

	
#{bindings.centerWidth}

	
50%


	
rightWidth

	
#{bindings.rightWidth}

	
25%


	
showHeader

	
#{bindings.showHeader}

	
false


	
showFooter

	
#{bindings.showFooter}

	
false












B.3.1.4 Resource Info Seeded ELs

Resource Info seeded EL expressions return values related to WebCenter Spaces resources, such as templates, styles, resource catalogs, and the like. For example, the expression #{srmContext.id['ResourceID'].singleResult}, returns the resource with the specified GUID.




	
See Also:

For additional resource-related EL expressions, see Section B.3.5, "EL Expressions Relevant to Resources."







Table B-4 lists the seeded EL expressions available under the category Resource Info and provides an example of the types of values each returns.


Table B-4 Seeded EL Expressions Under Resource Info

	Option	Expression	Example of Returned Value
	
Resource ID

	
#{srmContext.id['ResourceID'].singleResult}

	
id:gsr3396194a_3a72_44d6_90b4_57fd6efe4ff7 resourceScope:Scope[name=defaultScope, guid=s8bba98ff_4cbb_40b8_beee_296c916a23ed] resourceType:siteTemplate serviceId:oracle.webcenter.siteresources.sitetemplate category: displayName:Fusion Side Navigation displayNameKey:SITE_TEMPLATE_FUS_SIDE_STRETCH_NAV_DN description:Stretching Page Layout with Side Navigation. Use Fusion FX Skin. descriptionKey:SITE_TEMPLATE_FUS_SIDE_STRETCH_NAV_DESC contentDirectory:/oracle/webcenter/siteresources/shared metadataFile: jspx:/oracle/webcenter/webcenterapp/view/templates/WCSiteTemplateSideNavStretch.jspx pageDef:/oracle/webcenter/webcenterapp/bindings/pageDefs/oracle_webcenter_webcenterapp_view_templates_WCSiteTemplateSideNavStretchPageDef.xml iconURI: excludeFrom: usesCustomSecurity:false visible:TRUE seeded:true createdBy:system createdDate:Fri Jul 02 05:44:19 PDT 2010 modifiedBy:system resourceBundle:oracle.webcenter.sitetemplate.view.resource.SiteTemplateBundle modifiedDate:Fri Jul 02 05:44:19 PDT 2010 logoUrl:/adf/webcenter/srm_dflt_logo_qualifier.png attributes:[]


	
Resource Display Name

	
#{srmContext.displayName['DisplayName'].singleResult}

	
See Resource ID for an example of a returned value.


	
Description

	
#{srmContext.description['Description'].singleResult}

	
See Resource ID for an example of a returned value.


	
Creation Date

	
#{srmContext.createdDate['creationDate'].singleResult}

	
See Resource ID for an example of a returned value.


	
Modified By

	
#{srmContext.modifiedBy['UserName'].singleResult}

	
See Resource ID for an example of a returned value.


	
Modified Date

	
#{srmContext.modifiedDate['ModifiedDate'].singleResult}

	
See Resource ID for an example of a returned value.


	
Resource Scope

	
#{srmContext.resourceScope['ResourceScope'].singleResult}

	
See Resource ID for an example of a returned value.












B.3.1.5 Space Info Seeded ELs

Space Info seeded EL expressions return values related to Spaces (other than the Home Space). For example, the expression #{spaceContext.space['spaceName'].children}, returns a list of the Subspaces under the named parent Space.




	
See Also:

For additional Space-related EL expressions, see Section B.3.6, "EL Expressions Relevant to Specific Spaces."







Table B-5 lists the seeded EL expressions available under the category Space Info and provides an example of the types of values each returns.




	
Note:

Use the EL expressions listed in Table B-5 only in the context of Spaces other than the Home Space.








Table B-5 Seeded EL Expressions Under Space Info

	Option	Expression	Example of Returned Value
	
NamedSpace

	
#{spaceContext.space['spaceName']}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@15fc839


	
CurrentSpace

	
#{spaceContext.currentSpace}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@d5e197


	
CurrentSpace Name

	
#{spaceContext.currentSpaceName}

	
standards


	
NamedSpace Metadata Path

	
#{spaceContext.space['spaceName'].metadataPath}

	
/oracle/webcenter/space/metadata/spaces/spaceName/space.xml


	
CurrentSpace Metadata Path

	
#{spaceContext.currentSpace.metadataPath}

	
/oracle/webcenter/space/metadata/spaces/standards/space.xml


	
NamedSpace Metadata

	
#{spaceContext.space['spaceName'].metadata}

	
oracle.webcenter.spaces.beans.SpaceMetadataImpl@1d7320a


	
CurrentSpace Metadata

	
#{spaceContext.currentSpace.metadata}

	
oracle.webcenter.spaces.beans.SpaceMetadataImpl@1096c64


	
NamedSpace Metadata DisplayName

	
#{spaceContext.space['spaceName'].metadata.displayName}

	
Standards


	
CurrentSpace Metadata DisplayName

	
#{spaceContext.currentSpace.GSMetadata.displayName}

	
Sales


	
NamedSpace Metadata Icon

	
#{spaceContext.space['spaceName'].metadata.icon}

	
/oracle/webcenter/space/metadata/spaces/standards/images/wc_coi_icon.png


	
CurrentSpace Metadata Icon

	
#{spaceContext.currentSpace.metadata.icon}

	
/oracle/webcenter/space/metadata/spaces/Test_Space/images/wc_prj_icon.png


	
NamedSpace Metadata Description

	
#{spaceContext.space['spaceName'].metadata.description}

	
Central point for all standards, templates, and stylesheets for company collateral


	
CurrentSpace Metadata Description

	
#{spaceContext.currentSpace.GSMetadata.description}

	
Sales Force Team Site


	
NamedSpace Metadata CreationDate

	
#{spaceContext.space['spaceName'].metadata.creationDate}

	
java.util.GregorianCalendar[time=1290103432242,areFieldsSet=true,areAllFieldsSet=false,lenient=false,zone=java.util.SimpleTimeZone[id=,offset=-28800000,dstSavings=3600000,useDaylight=false,startYear=0,startMode=0,startMonth=0,startDay=0,startDayOfWeek=0,startTime=0,startTimeMode=0,endMode=0,endMonth=0,endDay=0,endDayOfWeek=0,endTime=0,endTimeMode=0],firstDayOfWeek=1,minimalDaysInFirstWeek=1,ERA=1,YEAR=2010,MONTH=10,WEEK_OF_YEAR=?,WEEK_OF_MONTH=?,DAY_OF_MONTH=18,DAY_OF_YEAR=?,DAY_OF_WEEK=?,DAY_OF_WEEK_IN_MONTH=?,AM_PM=0,HOUR=10,HOUR_OF_DAY=10,MINUTE=3,SECOND=52,MILLISECOND=242,ZONE_OFFSET=?,DST_OFFSET=?]


	
CurrentSpace Metadata CreationDate

	
#{spaceContext.currentSpace.metadata.creationDate}

	
java.util.GregorianCalendar[time=1290103432242,areFieldsSet=true,areAllFieldsSet=false,lenient=false,zone=java.util.SimpleTimeZone[id=,offset=-28800000,dstSavings=3600000,useDaylight=false,startYear=0,startMode=0,startMonth=0,startDay=0,startDayOfWeek=0,startTime=0,startTimeMode=0,endMode=0,endMonth=0,endDay=0,endDayOfWeek=0,endTime=0,endTimeMode=0],firstDayOfWeek=1,minimalDaysInFirstWeek=1,ERA=1,YEAR=2010,MONTH=10,WEEK_OF_YEAR=?,WEEK_OF_MONTH=?,DAY_OF_MONTH=18,DAY_OF_YEAR=?,DAY_OF_WEEK=?,DAY_OF_WEEK_IN_MONTH=?,AM_PM=0,HOUR=10,HOUR_OF_DAY=10,MINUTE=3,SECOND=52,MILLISECOND=242,ZONE_OFFSET=?,DST_OFFSET=?]


	
NamedSpace Metadata CreatedBy

	
#{spaceContext.space['spaceName'].metadata.createdBy}

	
j.doe


	
NamedSpace Metadata Keywords

	
#{spaceContext.space['spaceName'].metadata.keywords}

	
standards templates style sheets collateral


	
CurrentSpace Metadata Keywords

	
#{spaceContext.currentSpace.metadata.keywords}

	
sales salesReports salesNews salesTeam


	
NamedSpace Metadata Offline

	
#{spaceContext.space['spaceName'].metadata.offline}

	
false or true, depending on whether the named Space is offline


	
CurrentSpace Metadata Offline

	
#{spaceContext.currentSpace.metadata.offline}

	
false or true, depending on whether the current Space is offline


	
NamedSpace Metadata Closed

	
#{spaceContext.space['spaceName'].metadata.offline}

	
false or true, depending on whether the named Space is closed


	
CurrentSpace Metadata Closed

	
#{spaceContext.currentSpace.metadata.closed}

	
false or true, depending on whether the current Space is closed


	
NamedSpace Metadata SelfRegistration

	
#{spaceContext.space['spaceName'].metadata.selfRegistration}

	
false or true, depending on whether self registration is enabled for the named Space


	
CurrentSpace Metadata SelfRegistration

	
#{spaceContext.currentSpace.metadata.selfRegistration}

	
false or true, depending on whether self registration is enabled for the current Space


	
NamedSpace Metadata Discoverable

	
#{spaceContext.space['spaceName'].metadata.discoverable}

	
false or true, depending on whether the named Space is discoverable


	
CurrentSpace Metadata Discoverable

	
#{spaceContext.currentSpace.metadata.discoverable}

	
false or true, depending on whether the current Space is discoverable


	
NamedSpace Metadata PublishRSS

	
#{spaceContext.space['spaceName'].metadata.publishRSS}

	
false or true, depending on whether the named Space can be published in an RSS reader


	
CurrentSpace Metadata PublishRSS

	
#{spaceContext.currentSpace.metadata.publishRSS}

	
false or true, depending on whether the current Space can be published in an RSS reader


	
NamedSpace Distribution List

	
#{spaceContext.space['spaceName'].distributionList}

	
standardsGroup@myCompany.com


	
CurrentSpace Distribution List

	
#{spaceContext.currentSpace.distributionList}

	
salesTeam@myCompany.com


	
NamedSpace Metadata CustomAttributes

	
#{spaceContext.space['spaceName'].metadata.customAttributes['attributeName']}

	
Returns the value provided for the named custom attribute


	
CurrentSpace Metadata CustomAttributes

	
#{spaceContext.currentSpace.metadata.customAttributes['attributeName']}

	
Returns the value provided for the named custom attribute


	
CurrentSpace Metadata Logo

	
#{WCAppContext.spacesResourcesPath}#{spaceContext.currentSpace.metadata.logo}

	
/webcenter-spaces-resources/oracle/webcenter/space/metadata/spaces/standards/images/wc_coi_logo.png


	
CurrentSpace Role - Moderator

	
#{WCSecurityContext.userInScopedRole['Moderator']}

	
false or true, depending whether any users in the current scope are assigned the role Moderator


	
CurrentSpace Role - Participant

	
#{WCSecurityContext.userInScopedRole['Participant']}

	
false or true, depending whether any users in the current scope are assigned the role Participant


	
CurrentSpace Role - Viewer

	
#{WCSecurityContext.userInScopedRole['Viewer']}

	
false or true, depending whether any users in the current scope are assigned the role Viewer


	
CurrentSpace Role - Custom

	
#{WCSecurityContext.userInScopedRole['CustomRole']}

	
false or true, depending on if any users in the current scope are assigned the named custom role


	
NamedSpace Children

	
#{spaceContext.space['spaceName'].children}

	
[oracle.webcenter.spaces.internal.model.SpaceImpl@5705f4, oracle.webcenter.spaces.internal.model.SpaceImpl@147d658]

Note: The braces ([]) denote a set.


	
CurrentSpace Children

	
#{spaceContext.currentSpace.children}

	
[oracle.webcenter.spaces.internal.model.SpaceImpl@5705f4, oracle.webcenter.spaces.internal.model.SpaceImpl@147d658]

Note: The braces ([]) denote a set.


	
NamedSpace Parent

	
#{spaceContext.space['spaceName'].parent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@15fc839


	
CurrentSpace Parent

	
#{spaceContext.currentSpace.parent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@15fc839


	
NamedSpace Security Parent

	
#{spaceContext.space['spaceName'].securityParent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@1392793


	
CurrentSpace Security Parent

	
#{spaceContext.currentSpace.securityParent}

	
oracle.webcenter.spaces.internal.model.SpaceImpl@1392793


	
All visible root level spaces

	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE,DISCOVERABLE,PUBLIC_ACCESSIBLE,ALLUSER_ACCESSIBLE,USER_JOINED,USER_MODERATED'].shape['ROOT_LEVEL']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@ae34c8


	
All children and descendent spaces for specified Parent Space GUID

	
#{spaceContext.spacesQuery.parentSpaceGuid['spaceGuid'].shape['RECURSIVE_FLATTENED']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@4da22f


	
Immediate Sub Spaces for specified Parent Space name

	
#{spaceContext.spacesQuery.parentSpaceName['spaceGuid'].shape['ROOT_LEVEL']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@1089971


	
List of Spaces matching given Space Names

	
#{spaceContext.spacesQuery.containingNames['space1, space2,space3']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@68e467


	
List of Spaces matching given Space GUID

	
#{spaceContext.spacesQuery.containingGuids['spaceGuid1, spaceGuid2']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@1c56009


	
List of Spaces sorted based on criteria

	
#{spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.sortCriteria['sp.lastUpdateDate desc']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@6c3def


	
List of Spaces based on search pattern

	
#{spaceContext.spacesQuery.unionOf.ALL_QUERIABLE.search['searchKeyword']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@19b2cf3


	
List of Spaces with limited page size

	
#{spaceContext.spacesQuery.unionOf.USER_JOINED.itemsPerPage[2].pageNumber[1]}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@4f8818


	
List of Spaces matching the where clause

	
#{spaceContext.spacesQuery.unionOf.USER_JOINED.whereClause['sp.createdBy = \'userName\'']}

	
oracle.webcenter.spaces.query.SpacesQueryParameters@1ba816d












B.3.1.6 Space Page Info Seeded Paths

Rather than EL expressions, the selections under Space Page Info are directory paths to different application pages. Use them, for example, to provide navigation information to a specified page.

Table B-6 lists the seeded directory paths available under the category Space Page Info and provides an example of the types of values each returns.


Table B-6 Seeded Paths Under Space Page Info

	Option	Path	Destination
	
COIHome.jspx

	
/faces/oracle/webcenter/page/scopedMD/se2dff4fb_202a_4f4c_b56d_c7cf59ad1c04/COIHome.jspx

	
Path to the Home page of the current Space


	
GroupSpaceDocLibMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/GroupSpaceDocLibMainView.jspx

	
Path to the Documents page in the current Space


	
ForumMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/ForumMainView.jspx

	
Path to Discussions page in the current Space


	
AnnouncementsMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/AnnouncementsMainView.jspx

	
Path to Announcements page in current Space


	
EventsMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/EventsMainView.jspx

	
Path to Events page in current Space


	
ListsMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/ListsMainView.jspx

	
Path to Lists page in current Space


	
GroupSpaceActivityMainView.jspx

	
/faces/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/businessRolePages/GroupSpaceActivityStreamMainView.jspx

	
Path to Activity Stream page in current Space












B.3.1.7 System Seeded ELs

System seeded EL expressions return values related to system settings, such as the user name of the current user or the current user's specified locale. For example, the expression #{securityContext.userName}, returns the name of the currently logged in user. For example, if user j.doe is viewing a page where this expression is used, the returned value in j.doe's view is j.doe. If user j.smith is looking at the same page, the value returned in j.smith's view is j.smith.




	
See Also:

For additional utilitarian EL expressions, see Section B.3.15, "Utilitarian EL Expressions."







Table B-7 lists the seeded EL expressions available under the category System and provides an example of the types of values each returns.


Table B-7 Seeded EL Expressions Under System

	Option	Expression	Example of Returned Value
	
User

	
#{securityContext.userName}

	
The current user's user name


	
Locale

	
#{facesContext.externalContext.requestLocale}

	
The current user's specified locale

This may be taken from application or Space-level settings or user Preferences, whichever is taking precedence.

For example:


en_US












B.3.1.8 User Info Seeded ELs

User Info seeded EL expressions return values related to a given user's Profile. For example, the expression #{webCenterProfile[securityContext.userName].description}, returns the content of the About Me attribute of the current user's Profile.




	
See Also:

For additional user-related expressions, see Section B.3.13, "EL Expressions Relevant to the People Connections Service."







Table B-8 lists the seeded EL expressions available under the category User Info and provides an example of the types of values each returns.


Table B-8 Seeded EL Expressions Under User Info

	Option	Expression	Example of Returned Value
	
About Me

	
#{webCenterProfile[securityContext.userName].description}

	
Returns the content of the About Me attribute of the current user's Profile


	
Username

	
#{webCenterProfile[securityContext.userName].userName}

	
The user name specified in the current user's Profile

Compare this with the current user's display name.


	
First Name

	
#{webCenterProfile[securityContext.userName].firstName}

	
The current user's first name


	
Middle Name

	
#{webCenterProfile[securityContext.userName].middleName}

	
The current user's middle name


	
Last Name

	
#{webCenterProfile[securityContext.userName].lastName}

	
The current user's last name


	
Initials used

	
#{webCenterProfile[securityContext.userName].initials}

	
The current user's initials


	
Display Name

	
#{webCenterProfile[securityContext.userName].displayName}

	
The current user's display name

Compare this with the current user's user name.


	
Email

	
#{webCenterProfile[securityContext.userName].businessEmail}

	
The current user's business email address


	
Department

	
#{webCenterProfile[securityContext.userName].department}

	
The current user's department


	
Job Title/Designation

	
#{webCenterProfile[securityContext.userName].title}

	
The current user's job title or designation


	
Manager

	
#{webCenterProfile[securityContext.userName].managerDisplayName}

	
The current user's manager's display name


	
Time zone

	
#{webCenterProfile[securityContext.userName].timeZone}

	
The time zone associated with the current user


	
Employee type

	
#{webCenterProfile[securityContext.userName].employeeType}

	
The current user's employee type


	
Employee Number

	
#{webCenterProfile[securityContext.userName].employeeNumber}

	
The current user's employee number


	
Preferred Language Code

	
#{webCenterProfile[securityContext.userName].preferredLanguage}

	
The current user's preferred language


	
Organization

	
#{webCenterProfile[securityContext.userName].organization}

	
The company organization to which the current user belongs


	
Organizational Unit

	
#{webCenterProfile[securityContext.userName].organizationalUnit}

	
The unit of the company organization to which the current user belongs


	
Expertise

	
#{webCenterProfile[securityContext.userName].expertise}

	
The current user's expertise, for example, Application, system, and database administration


	
Business Fax

	
#{webCenterProfile[securityContext.userName].businessFax}

	
The current user's business fax number


	
Business Mobile

	
#{webCenterProfile[securityContext.userName].businessMobile}

	
The current user's business mobile or cell phone number


	
Business Phone

	
#{webCenterProfile[securityContext.userName].businessPhone}

	
The current user's business phone number


	
Business Pager

	
#{webCenterProfile[securityContext.userName].businessPager}

	
The curren user's business pager number


	
Business Street

	
#{webCenterProfile[securityContext.userName].businessStreet}

	
The street address of the current user's business office


	
Business City

	
#{webCenterProfile[securityContext.userName].businessCity}

	
The city where the current user's business office is located


	
Business State

	
#{webCenterProfile[securityContext.userName].businessState}

	
The state where the current user's business office is located


	
Business PO Box

	
#{webCenterProfile[securityContext.userName].businessPOBox}

	
The current user's business Post Office Box number


	
Business Postal Code

	
#{webCenterProfile[securityContext.userName].businessPostalCode}

	
The postal or ZIP code of the current user's business office


	
Business Country

	
#{webCenterProfile[securityContext.userName].businessCountry}

	
The country where the current user's business office is located


	
Home Address

	
#{webCenterProfile[securityContext.userName].homeAddress}

	
The current user's home address


	
Home phone

	
#{webCenterProfile[securityContext.userName].homePhone}

	
The current user's home phone number


	
Date of Birth

	
#{webCenterProfile[securityContext.userName].dateofBirth}

	
The current user's date of birth


	
Maiden Name

	
#{webCenterProfile[securityContext.userName].maidenName}

	
The current user's maiden name


	
Date of hire

	
#{webCenterProfile[securityContext.userName].dateofHire}

	
The date the current user was hired by the company


	
Name Suffix

	
#{webCenterProfile[securityContext.userName].nameSuffix}

	
Titles or credentials appended to the current user's name, for example, MD, Esq, and the like


	
Wireless Account Number

	
#{webCenterProfile[securityContext.userName].wirelessAcctNumber}

	
The account number for the current user's wireless internet account












B.3.1.9 WebCenter Events Seeded ELs

WebCenter Events seeded EL expressions return values related to document-related events, such a selected document, the document's creator, the date the document was last modified, and so on. For example, the expression #{wcEventContext.events.WebCenterResourceSelected.name}, returns the name of the currently selected document.

Table B-9 lists the seeded EL expressions available under the category WebCenter Events and provides an example of the types of values each returns.


Table B-9 Seeded EL Expressions Under WebCenter Events

	Option	Expression	Example of Returned Value
	
Selected User Name

	
#{wcEventContext.events.WebCenterUserSelected.UserName}

	
The user name of the currently selected user


	
Selected Document Name

	
#{wcEventContext.events.WebCenterResourceSelected.name}

	
The name of the currently selected document


	
Selected Document Creator

	
#{wcEventContext.events.WebCenterResourceSelected.createdBy}

	
The name of the user who created the currently selected document


	
Selected Document Last Modified

	
#{wcEventContext.events.WebCenterResourceSelected.lastModifiedBy}

	
The date the selected document was last modified














B.3.2 EL Expressions Relevant to the WebCenter Spaces Application

Table B-10 lists EL expressions relevant to WebCenter Spaces application information and describes the types of functionality it provides. The Context column indicates whether the expression can be used in a WebCenter Spaces context (WCS) or in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper (Both).


Table B-10 EL Expressions Relevant to WebCenter Spaces Application Information

	Expression	Function	Context
	
#{WCAppContext}

	
An oracle.webcenter.webcenterapp.context.WCApplicationContext object that provides an access point in the current web request for all WebCenter application-related information.

	
WCS


	
#{WCAppContext.currentWebCenterURI}

	
Returns a URL representing the current web request with bookmarkable WebCenter Spaces URL parameters of the request appended to the end (parameters are not necessarily in a fixed order).

Example:


http://name.us.oracle.com/webcenter/faces/oracle/webcenter/page/scopedMD/someguid/SomePage.jspx?
wc.contextURL=/spaces/somename&wc.pageScope=1234

	
WCS


	
#{WCAppContext.application.applicationConfig}

	
An oracle.webcenter.webcenterapp.beans.WebCenterType bean with a payload of metadata from the current WebCenter Spaces application.

	
WCS


	
#{WCAppContext.application.applicationConfig.title}

	
Returns the display name of the current WebCenter Spaces application (as configured through WebCenter Administration settings).

Out of the box, this returns WebCenter.

	
WCS


	
#{WCAppContext.application.applicationConfig.logo}

	
If an application logo was uploaded through WebCenter Administration settings, this expression returns the URL to the application logo image.

Out of the box, this returns null.

	
WCS


	
#{WCAppContext.application.applicationConfig.helpPage}

	
Returns the URL to the Help application used for the current WebCenter Spaces application (as configured through WebCenter Administration settings).

Out of the box, this returns /webcenterhelp/spaces.

	
WCS


	
#{WCAppContext.application.applicationConfig.copyrightMessage.customValue}

	
If a copyright message was configured through WebCenter Administration settings, this expression returns the application copyright message.

Out of the box, this returns null.

	
WCS


	
#{WCAppContext.application.applicationConfig.privacyPolicyUrl}

	
Returns the URL to the document that contains the application's privacy policy (as configured through WebCenter Administration settings).

Out of the box, this returns http://www.oracle.com/html/privacy.html

	
WCS


	
#{WCAppContext.application.applicationConfig.skin}

	
Returns the name of the default ADF Faces skin family to use for rendering pages in the application (as configured through WebCenter Administration settings).

This expression represents only the application-level setting that may not necessarily be used in all web requests. For example, you cannot use it successfully if a user has chosen to override the skin through application Preferences (for more information, see Chapter 35, "Setting Your Personal Preferences").

	
WCS


	
#{requestContext.skinFamily}

	
Returns the name of the ADF Faces skin family being used for the current web request, depending on factors such as what has been configured at the application level, the current user's preference setting, and so on.

Returns the same value as #{adfFacesContext.skinFamily}.

	
Both












B.3.3 EL Expressions Relevant to Application Security

Table B-11 lists EL expressions relevant to application security and describes the types of functionality it provides. The Context column indicates whether the expression can be used in a WebCenter Spaces context (WCS) or in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper (Both).




	
See Also:

For example implementations of expressions related to component-level security, see Section 23.2, "Setting Access on a Page Component."








Table B-11 EL Expressions Relevant to Security

	Expression	Function	Context
	
#{security.authenticated}

	
Returns true when the current user is authenticated in the context in which the EL is being invoked, otherwise false.

	
Both


	
#{securityContext.userName}

	
Returns the user name of the currently logged in user. If the current user is not logged in, this expression returns no value.

	
Both


	
#{security.pageContextCommunityModerator}

	
Returns the value true if the current user is a moderator of the current Space.

	
WCS


	
#{WCSecurityContext.userInScopedRole['role']}

	
Returns the value true if the current user is assigned the specified role in the current scope. Role can be Moderator, Participant, Viewer, or a custom role defined in that scope.

The scope is implicitly resolved to be the current scope. If you use this EL in the Home Space, it resolves to Home Space GUID and roles defined at the application level. If you use this EL in a Space scope, it resolves to roles defined for the Space.

	
WCS


	
#{WCSecurityContext.userInGroup['group']}

	
Returns the value true if the current user is assigned the specified group, for example, Administrators.

	
Both


	
#{WCSecurityContext.currentUser['userName']}

	
Returns the value true if the current user is the specified user.

	
Both












B.3.4 EL Expressions Relevant to Application Navigation

Table B-12 lists EL expressions relevant to WebCenter Spaces navigation and describes the types of functionality it provides. All navigation ELs can be used in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper.


Table B-12 EL Expressions Relevant to Navigation

	Expression	Function
	
Navigation Context Expressions

	

	
#{navigationContext.defaultNavigationModel}

	
Returns default navigation model. It gets the value from the preference bean. The preference bean gets the value based on the preference setting in adf-config.xml, static value.

The following example returns the specified default tree model:


#{navigationContext.defaultNavigationModel.defaultTreeModel}


You can also use defaultMenuModel and defaultListModel (see next listing).


	
#{navigationContext.currentNavigationModel}

	
Returns the navigation model used to navigate to the current view (that is, the current page)

There may be a number of navigation models on the page. Only the one used to navigate to the page is the current navigation model.

The current navigation model is set only when the processAction is called.

The following example returns the default tree model for the current navigation model:


#{navigationContext.currentNavigationModel.defaultTreeModel}


You can also use defaultMenuModel and defaultListModel.

See Also: #{navigationContext.processAction}.


	
#{navigationContext.navigationModel['model_path']}

	
Returns the navigation model specified by path.

Example:


#{navigationContext.navigationModel['/oracle/webcenter/portalapp/navigations/default-navigation-model']}


User can simply enter the path in the square bracket without having to remember the parameter name. For backward compatibility, comma-separated parameters are also supported. Available parameters (with examples) are:

	
modelPath=/oracle/webcenter/portalapp/navigations/default-navigation-model


	
modelScope=/oracle/webcenter/portalapp/navigation


	
modelId=default-navigation-model




Note: modelScope and modelId are used together, for example:


#{navigationContext.navigationModel['modelScope=/oracle/webcenter/portalapp/navigations,modelId=default-navigation-model']}


	
#{navigationContext.processAction}

	
Returns the default navigation method for binding to UI component's actionListener attribute. This assumes that the target resource to navigate to is passed in through the action UI component's node or path attribute.

The node attribute is typically used for the iterative case; while the path attribute is typically used to create a static link. If both are specified, the node attribute is used. Note that when using the path attribute, you must also specify the model attribute to pass in the navigation model object. If the model attribute is not specified, the current navigation model is used.

Example using the node attribute:


<af:forEach var="node" varStatus="vs"
 items="#{navigationContext.defaultNavigationModel.rootNode.children}">
  <af:subform id="pt_sfm1">
   <af:commandLink id="pt_cl1"
    text="#{node.title}"
    inlineStyle="font-size:small;color:White;"
    actionListener="#{navigationContext.processAction}"
    action="pprnav">
   <f:attribute name="node" value="#{node}"/>
    <af:showPopupBehavior popupId="menuPopup"
     align="afterStart"
     triggerType="mouseOver"/>
  </af:commandLink>


Example using the path attribute:


<af:commandLink id="pt_cl1" text="Prescriptions"
  inlineStyle="font-size:small; color:White;"
  actionListener="#{navigationContext.processAction}"
  action="pprnav">
<f:attribute name="path" value="/prescriptions"/>
<f:attribute name="model"   value="#{navigationContext.defaultNavigationModel}"/>
</af:commandLink>


	
Navigation Model Expressions

	

	
#{navigationContext.defaultNavigationModel.defaultTreeModel}

#{navigationContext.defaultNavigationModel.defaultMenuModel}

#{navigationContext.defaultNavigationModel.defaultListModel}

#{navigationContext.defaultNavigationModel.defaultSiteMap}

	
Returns a tree/menu/list model based on the default settings

The default values for the settings are specified in the next row. For example, the default value for depth is 0.

For defaultSiteMap, it returns the XML for the sitemap of the navigation based on the default settings.

This expression returns a model of type:

	
ChildPropertyTreeModel—used in <af:tree> component


	
ChildPropertyMenuModel—used in <af:breadcrumbs> or <af:menu> component


	
List<NavigationResource>—used in <af:foreach>





	
#{navigationContext.defaultNavigationModel.treeModel['parameters']}

#{navigationContext.defaultNavigationModel.menuModel['parameters']}

#{navigationContext.defaultNavigationModel.listModel['parameters']}

#{navigationContext.defaultNavigationModel.siteMap['parameters']}

	
Returns tree/menu/list model based on the specified comma-separated parameters. Available parameters (with default values as examples) are:

	
startNode=/—specify the starting node of the model (do not need "/" prefix unless requesting the root node, for example, home).


	
includeStartNode=true—specify true if you want to include the starting node (for example, the root node above) or false to start from its children.


	
depth=0—defines the initial depth of fetching. "0" means fetch the entire tree, which may take a long time. In which case, use "1" to fetch on demand (when users click the Expand icon).


	
prefetchOnly=false—by default (true), it returns nodes up to the depth level requested initially; deeper level nodes are returned on demand. Use false if you want only the initial sets of nodes. In which case, it does not return deeper nodes later on when requested, even when there are deeper nodes.




For siteMap, the available parameters are startNode and includeStartNode.

Example:


#{navigationContext.defaultNavigationModel.treeModel['startNode=home,includeStartNode=false,depth=2']}


	
#{navigationContext.defaultNavigationModel.rootNode}

	
Returns a root node (of type NavigationResource) of the navigation model.

Example:


<af:commandLink id="pt_cl1" text="Prescriptions"
  inlineStyle="font-size:small; color:White;"
  actionListener="#{navigationContext.processAction}"
  action="pprnav">
 <f:attribute name="node"
    value="#{navigationContext.
    defaultNavigationModel.
    rootNode.children[2]"/>
</af:commandLink>


	
#{navigationContext.defaultNavigationModel.node['path']}

	
Returns a node (of type NavigationResource) based on the path specified (you do not need "/" prefix unless you are requesting the root node, for example, '/')

Example:


#{navigationContext.defaultNavigationModel.node['home/page1']}


	
#{navigationContext.defaultNavigationModel.currentSelection}

	
Returns currently selected navigation resource.


	
#{navigationContext.defaultNavigationModel.newCurrentSelection['path']}

	
Sets the current selection to a node specified by the given path (you do not need "/" prefix unless you are requesting the root node, for example, '/'). If successful, returns the newly selected node of type NavigationResource.

The user must have the ability to explicitly set the current selection without having to actually navigate to a node.

This can be used where the user enters a page directly, and no selection is set. It provides a mechanism for the user to control what is the default when there is no current selection.

Example:


<c:set  value="${navigationContext.defaultNavigationModel.newCurrentSelection['home/page1']}"
 var="currSel" scope="session"/>
<c:if test="${currSel!=null}">
 <af:forEach items="#{currSel.children}"
  var="cnode" varStatus="cnodestatus">
...</c:if>


	
#{navigationContext.defaultNavigationModel.attributes.Description}

#{navigationContext.defaultNavigationModel.attributes['Description']}

	
Returns the value of the specified attribute of the navigation model.


	
Navigation Resource Expressions

	

	
#{node.attributes.Description}

#{node.attributes['Description']}

	
Returns the value of the specified attribute of the navigation resource.


	
#{node.parameters.StockSymbol}

#{node.parameters['StockSymbol']}

	
Returns the value of the specified parameter of the navigation resource.


	
#{node.parametersRaw.StockSymbol}

#{node.parametersRaw['StockSymbol']}

	
Returns the raw value of the specified parameter of the navigation resource (before it is evaluated).


	
#{node.title}

	
Returns the title of the navigation resource.


	
#{node.path}

	
Returns the path to the navigation resource.


	
#{node.externalURL}

	
Returns the URL for the navigation resource of type External Link.


	
#{node.prettyUrl}

	
Returns the identifying path for this navigation resource.


	
#{node.prettyUrlPath}

#{node.prettyUrlPath[N]}

	
Returns a collection of identifying paths by depth to enable its use as a starting path to drive another navigation view.

For example, assuming the currentSelection is home/company/products/applications, the following EL returns home/company/products:


#{node.prettyUrlPath[3]}


	
#{node.goLinkPretty Url}

	
Returns the identifying path for this navigation resource suitable for goLink destination


<af:goLink id="pt_gl2" text="#{node.title}"
   destination="#{node.goLinkPrettyUrl}"
   targetFrame="#{node.attributes['Target']}"
   inlineStyle="font-size:small;#{node.selected ?
   'font-weight:bold;' : ''}"/>


	
#{node.separator ? ... : ...}

	
Returns whether this resource is a separator item.


	
#{node.navigable ? ... : ...}

	
Returns whether it is possible to navigate to this resource.


	
#{node.selected ? ... : ...}

	
Returns whether this resource is currently selected.


	
#{node.currentlySelected ? ... : ...}

	
Returns whether the resource is the currently selected resource and the model is the currently selected model.


	
#{node.onSelectedPath ? ... : ...}

	
Returns whether this node lies on the selected path. This is useful for highlighting the selected tab, for example.

For example, assuming the currently selected node is home/company/products/applications, the following EL highlights the home tab.


<c:set  value="${navigationContext.defaultNavigationModel.node['home']}"
 var="home" scope="session"/>
  <af:commandImageLink id="cil1"
    icon="#{(home.onSelectedPath) ?
    '/images/caremark/nav/HomeSelected.png' :
    '/images/caremark/nav/HomeIcon.png'}"
    actionListener="#{navigationContext.processAction}"
    action="pprnav">
  <f:attribute name="node" value="#{home}"/></af:commandImageLink>


	
#{node.leaf ? ... : ...}

	
Returns whether this resource is a leaf node.


	
#{node.parent}

	
Returns the parent node (of type NavigationResource) of this node. For the root node, null is returned.


	
#{node.ancestors}

	
Returns the hierarchy list of ancestors of this node (of type NavigationResource) starting with the root node.

For example, assuming the current node is home/company/products/applications, the following ELs return the following values:

	
#{node.ancestors[1]} returns the node for home


	
#{node.ancestors[3]} returns the node for home/company/products





	
#{node.depth}

	
Returns the depth of this node from the root node. Root node has a depth of zero.


	
#{node.siblings}

	
Returns the list of siblings (of type NavigationResource) of this node (inclusive).


	
#{node.nextSibling}

	
Returns the next sibling in the list (of type NavigationResource) of this node.

For example, the following code ensures that you do not output two separators in a row:


<c:if test="${(node.separator) && (!node.nextSibling.separator}">
  <af:separator id="s166"/>
</c:if>


	
#{node.previousSibling}

	
Returns the previous sibling in the list (of type NavigationResource) of this node.


	
#{node.index}

	
Returns the zero-relative index of this node relative to its siblings.


	
#{node.children}

#{node.children[N].title}

#{node.children[N].children[N].title}

	
Returns a collection of child resources.


	
#{node.childCount}

	
Returns the number of children of this node.


	
#{node.childByIndex['index']}

	
Returns the child node (of type NavigationResource) specified by the zero-relative index

If not found, this returns null.


	
#{node.childByPath['admin']}

	
Returns the child node (of type NavigationResource) specified by the path relative to this node

The path can be deeper than one level and does not need the '/' prefix. If not found, this returns null.












B.3.5 EL Expressions Relevant to Resources

Use the expressions in this section to query for resources. Querying for a resource through an EL expression is similar to querying for it through an API call. That is, you must set query parameters in the format .property['value'], where property is the name of the property, for example, id, resourceScope, and the like, and value is the search value for the attribute.

A query can result in single or multiple results. The query designer must decide what is wanted. The query designer determines whether to return one or multiple results by encountering one of the following values in the expression:

	
singleResult—Returns a single resource. When no matching resource is found, null is returned.


	
resultList—Returns a list of resources. When no matching resources are found, an empty list is returned.







	
Note:

Occurrences of singleResult or resultList in the expression are used internally as the query end point, and, after this, the query is executed immediately. Anything set after the end point can result in unexpected behavior.







The following example returns the first template resource found with a display name that contains myPage:


#{srmContext.resourceType['siteTemplate'].displayName['myPage'].singleResult}


The following example returns a list of template resources residing in the directory resourceDir, with a description that contains sampleDesc:


#{srmContext.resourceType['siteTemplate'].description['sampleDesc'].contentDirectory['resourceDir'].resultList}


A property of this class includes any attribute of this class. Example properties include: Id, DisplayName, iconURI, contentDirectory, and the like.

The property value can be an explicit value or an EL expression that returns that type of value. For example, the following two queries return the same result:


#{srmContext.id['resourceId'].singleResult}

#{srmContext.id['spacesContext.currentSpace.uiMetadata.siteTemplateId'].singleResult}


You can use any property of this class in an EL-based query in the format property['value'] and in any order. For example, the following two queries return the same result:


#{srmContext.resourceScope['scopeName'].id['resourceId'].singleResult}

#{srmContext.id['resourceId'].resourceScope['scopeName'].singleResult} 


Table B-13 lists EL expressions relevant to WebCenter resources and describes the types of functionality each provides. You can use all resource EL expressions in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper.


Table B-13 ELs Relevant to WebCenter Site Resources

	EL	Function
	
#{srmContext.id['resourceGUID']}

	
Returns the resource with the specified ID


	
#{srmContext.displayName['resourceDisplayName']}

	
Returns any resources with the specified display name


	
#{srmContext.displayNameKey['displayNameKey']}

	
Returns any resources with the specified display name key


	
#{srmContext.description['resourceDescription'].singleResult}

	
Returns one result of a resource that contains the specified value in its description

To get multiple results, use resultList in lieu of singleResult.


	
#{srmContext.descriptionKey[descriptionKey].singleResult}

	
Returns one result of a resource with the specified description key

The description key is the key in the xsrt file for the resource description.

To get multiple results, use resultList in lieu of singleResult.


	
#{srmContext.createdDate['resourceCreationDate']}

	
Returns any resource with the specified creation date


	
#{srmContext.modifiedBy['resourceLastModifiedBy']}

	
Returns any resource that was last modified bythe user with the specified user name


	
#{srmContext.modifiedDate['resourceLastModifiedDate']}

	
Returns any resource that was last modified by the specified date


	
#{srmContext.resourceScope['resourceScope']}

	
Returns any resource that falls within the specified scope


	
#{srmContext.category['categoryName']}

	
Returns any resource that falls within the specified category

For example:


#{srmContext.category['siteTemplates']}


	
#{srmContext.contentDirectory['contentDirectory']}

	
Returns any resource that is stored within the specified directory


	
#{srmContext.metadataFile['metadataFileLocation']}

	
Returns resource metadata from the specified metadata file

For example, the following expression returns resource metadata from the following file /home/metadata/data.xml:


#{srmContext.metadataFile['/home/metadat/data.xml']}


	
#{srmContext.jspx['jspxFileLocation']}

	
Returns any jspx file in the specified location

For example, the following expression returns the page.jspx file:


#{srmContext.jspx['/home/web/page.jspx']}


	
#{srmContext.pageDef['pageDefinition']}

	
Returns any jspx file with the specified page definition


	
#{srmContext.iconURI['iconURI']}

	
Returns the icon at the specified icon URI


	
#{srmContext.excludeFrom['excludeFromScopes']}

	
In a larger expression, returns all specified resources except those available in the excluded scopes


	
#{srmContext.usesCustomSecurity['usesCustomSecurity']}

	
In a larger expression, returns any resource the either does or does not use custom security

Set usesCustomSecurity to TRUE or FALSE. For example:


#{srmContext.usesCustomSecurity['TRUE']}


	
#{srmContext.seeded['seeded']}

	
In a larger expression, returns any resource that is or is not seeded, depending on the provided value

Set seeded to TRUE or FALSE. For example:


#{srmContext.seeded['TRUE']}


	
#{srmContext.visibleType['visibleType']}

	
In a larger expression, returns any resource that is of the specified type of visibility

Set visibleType to TRUE, FALSE, or NEVER to indicate that the resource is never shown. For example, the following expression returns resources that are visible, that is, resources that are set to Show:


#{srmContext.visibleType['TRUE']}


	
#{srmContext.visible['visible']}

	
In a larger expression, returns one or multiple resources with visibility set to either TRUE or FALSE


	
#{srmContext.createdBy['resourceCreator']}

	
In a larger expression, returns any resource created by the specified user


	
#{srmContext.resourceType['resourceType']}

	
In a larger expression, returns one or multiple resources of the specified type

For example, the following expression searches for a resource of the type SITE_TEMPLATE:


#{srmContext.resourceType['SITE_TEMPLATE']}


Note that all resource types are listed in Oracle Fusion Middleware Java API Reference for Oracle WebCenter, in the GenericSiteResourceTypes class.


	
#{srmContext.version['version']}

	
In a larger expression, returns one or multiple resources available in the application of the specified version


	
#{srmContext.resourceScope['scopeName']}

	
In a larger expression, returns one or multiple resources available in the specified scope

For example, the following expression searches for resources in the scope (in this instance, the Space) MySpace:


#{srmContext.resourceScope['MySpace']}


To search in the default scope, that is, the application scope, use defaultScope.


	
#{srmContext.searchType['searchType']}

	
In a larger expression, returns one or multiple resources that contain or equal the values set by other included expressions

Set searchType to CONTAINS or EQUALS.












B.3.6 EL Expressions Relevant to Specific Spaces

Table B-14 lists EL expressions relevant to Spaces and describes the types of functionality each provides. All of the listed ELs are for use in WebCenter Spaces.




	
Note:

The Space internal name is the name specified by the Space URL on the General page of a Space's administration settings. The Space display name is specified by Display Name. Many of the EL expressions in Table B-14 call for the Space internal name.








Table B-14 EL Expressions Relevant to WebCenter Spaces Spaces

	Expression	Function
	
#{spaceContext}

	
An oracle.webcenter.spaces.context.SpacesContext object that provides an access point in the current web request for all Space-related information.

The value of this expression is whatever is returned on invoking the java API: SpacesContext.getCurrentInstance()


	
#{spaceContext.currentSpace}

	
An oracle.webcenter.spaces.Space object that represents the Space associated with the current web request. If the current web request is in the Home Space context, it returns a value of null.

The value of this expression is whatever is returned on invoking the Java API: SpacesContext.getCurrentInstance().getCurrentSpace()


	
#{spaceContext.currentSpaceName}

	
The name of the Space associated with the current web request. If the current web request is in a Home Space context, it returns a value of null.

The value of this expression is whatever is returned on invoking the java API: SpacesContext.getCurrentInstance().getCurrentSpace()


	
#{spaceContext.space['spaceName']}

#{spaceContext.currentSpace}

	
An oracle.webcenter.spaces.Space object that represents the Space that is named spaceName or the current Space (currentSpace). For example, #{spaceContext.space['FinanceProject']} returns the Space object for the Space called FinanceProject.

The value of this expression is whatever is returned in Java on invoking .getSpace(...) on the current SpacesManager passing in the MDSSession of the current ADFContext.


	
#{spaceContext.space['spaceName'].metadataPath}

#{spaceContext.currentSpace.metadataPath}

	
The MDS path of the space metadata document for the Space with specified name spaceName or the current Space (currentSpace). For example, #{spaceContext.space['FinanceProject'].metadataPath} evaluates to /oracle/webcenter/space/metadata/spaces/FinanceProject/space.xml

The value of this expression is whatever is returned in java on invoking .getMetadataPath() on the space object for the Space.


	
#{spaceContext.space['spaceName'].metadata}

#{spaceContext.currentSpace.metadata}

	
An oracle.webcenter.spaces.beans.SpaceType bean that carries metadata about the Space that is named spaceName or the current Space (currentSpace).

The value of this expression is whatever is returned in java on invoking .getMetadata() on the space object for the Space passing in the MDSSession of the current ADFContext.


	
#{spaceContext.space['spaceName'].metadata.displayName}

#{spaceContext.currentSpace.metadata.displayName}

	
The display name of the Space that is named spaceName or the current Space (currentSpace). For example, if a Space called Web20Space has the display name web 2.0 Space, then #{spaceContext.space['Web20Space'].metadata.displayName} evaluates to web 2.0 Space.


	
#{WCAppContext.spacesResourcesPath}#{spaceContext.space['spaceName'].metadata.icon}

#{WCAppContext.spacesResourcesPath}#{spaceContext.currentSpace.metadata.icon}

	
A URL to the icon associated with the Space that is named spaceName or the current Space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.description}

#{spaceContext.currentSpace.metadata.description}

	
The description of the Space that is named spaceName or the current Space (currentSpace). For example, #{spaceContext.space['FinanceProject'].metadata.description} evaluates to Conglomeration of all teams involved in financial activities.


	
#{spaceContext.space['spaceName'].metadata.creationDate}

#{spaceContext.currentSpace.metadata.creationDate}

	
A java.util.Calendar object representing the date-time on which the Space with specified name spaceName or the current Space (currentSpace) was created.


	
#{spaceContext.space['spaceName'].metadata.createdBy}

#{spaceContext.currentSpace.metadata.createdBy}

	
The user-name of the person who created the Space that is named spaceName or the current Space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.keywords}

#{spaceContext.currentSpace.metadata.keywords}

	
A comma-delimited list of searchable keywords associated with the Space with the name spaceName or the current Space (currentSpace). For example, if the Space FinanceProject has the keywords finance, project, money, then #{spaceContext.space['FinanceProject'].metadata.keywords} evaluates to finance, project, money.


	
#{spaceContext.space['spaceName'].metadata.offline}

#{spaceContext.currentSpace.metadata.offline}

	
Boolean value that indicates whether the Space that is named spaceName or the current Space (currentSpace) is offline.


	
#{spaceContext.space['spaceName'].metadata.closed}

#{spaceContext.currentSpace.metadata.closed}

	
Boolean value that indicates whether the Space that is named spaceName or the current Space (currentSpace) is closed.


	
#{spaceContext.space['spaceName'].metadata.selfRegistration}

#{spaceContext.currentSpace.metadata.selfRegistration}

	
Boolean value that indicates whether users are allowed to register themselves with the Space that is named spaceName or the current Space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.discoverable}

#{spaceContext.currentSpace.metadata.discoverable}

	
Boolean value that indicates whether users can discover the existence of the Space that is named spaceName or the current Space (currentSpace) by searching for it or seeing it listed on the My Spaces page.


	
#{spaceContext.space['spaceName'].metadata.publishRSS}

#{spaceContext.currentSpace.metadata.publishRSS}

	
Boolean value indicating whether the Space that is named spaceName or the current Space (currentSpace) publishes RSS feeds.


	
#{spaceContext.space['spaceName'].distributionList}

#{spaceContext.currentSpace.distributionList}

	
The email address of the mailing list associated with the Space that is named spaceName or the current Space (currentSpace).


	
#{spaceContext.space['spaceName'].metadata.customAttributes['attributeName']}

#{spaceContext.currentSpace.metadata.customAttributes['attributeName']}

	
The value of a specific custom attribute of the name attributeName for the Space that is named spaceName or the current Space (currentSpace). For example, if the FinanceProject Space has a custom attribute called stockPrice with a value of 13.9, then #{spaceContext.space['FinanceProject'].metadata.customAttributes['stockPrice']} evaluates to 13.9.


	
#{WCAppContext.spacesResourcesPath}#{spaceContext.space['spaceName'].metadata.logo}

#{WCAppContext.spacesResourcesPath}#{spaceContext.currentSpace.metadata.logo}

	
Returns the logo URL for the Space named spaceName or the current Space (currentSpace).


	
#{spaceContext.spacesQuery.property['value']}

#{spaceContext.spacesQuery.property['value'].listSpaces}

	
A means of querying a Space using a query parameter in the form of property['value'], where property means the name of the property, for example, unionOf, shape, and the like; and value means the criteria to use in fetching the list of all Spaces, discoverable Spaces, and the like.

If listSpaces is appended to the expression, the query returns the list of Spaces of type GSMetadata. (For more information, see Interface GSMetadata in Oracle Fusion Middleware Java API Reference for Oracle WebCenter.)

For example, the following EL expression returns a list of all discoverable Spaces.


#{spaceContext.spacesQuery.unionOf['DISCOVERABLE'].listSpaces}


If listSpaces is not appended to the EL, then the EL evaluates to an object of type SpacesQueryParameter. This object type must be evaluated using SpacesManager.getSpaces(SpacesQueryParameters), which in turn returns a list of spaces of type GSMetadata.

For example, the following EL expression returns an instance of type SpacesQueryParameters with all the query conditions populated.


#{spaceContext.spacesQuery.unionOf['DISCOVERABLE']}


	
#{spaceContext.spacesQuery.unionOf['USER_JOINED'].shape['ROOT_LEVEL'].listSpaces}

	
Returns a list of all top-level Spaces of which the current user is a member

This EL returns only those Spaces that do not have a parent, that is, it does not return Subspaces.


	
#{spaceContext.spacesQuery.unionOf['USER_JOINED'].shape['RECURSIVE_FLATTENED'].listSpaces}

	
Returns a list of all Spaces of which the current user is a member

This EL also returns all the Subspaces under each of the parent Spaces to which the current user has access.


	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sortCriteria[sortBy fields picked from WcSpaceHeader]}

	
Returns Spaces sorted into the order specified by the sort criteria

For example, the following query returns a list of Spaces to which the user has access sorted by discoverable and lastUpdateDate fields.

Note that in the following example, the idenitifier sp represents the JPA entity for a space, WcSpaceHeader.


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].sortCriteria['sp.discoverable, sp.lastUpdateDate desc'].listSpaces}


	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].pageNumber[page_num].listSpaces}

	
Allows specifying the page number (0-based) to select from the results matching the query criteria

For example, the following expression returns a list of all Spaces to whichc a user has access and returns the third page of the result set:


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].pageNumber[2].listSpaces]}


	
#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].itemsPerPage[page_num].listSpaces}

	
Allows specifying the number of results to be included in each page when breaking down the result space into pages

For example, the following expression returns a list of all Spaces to which a user has access, listing 10 records per page.


#{spaceContext.spacesQuery.unionOf['ALL_QUERIABLE'].pageNumber[10].listSpaces]}












B.3.7 EL Expressions Relevant to Specific Pages

Table B-15 lists EL expressions relevant to application pages and describes the types of functionality it provides. The Context column indicates whether the expression can be used in a WebCenter Spaces context (WCS) or in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper (Both). These expressions are useful in WebCenter Spaces and in custom WebCenter applications that include the Page service.


Table B-15 EL Expressions Relevant to Application Pages

	Expression	Function
	
#{pageDocBean.title}

	
Returns the page display name, for example:

FinanceProject


	
#{pageDocBean.createdBy}

	
Returns the user name of the person who created the page, for example:

monty


	
#{pageDocBean.createDateString}

	
Returns the date and time the page was created, for example:

2008-11-19T10:18:36


	
#{pageDocBean.lastUpdatedBy}

	
Returns the user name of the person who last updated the page, for example:

monty


	
#{pageDocBean.lastUpdateDateString}

	
Returns the date and time the page was last updated, for example:

2008-11-19T10:18:36


	
#{pageDocBean.pagePath}

	
Returns the file directory path to the page relative to the application root directory, for example:

/oracle/webcenter/page/scopedMD/s8bba98ff_4cbb_40b8_beee_296c916a23ed/user/Umonty/Page4.jspx


	
#{pageDocBean.name}

	
Returns the file name of the page, for example:

Page4.jspx


	
#{pageDocBean.UICSSStyle}

	
Returns the name of the style scheme used on the page, for example:

WCSchemeEggShell


	
#{pageDocBean.UISchemeBGImage}

	
Returns the directory path and file name of the page scheme background image.


	
#{pageDocBean.UISchemeBGColorString}

	
Returns the hexadecimal value of the page scheme background color, for example:

#ffa500


	
#{pageDocBean.pagePermission}

	
Returns the permission the current user has on the page, for example:

oracle.webcenter.page.model.security.CustomPagePermission


	
#{pageDocBean.pageSecurityTarget}

	
A string of 60 or so characters that uniquely identifies the current page to the security system, for example:

oracle_webcenter_page_scopedMD_s8bba98ff_4cbb_40b8_beee_296c916a23ed_user_Umonty_Page4PageDef












B.3.8 EL Expressions Relevant to Oracle Composer

Table B-16 lists EL expressions relevant to Oracle Composer. The Context column indicates whether the expression can be used in a WebCenter Spaces context (WCS) or in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper (Both). These expressions are useful in WebCenter Spaces and in custom WebCenter applications that include Oracle Composer.


Table B-16 EL Expressions Relevant to Oracle Composer

	Expression	Function	Context
	
#{composerContext.inEditMode}

	
Determines whether the current page is in View mode or Edit mode, for example:


<af:outputText id="ot1"
  value="#{composerContext.inEditMode ne
  true ? 'View mode' : 'Edit mode'} />


This example shows an ADF Faces outputText component that returns View mode when the page is in View mode and Edit mode when the page is in Edit mode.

	
Both












B.3.9 EL Expressions Relevant to Event Contexts

Table B-17 lists EL expressions relevant to the types of events that can trigger the passing of payloads (rather than events relevant to the Events service).

You can access all or part of the event payloads provided in Table B-17 once they have been raised.

For example, for the whole payload, use the following EL:


#{wcEventContext.events.<eventName>}


For example:


#{wcEventContext.events.WebCenterUserSelected}


All of the payloads for the ELs in Table B-17 are Maps. To dereference a map entry, use the standard EL for Maps:


#{wcEventContext.events.WebCenterUserSelected.UserName}





	
See Also:

For more information about event wiring, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."








Table B-17 EL Expressions Relevant to Event Contexts

	Expression	Function
	
Event Context


#{wcEventContext.events.WebCenterResourceSelected}


Document Name


#{wcEventContext.events.WebCenterResourceSelected.name}


Document Creator


#{wcEventContext.events.WebCenterResourceSelected.createdBy}


Document Last Modified By


#{wcEventContext.events.WebCenterResourceSelected.lastModifiedBy}

	
Use in context wiring between producer and consumer task flows. Returns a map that relates some piece of metadata from the producer to some piece of metadata from the consumer, for example, from a document creator to the creator's Profile.

Producer task flows include:

	
Document Manager


	
Recent Documents


	
Document List Viewer




Consumer task flows include:

	
Activity Graph - Similar Items (show other documents that may be of interest to the user)


	
Links (showthe items that are linked to the selected document)


	
Profile (view the Profile of the document's author)


	
Activity Stream (view activities related to this document)


	
Tags (tags on this document and a means of accessing the Tag Center)





	
Event Context


#{wcEventContext.events.WebCenterUserSelected}


User Name


#{wcEventContext.events.WebCenterUserSelected.userName}


User GUID


#{wcEventContext.events.WebCenterUserSelected.userGUID}


Space Name


#{wcEventContext.events.WebCenterUserSelected.spaceName}


Space GUID


#{wcEventContext.events.WebCenterUserSelected.spaceGUID}

	
Use in context wiring between producer and consumer task flows. Returns a map that relates some piece of metadata from the producer to some piece of metadata from the consumer, for example, from a user to the user's connections.

Producer task flows include:

	
Connections


	
Space Members




Consumer task flows include:

	
Connections (show connections of the selected user)


	
Documents task flows (show documents created by the selected user)


	
Activity Stream (view this user's activities)


	
Tags (tags created by this user)


	
Profile (show this user's Profile)





	
Event Context


#{wcEventContext.events.WebCenterConnectionSelected}


Profile User Name


#{wcEventContext.events.WebCenterConnectionSelected.profileUserName}


Profile User GUID


#{wcEventContext.events.WebCenterConnectionSelected.profileUserGUID}


Connected User Name


#{wcEventContext.events.WebCenterConnectionSelected.userName}


Connected User GUID


#{wcEventContext.events.WebCenterConnectionSelected.userGUID}

	
--


	
#{wcEventContext.events.WebCenterSpaceSelected.SpaceName}

	
Returns the name of the selected Space


	
#{wcEventContext.events.WebCenterSpaceSelected.SpaceGUID}

	
Returns the GUID of the selected Space












B.3.10 EL Expressions Relevant to Services

Table B-18 lists EL expressions relevant to services and describes the types of functionality it provides. All listed ELs can be used in both WebCenter Spaces and WebCenter Framework.


Table B-18 EL Expressions Relevant to Services

	Expression	Function
	
#{webcenterService['serviceId']}

	
An oracle.webcenter.framework.service.Service object representing the WebCenter service with the service ID serviceId. For example, the following EL returns Documents Service.


#{webcenterService['oracle.webcenter.doclib']}


For service IDs, see Table B-19.


	
#{webcenterService['serviceId'].configured}

	
Returns a Boolean value that indicates whether the WebCenter service with the service ID serviceId is configured for use in the current WebCenter Spaces application. For example, the following EL returns true if Discussions service can be used in the application, false otherwise:

#{webcenterService['oracle.webcenter.collab.forum'].configured}

For service IDs, see Table B-19.


	
#{sessionContext['oracle.webcenter.collab.forum'].groupInfo['spaceName'].forumId}

	
Returns the forum ID of the specified Space discussion forum. Enter the Space name in lieu of spaceName.


	
#{sessionContext['oracle.webcenter.collab.forum'].groupInfo['spaceName'].categoryId}

	
Returns the category ID of the specified Space discussion forums. Enter the Space name in lieu of spaceName.








Table B-19 lists service IDs associated with services at runtime.


Table B-19 Service IDs

	Service	ID
	
Announcements

	
oracle.webcenter.collab.announcement


	
Discussions

	
oracle.webcenter.collab.forum


	
Documents and Wikis

	
oracle.webcenter.doclib


	
Events

	
oracle.webcenter.collab.calendar.community


	
Space Management

	
oracle.webcenter.community


	
Instant Messaging and Presence (IMP)

	
oracle.webcenter.collab.rtc


	
Links

	
oracle.webcenter.relationship


	
Lists

	
oracle.webcenter.list


	
Mail

	
oracle.webcenter.collab.mail


	
Notes

	
oracle.webcenter.note


	
Notifications

	
oracle.webcenter.notification


	
Page

	
oracle.webcenter.page


	
People Connections: Activity Stream

	
oracle.webcenter.activitystreaming


	
People Connections: Connections

	
oracle.webcenter.peopleconnections.connections


	
People Connections: Feedback

	
oracle.webcenter.peopleconnections.kudos


	
People Connections: Message Board

	
oracle.webcenter.peopleconnections.wall


	
People Connections: Profile

	
oracle.webcenter.peopleconnections.profile


	
Polls

	
oracle.webcenter.collab.survey


	
Recent Activities

	
oracle.webcenter.recentactivity


	
Activity Graph

	
oracle.webcenter.activitygraph


	
RSS

	
oracle.webcenter.rss


	
Search

	
oracle.webcenter.search


	
Tags

	
oracle.webcenter.tagging


	
Blogs

	
oracle.webcenter.blog


	
Worklist

	
oracle.webcenter.worklist












B.3.11 EL Expressions Relevant to the Personalization Conductor

Table B-20 lists EL expressions relevant to the Personalization Conductor and describes the types of functionality it provides. All listed ELs can be used in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper.


Table B-20 EL Expressions Relevant to the Personalization Conductor

	Expression	Function
	
#{p13nContext.reset}

	
Clears the state of the context object in which it is invoked.

Other examples:


#{p13nContext.conductor['ConductorConnection'].reset} 



#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].reset}



#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].reset}


	
#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].update}

	
Updates the property set with new values if bound to a form.

The update method applies only to the context PropertySetContext, and can be called onlyas part of a form-based action.


	
#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].results}

	
Retrieves the results of the context object. In the case of PropertySetContext, it retrieves the property set by name and property set definition, if they exist.

In the case of ScenarioExecutionContext and ParameterizedScenarioExecutionContext, the scenario results are retrieved.

Other examples:


#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].scenario['MyScenario'].results}



#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].scenario['MyScenario'].withInput['input1=val1;input2=value2;input3=value3'].results} 


	
#{p13nContext.conductor['PropertiesConnection'].namespaces['MyNamespace'].scenario['MyScenario'].results}

	
Executes a scenario by name.


	
#{p13nContext.conductor['ConductorConnection'].namespaces['MyNamespace'].scenario['MyScenario'].withInput['input1=val1;input2=value2;input3=value3'].results}

	
Executes a scenario by name with input parameters. Input parameters must be in the following format:


<paramOne>=<valueOne>;<paramTwo>=<valueTwo>;<paramThree>=<valueThree> 


Where each parameter name and value is separated by semicolon.

The withInput method applies only to the context ScenarioExecutionContext.


	
#{p13nContext.conductor['ConductorConnection'].namespaces[myManagedBean.namespace].scenario[myManagedBean.scenario].isError}

	
Determines if an error has occurred in the current context object.

The isError method applies only to PropertySetContext and ~ScenarioExecutionContext.

Other examples:


#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].isError}


	
#{p13nContext.conductor['ConductorConnection'].namespaces['myManagedBean.namespace'].scenario['myManagedBean.scenario'].errorMessage}

	
Returns the error message if an error has occurred in the current context object.

The errorMessage method applies only to PropertySetContext and ~ScenarioExecutionContext.

Other examples:


#{p13nContext.properties['PropertiesConnection'].namespaces['MyNamespace'].setDefinitions['MyPropertySetDefinition'].set['MyPropertySet'].errorMessage}












B.3.12 EL Expressions Relevant to the Documents Service

Table B-21 lists EL expressions relevant to the Documents service and describes the types of functionality it provides. The Context column indicates whether the expression can be used in a WebCenter Spaces context (WCS) or in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper (Both).


Table B-21 EL Expressions Relevant to the Documents Service

	Expression	Function	Context
	
#{documentsService.currentGroupSpace}

	
Provides information on the Space's documents. Returns a bean that provides access to documents-related information for the Space.

	
WCS


	
#{documentsService.currentUser}

	
Provides information about the current user's documents.

	
WCS


	
#{documentsService.defaultConnectionName}

	
Gets the default content repository connection name. Returns null if no connection name is defined.

	
Both


	
#{documentsService.groupSpaceByGUID['GUID']}

	
Provides a way to look up a given Space's documents information by the Space's GUID. Returns a bean that provides documents-related information for the Space.

	
WCS


	
#{documentsService.groupSpaceByName['spaceName']}

	
Provides a way to look up a given Space's documents information by the Space's name. Returns a bean that provides access to documents-related information for the Space.

Enter the Space internal name. The Space internal name is the name specified by the Space URL on the General page of a Space's administration settings. The Space display name is specified by Display Name, and is the name that appears in the banner at the top of a Space. Many of the EL expressions in Table B-14 call for the Space internal name.

	
WCS


	
#{documentsService.userByName['userName']}

	
Provides a way to look up user documents information by user name. Returns a bean that provides access to documents-related information for the user.

	
WCS


	
#{documentsService.configured}

	
Checks whether the Documents service is configured. Returns true if the Documents service is configured, otherwise false.

	
Both












B.3.13 EL Expressions Relevant to the People Connections Service

Table B-22 lists EL expressions relevant to the Profile feature of the People Connections service and describes the types of functionality it provides. All listed ELs can be used in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper.




	
Note:

The entry securityContext.userName, included in every Profile expression, returns the name of the current user. Note also that information is returned only if it is present in the user's profile. If the information is not included in the profile, a null value is returned.








Table B-22 EL Expressions Relevant to the People Connections Service (Profile)

	Expression	Function
	
#{WebCenterProfile[userName].ManagerDisplayName}

#{WebCenterProfile[securityContext.userName].ManagerDisplayName}

	
The display name of the specified user's manager if the current user is allowed to know it.


	
#{WebCenterProfile[userName].employeeNumber}

#{WebCenterProfile[securityContext.userName].employeeNumber}

	
The specified user's employee number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPOBox}

#{WebCenterProfile[securityContext.userName].businessPOBox}

	
The post office box number associated with the specified user if the current user is allowed to know it.


	
#{WebCenterProfile[userName].timeZone}

#{WebCenterProfile[securityContext.userName].timeZone}

	
The time zone in which the specified user's home office is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].description}

#{WebCenterProfile[securityContext.userName].description}

	
A description of the specified user (from Profile "About Me") if the current user is allowed to know it.


	
#{WebCenterProfile[userName].department}

#{WebCenterProfile[securityContext.userName].department}

	
The department to which the specified user belongs if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPager}

#{WebCenterProfile[securityContext.userName].businessPager}

	
The specified user's business pager number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessCity}

#{WebCenterProfile[securityContext.userName].businessCity}

	
The city in which the specified user is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].maidenName}

#{WebCenterProfile[securityContext.userName].maidenName}

	
The specified user's surname or last name before marriage if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessFax}

#{WebCenterProfile[securityContext.userName].businessFax}

	
The specified user's business fax number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].dateofHire}

#{WebCenterProfile[securityContext.userName].dateofHire}

	
The specified user's date of hire if the current user is allowed to know it.


	
#{WebCenterProfile[userName].nameSuffix}

#{WebCenterProfile[securityContext.userName].nameSuffix}

	
Additional information appended to the user's name, such as Esq., Jr., and so on if the current user is allowed to know it.


	
#{WebCenterProfile[userName].middleName}

#{WebCenterProfile[securityContext.userName].middleName}

	
The specified user's middle name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].homePhone}

#{WebCenterProfile[securityContext.userName].homePhone}

	
The specified user's home phone number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].employeeType}

#{WebCenterProfile[securityContext.userName].employeeType}

	
The specified user's employee type classification, for example, IC4 if the current user is allowed to know it.


	
#{WebCenterProfile[userName].lastName}

#{WebCenterProfile[securityContext.userName].lastName}

	
The specified user's surname or last name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].dateofBirth}

#{WebCenterProfile[securityContext.userName].dateofBirth}

	
The specified user's birthday if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessState}

#{WebCenterProfile[securityContext.userName].businessState}

	
The state in which the specified user's home office is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].homeAddress}

#{WebCenterProfile[securityContext.userName].homeAddress}

	
The specified user's home street address if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessStreet}

#{WebCenterProfile[securityContext.userName].businessStreet}

	
The street on which the specified user's home office is located if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPostalCode}

#{WebCenterProfile[securityContext.userName].businessPostalCode}

	
The specified user's postal or ZIP code if the current user is allowed to know it.


	
#{WebCenterProfile[userName].initials}

#{WebCenterProfile[securityContext.userName].initials}

	
The specified user's initials if the current user is allowed to know it.


	
#{WebCenterProfile[userName].firstName}

#{WebCenterProfile[securityContext.userName].firstName}

	
The specified user's first name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].organizationalUnit}

#{WebCenterProfile[securityContext.userName].organizationalUnit}

	
The organizational unit to which the specified user belongs, for example, D10, if the current user is allowed to know it.


	
#{WebCenterProfile[userName].wirelessAcctNumber}

#{WebCenterProfile[securityContext.userName].wirelessAcctNumber}

	
The specified user's wireless account number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessPhone}

#{WebCenterProfile[securityContext.userName].businessPhone}

	
The specified user's business telephone number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessCountry}

#{WebCenterProfile[securityContext.userName].businessCountry}

	
The country in to which the specified user is assigned if the current user is allowed to know it.


	
#{WebCenterProfile[userName].preferredLanguage}

#{WebCenterProfile[securityContext.userName].preferredLanguage}

	
The specified user's preferred language if the current user is allowed to know it.


	
#{WebCenterProfile[userName].displayName}

#{WebCenterProfile[securityContext.userName].displayName}

	
The specified user's display name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].userName}

#{WebCenterProfile[securityContext.userName].userName}

	
The specified user's actual name if the current user is allowed to know it.


	
#{WebCenterProfile[userName].title}

#{WebCenterProfile[securityContext.userName].title}

	
The specified user's job title if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessEmail}

#{WebCenterProfile[securityContext.userName].businessEmail}

	
The specified user's business email address if the current user is allowed to know it.


	
#{WebCenterProfile[userName].organization}

#{WebCenterProfile[securityContext.userName].organization}

	
The organzation to which the specified user belongs, for example, Sales, if the current user is allowed to know it.


	
#{WebCenterProfile[userName].businessMobile}

#{WebCenterProfile[securityContext.userName].businessMobile}

	
The specified user's cell or mobile phone number if the current user is allowed to know it.


	
#{WebCenterProfile[userName].expertise}

#{WebCenterProfile[securityContext.userName].expertise}

	
The specified user's business expertise if the current user is allowed to know it.












B.3.14 EL Expressions Relevant to User Preferences

Table B-23 lists EL expressions relevant to user preferences and describes the types of functionality they provide. All listed ELs can be used in both WebCenter Spaces and custom portal applications built with Oracle JDeveloper.


Table B-23 EL Expressions Relevant to User Preferences

	Expression	Function
	
#{generalSettings.userTimeZone}

	
Returns the time zone the current user has selected in application Preferences. For more information, see Section 35.3, "Setting Date and Time Preferences."


	
#{generalSettings.preferredDateStyle}

	
Returns the date format the current user has selected in application Preferences. For more information, see Section 35.3, "Setting Date and Time Preferences."


	
#{generalSettings.preferredDatePattern}

	
Returns the current user's preferred date format pattern if it has been set, else, returns null.

Note that date + pattern is applicable only to custom WebCenter applications, where they take precedence over date + style if they are set.


	
#{generalSettings.preferredTimeStyle}

	
Returns the time format the current user has selected in application Preferences. For more information, see Section 35.3, "Setting Date and Time Preferences."


	
#{generalSettings.preferredTimePattern}

	
Returns the current user's preferred time format pattern if it has been set, else, returns null.


	
#{generalSettings.preferredDateTimePattern}

	
Returns the current user's preferred date and time format pattern if it has been set, else, returns null.


	
#{generalSettings.preferredAccessibilityMode}

	
Returns the current user's preferred accessibility mode (either default, inaccessible, or screenReader)


	
#{generalSettings.preferredSkinName}

	
The current user's preferred skin name if one is specified, otherwise the default value.


	
#{generalSettings.formattedCurrentDate}

	
Returns the current date in the current user's selected locale.


	
#{generalSettings.formattedCurrentTime}

	
Returns the current time in the current user's selected locale.


	
#{generalSettings.formattedCurrentDateTime}

	
Returns the current date and time in the current user's selected locale.


	
#{requestContext.skinFamily}

	
Returns the name of the ADF Faces skin family being used for the current web request, depending on factors such as what has been configured at the application level, the current user's preference setting, and so on.












B.3.15 Utilitarian EL Expressions

Table B-24 lists utilitarian EL expressions and describes the types of functionality it provides.


Table B-24 Utilitarian EL Expressions

	Expression	Function
	
#{userPreferences.currentDate}

	
Returns the current date in the format specified in the current user's preferences.


	
#{WCTruncator['text']['numberOfChars']}

	
Returns a truncation of the string specified as text to the number of characters specified as numberOfChars, followed by a trailing ellipsis, for example: #{WCTruncator['abracadabra']['5']} evaluates to abrac...


	
#{facesContext.viewRoot.locale}

#{facesContext.externalContext.requestLocale}

	
Both of these expressions return the request locale (that is, the browser locale setting).


	
#{changeModeBean.inEditMode}

	
Returns true if current application page is in Oracle Composer mode. Returns false if current application page is not in Oracle Composer mode


	
#{adfFacesContext.skinFamily}

	
Returns the current application skin family. Returns the same value as #{requestContext.skinFamily}.
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Part XVII


Appendices

Part XVII of the User's Guide catalogs short, user-friendly URLs to locations within the WebCenter Spaces UI, such as Administration pages and pages in Spaces and Home Spaces (pretty URLs). It also catalogs Expression Language expressions for use in a WebCenter Spaces context.

Part XVII includes the following appendices:

	
Appendix A, "WebCenter Spaces User Interface URLs"


	
Appendix B, "Expression Language Expressions"


	
Appendix C, "Business Mashup Examples"
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Part VIII


Creating and Managing Portlets and Task Flows at Runtime

Part VIII of the User's Guide provides information about creating visualizations, such as forms, tables, and graphs, by gathering and publishing data from various data sources. It describes these tasks in terms of a data composer and seeded portlets.

Part VIII includes the following chapters:

	
Chapter 25, "Understanding Portlet Basics"


	
Chapter 26, "Creating Business Mashups"


	
Chapter 27, "Working with OmniPortlet"


	
Chapter 28, "Working with the Web Clipping Portlet"
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62 Working with the Instant Messaging and Presence Service (IMP)

This chapter describes how to use the features provided through the Instant Messaging and Presence (IMP) service. The IMP service lets you see the presence status of other authenticated application users. It provides instant access to interaction options, such as instant messages and mails. Additionally, if enterprise presence is unavailable, you can connect to a 3rd-party network presence service, such as Yahoo! Messenger.

This chapter includes the following sections:

	
Section 62.1, "What You Should Know About the IMP Service"


	
Section 62.2, "Identifying Your Preferred Instant Messaging Provider"


	
Section 62.4, "Working with IMP Service Features"





Audience

This chapter is intended for authenticated users who want to view, create, and manage instant messaging and presence. It also is intended for WebCenter Spaces administrators with the Application-Manage Configuration permission and individual Space moderators who want to configure instant messaging and presence within their Spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the IMP service is not enabled in the current Space.









62.1 What You Should Know About the IMP Service

The IMP service enables you to observe the presence status of other authenticated users (online, offline, busy, or away) and provides instant access to interaction options, such as instant messages (IM) and mail. Any WebCenter service that has a user name can integrate with the IMP service; for example, Discussions, Documents, or Mail. Wherever a user is indicated, for example as the author of a document in the document library, you can see an icon (Figure 62-1) depicting the presence state of that user.


Figure 62-1 The Presence Icon for Online Users

[image: Presence icon, online]



If you hover your mouse over the Presence icon, a tooltip displays the current status message for that user, if available. If the user has not provided a status message, or the message cannot be retrieved, then the tooltip displays the presence state of the user (online, offline, busy, or away).




	
Note:

There is no idle status. In the case of extended user inactivity, the status still displays as online.







Additionally, you can click the Presence icon to invoke a context menu (Figure 62-2).


Figure 62-2 The Presence Icon Context Menu

[image: Presence icon context menu]



From the context menu you can:

	
Send mail to the user. For more information, see Section 62.4.2, "Sending a Mail Message from the Presence Icon Menu."


	
View the user's profile. For more information, see Section 30.5.1, "Viewing Profile Details."


	
Send an instant message to the user. For more information, see Section 62.4.3, "Sending an Instant Message from the Presence Icon Menu."


	
Change credentials, which works as an alternative to using an external application. This option is available with Microsoft Office Live Communications Server (LCS) 2005 and Microsoft Office Communications Server (OCS) 2007.







	
Note:

The options that display on the context menu depend on what services are available to your WebCenter Spaces application, how those services are configured, and which services are supported by the back-end presence server. For example, the Phone Conference option is supported by Oracle WebLogic Communications Services (OWLCS) only.












62.2 Identifying Your Preferred Instant Messaging Provider

If Oracle WebCenter presence is not available (for example, if your enterprise uses a Jabber/XMPP presence server or has federated presence servers with users distributed across identity management systems), you can connect to a public network presence service.

Out-of-the-box, WebCenter supports Yahoo! Messenger on network presence. However, the network presence model can be extended to include other providers, such as ICQ.

To enable network presence:

	
Click the Preferences link at the top of the application.


	
Click Presence to open the Presence Preferences pane.


	
Enter the IM address for the presence status and a display name (Figure 62-3).


Figure 62-3 The Presence Preferences Pane

[image: Presence Preferences panel in Preferences dialog]



	
Click OK to save your change and exit the Preferences dialog.




Presence tags for that user shows their network presence, either online (Figure 62-4) or offline (Figure 62-5).


Figure 62-4 Yahoo Presence Icon - Online

[image: Description of Figure 62-4 follows]







Figure 62-5 Yahoo Presence Icon - Offline

[image: Description of Figure 62-5 follows]










62.3 Configuring Network Presence

To set your presence to Yahoo! Messenger:

	
Click the Preferences link at the top of the application.


	
Click Presence to open the Presence Preferences pane.


	
Enter your Yahoo! Messenger ID and a display name for yourself (Figure 62-3).


Figure 62-6 The Presence Preferences Pane

[image: Presence Preferences panel in Preferences dialog]



	
Click OK to save your change and exit the Preferences dialog.




To revert back to your enterprise presence, when you are back on your network, simply remove this information from Presence Preferences.




	
Note:

To send instant messages to an online user on Yahoo! Messenger, you also must have Yahoo! Messenger installed.












62.4 Working with IMP Service Features

Many WebCenter task flows include a presence capability that enables you to make contact with other users from within the context of what you want to contact them about. For example, if you see a post in a discussion topic and want to contact the author of that post, you can do so directly from the Discussions task flow.

This section includes the following subsections:

	
Section 62.4.1, "Viewing the Status of Other Users"


	
Section 62.4.2, "Sending a Mail Message from the Presence Icon Menu"


	
Section 62.4.3, "Sending an Instant Message from the Presence Icon Menu"


	
Section 62.4.4, "Initiating a Phone Conference from the Presence Icon Menu"






62.4.1 Viewing the Status of Other Users

Many task flows support on-the-spot communication with other users. That is, wherever a task flow includes a Presence icon (Figure 62-1), you can start an instant chat or send a mail to the user associated with the icon.

The way you communicate with another user depends upon their availability. For example, if the user is online, then you could send an instant message to make immediate contact. However, if the user is offline or busy, then sending a mail is probably a better option.

Additionally, users can provide further information about their status by providing status messages. If such a status message exists for a user, hovering over the Presence icon displays that message as a tooltip. The status message enables you to make an even more informed decision about how to make contact. If there is no status message for the user, then the presence state is displayed in the tooltip instead (online, offline, busy, or away).

To view the current presence status or status message of a user, simply hover the mouse over the Presence icon next to the user's name.




	
Note:

The presence state of the user is held in a cache with a default expiry time of 60 seconds. As a result, the Presence icon may not reflect the actual status of the user if the status has changed between the initial retrieval and the cache expiry time.







Table 62-1 describes the presence state each Presence icon indicates.


Table 62-1 Presence Icon Presence States

	Presence Icon	State
	
[image: Green circle; user is available]


	
Associated user is online.


	
[image: Red circle with thick white line (no entry); user is busy]


	
Associated user is online, but busy. Please do not disturb.


	
[image: Clock; user is away]


	
Associated user is still connected but away from the computer.


	
[image: Greyed out icon with cross; user is offline]


	
Error indicator. This icon appears against the name of the current logged-in user, meaning the user has not provided required credentails to log on to the presence server.












62.4.2 Sending a Mail Message from the Presence Icon Menu

Wherever you see a Presence icon, you can send a mail message to its associated user.

To send a mail message:

	
Locate a Presence icon (Figure 62-1) for the person you want to contact.

For example, you can find Presence icons associated with documents and discussion topics, and anywhere a task flow is configured to support IMP.


	
Click the Presence icon associated with the user you want to contact.

For example, in Figure 62-7 the Presence icon is associated with the user monty.


Figure 62-7 The Presence Icon Associated with the User monty

[image: Presence icon associated with user monty]



	
From the menu, choose Send Mail.

You may be presented with a login window. If so, then enter your user name and password for your mail application. If your preferences are set up to deliver your login credentials automatically, you can start your message right away. For more information about login credentials and preferences, see Chapter 35, "Setting Your Personal Preferences."


	
Compose your message and click Send (Figure 62-8).


Figure 62-8 Sending Mail Using the IMP Service

[image: The New Message dialog box]










62.4.3 Sending an Instant Message from the Presence Icon Menu

Wherever you see a Presence icon, you can send an instant message to its associated user.

Before you can send an instant message, you must install the appropriate chat client (and only that client) on your local computer. The client must be configured to connect to the back-end presence server.

	
If the back-end presence server is Microsoft Live Communications Server (LCS) 2005, then install Microsoft Communicator.


	
If the back-end presence server is Microsoft Office Communications Server (OCS) 2007, then install Microsoft Communicator.


	
If the back-end presence server is Oracle WebLogic Communications Server (OWLCS), then install Oracle Communicator.




Contact your administrator if you are not sure which client to install or how to connect to the presence server.

To send an instant message:

	
Locate a Presence icon (Figure 62-1) for the person you want to contact.

For example, you can find Presence icons associated with documents and discussion topics, and anywhere a task flow is configured to support IMP.


	
Click the Presence icon associated with the user you want to contact.

For example, in Figure 62-9 the Presence icon is associated with the user monty.


Figure 62-9 The Presence Icon Associated with the User monty

[image: Presence icon associated with user monty]



	
From the menu, choose Send Instant Message.

WebCenter invokes your instant messaging client, and starts a chat session with the selected user.









62.4.4 Initiating a Phone Conference from the Presence Icon Menu

If you are using Oracle WebLogic Communications Server (OWLCS) as the presence server, then wherever you see a Presence icon, you can initiate a phone conference with its associated user.

To initiate a phone conference:

	
Locate a Presence icon (Figure 62-1) for the person you want to contact.

For example, you can find Presence icons associated with documents and discussion topics, and anywhere a task flow is configured to support IMP.


	
Click the Presence icon associated with the user you want to contact.

For example, in Figure 62-10 the Presence icon is associated with the user monty.


Figure 62-10 The Presence Icon Associated with the User monty

[image: Presence icon associated with user monty]



	
From the menu, choose Start Phone Conference.

OWLCS places a call to you and then to the target user, using the phone numbers specified in the user profiles.







	
Notes:

	
This functionality requires the Third Party Call Center (TPCC) Service. Refer to OWLCS Documentation for more information.


	
If you encounter an error when initiating a phone conference with other WebCenter users, ensure that user names are lowercase.
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18 Adding and Configuring Page Layout Components

Layout components provide a means of enhancing a page's given layout with additional content areas, images, links, text, and the like. Use page layout components to boost company branding (Image), provide a mission statement (Text), direct users to related information (Links and Hyperlink), and so on.

This chapter describes how to work with page layout components that are packaged with WebCenter Spaces. It includes the following sections:

	
Section 18.1, "Adding a Layout Component to a Page"


	
Section 18.2, "Working with Layout Components"


	
Section 18.3, "Deleting Layout Components"





Audience

This chapter is intended for users granted the application-level permission Pages: Create, Edit, and Delete Pages or the Space-level permission Basic Services: Edit Page Access, Structure, and Content. Typically such users want to enhance page layout by adding and configuring layout components. Such users include authorized users working in the Home Space and in Spaces.

Your application administrator has the authority to expose or hide application resources and revise default permissions. Tasks discussed in this chapter are not available to you if the relevant resource is hidden or you are not authorized to perform them.



18.1 Adding a Layout Component to a Page

The process of adding a layout component to a page is the same for every layout component. Therefore, you can use the steps in this section for any layout component you add to a page.




	
See Also:

This section provides information about adding a layout component while the page is in Design view. For information about adding content while the page is in Source view, see Section 17.5.1.2, "Adding a Component to a Page in Source View of Page Edit Mode."







To add a layout component to a page:

	
Go to the page where you want to add a layout component, and open it in Oracle Composer.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click the Add Content button in the content area where you want to place the layout component to open the Resource Catalog (Figure 18-1).


Figure 18-1 Add Content Button and Resulting Resource Catalog

[image: Add Content button and resulting Resource Catalog]









	
Note:

In WebCenter Spaces, the content of the Resource Catalog varies according to the services that are integrated with the application, the location from which the catalog is opened, and the resources provided by your administrator. For example, the components that appear in the catalog when you open it from the Home Space differ from those that appear when you open it from a Space. Additionally, authorized users can create custom catalogs that may or may not contain the components you want. Such users can reconfigure the catalog if needed components are not present. They can also rename catalog folders. For more information, see Chapter 16, "Working with Resource Catalogs."








	
In the catalog, click the Open link next to Web Development to display a selection of layout components (Figure 18-2).


Figure 18-2 Web Development Components in Resource Catalog

[image: Web Development components in Resource Catalog]






	
Click the Add link next to the component you want to add to the page.




	
Tip:

By default, new components are added to the top of their content areas.
When you add a component to a page, you must wait for the application status indicator to finish processing before taking additional action.










	
Click the Close button to exit the catalog.


	
Optionally, drag-and-drop the newly-added component to the desired position on the page, or use the Move icons on the component to reposition it.




	
Tip:

As you drag a component around, a dark box marks the target drop location.








	
Click Save to save your changes, and then Close to exit Oracle Composer.







	
Tip:

Some layout components are provided as part of the page infrastructure and are not obviously exposed in the Resource Catalog. An example of this is the spacer component. Although you cannot add more of them to a page, you can configure their properties. For more information, see Section 18.2.10, "Working with Internal Layout Components."












18.2 Working with Layout Components

Each layout component has associated properties that you can use to refine the appearance and behavior of a layout component instance. This section provides information about accessing and providing values for layout component properties. It contains the following subsections:

	
Section 18.2.1, "Setting Properties on a Layout Component"


	
Section 18.2.2, "Working with the Box Layout Component"


	
Section 18.2.3, "Working with the Movable Box Layout Component"


	
Section 18.2.4, "Working with the HTML Markup Layout Component"


	
Section 18.2.5, "Working with the Links Layout Component"


	
Section 18.2.6, "Working with the Hyperlink Layout Component"


	
Section 18.2.7, "Working with the Image Layout Component"


	
Section 18.2.8, "Working with the Text Layout Component"


	
Section 18.2.9, "Working with the Web Page Layout Component"


	
Section 18.2.10, "Working with Internal Layout Components"






18.2.1 Setting Properties on a Layout Component

Layout components have associated properties, which authorized users can access from the Oracle Composer Component Properties dialog.




	
Note:

When you enter most types of property values in the Component Properties dialog and then click Apply, the dialog remains open. With values other than expected value types, the dialog closes, and the page is refreshed to reflect the new value. For example, if a component takes a java.util.ArrayList of java.awt.Color classes, then the Component Properties dialog closes and Composer does a full-page-refresh.







There are two ways to access the Component Properties dialog: through Oracle Composer Design view and Oracle Composer Source view. This section describes both methods. It includes the following subsections:

	
Section 18.2.1.1, "Setting Layout Component Properties in Design View"


	
Section 18.2.1.2, "Setting Layout Component Properties in Source View"






18.2.1.1 Setting Layout Component Properties in Design View

To set layout components properties in Design view:

	
Go to the page where you want to edit layout component properties, and open it in Oracle Composer.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click the Edit icon (Figure 18-3) on the layout component of interest to open the Component Properties dialog.


Figure 18-3 Edit Icon on a Layout Component

[image: Edit icon on a layout component]






	
Edit component properties, and click OK when you have finished.




	
Tip:

in addition to entering literal text (value), you can also enter an Expression Language (EL) expressions (#{value}). For information about EL expressions, see Appendix B, "Expression Language Expressions."













	
See Also:

For information about properties associated with a particular layout component, see the section that covers the particular component. For example, see Section 18.2.2.2, "Setting Box Layout Component Properties" for information about properties associated with the Box layout component.
For detailed information about properties that are common to most types of components, see Section 17.5.2, "Setting Properties on Page Components."














18.2.1.2 Setting Layout Component Properties in Source View

To set layout component properties in Source view:

	
Go to the page where you want to edit layout component properties, and open it in Oracle Composer.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
From the View menu, select Source (Figure 18-4).


Figure 18-4 Source Option on View Menu

[image: Source option on View menu]






	
In the list of components, click the component with properties you want to configure.


	
Click the Edit icon in the Source view header (Figure 18-5) to open the Component Properties dialog.


Figure 18-5 Edit Button and Selected Box Layout Component

[image: Edit button and selected Box layout component]






	
Edit component properties, and click OK when you have finished.




	
Tip:

in addition to entering literal text (value), you can also enter an Expression Language (EL) expressions (#{value}). For information about EL expressions, see Appendix B, "Expression Language Expressions."

















18.2.2 Working with the Box Layout Component

A Box is a content area that you can use to place other components on the page. Unlike its counterpart, Movable Box, a Box cannot be moved around the page at application runtime, though its content can be rearranged. This section provides an overview of the Box layout component and lists and describes its associated properties. It includes the following subsections:

	
Section 18.2.2.1, "What You Should Know About the Box Layout Component"


	
Section 18.2.2.2, "Setting Box Layout Component Properties"






18.2.2.1 What You Should Know About the Box Layout Component

The Box layout component is the landing place for the task flows, portlets, and layout components that you add to a page.

In page edit mode, a Box is typically rendered as rectangle comprised of dashed lines, an Add Content button, and Add a Tab Set or a Tab, Add Box, Edit, and Delete icons (Figure 18-6).


Figure 18-6 Box Layout Component

[image: Box layout component]






Not all Box controls appear every time. What you see depends on your permissions, whether the Box is the top-most Box (which cannot be deleted, thus no Delete icon), whether the Box is stretched (in which case you cannot add other Boxes to it, thus no controls for doing so), and whether Box properties are set to show or omit certain controls (for more information, see Table 18-1, "Box Layout Component Display Options").

You can place content within a Box, and you can place one or more Boxes within a Box (unless the Box is configured to stretch its content, that is, Layout equals stretch). You can configure Box properties to display content horizontally, vertically, or stretched. You can specify the display of a scrollbar or set the Box to devote all its area to a single component (stretched). You can use Box controls to add Boxes above, below, or to either side of a given Box and to add a tab or a tab set within the Box.




	
See Also:

For information about adding tab sets and configuring tabs, see Section 17.3.5.5, "Creating Layered Content Regions Using Tabs."







You could, if you like, add one Box to a page, and use its controls to add all the Boxes and tabs you require, rather than adding multiple Boxes for that purpose.






18.2.2.2 Setting Box Layout Component Properties

Box layout component properties provide a means of enabling or disabling the display of an Actions menu, a tab creation icon, and Box split icons; specifying the alignment and orientation of Box content; rearranging Box components; and providing tooltip text on the Box.

Box layout component properties include a Child Components tab with options for hiding, showing, and rearranging the Box content. For more information, see Section 17.5.2.6, "Working with Child Components."

A Style tab is available for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance, primarily the styles otherwise provided by the application skin. Box style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-1 lists and describes Box layout component display options.


Table 18-1 Box Layout Component Display Options

	Property	Description
	
Allow Action

	
Enables or disables the display of various actions on the Box and on the components you add to the box:

	
all—Show the Add Content button on the Box, show the Add Box icons, display the Actions menu on all Box child components that support it, and allow the movement of Movable Boxes into and out of the Box.


	
none—Hide the Add Content button on the Box, hide the Add Box icons, and disable the display of the Actions menu on all Box child components. Additionally, any Movable Boxes inside the Box are frozen and cannot be moved; and users cannot move Movable Boxes into the Box.





	
Horizontal Alignment

	
Specifies how Box content should align between its left and right boundaries:

	
start—Align content with the front position, determined by the reading order of the selected language. This value is provided to accommodate environments that support bidirectional languages.


	
center—Align content with the center of the Box.


	
end—Align content with the final position, determined by the reading order of the selected language. This value is provided to accommodate environments that support bidirectional languages.


	
left—Align content with the left side of the Box.


	
right—Align content with the right side of the Box.





	
Layout

	
Specifies the orientation of Box content:

	
vertical—Align Box content in a vertical orientation (that is, as a column of objects).


	
horizontal—Align Box content in a horizontal orientation (that is, as a row of objects). When Layout is set to horizontal, this component cannot be stretched by a parent component that stretches its children.


	
scroll—Align Box content vertically with a scrollbar. The scrollbar is rendered when the height/width of its content exceeds the Box's height or width.


	
stretch—The Box content stretches to accommodate the specified size of the Box. If no height (see Section 17.5.2.7, "Working with Style and Content Style Properties") is specified for the Box, it defaults to a height of 200 pixels, unless the Box is placed inside another stretching component. In this case, the Box height is controlled by its parent (but see, horizontal). When you select stretch, the Add Content button is hidden after one component is added to the Box, and you cannot drag and drop content into the Box. Additionally, you cannot split a Box with a Layout value of stretch.





	
Short Desc

	
Specifies tooltip text for the Box

Tooltip text appears when users roll their mouse pointers over the Box.


	
Show Component

	
Hides or shows the component on the page:

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.


	
Show Split Action

	
Show or hide the icons that enable splitting a Box into one or more Boxes

	
Select the checkbox to show Add Box icons on the Box


	
Clear the checkbox to hide the icons on the Box





	
Show Tab Action

	
Show or hide the icon that enables adding tabbed regions to a Box

	
Select the checkbox to show the Add a Tab Set or a Tab icon on the Box


	
Clear the checkbox to hide the icon on the Box





	
Vertical Alignment

	
Specifies how Box content should align between its top and bottom boundaries:

	
top—Align content at the top of the Box.


	
middle—Align content with the middle of the Box.


	
bottom—Align content at the bottom of the Box.


	
baseline—Align content at the Box baseline, which is slightly above the bottom.




Vertical Alignment applies only when the layout is horizontal.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.3 Working with the Movable Box Layout Component

A Movable Box is a container wrapped around a Box that not only enables the placement of content on a page (via the Box), but also provides a means of moving all of that content at once in both page edit mode and page view mode. This section provides an overview of the Movable Box layout component. It includes the following subsections:

	
Section 18.2.3.1, "What You Should Know About the Movable Box Layout Component"


	
Section 18.2.3.2, "Setting Movable Box Layout Component Properties"






18.2.3.1 What You Should Know About the Movable Box Layout Component

The Movable Box layout component (Figure 18-7) enhances the features of a Box by adding mobility.


Figure 18-7 Movable Box Layout Component

[image: Movable Box layout component]






Users can grab the Movable Box by its header and drag it and all of its content to a new position on a page. Users can reposition a Movable Box in both page edit and page view modes. Movable Boxes can also be resized.




	
Tip:

Avoid adding a portlet to a Movable Box layout component. Adding a portlet to a Movable Box creates an unnecessary and potentially error-prone redundancy.












18.2.3.2 Setting Movable Box Layout Component Properties

The Display Options associated with Movable Boxes provide a means of hiding or showing the Movable Box header, providing header text, adding a tooltip to the Movable Box that users see when they roll their mouse pointers over the header, and other like controls.

Movable Box Display Options are common to many other types of components and are listed in Table 17-1, "Display Options Properties".

Movable Box Display Options are presented on two subtabs: Basic and Advanced (Figure 18-8).


Figure 18-8 Movable Box Layout Component Display Options

[image: Movable Box display options]






By default, each Movable Box encloses a Box layout component. For information about Box component properties, see Section 18.2.2.2, "Setting Box Layout Component Properties."








18.2.4 Working with the HTML Markup Layout Component

The HTML Markup layout component is a simple editor for adding HTML markup to a page. (This includes JavaScript embedded in HTML <script> tags.) This section provides an overview of the HTML Markup layout component and lists and describes its associated properties. It also provides a sample use case for embedding a YouTube video onto a page.

This section includes the following subsections:

	
Section 18.2.4.1, "What You Should Know About the HTML Markup Layout Component"


	
Section 18.2.4.2, "Setting HTML Markup Layout Component Properties"


	
Section 18.2.4.3, "Embedding Video, Music, Slides, and Other Types of Content"






18.2.4.1 What You Should Know About the HTML Markup Layout Component

The HTML Markup layout component is a simple editor for entering raw text and HTML tags, including HTML <script> tags (Figure 18-9).


Figure 18-9 An HTML Markup Layout Component

[image: HTML Markup layout component]






Enter markup through the editor's component properties. Enter any type of valid HTML. Enclose JavaScript in the appropriate HTML markup. For example, enter (Figure 18-10):


<script type="text/javascript">
   document.write("This is my JavaScript.");
</script>



Figure 18-10 Sample JavaScript in HTML Markup Display Options

[image: Sample JavaScript in HTML Markup component]






The editor's header appears in page edit mode, but does not appear in page view mode. So you can place an individualized message on a page, for example, Welcome #{securityContext.userName}!, and the message will not be cluttered with the component header.






18.2.4.2 Setting HTML Markup Layout Component Properties

HTML Markup layout component properties provide a means of entering a brief bit of HTML markup, JavaScript, text, or Expression Language (EL). For example, use the HTML Markup layout component to embed a personalized message to page visitors, a YouTube video, a Google Gadget, a Pandora Music Station, and the like (for more information, see Section 18.2.4.3, "Embedding Video, Music, Slides, and Other Types of Content").

In addition to content entry, use the properties on the Display Options tab to control text entry behavior and provide tooltip text (see Table 18-2).

HTML Markup layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. HTML Markup style properties are common to many other components, and are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-2 lists and describes HTML Markup layout component display options.


Table 18-2 HTML Markup Layout Component Display Options

	Property	Description
	
Escape

	
A checkbox for enabling or disabling literal evaluation of special characters

Use this property to make the output safe or not safe. Safe means that any tags, such as <script> are escaped into &lt;script&gt; so that they do not run. Not safe means whatever you enter for value finds its way onto the page, even if it does something undesirable.

	
Checked (true) enables literal evaluation of such characters as angle brackets (<|>) and HTML special characters. For example, when a user enters &#8212; it is rendered as &#8212;.


	
Cleared (false) disables literal interpretation of special characters. For example, when a user enters &#8212;, it is rendered as —. False is the default value.





	
No Wrap

	
A checkbox for enabling or disabling text wrapping

	
Checked (true) disables text wrapping. Users must enter line breaks manually.


	
Cleared (false) enables text wrapping. Lines wrap in accordance with the component width. False is the default value.





	
Short Desc

	
A field for entering tooltip text for the HTML Markup layout component

When users roll their mouse pointers over the component, this text appears as a tooltip.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.


	
Value

	
A field for specifying the content that this component renders

In addition to text, this parameter also accepts HTML, JavaScript, and Expression Language (EL) expressions. For guidelines and examples, see Section 18.2.4.1, "What You Should Know About the HTML Markup Layout Component."

After you save your changes and close the page editor, the HTML Markup component shows the evaluated value of the markup.











	
Tip:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.4.3 Embedding Video, Music, Slides, and Other Types of Content

You can use the HTML Markup layout component to expose video, music, Google Gadgets, and other types of content in your application pages. This section describes how.




	
Note:

When you add a component to a page, you must wait for the application status indicator to finish processing before taking additional action.







To embed different types of media on an application page:

	
Copy the HTML code you want to embed.

For example:


<object width="640" height="385">
  <param name="movie"
      value="http://www.youtube.com/v/cAYw2zcSIPw?fs=1&amp;hl=en_US" />
  <param name="allowFullScreen" value="true" />
  <param name="allowscriptaccess" value="always" />
  <embed src="http://www.youtube.com/v/cAYw2zcSIPw?fs=1&amp;hl=en_US"
      type="application/x-shockwave-flash" allowscriptaccess="always"
      allowfullscreen="true" width="640" height="385" />
</object>


	
Go to the page where you want to embed video, music, or some other type of medium, and open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click the Add Content button associated with the Box or Movable Box where you want to embed content to open the Oracle Composer Catalog.


	
Click the Open link next to Layout, and then click the Add link next to HTML Markup.

Optionally, use the Catalog Search feature to locate the HTML Markup layout component, and then click the Add link next to the component.


	
Click the Close button to close the Catalog.


	
Click the Edit icon on the HTML Markup component (Figure 18-11) to open the Component Properties dialog.


Figure 18-11 Edit Icon on an HTML Markup Layout Component

[image: Edit icon on an HTML Markup layout component]






	
Click the Display Options tab to bring it forward, and then, in the Value field, paste the copied HTML code.


	
Click OK to close the Component Properties dialog.


	
Click Save and then Close to exit Oracle Composer.











18.2.5 Working with the Links Layout Component

Use the Links layout component to add a navigation instance to a page. Links component navigation can include links to pages, external web sites, and application content. A browse capability is available to simplify the process of locating link targets. An advanced search feature is also available to assist in locating content objects.

This section provides information about the Links layout component, how to set it up, and how to configure its properties. It includes the following subsections:

	
Section 18.2.5.1, "What You Should Know About the Links Layout Component"


	
Section 18.2.5.2, "Configuring the Links Component"


	
Section 18.2.5.3, "Setting Links Layout Component Properties"






18.2.5.1 What You Should Know About the Links Layout Component

The Links layout component enables you to add a single instance of navigation to a page, outside the more formal structure of your portal's navigation resources (Figure 18-12).


Figure 18-12 Links Layout Component

[image: Links layout component]






The links component is associated with the page or template on which it is placed. When you put a links component on a page and add some links, those links are associated with the page. That is, the lifecycle of the links component respects the lifecycle of the page or template on which it is placed. For example:

	
When a page containing links is copied, all the links are also copied, and the page copy has its own set of links. Modifying links on the original page does not affect the page copy. The same is true for links on page templates.


	
When a page is deleted, all links associated with the page are also deleted. The same is true for links on page templates.


	
If a Space template contains pages with links, creating a new Space based on the template effectively creates a clone of all the pages in the template. Consequently, the new Space has pages with links that are separate from the ones in the template.


	
When a Space is exported or imported, any links associated with Space pages are also exported or imported.




The Links component's Add, Edit, and Delete Link UI is available in both page view and page edit modes to users with Edit permission on the page. Users without Edit permission see only the added navigation links. Changes in both edit and view modes are visible to all users who can view the page. That is, the addition of links falls outside the constraints of user customization, where changes made in page view mode are visible only to the user who made them.

A control is available for specifying that a link target is opened within the context of the current page template or in place of the page on which it was invoked. There are also controls on each link for configuring a given link's properties and deleting the link (Figure 18-13).


Figure 18-13 Controls on Individual Links

[image: Controls on individual links]






The Links component's properties provide opportunities for controlling the behavior and look and feel of a Links component instance. For more information, see Section 18.2.5.3, "Setting Links Layout Component Properties."






18.2.5.2 Configuring the Links Component

This section steps you through the process of setting up informal navigation using the Links component. It includes the following sections:

	
Section 18.2.5.2.1, "Adding Navigation Links"


	
Section 18.2.5.2.2, "Configuring an Advanced Search for Content Links"


	
Section 18.2.5.2.3, "Configuring a Link in the Links Component"


	
Section 18.2.5.2.4, "Reordering Navigation Links"


	
Section 18.2.5.2.5, "Deleting a Link from the Links Component"






18.2.5.2.1 Adding Navigation Links

To add links using the Links component:

	
Open the Add Link menu and select a link type:

	
Page Link—Add a link that targets an application page.


	
External Link—Add a link that targets a site that is external to the application.


	
Content Link—Add a link that targets a document from a content repository.




To add a Page Link: 

	
Select Page Link to open the New Page Link dialog (Figure 18-14).


Figure 18-14 New Page Link Dialog

[image: New Page Link dialog]






	
In the Name field, enter a display name for the link.


	
For Path, click Browse to open the Select a Page dialog (Figure 18-15).


Figure 18-15 Select a Page Dialog

[image: Select a page dialog]






	
Select a page from the given options, or click Search to locate a page on the available list of pages.




	
Tip:

In the Home Space, you can select from pages that are available to you in your view of the Home Space. In other Spaces, you can select from pages that are available within the scope of the current Space.








	
Click Select.


	
Click OK.




To add an External Link: 

	
Select External Link to open the New External Link dialog (Figure 18-16).


Figure 18-16 New External Link Dialog

[image: New External Link dialog]






	
In the Name field, enter a display name for the link.


	
In the URL field, enter the URL to the link target, for example:


http://www.mywebdestination.com


	
Select Render in page template to present the link target content within the context of the current page template.

Clear this checkbox to redirect the current page to the link target.


	
Click OK.




To add a Content Link: 

	
Select Content Link to open the New Content Link dialog (Figure 18-17).


Figure 18-17 New Content Link Dialog

[image: New Content Link dialog]






	
In the Name field, enter a display name for the link.


	
For Path, click Browse to open the Select Document dialog (Figure 18-18).


Figure 18-18 Select Document Dialog

[image: Select Document dialog]






If the link target is not readily accessible, you can use the Search feature to locate it. For a more pointed search, click Advanced. For more information, see Section 18.2.5.2.2, "Configuring an Advanced Search for Content Links."


	
Click Select.


	
Click OK.












18.2.5.2.2 Configuring an Advanced Search for Content Links

The Links component's Advanced Search feature provides controls for specifying additional search criteria and filters for Content Links searches (Figure 18-19).


Figure 18-19 Advanced Search Dialog

[image: Advanced Search dialog]






This search is very similar to an advanced document search. For more information, see Section 41.29.2, "Running an Advanced Document Search."






18.2.5.2.3 Configuring a Link in the Links Component

Users with Edit permission on the page can access a configure control on a given link to revise the link's name and target. If you can see the Configure icon to the right of each link, you are authorized to configure links (Figure 18-20).


Figure 18-20 Configure Icon on a Link

[image: Configure icon on a link]






To configure a link in the Links component:

	
Go to the instance of the Links component where you want to configure a link.


	
Click the Configure icon to open the Edit Page Link dialog (Figure 18-21).


Figure 18-21 Edit Page Link Dialog

[image: Edit Page Link dialog]






	
Revise the values as required.




	
See Also:

For information about the values required by Edit Page Link fields, see Section 18.2.5.2.1, "Adding Navigation Links"








	
Click OK.









18.2.5.2.4 Reordering Navigation Links

You can reorder navigation links in a Links layout component by dragging and dropping. Click and hold on a link, drag it to its new position, and release the link.






18.2.5.2.5 Deleting a Link from the Links Component

Authorized users can access a delete control on a given link to remove the link from the Links component. If you can see the Delete icon to the right of each link, you are authorized to delete links (Figure 18-22).


Figure 18-22 Delete Icon on a Link

[image: Delete icon on a link]






To delete a link from the Links component:

	
Go to the instance of the Links component where you want to delete a link.


	
Click the Delete icon to delete the link.


	
Click the Delete button in the confirmation dialog.











18.2.5.3 Setting Links Layout Component Properties

The Links component parameters Navigation and Start Path are preconfigured and must not be changed. Changing these parameters can result in breaking the instance's functionality. Table 18-3 lists and describes the parameters associated with the Links layout component.


Table 18-3 Links Layout Component Parameters

	Parameter	Description
	
Navigation

	
The path to a navigation model that is created specifically for this instance

You should not change this value. Changing this value risks breaking the component instance.


	
Start Path

	
The starting location for this navigation instance

Because the Links layout component supports only one hierarchical level, any value other than the default (/) is not supported.


	
Show Levels

	
The number of levels of navigational hierarchy to show

Because the Links layout component supports only one hierarchical level, any value you specify has no effect.


	
Show Root

	
Specify how to show the navigation root in a tree model

	
Do Not Show Root—Do not show the navigation root


	
Show Tree Root—Show the navigation root as a stem under which all other navigation is listed


	
Show Root As Box—Show the navigation root as a box under which all other navigation is listed




Because the Links layout component supports only one hierarchical level, any value you specify has no effect.


	
Style

	
The display style for navigation links

	
Collapsed Tree—Navigation is rendered in a tree hierarchy that is initially shown as collapsed


	
Expanded Tree—Navigation is rendered in a tree hierarchy that is initially shown as expanded


	
List—Navigation links are rendered as a list




Because the Links layout component supports only one hierarchical level, the tree selections have no effect. Navigational links are rendered as a list.


	
Show Icons

	
Indicate whether to show or hide any icon associated with a navigation link








The Links layout component also has associated properties that you can safely change. These include Display Options, Style, and Content Style properties. Use these to set default behavior and styles on the component instance.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







The Display Options you set on the component affect only the particular instance. Links Display Options are common to many other components. Commonly shared Display Options are listed and described in Section 17.5.2.5, "Working with Component Display Options."

The styles you set on the component override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application skin. Links style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."








18.2.6 Working with the Hyperlink Layout Component

Use the Hyperlink layout component to add a link to a web location to a page. The Hyperlink can point to a location that is either internal or external to the application. This section provides an overview of the Hyperlink layout component and lists and describes its unique properties.

This section includes the following subsections:

	
Section 18.2.6.1, "What You Should Know About the Hyperlink Layout Component"


	
Section 18.2.6.2, "Setting Hyperlink Layout Component Properties"






18.2.6.1 What You Should Know About the Hyperlink Layout Component

A Hyperlink layout component (Figure 18-23) is comprised of two elements: the link text and the link URL, both of which are added through component properties.


Figure 18-23 Hyperlink Layout Component

[image: Hyperlink layout component]






Hyperlinks can take both internal and external link targets. For an internal target, you can use a relative directory path. For an external target, that is, a target outside of your portal, always use the full URL.




	
Tip:

An easy way to obtain the relative directory path of a WebCenter Spaces page is to navigate to the target page and go through the motions of adding it as a Favorite. By default, the Add Favorite dialog provides the relative URL of the current page. Simply copy this information, and use it to define the Hyperlink target. For information about adding a Favorite to WebCenter Spaces, see Section 37.3, "Adding Favorites."
An easy way to obtain the direct URL to a page is to access its About this Page dialog. For more information, see Section 29.9.2, "Accessing Page Information."









Hyperlink layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. Hyperlink style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."






18.2.6.2 Setting Hyperlink Layout Component Properties

Hyperlink layout component properties provide a means of specifying link text, target destination, and open behavior.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-4 lists and describes Hyperlink layout component display options.


Table 18-4 Hyperlink Layout Component Display Options

	Property	Description
	
Destination

	
A field for entering the hyperlink target URL

Enter the Web address of the page you want to link to.


	
Open in a new window

	
Option for determining link target open behavior

	
Select to open the link target in a new browser tab or window.


	
Clear to open the link target in the current browser tab or window.





	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.


	
Title

	
A field for specifying hyperlink text

Enter the word or phrase you want to use as link text.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.7 Working with the Image Layout Component

You can add images from two places in the Resource Catalog:

	
Image layout components


	
Image files from Documents folder




Unlike images from the Documents folder, Image layout components provide controls for associating a link target with the image. You have the option of associating or omitting a link with an Image layout component.




	
Tip:

Another difference between image files from the Documents folder and an Image layout component is that image files can be discovered in a search, Image layout components cannot, preventing a return of irrelevant search results.







This section provides an overview of the Image layout component, and lists and describes its associated properties.

This section includes the following subsections:

	
Section 18.2.7.1, "What You Should Know About the Image Layout Component"


	
Section 18.2.7.2, "Setting Image Layout Component Properties"






18.2.7.1 What You Should Know About the Image Layout Component

Use the Image layout component to add a picture, a logo, a linked image, and the like to a page (Figure 18-24).


Figure 18-24 Image Layout Component

[image: Image layout component]






Use any Web-compatible image from any accessible location. That is, do not put in a path to an image on an external server that requires authentication.




	
Tip:

If you want to display an image that is not linked and is returned in a search, consider using the Documents service Content Presenter task flow in lieu of the Image layout component. For more information, see Section 41.1, "What You Should Know About the Documents Service Task Flows."







The Image layout component includes properties for defining not only the image, but also an optional target URL and short-description (ALT text) text to enhance application accessibility. Target frame options are provided to enable you to define open behavior for the Image's link target.






18.2.7.2 Setting Image Layout Component Properties

Image layout component properties provide a means of specifying the location of the image file, an optional hyperlink target, ALT text, and a target frame for the hyperlink.

Image layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. Image style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-5 lists and describes Image layout component display options.


Table 18-5 Image Layout Component Display Options

	Property	Description
	
Depressed Icon

	
A URL to the image that represents the image in a clicked state

Use any web-compatible image from any internal or publicly-accessible location.


	
Destination

	
A URL for the Image link target destination

For your link target, you can use URLs that are internal or external to the application.

For an internal target, that is, for a WebCenter Spaces page, you can use a directory path relative to the application root directory.


	
Disabled Icon

	
A URL to the image that represents the image in a disabled state

Use any web-compatible image from any internal or publicly-accessible location.


	
Hover Icon

	
A URL to the image that represents the image when a mouse pointer hovers over it

Use any web-compatible image from any internal or publicly-accessible location.


	
Icon

	
The URL to the image file that represents the image in its active, unclicked state

Use any web-compatible image from any internal or publicly-accessible location.


	
Icon Position

	
A selection of options for placement of the image

	
leading—The image renders at the start of its associated text


	
trailing—The image renders at the end of its associated text





	
Short Desc

	
Image ALT text

ALT text appears as a tooltip when users roll their mouse pointers over the image.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.


	
Target Frame

	
Open behavior for the link target

Enter any standard browser target, such as:

	
_top—Loads the link target in the current browser window (as opposed to the current frame)


	
_parent—Loads the link target in the parent frame of the current frame.


	
_self—Loads the link target within the same frame as the frame containing the link.


	
_blank—Loads the link target in a new browser tab or window, without closing the original tab or window.





	
Text

	
An optional text label to accompany the image

The Icon Position determines whether the image is placed before or after the text specified here.


	
Text And Access Key

	
Sets both text and an access key on the image

The access key is denoted by a leading ampersand (&amp;). For example, enter &amp;click me to set the text to click me and the access key to c.

An access key provides a keyboard shortcut to an action. In this case, users press Alt-<access_key>, or Alt-Shift-<access_key> to jump to the image's target destination. The keys that users press to engage the access key depend on the requirements of their browsers.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.8 Working with the Text Layout Component

Use the Text layout component to add a brief statement, page instructions, or any other kind of informative content to a page. This section provides an overview of the Text layout component and lists and describes its associated properties.

This section includes the following subsections:

	
Section 18.2.8.1, "What You Should Know About the Text Layout Component"


	
Section 18.2.8.2, "Setting Text Layout Component Properties"






18.2.8.1 What You Should Know About the Text Layout Component

The Text layout component provides a convenient way to add static display text and HTML to a WebCenter Spaces page (Figure 18-25).


Figure 18-25 Text Layout Component

[image: Text layout component]






The Text layout component provides a Rich Text Editor (RTE), which you can use to enter text, apply text styles, and add links and images (Figure 18-26).


Figure 18-26 Text Layout Component Rich Text Editor

[image: Rich Text Editor (RTE)]









	
See Also:

For information about the RTE, see Section 41.11, "Using the Rich Text Editor (RTE)."












18.2.8.2 Setting Text Layout Component Properties

The Display Options associated with the Text layout component provide a means of hiding or showing the component header, providing header text, adding a tooltip that users see when they roll their mouse pointers over the header, and other like controls.

Text Display Options are common to many other types of components and are listed in Table 17-1, "Display Options Properties".

Text layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and through the application skin. Text style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."








18.2.9 Working with the Web Page Layout Component

The Web Page layout component provides a means of opening a view onto another web page within the context of an application page. This section provides an overview of the Web Page layout component and lists and describes its associated properties.

This section includes the following subsections:

	
Section 18.2.9.1, "What You Should Know About the Web Page Layout Component"


	
Section 18.2.9.2, "Setting Web Page Layout Component Properties"






18.2.9.1 What You Should Know About the Web Page Layout Component

The Web Page layout component provides a means of displaying a window onto other web pages within the context of a WebCenter application page (Figure 18-27).


Figure 18-27 Web Page Layout Component

[image: Web Page layout component]






The content exposed through a Web Page layout component retains all of the controls associated with the exposed web page. These controls retain their functionality, enabling you to, for example, control the volume of a video, edit a wiki, or post an entry to a blog, depending on the type of content you expose.

You can use internal and external link targets for a Web Page. For an internal target, you can use a relative directory path.




	
Tip:

In WebCenter Spaces, an easy way to obtain the relative directory path of an application page is to navigate to the target page and go through the motions of adding it as a Favorite. By default, the Add Favorite dialog provides the relative URL of the current page. Simply copy this information, and use it to define the Web Page target.
For information about adding a Favorite to WebCenter Spaces, see Chapter 37, "Creating and Managing Your Personal Favorites."









The Web Page layout component provides a variation on the Web Page page style offered through the Create Page dialog (for more information, see Table 15-2, "Default Page Styles"). The Web Page page style is useful for offering the full external Web page experience. In contrast, the Web Page layout component is useful for including Web page content along with other content types on an application page.

Web Page layout component properties include a Style tab with options for setting styles on the component instance. The styles you set here override the styles that would otherwise govern the component's appearance. These include styles set on the component's parent container, the current page, and the application. Web Page style properties are common to many other components. Commonly shared Style properties are listed and described in Section 17.5.2.7, "Working with Style and Content Style Properties."






18.2.9.2 Setting Web Page Layout Component Properties

Web Page layout component properties provide a means of specifying the URL of the content to render in the Web Page area and the ALT text to display when users roll their mouse pointers over the component border.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-6 lists and describes Web Page layout component display options.


Table 18-6 Web Page Layout Component Display Options

	Property	Description
	
Short Desc

	
A field for entering ALT text for the Web Page area

Note that, for the Web Page component, the ALT text appears only when users hover their mouse pointers over the component border. You can improve the ease of this occurrence by increasing, for example, the padding around the component using the Other CSS property on the Component Properties Style tab. For example, you can enter the following in the Other CSS text box:


padding-top:30px;


	
Source

	
A field for entering the fully qualified URL to the source Web content to render in the Web Page area

For example:


http://www.oracle.com


Note that www.oracle.com (that is, without http://) does not qualify. If a given URL is invalid, your content does not render within the Web Page layout component.

Note: Use the component's Style properties to adjust the width and height of the display area (for more information, see Section 17.5.2.7, "Working with Style and Content Style Properties.").

If you plan to display the content of another WebCenter Spaces page, you can use a relative address. For more information, see Section 18.2.9.1, "What You Should Know About the Web Page Layout Component."


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."














18.2.10 Working with Internal Layout Components

This section provides information about the types of layout components that support page infrastructure, but are not available through the Resource Catalog (thus, internal). Such components are exposed through Source view of page edit mode.

This section includes the following subsections:

	
Section 18.2.10.1, "What You Should Know About Internal Layout Components"


	
Section 18.2.10.2, "Setting panelGroupLayout Properties"


	
Section 18.2.10.3, "Setting panelStretchLayout Properties"


	
Section 18.2.10.4, "Setting panelTabbed Properties"


	
Section 18.2.10.5, "Setting showDetailFrame Properties"


	
Section 18.2.10.6, "Setting sidebarItem Properties"


	
Section 18.2.10.7, "Setting spacer/Separator Properties"






18.2.10.1 What You Should Know About Internal Layout Components

Some page layout components are not exposed for use in the Catalog. They are nonetheless on view and configurable when you edit a page and set Oracle Composer to Source view (Figure 18-28).


Figure 18-28 Internal Layout Components in Source View

[image: Internal layout components in Source view]






Table 18-7 lists and describes the internal layout components you are likely to encounter in Source view of page edit mode.


Table 18-7 Internal Layout Components

	Layout Component	Description
	
panelGroupLayout

	
Provides a means of arranging a series of child components vertically or horizontally (no wrapping), or consecutively (wrapping). The Layout property determines the arrangement of the child components. For more information, see Section 18.2.10.2, "Setting panelGroupLayout Properties."


	
panelStretchLayout

	
Provides a means of arranging content in defined areas on a page. Useful useful for enabling content to stretch when the browser is resized. For more information, see Section 18.2.10.3, "Setting panelStretchLayout Properties."


	
panelTabbed

	
The parent component of a tab set. For more information, see Section 18.2.10.4, "Setting panelTabbed Properties."


	
showDetailFrame

	
Renders a border, or chrome, around its child component along with a header that contains icons to enable users to perform some operations. These include a menu icon with options for moving the component, along with its content, to new positions on the page. Users can drag and drop showDetailFrame components from one panelCustomizable component to another on the page. Note that a showDetailFrame must be included inside a panelCustomizable component for it to be movable.

For more information, see Section 18.2.10.5, "Setting showDetailFrame Properties."


	
sidebarItem

	
A child component of a tab set (panelTabbed). For more information, see Section 18.2.10.6, "Setting sidebarItem Properties."


	
spacer

	
Provides a means of incorporating some blank space in pages so that the page appears less cluttered than it would if all the components were presented immediately next to each other or immediately below each other. For more information, see Section 18.2.10.7, "Setting spacer/Separator Properties."











	
See Also:

For information about setting component properties, see Section 18.2.1, "Setting Properties on a Layout Component."












18.2.10.2 Setting panelGroupLayout Properties

The panelGroupLayout component provides a means of arranging a series of child components vertically or horizontally (no wrapping), or consecutively (wrapping). The component's Layout property determines the arrangement of child components.

Properties for the panelGroupLayout component include a Child Components tab with options for hiding, showing, and rearranging component content. For more information, see Section 17.5.2.6, "Working with Child Components."




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-8 lists and describes the panelGroupLayout properties that appear on the Display Options tab in the Component Properties dialog.


Table 18-8 panelGroupLayout Display Options

	Property	Description
	
Halign

	
A means of expressing the horizontal alignment of component content

Select one of:

	
start—align content horizontally, starting from the starting position

This is either left or right depending on whether the current context is localized for a left-reading or right-reading language.


	
center—align content horizontally, starting from the center


	
end—align content horizontally, starting from the ending position

This is either right or left depending on whether the current context is localized for a left-reading or right-reading language.


	
left—align content horizontally, starting from the left


	
right—align content horizontally, starting from the right





	
Landmark

	
A means of enhancing user accessibility as described by the Web Accessibility Initiative for Accessible Rich Internet Applications (WAI-ARIA). Each option describes the intended role of a content area to assist in using the area as a navigational landmark on the page.

Screen readers and other assistive technologies can make use of these landmarks in page navigation.

Select an option to clarify the role or purpose of a content area's content:

	
none—A content area that is not intended as a page navigational landmark


	
banner—A content area containing mostly site-oriented content, rather than page-specific content, such as the company logo or the portal-wide search feature

Typically, a banner appears at the top of a page and spans the page width.


	
complementary—Supporting content, designed to be complementary to the main content at a similar level on the page, but still meaningful when separated from the main content, such as related documents


	
content info—A content area that contains information about the application, such as the copyright or privacy statement.


	
main—The main content area of the page


	
navigation—A collection of navigational elements (usually links) for navigating the page or related pages.


	
search—A content area that contains one or more widgets used to define and execute a search.





	
Layout

	
A means of specifying the orientation of component content

Choose from:

	
default—align content vertically.


	
horizontal—align content horizontally


	
vertical—align content vertically


	
scroll—align content vertically with a scrollbar

The scrollbar is rendered when the height/width of component content exceeds the component height or width.





	
Short Desc

	
A field for entering ALT text for the component

ALT text appears as a tooltip when users roll their mouse pointers over the component.


	
Theme

	
The component style theme to apply to the children of this component. Use this property to change the theme without causing associated skin changes. Application skins are the sources of the themes. Some skins may have no themed definitions.

Enter one of:

	
dark


	
medium


	
light




No theme (none) is the default.


	
Valign

	
A means of expressing the vertical alignment of component content.

Select one of:

	
middle—content is aligned with the middle of the parent component


	
top—content is aligned with the top of the parent component


	
bottom—content is aligned with the bottom of the parent component


	
baseline—content is aligned with the baseline of the parent component





	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.10.3 Setting panelStretchLayout Properties

The panelStretchLayout component provides a means of arranging content in defined areas on a page. This component is useful for enabling content to stretch when the browser is resized.

The panelStretchLayout component's defined areas are called facets (Figure 18-29).


Figure 18-29 Facets of a panelStretchLayout Component

[image: facets of a panelStretchLayout component]









	
Note:

Figure 18-29 shows the facets when the language reading direction of the application is configured left-to-right. If instead the language direction is right-to-left, the start and end facets are switched.







Facets are controlled by the values you enter for its Display Options properties. When you set the height of the top and bottom facets, any contained components are stretched to fit the height. Similarly, when you set the width of the start and end facets, any components contained in those facets are stretched to that width. If no components are placed in a facet, then the facet does not take up any space.




	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-9 lists and describes the panelStretchLayout properties that appear on the Display Options tab in the Component Properties dialog.




	
Note:

All panelStretchLayout height and width facets take the value auto; however, using auto slows page performance.








Table 18-9 panelStretchLayout Display Options

	Property	Description
	
Bottom Height

	
The height of the bottom facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect. If you want your component to take up 100% of a page, consider creating a page using the Stretch page style and adding the component to it.


	
End Width

	
The width of the end facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Start Width

	
The width of the start facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.


	
Theme

	
The component style theme to apply to the children of this component. Use this property to change the theme without causing associated skin changes. Application skins are the sources of the themes. Some skins may have no themed definitions.

Enter one of:

	
dark


	
medium


	
light




No theme (none) is the default.


	
Top Height

	
The height of the top facet. Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect. If you want your component to take up 100% of a page, consider creating a page using the Stretch page style and adding the component to it.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.10.4 Setting panelTabbed Properties

The panelTabbed layout component is the parent component of a tab or tab set. Its unique set of Display Options control the behind-the-scenes method of tab creation, the source for the tabs dimensions, the tab's position, and the like.




	
See Also:

For information about working with tabs, see Section 17.3.5.5, "Creating Layered Content Regions Using Tabs."







Table 18-10 lists and describes Display Options associated with the panelTabbed layout component.


Table 18-10 panelTabbed Display Options

	Property	Description
	
Child Creation

	
Specifies when tab content is rendered

	
immediate—All tab content is rendered as soon as the page is accessed.


	
lazy—Tab content is rendered when the tab is brought forward. This selection may enhance performance by delaying the trip to the server to fetch content.





	
Dimensions From

	
Specifies the source of the dimensions applied to the component

	
auto—Either parent or disclosedChild, depending on the panelTabbed parent container. If the parent's Layout attribute is set to stretch, then parent is used; otherwise disclosedChild is used.


	
disclosedChild—The dimension is taken from the currently active tab.


	
parent—(default) The dimension is taken from any values specified on the component; if no values are specified, then they are taken from the parent; if no values are specified on the parent, then they are taken from the skin.





	
Position

	
The position of the tab portion of the panelTabbed

	
above—(default) Tabs are shown above the tab content area.


	
below—Tabs are shown below the tab content area.


	
both—Tabs are shown above and below the tab content area.




In accessibility screen reader mode, the tab position is always above.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Tab Removal

	
Specifies whether some, none, or all tabs can be removed

	
none—Tabs cannot be deleted from the tab set


	
all—All tabs can be deleted from the tab set


	
allExceptLast—All but one the last tab can be deleted from the tab set

Note: The selection allExceptLast renders a Close icon on all except the last tab when users hover their mouse pointers over them. Additional coding is required on the panelTabbed component before the Close action can execute.

Developers must write code to respond to ItemEvent with a listener attached to the showDetailItem's itemListener attribute. For example:


<af:panelTabbed tabRemoval="allExceptLast" id="pt1">
   <af:showDetailItem itemListener="myBean.onRemove" id="sdi1">
…


Write the deletion code in a Java bean named myBean with the method onRemove.





	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

For information about working with tabs, see Section 17.3.5.5, "Creating Layered Content Regions Using Tabs."












18.2.10.5 Setting showDetailFrame Properties

The showDetailFrame component renders a border, or chrome, around its child component along with a header that contains icons to enable users to perform some operations. These include a menu icon with options for moving the component, along with its content, to new positions on the page. Users can drag and drop showDetailFrame components from one panelCustomizable component to another on the page. Note that a showDetailFrame must be included inside a panelCustomizable component for it to be movable.

A showDetailFrame component enables the following actions:

	
Collapse and expand the component


	
Move content to different positions on the page


	
Rearrange task flows using options on the Actions menu


	
Edit and save text in the Rich Text Editor.




The Display Options associated with showDetailFrame are common to many other types of components and are listed in Table 17-1, "Display Options Properties" with one exception: the showDetailFrame layout component does not expose the property Allow Child Selection.

Display Options for showDetailFrame are presented on two subtabs: Basic and Advanced (Figure 18-30).


Figure 18-30 Basic and Advanced Display Options

[image: Basic and Advanced display options]










18.2.10.6 Setting sidebarItem Properties

The sidebarItem component is a child component of panelTabbed (see Section 18.2.10.4). Unlike panelTabbed, which provides all of the properties associated with a tab set, sidebarItem provides all of the properties associated with a single tab.

Table 18-11 describes the sidebarItem properties that appear on the Display Options tab in the Component Properties dialog.


Table 18-11 sidebarItem Display Options

	Property	Description
	
Disclosed

	
Indicates the current active tab, that is, the tab that is forward

This value is set by default depending on whether the selected tab is forward. Changes you make to this value have no effect.


	
Icon

	
The URL to an image

Use any Web-compatible image from any accessible location. That is, do not put in a path to an image on an external server that requires authentication.

Enter a full URL or a URL that is relative to the application root. Use CSS formatting. For example, enter:


url(http://www.abc.com/image.jpg)


	
Inflexible Height

	
The number of pixels the component will use when in a container that allocates size among multiple sibling items

If the component requires more than the set limit, its sibling components are pushed to overflow menus. The default is 100 pixels.

Note: This attribute is valid only when the parent container is a panelAccordion component.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Text

	
The text to render on the tab

The default value, an EL expression, evaluates to New Tab.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, any child components are also hidden. You can show the component again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."












18.2.10.7 Setting spacer/Separator Properties

The spacer component provides a means of incorporating some blank space in pages so that the page appears less cluttered than it would if all the components were presented immediately adjacent to each other.




	
Tip:

In the Resource Catalog, this component is called a Separator.










	
See Also:

For information about setting layout component properties, see Section 18.2.1, "Setting Properties on a Layout Component."







Table 18-12 lists and describes the spacer properties that appear on the Display Options tab in the Component Properties dialog.


Table 18-12 spacer Display Options

	Property	Description
	
Height

	
A field for specifying the spacer height

Use any standard CSS unit of measure, such as pt, px, pc, li, and so on.

Never express a Height value as a percentage. Because of differences between browsers and between layout containers, percentages do not work as you expect.


	
Short Desc

	
A field for entering tooltip text for the component

The tooltip appears when users roll their mouse pointers over the component.


	
Width

	
A field for specifying spacer width

Use any standard CSS unit of measure, such as pt, px, pc, li, %, and so on.


	
Show Component

	
An option for hiding or showing the component on the page

	
Select to show the component


	
Clear to hide the component




Once you hide a component in this way, you can show it again in Oracle Composer Source view. Right-click the hidden component, and select Show Component from the resulting context menu.











	
See Also:

Display Options properties additionally provide access to an Expression Language (EL) editor, which you can use to enter and test EL values. For more information, see Appendix B, "Expression Language Expressions."
















18.3 Deleting Layout Components

When you delete a layout component, such as a Box, all of the component's children—that is, anything contained in the component—are also deleted. For example, if you delete a Box that contains multiple task flows, the Box and all of the task flow instances it contains are deleted.

The controls for deleting a component are located on the component itself in Oracle Composer Design view and on the header of the list of components in Source view. This section describes how to delete layout components in both Design view and Source view. It includes the following subsections:

	
Section 18.3.1, "Deleting a Layout Component in Design View"


	
Section 18.3.2, "Deleting a Layout Component in Source View"






18.3.1 Deleting a Layout Component in Design View

To delete a layout component in Design view:

	
Go to the page where you want to delete a layout component, and open it in Oracle Composer.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
If necessary, open the View menu and select Design.


	
Click the Remove icon on the component header (Figure 18-31), or, if no header is shown, on the component's floating palette.


Figure 18-31 Remove Icon on a Layout Component

[image: Remove icon on a layout component]






	
In the resulting confirmation dialog, click the Delete button.

The layout component is permanently removed from the page. If the layout component had any child components, those child components are deleted as well.









18.3.2 Deleting a Layout Component in Source View

To delete a layout component in Source view:

	
Go to the page where you want to delete a layout component, and open it in Oracle Composer.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
From the View menu, select Source (Figure 18-32).


Figure 18-32 Source Option on View Menu

[image: Source option on View menu]






	
In the list of components, select the component you want to delete.


	
Click the Delete button on the list header (Figure 18-33).


Figure 18-33 Delete Button in Source View

[image: Delete button in Source view]






	
In the resulting confirmation dialog, click the Delete button.

The layout component is permanently removed from the page. If the layout component had any child components, those child components are deleted as well.
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66 Working with the Notes Service

This chapter describes the features and functions of the Notes service, and provides specific how-to information about creating personal notes.




	
Note:

The Notes service is available only in the WebCenter Spaces application, not in WebCenter Portal applications.







This chapter includes the following sections:

	
Section 66.1, "What You Should Know About the Notes Service"


	
Section 66.2, "Working with the Notes Service Task Flow"


	
Section 66.3, "Setting Notes Service Task Flow Properties"





Audience

This chapter is intended for WebCenter Spaces users interested in creating personal notes in the WebCenter Spaces application.

The WebCenter Spaces application administrator has the authority to expose or hide a particular service's task flows. Tasks discussed in this chapter are not available to you if the Notes service is hidden.



66.1 What You Should Know About the Notes Service

The Notes service provides useful features for writing yourself reminders in the form of personal notes. You can add notes by using the Notes task flow, which displays the personal notes of the currently logged in user (Figure 66-1). Only the notes that you create are displayed in the Notes task flow. No other user sees your notes, and you do not see any other user's notes.


Figure 66-1 A Notes Task Flow

[image: Notes task flow]






You can filter your Notes list by note titles. Filtering enables you to narrow the focus of your Notes to just the notes that match your filtering criteria. Consider devising a naming scheme for your notes to make the most of filtering.

The Notes service is integrated with the Links service. In a Space or Home Space, by using the Link service, you can link a note to an object like a document, list, or announcement. While you can link to a new note (Figure 66-2), you cannot link to existing notes. All users who have access to the object can view the linked note too. For more information, see Section 63.2.2.5, "Adding and Linking to a Note."


Figure 66-2 Linking a Discussion Topic to a New Note

[image: Linking a Discussion Topic to a New Note]










66.2 Working with the Notes Service Task Flow

Every work day brings new things that you, and only you, must remember: I before E except after C. Use only bonded 25# paper for your report. John hides his candy in the coffee room stir-stick drawer. WebCenter Spaces offers a way for you to keep track of these useful, sometimes vital, bits of information through Notes.

This section describes how to use the Notes task flow. It includes the following subsections:

	
Section 66.2.1, "Adding the Notes Service Task Flow to a Resource Catalog"


	
Section 66.2.2, "Adding the Notes Service Task Flow to a Page"


	
Section 66.2.3, "Creating a Note"


	
Section 66.2.4, "Filtering and Clearing Filters on Notes"


	
Section 66.2.5, "Editing Note Details"


	
Section 66.2.6, "Refreshing Your View of Notes"


	
Section 66.2.7, "Deleting Notes"






66.2.1 Adding the Notes Service Task Flow to a Resource Catalog

WebCenter Spaces provides rich Resource Catalogs that expose components and connections that WebCenter Spaces users can add to their pages. You can use a Resource Catalog to populate resources such as page templates, navigation models, pages, and task flows.

As a Spaces administrator or a Space moderator, you can make the Notes task flow available in a custom Resource Catalog so that users can add the task flow to their pages and use it for adding personal notes.

To make the Notes task flow available in a custom Resource Catalog:

	
Create a Resource Catalog or make a copy of an existing one. Creating a Resource Catalog follows the same procedure as any other resource. For information about creating a blank Resource Catalog, see Section 10.2, "Creating Resources." For information about copying an existing Resource Catalog, see Section 10.4.1, "Copying a Resource."


	
On the Resources page, select the Resource Catalog to which you want to add the Notes task flow.


	
From the Edit menu, choose Edit.


	
If you have created folders (see Section 16.3.1.1, "Creating a Folder") and want to add resources inside a particular folder, select the folder in the Edit dialog.


	
In the Edit dialog, select Add, and then Add From Library, as shown in Figure 66-3.


Figure 66-3 Adding a Resource to a Resource Catalog

[image: Adding a Resource to a Resource Catalog]






	
In the Add Resource Catalog Item dialog, select Task Flows from the list displayed on the left.


	
From the list on the right, select Notes (Figure 66-4).


Figure 66-4 Adding the Notes Task Flow to a Resource Catalog

[image: Adding the Notes Task Flow to a Resource Catalog]






	
Click Add.

The Notes task flow displays in the Edit dialog of your Resource Catalog (Figure 66-5).


Figure 66-5 Notes Task Flow in a Resource Catalog

[image: Notes Task Flow in a Resource Catalog]






	
Click OK to close the Edit dialog.


	
Configure the application or Space to use the new catalog as the default one. For information, see Section 16.10, "Configuring Resource Catalogs in Your Application."









66.2.2 Adding the Notes Service Task Flow to a Page

To add the Notes task flow to a page, you need to click Add next to the Notes task flow in the Resource Catalog, as shown in Figure 66-5.

The procedure for adding the Notes service task flow to a page is same as adding any other component from the Resource Catalog. For the generic procedure, see Section 17.5.1, "Adding a Component to a Page."


Figure 66-6 Selecting the Notes Task Flow from the Resource Catalog

[image: Notes Task Flow in the Resource Catalog]










66.2.3 Creating a Note

Create notes to track personally relevant bits of information, such as your favorite route to the fifth floor, the place to find the most plentiful desk supplies, and so on. This section describes how to create a note.

To create a note:

	
Navigate to the page that contains the Notes task flow.


	
In the Notes task flow, click the Create a new note icon (Figure 66-7).


Figure 66-7 The Create a New Note Icon in a Notes Task Flow

[image: Create a new note icon]






A panel opens with fields for entering your note (Figure 66-8).


Figure 66-8 Panel for Creating a New Note

[image: Panel for creating a new note]






	
In the Title field, enter a note title.

The note title is rendered as a link in the list of notes. You can filter your notes by their titles. Consider devising a naming scheme for your notes to make the most of filtering. For more information about filtering, see Section 66.2.4, "Filtering and Clearing Filters on Notes."


	
In the Detail field, enter note content.


	
Click Save to save the note.

When you click Save, the detail panel remains open, allowing you to create additional notes. After you finish, click Close to exit the panel.









66.2.4 Filtering and Clearing Filters on Notes

Your note list may become lengthy, making it a challenge to find a particular note. In a given session with the Notes task flow, you can shorten the list by filtering out all but the note titles that contain your filtering criteria. Enter a filtering value to temporarily limit display to notes that match the value. You can filter the Notes list against whole or partial words. Filtering looks for matches anywhere in the title.

To clear the filter, click the filtering icon again.

To filter notes:

	
Go to a Notes task flow, and click the Filter notes icon (Figure 66-9).


Figure 66-9 The Filter Notes Icon

[image: Filter notes icon]






A filtering toolbar opens.


	
Enter your filtering term in the field provided in the filtering toolbar, then click the Filter icon next to the field, to apply the filter (Figure 66-10).


Figure 66-10 Filtering Toolbar

[image: Filtering toolbar]









	
Note:

Filtering terms are not case sensitive. Use whole or partial words. Filtering looks for matches anywhere in the title.








	
Click the Cancel Filter icon to remove the filter and display all notes (Figure 66-11).


Figure 66-11 The Cancel Filter Icon

[image: Cancel Filter icon]













66.2.5 Editing Note Details

Things change. This truism may apply to the details you have entered about a particular note. If so, it's an easy matter to revise note details. This section tells you how.

To edit note details:

	
Go to a Notes task flow, then click the title of the note that you want to edit (Figure 66-12).


Figure 66-12 A Note Title in the Notes Task Flow

[image: A note title in the Notes task flow]






Note details display at the top of the task flow (Figure 66-13).


Figure 66-13 Note Details

[image: Note details]






	
Edit the details in the Title and Detail fields as you prefer.


	
Click the Update button to save your changes and exit the edit panel.









66.2.6 Refreshing Your View of Notes

The Notes task flow includes a Refresh notes icon that you can use to refresh your display of notes (Figure 66-14).


Figure 66-14 The Refresh Notes Icon on a Notes Task Flow

[image: Refresh icon on a Notes task flow]



This comes in handy for updating your view of the task flow with any recent changes. Click the Refresh notes icon, and the Notes task flow redraws, reflecting recent changes.






66.2.7 Deleting Notes

When a note has outlived its usefulness, you can remove it from the Notes task flow. Each note comes equipped with its own Delete note icon. This section describes how to delete a note.

To delete a note:

	
Go to a Notes task flow, and click the Delete note icon next to the note you want to delete (Figure 66-15).


Figure 66-15 Delete Note Icon

[image: Delete note icon]






A Delete Note dialog opens (Figure 66-16).


Figure 66-16 Delete Note Dialog

[image: Delete Note dialog]






	
Click the Delete button to delete the selected note.











66.3 Setting Notes Service Task Flow Properties

The Notes service task flow has associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 66-17). Many properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components."


Figure 66-17 Notes Service Task Flow Component Properties

[image: Component Properties dialog]






To access the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The Notes service task flow does not have any unique properties, and therefore no Parameters tab in the Component Properties dialog.

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2.5, "Working with Component Display Options" and Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."
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8 Customizing Task Flows

[bookmark: ABC1004535667][bookmark: ABC1004535667SRI1]Through system pages, you can customize a task flow so that all instances of the task flow are affected. You can change all task flow instances in the application or limit your customizations to only those instances in a given Space.

This chapter provides details about task flow customization and steps you through the process of customizing task flows application-wide and Space-wide. It includes the following sections:


	
Section 8.1, "What You Should Know About Task Flow Customization"



	
Section 8.2, "Customizing Task Flows at the Application Level"



	
Section 8.3, "Customizing Task Flows at the Space Level"



	
Section 8.4, "Customizing Seeded Task Flows Using the Task Flow Editor Page"



	
Section 8.5, "Removing Task Flow Customizations"











	
See Also:

For information about system pages, see Section 7.3, "Working with System Pages." Task flow customization is also possible at design time through Oracle JDeveloper. The process differs significantly from the runtime procedure we discuss in this chapter. For more information, see the chapter, "Customizing Task Flows," in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.










[bookmark: BABEDHGB][bookmark: WCSUG9239]

8.1 What You Should Know About Task Flow Customization

[bookmark: sthref522][bookmark: sthref523]Task flow customization provides a means of configuring a particular task flow in a way that all instances of that task flow within the current scope are affected.

The task flow customization feature is available exclusively on system pages. System pages are available at both the application and Space levels:


	
To change all instances of a given task flow across all Spaces (including the Home Space), customize the task flow on an application-level system page.



	
To change only those instances exposed in a given Space, customize the task flow on a Space-level system page.











	
Note:

When you customize a task flow element at the application level, and another user customizes the same task flow element at the Space level, the Space-level customization take precedence in that Space.










The Task Flow Editor system page is provided to enable customization of any seeded task flow (custom task flows that are created through the Resource Manager cannot be customized in this way). Customize the Task Flow Editor page and add any seeded task flow to it. Edit the task flow by selecting any of its elements on the page and then editing its properties. The changes you make here affect all instances of the task flow at the application level, when you customize the application-level system page, or within the scope of the current Space, when you customize a Space-level system page. For more information, see Section 8.4, "Customizing Seeded Task Flows Using the Task Flow Editor Page."

System pages at both the application and Space level have a Restore Default feature that enables authorized users to remove all page customizations and restore a system page to its out-of-the-box state. It is important to note that Restore Default does not also restore customized task flows that are included on the system page to their default states. A separate control, Reset Task Flow, is available to remove task flow customizations.







	
Note:

Customizations made to task flows created at runtimethat is, created through the Resource Managerare base document edits rather than layered customizations. Consequently, they cannot be reset. When you edit a task flow created at runtime in Oracle Composer, edits are saved, even if you do not explicitly click Save.
















	
See Also:

For information about removing task flow customizations, see Section 8.5, "Removing Task Flow Customizations."
For information about the Restore Default feature for system pages, see Section 7.3.3, "Removing All Page Customizations from a System Page."












Make task flow customizations in page edit mode through Source view. In Source view, an Edit Task Flow link is provided next to the region that represents the task flow. You can click this link to start the customization process (Figure 8-1).

[bookmark: BABBBFGE][bookmark: WCSUG9811]
Figure 8-1 Edit Task Flow Link Next to a Region Tag

[image: Edit Task Flow link next to a region tag]






Once in, you can select different task flow elements directly on the page and edit their properties through the Component Properties dialog. All changes made in this way affect all instances of the task flow either application-wide or within the scope of a Space, depending on where you initiated the customization. Changes to one element affect all like elements. For example, if you select a folder in the Document Explorer task flow, and change its icon, all folder icons in all Document Explorer task flows within the current scope are affected.




[bookmark: CJADIAIH][bookmark: WCSUG9074]

8.2 Customizing Task Flows at the Application Level

[bookmark: sthref525][bookmark: sthref526]This section describes how to perform task flow customizations at the application level.







	
Note:

When you customize a task flow element at the application level, and another user customizes the same task flow element at the Space level, the Space-level customization take precedence in that Space.










To perform application-wide task flow customizations through a system page:


	
Navigate to the Spaces Administration page, click the Pages tab to bring it forward, and then click System Pages to view all system pages.

You can use the following URL to get to this location:


http://host:port/webcenter/spaces/admin/systempages



	
Click the Customize link next to the system page to open it in page edit mode (Figure 8-2).

[bookmark: BABFCBCD][bookmark: WCSUG9812]
Figure 8-2 Customize Link Next to a System Page

[image: Customize link next to system page]







	
From the View menu, select Source to view the page source (Figure 8-3).

[bookmark: BABFCHHI][bookmark: WCSUG9813]
Figure 8-3 Source Option on View Menu

[image: Source option on View menu]







	
Click the Edit Task Flow link next to the task flow you want to customize (Figure 8-4).

[bookmark: BABGICBJ][bookmark: WCSUG9814]
Figure 8-4 Edit Task Flow Link Next to a Region Tag

[image: Edit Task Flow link next to a region tag]







	
In the resulting Confirm Task Flow Edit dialog, click Edit.

Source view zooms into the source code hierarchy of the task flow being edited (Figure 8-5)

[bookmark: BABHEHBD][bookmark: WCSUG9815]
Figure 8-5 Zoomed-In View of Task Flow

[image: Zoomed-in view of task flow]












	
Tip:

Use the Show Hierarchy icon (arrow) in Source view to navigate back up the source hierarchy. [image: Show Hierarchy icon]
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Part XI


Planning and Building a Space

Part XI of the User's Guide describes how to build and manage Spaces other than Home Spaces (for information about Home Spaces, see Chapter 29, "Exploring the Home Space"). It includes general information about Spaces as well as the specifics of managing Space members and roles, administering Space resources, and using hierarchical Spaces.

Part XI includes the following chapters:

	
Chapter 49, "Understanding Space Basics"


	
Chapter 50, "Working with Space Templates"


	
Chapter 51, "Managing a Space"


	
Chapter 52, "Managing Space Members and Roles"


	
Chapter 53, "Administering Spaces and Templates"


	
Chapter 54, "Working with a Space Hierarchy"
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70 Working with the Worklist Service

The Worklist service provides access to all the worklist items that require your attention. These worklist items are displayed on your application page, where you can view and act on all items in one place. These worklist items may be queried from all of the BPEL servers configured in your application.

This chapter contains the following sections:

	
Section 70.1, "What You Should Know About the Worklist Service"


	
Section 70.2, "Adding a Worklist Service Task Flow to a Page"


	
Section 70.3, "Working with the Worklist Service Task Flow"


	
Section 70.4, "Setting Worklist Service Task Flow Properties"





Audience

This chapter is intended for users interested in understanding and using the features of the Worklist service to track their tasks, notifications, and alerts.

The WebCenter Spaces application administrator has the authority to expose or hide task flows from a particular service. Tasks discussed in this chapter are not available to you if the relevant service is hidden.




	
Note:

For information about WebCenter Spaces seeded user roles, see "Managing Users and Roles for WebCenter Spaces" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.









70.1 What You Should Know About the Worklist Service

The Worklist service provides access to BPEL worklist items that are created when a BPEL workflow process is invoked, or when messages are sent to the worklist channel on the Oracle User Messaging Service.

In WebCenter Spaces, the Worklist task flow (Figure 70-1) enables you to view and respond to all the worklist items that are allocated to you. If BPEL workflows are enabled in WebCenter Spaces, you must add a Worklist task flow to a page if you want to see your Space membership notifications, invitations to join new Spaces, and so on.


Figure 70-1 Worklist Task Flow

[image: Worklist task flow]






The Worklist task flow provides a fast and easy way to view and respond to messages, alerts, and notifications from the automated processes in place in your organization. You can click an item in the Worklist task flow to view details in a separate window (Figure 70-2).


Figure 70-2 Worklist Notification

[image: Description of Figure 70-2 follows]






For example, in WebCenter Spaces, if you are selected as an approver for Space membership, every time a user applies to become a member of the Space a notification is sent to your Worklist. This is just one example of the types of notifications and requests that can be posted on your Worklist.

One Worklist item might be a request for Space membership. Response to such a request would be to approve or reject it. Another Worklist item might be a notice of acceptance as a member of a Space. Response to such a notification would be to acknowledge that you have received it. These are two small examples of a much wider range of possible messages, alerts, notifications, and responses.

The Worklist only shows items from the Oracle SOA Suite BPEL Servers. Some Worklist items are kicked off by events that are associated with an externally defined workflow. A workflow maps the route an item follows after an event kicks off. For example, a workflow might define the way a project assignment is routed, such as from administrator, to moderator, and then to participant. Additionally, it specifies what happens (if anything) when the assignee responds (such as with an Acknowledge). This type of workflow is enabled in a Workflow server that comes with Oracle SOA Suite. The definition of these workflows is an administrative or development task.

The WebCenter Spaces application also has internally-defined workflows. An example of an internally-defined workflow includes the process of subscribing to a Space. A user requests a subscription. The request appears on the Space moderator's Worklist. If the Space has multiple moderators, the first response to the Worklist item is to claim ownership of the request, so that only one moderator responds to the request itself.

Messages, alerts, and notifications might also come from the User Messaging Service. The Worklist task flow includes a control for accessing messaging preferences on this server (Figure 70-3). Clicking the Messaging preferences icon displays the User Messaging Preferences page in which you can specify the channels over which to receive User Messaging Service messages and define messaging filters.


Figure 70-3 Worklist Messaging Preferences Icon

[image: Worklist Messaging Preferences icon]






For information about setting messaging preferences for the User Messaging Service through WebCenter Spaces, see Section 70.3.2, "Setting Messaging Preferences."

Every 15 minutes, the Worklist task flow refreshes automatically with new messages, alerts, and notifications. Optionally, you can update your view yourself by clicking the task flow's Refresh Worklist icon (Figure 70-4).




	
Note:

The Worklist task flow does not get refreshed automatically when you perform an action on any task. You must refresh the task flow to list the latest items.








Figure 70-4 The Refresh Worklist Icon
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Roll your mouse pointer over the Refresh Worklist icon to display the date and time the task flow was last refreshed.

To assist you in maintaining an organized view of your Worklist items, the Worklist task flow provides a variety of display options, accessible from the Worklist toolbar (Figure 70-5).


Figure 70-5 Worklist Display Options

[image: Worklist display options]






Worklist display options enable you to approach responding to messages, alerts, and notifications according to timeliness and relevance.

For more information about Worklist display options, see Section 70.3.3, "Arranging Your Display of Worklist Items."






70.2 Adding a Worklist Service Task Flow to a Page

For the steps to add a Worklist service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."




	
Note:

You can add worklist task flows in personal pages only.












70.3 Working with the Worklist Service Task Flow

The Worklist task flow provides a fast and easy way to read and respond to items from the automated processes in place in your organization. All of the information on the Worklist is specifically relevant to you.

This section provides information about the Worklist task flow and describes how to use it. This section includes the following subsections:

	
Section 70.3.1, "Viewing and Responding to Worklist Items"


	
Section 70.3.2, "Setting Messaging Preferences"


	
Section 70.3.3, "Arranging Your Display of Worklist Items"






70.3.1 Viewing and Responding to Worklist Items

To view a task, message, alert, or notification, simply click the Details link (Figure 70-6).


Figure 70-6 Selecting a Worklist Item for Viewing

[image: Selecting a Worklist item]






Any Worklist item that is no longer of the Assigned state is removed from the Worklist during the next refresh.






70.3.2 Setting Messaging Preferences

The Worklist Messaging preferences icon provides access to controls for specifying your messaging preferences on the User Messaging Service. Use messaging preferences to specify the channels over which to receive User Messaging Service messages and to define messaging filters. User Messaging Service messages may include Worklist notifications in addition to other notifications and alerts from other consumers of the server.

Messaging channels are the channels over which messages, notifications, and alerts are received from the User Messaging Service. These include mail, voice over internet (VoIP), and the like. Messages, notifications, and alerts come from the services that are registered with the User Messaging Service.

Messaging filters define sorting conditions for messages and specify the channels through which to send messages that meet those conditions.

You can define messaging channels and filters using the User Messaging Preferences dialog. This section provides an overview of how to use this dialog to configure messaging channels and define messaging filters for messages generated from the User Messaging Service. For more information, see the User Messaging Service online help and the chapter "Oracle User Messaging Service Applications" in Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

To access the User Messaging Preferences dialog from the Worklist task flow:

	
Log in to your application.


	
Click the Messaging preferences icon in the Worklist toolbar and specify credentials to log in to the BPEL server.




	
Note:

In WebCenter Spaces, you can access the Worklist service by expanding the Worklist pane.








Figure 70-7 User Messaging Preferences
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A web page opens with two tabs (Figure 70-7):

	
Messaging Channels—Configure channels (such as mail, voice, and so on) to receive your User Messaging Service notifications and alerts.


	
Messaging Filters—Define rules for filtering your User Messaging Service notifications and alerts.





	
Configure channels and filters by referring to the User Messaging Service online help.









70.3.3 Arranging Your Display of Worklist Items

This section describes how to use Worklist sorting and grouping options to arrange your display of the Worklist. Sorting affects the display order of Worklist items. Grouping divides items into groups that share a common attribute, such as a common category, a shared priority level, or some other common attribute.

You may notice a number next to each group (Figure 70-8). These indicate the number of items contained in a particular group. To expand a group and see the items it contains, click the Expand icon to the left of the group title.


Figure 70-8 Numbers Next to Worklist Groups
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To arrange your display of Worklist items:

	
Log in to your application.


	
Click the Display Options icon at the top of the Worklist on your application page.




	
Note:

In WebCenter Spaces, you can access the Worklist by expanding the Worklist pane.








	
In the Display Options dialog box, expand the Group By list (Figure 70-9), and select an option for grouping your Worklist items.


Figure 70-9 The Worklist Group By List
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Choose from:

	
Category—Group Worklist items into their assigned categories. Items that do not belong to a category are grouped under the heading Not Categorized. Whether a Worklist item includes a category is determined by the workflow developer; consequently, not all items might include categories.


	
Create Date—Group Worklist items according to the date they were created, starting with the most recent.


	
Due Date—Group Worklist items according to when they are due. Due dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Expiration Date—Group Worklist items according to when they are due to expire. Expiration dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Not Grouped—Do not group Worklist items. When you group Worklist items by Not Grouped, the Worklist displays items in a flat list. All other grouping options display the items in a tree format.


	
Priority—Group Worklist items according to priority, either high, normal, or low. Table 70-1 illustrates the priority indicators that are used in the Worklist.


Table 70-1 Worklist Priority Indicators

	High	Normal	Low
	[image: High priority indicator]
	
No indicator

	[image: Low priority indicator]







	
Worklist Server—Group Worklist items according to the server from which they originated.





	
Select a Sort By option (Figure 70-10).


Figure 70-10 Sort By Options in the Worklist Display Options Dialog Box

[image: Worklist Display Options dialog box]






Choose from:

	
Create Date—Sort Worklist items according to the date they were created, starting with the most recent.


	
Due Date—Sort Worklist items according to when they are due. Due dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Expiration Date—Sort Worklist items from the most recent expiration to the furthest away. Expiration dates are optional; therefore, some items may not have them. In such cases, the date the item was created is used.


	
Priority—Sort Worklist items from highest to lowest priority (see Table 70-1 for illustrations of priority indicators).


	
Title—Sort Worklist items first from 0 to 9 then from a to z.





	
Click Save to save your changes and close the Display Options dialog box.

The Worklist displays newest created 25 items per Worklist server connection. For items exceeding the 25-item limit, follow the link to the BPEL Worklist Application, where you can view and act on a larger volume of Worklist items.











70.4 Setting Worklist Service Task Flow Properties

The Worklist service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 70-11). Many properties are common to all task flows, and the method for accessing task flow properties is the same from task flow to task flow. Common task flow properties and how to access them are discussed in Section 17.5.2, "Setting Properties on Page Components."


Figure 70-11 Worklist Task Flow Component Properties

[image: Recent Activity task flow properties]






Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.7, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on Display Options tab provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Expression Builder icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."
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58 Working with the Activity Graph Service

The Activity Graph service provides a means of enlarging your sphere of interest in WebCenter Spaces by offering recommendations for new connections, suitable items, and relevant Spaces, and by returning more relevant search results. It does this by tracking application activities across users for a period of time. Based on these activities the Activity Graph engine starts to provide recommendations.

This chapter provides an overview of Activity Graph service features and describes how to use them. It includes the following sections:

	
Section 58.1, "What You Should Know About the Activity Graph Service"


	
Section 58.2, "Working with Activity Graph Service Task Flows"


	
Section 58.3, "Setting Activity Graph Service Task Flow Properties"




For Activity Graph task flows to work, the Analytics schema (activities) must be installed and configured, and a connection set up between your application and the Analytics Collector.




	
See Also:

For more information, see the chapter "Managing the Analytics Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.









58.1 What You Should Know About the Activity Graph Service

The advent of Enterprise 2.0 has enabled users to contribute content at unprecedented rates. In view of this, there is now a need for better information retrieval technologies that are seamlessly integrated with Enterprise 2.0 products, such as WebCenter Spaces. The Activity Graph service provides the solution by leveraging collective intelligence, gathered by the underlying Activity Graph engine, to benefit search and social applications.

The Activity Graph service provides suggestions of people that a user may be interested in connecting with, based on existing connections and shared interaction with objects in the application. It also directs users to Spaces or items that may be of interest, based on similar interactions with those Spaces or items the user is currently viewing.

The Activity Graph service presents these suggestions based on data gathered and analyzed by the Activity Graph engine. The Activity Graph engine provides a central repository for actions that are collected by enterprise applications.

The Activity Graph service serves up its recommendations in the following three out-of-the-box task flows:

	
Recommended Connections

Use the Recommended Connections task flow (Figure 58-1) to view and connect with users similar to you.


Figure 58-1 The Recommended Connections Task Flow

[image: Description of Figure 58-1 follows]









	
See Also:

For more information about this task flow, see Section 58.2.2, "Working with the Recommended Connections Task Flow."








	
Similar Spaces

Use the Similar Spaces task flow (Figure 58-2) to identify and interact with Spaces that may be of interest to you.


Figure 58-2 The Similar Spaces Task Flow

[image: Description of Figure 58-2 follows]









	
See Also:

For more information about this task flow, see Section 58.2.3, "Working with the Similar Spaces Task Flow."








	
Similar Items

Use the Similar Items task flow (Figure 58-3) to identify and interact with WebCenter content that may be of interest to you.


Figure 58-3 The Similar Items Task Flow

[image: Description of Figure 58-3 follows]









	
See Also:

For more information about this task flow, see Section 58.2.4, "Working with the Similar Items Task Flow."













	
Note:

The Activity Graph service task flows display recommendations only if the Activity Graph service is configured in your application. For more information, see the section "Activity Graph Service Prerequisites" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.







Out of the box, the Activity Graph service tracks certain WebCenter objects and actions. However, you can extend the service to track other WebCenter objects or actions, or objects and actions from other applications.




	
See Also:

For more information, see the section "Extending the Activity Graph Service" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.












58.2 Working with Activity Graph Service Task Flows

The Activity Graph service task flows expose the functionality available from the Activity Graph service.

This section includes the following subsections:

	
Section 58.2.1, "Adding an Activity Graph Service Task Flow to a Page"


	
Section 58.2.2, "Working with the Recommended Connections Task Flow"


	
Section 58.2.3, "Working with the Similar Spaces Task Flow"


	
Section 58.2.4, "Working with the Similar Items Task Flow"






58.2.1 Adding an Activity Graph Service Task Flow to a Page

By default, the Recommended Connections task flow is included in each user's Profile Gallery, available through the Home Space. The Similar Items task flow is included, by default, in the Document Viewer Related Items pane for files, to show items similar to the currently viewed file.

To include any of the Activity Graph service task flows anywhere else, you must add the task flow to the appropriate page.

To add an Activity Graph service task flow to a page:

	
Open the page in edit mode.




	
See Also:

For more information, see Section 17.3.1, "Entering and Exiting Page Edit Mode."








	
Click Add Content in the target region to open the Resource Catalog.


	
Navigate to the section of the Resource Catalog that contains the Activity Graph service task flows or search for the task flow.




	
Tip:

The presence or location of this component depends on how the Resource Catalog is configured. For example, in the default Resource Catalog, next to Social and Communication, click Open to expose a list that includes the Activity Graph service task flows.








	
Click Add next to the task flow that you want to add to your page.









58.2.2 Working with the Recommended Connections Task Flow

The Recommended Connections task flow enables viewing and connecting to people considered to be similar to you.




	
Note:

The recommendations provided in the task flow reflect the contents of the activity graph when the Activity Graph Engines were last run. Activities that occurred after the last run are not included. For more information, see the section "Preparing Data for the Activity Graph Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.







This section includes the following subsections:

	
Section 58.2.2.1, "Learning More About a Recommended Connection"


	
Section 58.2.2.2, "Inviting a Recommended Connection to Connect with You"


	
Section 58.2.2.3, "Removing a User from Your Recommended Connections"







	
See Also:

For general information about connections, see Chapter 31, "Creating Your Social Network."









58.2.2.1 Learning More About a Recommended Connection

Before you connect with someone new, you probably want to find out a bit more about that person to determine whether it is really a connection that you want to make. The Recommended Connections task flow enables this by providing access to the user profile information and by including reasons why the recommendation has been made.

To view information about a recommended connection:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home Space.








	
For each of your recommended connections, the task flow includes the name, title, and profile icon of the user. This provides a snapshot to help you decide quickly if you want to connect to this person.


	
To find out more information about the user, click name of the user to display the User Detail popup.




	
Note:

Alternatively, you can click the user icon to display the user's Profile Gallery.








	
In the User Detail popup (Figure 58-4), you can view additional information about the user, such as his or her location and current status. You can also choose to view the full profile or contact the user by email or instant message.


Figure 58-4 The User Detail Popup

[image: Description of Figure 58-4 follows]









	
Note:

The information in the User Detail popup depends on the information that the user has provided in their profile, and the services that are enabled in the Space.








	
Click anywhere away from the popup to close it.


	
The task flow may also provide a reason why each person was recommended as a potential connection. For example, you may be connected to some of the same people or you may have worked on the same documents or wikis.

Reasons for recommending a connection are:

	
You share connections with the user


	
You and the user edited one or more of the same items


	
You and the user worked in one or more of the same Spaces


	
You and the user tagged one or more of the same items




Click the reason to find out more details. For example, a list of the connections you have in common, or a list of the objects that you have both worked on (Figure 58-5).


Figure 58-5 Details for Reasons for Recommended Connections

[image: Description of Figure 58-5 follows]






	
Click anywhere away from the popup to close it.


	
After examining this information you can decide whether to connect to this person, or remove him or her from the list of recommended connections.









58.2.2.2 Inviting a Recommended Connection to Connect with You

If you find a person in the list of recommended connections that you want to connect with, you can do so quickly from the User Detail popup or the user's Profile Gallery.

To invite a recommended connection to connect with you:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home Space.








	
Find the person in the list of recommended connections.


	
Click the name of the user to display the User Detail popup, or the user icon to display the user's Profile Gallery.


	
Click Get Connected (Figure 58-6).


Figure 58-6 The Get Connected Link

[image: Description of Figure 58-6 follows]






	
In the Invitation Message dialog (Figure 58-7), enter your own message or keep the default.


Figure 58-7 The Invitation Message Dialog

[image: Description of Figure 58-7 follows]






	
From the Select connection lists dropdown list, select the connection list to which you want to add this user.




	
See Also:

For more information about connections lists, see Section 31.4.5, "Creating and Managing Connections Lists."








	
Click Invite.

If the person you have invited set Preferences to automatically accept all invitations, you are connected immediately. Otherwise, the invitation becomes available in the recipient's Connections page.




	
See Also:

For more information, see Section 31.4.3, "Viewing Invitations to Connect."















58.2.2.3 Removing a User from Your Recommended Connections

If the list of recommended connections includes people that you do not want to connect with, you can remove them, making space for more recommendations. You might also choose to remove someone after you have issued them an invitation to connect. If you do so, the recommendation is removed from the list, but the invitation is not canceled.

To remove a recommended connection:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home Space.








	
Find the person in the list of recommended connections.


	
Click the Do not show this person icon next to the user in the list (Figure 58-8).


Figure 58-8 The Do Not Show This Person Icon

[image: Description of Figure 58-8 follows]






	
The task flow is refreshed with a new recommended connection taking the place of the one you removed.









58.2.2.4 Setting the Number of Users to Display in the Recommended Connections Task Flow

You can control the number of users that are displayed in the Recommended Connections task flow.

To set the number of recommended connections to display:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home Space.








	
Click the Display Options icon.


	
In the Display Options dialog, in the Number of People field (Figure 58-9), enter how many recommended connections you want to list in the task flow. The default value is 5.


Figure 58-9 The Number of People Field

[image: Description of Figure 58-9 follows]






	
Click OK.









58.2.2.5 Controlling Which Users to Include in the Recommended Connections Task Flow

By default, the Recommended Connections task flow includes all recommended connections except those with whom you are already connected. You can change this setting by editing the task flow's display options. For example, you could use the task flow to show users who are similar to you, rather than to show recommended connections. In this case, you might want to include existing connections.

To control which users to include in the task flow:

	
Go to a Recommended Connections task flow.




	
Tip:

By default, you can find a Recommended Connections task flow on the Profile page in your Home Space.








	
Click the Display Options icon.


	
In the Display Options dialog, select the Users I am connected with checkbox (Figure 58-10) to include users in the list of recommended connections even if you are already connected with them.

Deselect the checkbox to remove users from the list if you are already connected with them.


Figure 58-10 The Users I Am Connected With Option

[image: Description of Figure 58-10 follows]









	
Note:

This checkbox is not selected by default.








	
Click OK.











58.2.3 Working with the Similar Spaces Task Flow

The Similar Spaces task flow can be placed on any page in a Space. It provides you with suggestions of other Spaces that are similar to the one you are currently viewing. A Space is considered similar to another Space if the same people interact with it, especially if they edit the content.

Only Spaces that you are permitted to view are listed in the Similar Space task flow.




	
Note:

The suggestions made in the Similar Spaces task flow are determined based on the currently viewed Space only; they are not specific to the current user.










	
Note:

The recommendations provided in the task flow reflect the contents of the activity graph when the Activity Graph Engines were last run. Activities that occurred after the last run are not included. For more information, see the section "Preparing Data for the Activity Graph Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.







This section includes the following subsections:

	
Section 58.2.3.1, "Learning More About a Suggested Space"


	
Section 58.2.3.2, "Joining a Suggested Space"


	
Section 58.2.3.3, "Removing a Space from the Task Flow"


	
Section 58.2.3.4, "Setting the Number of Spaces to Display in the Similar Spaces Task Flow"


	
Section 58.2.3.5, "Controlling Which Spaces to Include in the Similar Spaces Task Flow"






58.2.3.1 Learning More About a Suggested Space

When looking at a Space in the Similar Spaces task flow, one of the first things you will probably want to do is find out more about that Space. This will help you determine whether the Space is one that you are interested in joining or not.

To learn more about a suggested Space:

	
Go to the Similar Spaces task flow that includes the Space about which you want to learn more.


	
For each of the suggested Spaces, the task flow includes the name and description of the Space. This provides a snapshot to help you decide quickly if the Space is one that you might be interested in.


	
To go to the Space to find out more about it, click the name.


	
Examine the contents of the Space to determine if you are interested in it.


	
After examining the Space you can decide whether to join the Space, or remove it from the task flow.









58.2.3.2 Joining a Suggested Space

If you find a Space in Similar Spaces task flow that you want to join, you can do so by visiting the Space.

To join a suggested Space:

	
Go to the Similar Spaces task flow that includes the Space that you want to join.


	
Find the Space that you want to join.


	
Click the Space name to open the Space.


	
In the Space, subscribe to the Space. Some membership requests require approval from the Space moderator so you may not gain access immediately.




	
See Also:

For more information, see Section 49.6, "Joining a Space."















58.2.3.3 Removing a Space from the Task Flow

If you decide that you are not particularly interested in a Space listed in the Similar Spaces task flow, you can remove it, making space for more suggestions. The Space is removed only from your view of the task flow; the Space will continue to be listed for other users, as long as they have permission to view it.

To remove a Space from the task flow:

	
Go to the Similar Spaces task flow that includes the Space that you want to remove.


	
Find the Space that you want to remove.


	
Click the Do no show this space icon next to the Space (Figure 58-11).


Figure 58-11 The Do Not Show This Space Icon

[image: Description of Figure 58-11 follows]






	
The task flow is refreshed with a new similar Space taking the place of the one you removed.









58.2.3.4 Setting the Number of Spaces to Display in the Similar Spaces Task Flow

You can control the number of Spaces that are displayed in the Similar Spaces task flow.

To set the number of similar Spaces to display:

	
Go to the Similar Spaces task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, in the Number of Spaces field (Figure 58-12), enter how many similar Spaces you want to list in the task flow. The default value is 5.


Figure 58-12 The Number of Spaces Field

[image: Description of Figure 58-12 follows]






	
Click OK.









58.2.3.5 Controlling Which Spaces to Include in the Similar Spaces Task Flow

By default, the Similar Spaces task flow does not include Spaces that you are already a member of, but it does include Spaces that you have already viewed. You can change these settings by editing the task flow's display options.

To which Spaces to include in the task flow:

	
Go to the Similar Spaces task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, select the Show Spaces I have worked on before checkbox (Figure 58-13) to display Spaces in which you have performed an action (excluding viewing) in the list of similar Spaces.

Deselect the checkbox if you do not want to include Spaces that you have worked on.


Figure 58-13 The Show Spaces I Have Worked on Before Option

[image: Description of Figure 58-13 follows]









	
Note:

This checkbox is not selected by default.








	
Select the Show Spaces I have visited before checkbox (Figure 58-14) to include Spaces in the list of similar Spaces even if you have already viewed them.

Deselect the checkbox to remove Spaces from the list if you have already viewed them.


Figure 58-14 The Show Spaces I Have Visited Before Option

[image: Description of Figure 58-14 follows]









	
Note:

This checkbox is selected by default.








	
Click OK.











58.2.4 Working with the Similar Items Task Flow

The Similar Items task flow provides you with suggestions of other items you might want to view, based on the item you have currently selected on the page.




	
Note:

The suggestions made in the Similar Items task flow are determined based on the currently selected item only; they are not specific to the current user.










	
Note:

The recommendations provided in the task flow reflect the contents of the activity graph when the Activity Graph Engines were last run. Activities that occurred after the last run are not included. For more information, see the section "Preparing Data for the Activity Graph Service" in the Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.







This section includes the following subsections:

	
Section 58.2.4.1, "Populating the Similar Items Task Flow"


	
Section 58.2.4.2, "Viewing a Suggested Item"


	
Section 58.2.4.3, "Removing an Item from the Similar Items Task Flow"


	
Section 58.2.4.4, "Setting the Number of Items to Display in the Similar Items Task Flow"


	
Section 58.2.4.5, "Controlling Which Items to Include in the Similar Items Task Flow"






58.2.4.1 Populating the Similar Items Task Flow

The Similar Items task flow lists items that are similar to the currently selected item on the page. When you initially display a page that contains the Similar Items task flow, the task flow will probably be empty. To populate the task flow, you need to select an item for which you want to see similar items.




	
Note:

If the page containing the Similar Items task flow also contains the Document Viewer, the document currently displayed in the Document Viewer drives the content of the Similar Items task flow and you do not need to explicitly select an item.







To populate the Similar Items task flow:

	
Go to the page containing the Similar Items task flow.


	
In one of the other task flows on the page, select the item for which you want to see similar items.

The Similar Items task flow works in conjunction with the following task flows:

	
Documents service task flows:

	
Recent Documents


	
Document List Viewer


	
Document Navigator


	
Document Explorer


	
Folder Viewer


	
Document Manager


	
Document Browser





	
Discussions Manager task flow





	
The Similar Items task flow refreshes to display items that are similar to the one you selected.









58.2.4.2 Viewing a Suggested Item

If you see an item in the Similar Items task flow that you think might be useful, you can go ahead and view it.

To view a suggested item:

	
Go to the Similar Items task flow that includes the item that you want to view.


	
Click the item's name to display the item.

The way the item is displayed depends on the type of item. For example, documents are displayed in the Document Viewer task flow.









58.2.4.3 Removing an Item from the Similar Items Task Flow

If you decide that you are not particularly interested in an item listed in the Similar Items task flow, you can remove it, making space for more suggestions. The item is removed only from your view of the task flow; the item will continue to be listed for other users, as long as they have permission to view it.

To remove an item from the task flow:

	
Go to the Similar Items task flow that includes the item that you want to remove.


	
Find the item that you want to remove.


	
Click the Do not show this item icon next to the item (Figure 58-15).


Figure 58-15 The Do Not Show This Item Icon

[image: Description of Figure 58-15 follows]






	
The task flow is refreshed with a new similar item taking the place of the one you removed.









58.2.4.4 Setting the Number of Items to Display in the Similar Items Task Flow

You can control the number of items that are displayed in the Similar Items task flow.

To set the number of items to display in the task flow:

	
Go to the Similar Items task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog, in the Number of items field (Figure 58-16), enter how many similar items you want to list in the task flow. The default value is 5.


Figure 58-16 The Number of Items Field

[image: Description of Figure 58-16 follows]






	
Click OK.









58.2.4.5 Controlling Which Items to Include in the Similar Items Task Flow

By default, the Similar Items task flow include items that you have already viewed. It also includes all types of supported items (documents, wiki pages, blogs, and discussion topics). You can change these settings by editing the task flow's display options. For example, you could use the task flow to show only discussion topics that are similar to the selected item.

To control which items to include in the task flow:

	
Go to the Similar Items task flow that you want to edit.


	
Click the Display Options icon.


	
In the Display Options dialog , select the Show items I have viewed before checkbox (Figure 58-17) to include items in the list of similar items even if you have already viewed them.

Deselect the checkbox to remove items from the list of similar items if you have already viewed them.


Figure 58-17 The Show Items I Have Viewed Before Option

[image: Description of Figure 58-17 follows]









	
Note:

This checkbox is selected by default.








	
Select the Show items I have worked on before checkbox () to include items in the list of similar items even if you have already interacted with them in some way (other than viewing).

Deselect the checkbox to remove items from the list of similar items if you have interacted with them already.


Figure 58-18 The Show Items I Have Worked on Before Option

[image: Description of Figure 58-18 follows]









	
Note:

This checkbox is not selected by default.








	
Select or deselect the following checkboxes as required to determine which types of items to display in the task flow (Figure 58-19):

	
Show documents


	
Show wiki pages


	
Show blogs


	
Show discussion topics





Figure 58-19 Options for Displaying Different Types of Items

[image: Description of Figure 58-19 follows]









	
Note:

These checkboxes are selected by default.








	
Click OK.













58.3 Setting Activity Graph Service Task Flow Properties

The Activity Graph service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 58-20).


Figure 58-20 Recommended Connections Task Flow - Component Properties

[image: Description of Figure 58-20 follows]






For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Activity Graph service task flows and describe the properties on the Parameters tab:

	
Section 58.3.1, "What You Should Know About the Activity Graph Service Task Flow Properties"


	
Section 58.3.2, "Activity Graph Service Task Flow Parameters"






58.3.1 What You Should Know About the Activity Graph Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 58.3.2, "Activity Graph Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






58.3.2 Activity Graph Service Task Flow Parameters

Table 58-1 describes the parameters that are unique to the Activity Graph service task flows.


Table 58-1 Activity Graph Service Task Flow Parameters

	Parameter	Description	Task Flow
	
Resource Id

	
The ID of the person, Space, or item to use as a context for recommendations.

For connections, the default value is the expression language token for the logged in user.

For Spaces, the default value is the expression language token for the resource ID of the Space containing the task flow.

For items, the value is derived from the selection event using the EL expression #{wcEventContext.events.WebCenterResourceSelected}

	
Recommended Connections

Similar Spaces

Similar Items


	
Class URN

	
The class of the context. By default the information is derived from the selection event.

	
Similar Items


	
Object Name

	
The name of the Space or item to use as a context for recommendations.

For Spaces, the default value is the expression language token for the resource ID of the Space containing the task flow.

For items, the default value is derived from the selection event.

	
Similar Spaces

Similar Items


	
Recipe

	
A comma separated list of registered similarity calculation = weight pairs. The list determines what recommendations appear and how they are ordered.

For more information about the default recipes for Activity Graph task flows, see the section "Activity Graph Service Task Flows" in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.

	
Recommended Connections

Similar Spaces

Similar Items


	
Class URN Restrictions

	
A comma separated list of object classes to exclude from recommendations.

	
Similar Items


	
Exclude Object Actions

	
A comma separated list of registered actions. The task flow will not show people, Spaces, or items on which the logged in user took any of the listed actions.

	
Recommended Connections

Similar Spaces

Similar Items


	
Service Id

	
Used in conjunction with resourceId, and optionally resourceType, as an alternative to classURN for identifying the node class of an object.

	
Similar Items


	
Resource Type

	
Used in conjunction with resourceId and serviceId, as an alternative to classURN for identifying the node class of a WebCenter object.

For example resourceType is used by the Documents service to identify whether an object is a wiki, blog, or document.

	
Similar Items


	
Suppress Popup

	
Determines whether links in the task flow launch content in inline popups (false) or in browser windows (true).

The default value is false.

	
Similar Items
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Part XII


Analyzing and Monitoring Your Portal


Part XII of the User's Guide provides information about analyzing your portal's usage and performance metrics.

Part XII includes Chapter 55, "Analyzing Usage and Performance Metrics."
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Part XVI


Services: Lists through Worklist

Part XVI of the User's Guide provides overview and usage information about services from Lists through Worklist.

Part XVI includes the following chapters:

	
Chapter 64, "Working with the Lists Service"


	
Chapter 65, "Working with the Mail Service"


	
Chapter 66, "Working with the Notes Service"


	
Chapter 67, "Working with the Polls Service"


	
Chapter 68, "Working with the RSS Service"


	
Chapter 69, "Working with the Recent Activities Service"


	
Chapter 70, "Working with the Worklist Service"





Working with Microsoft Office and Explorer Integration






46 Working with Microsoft Office and Explorer Integration

WebCenter Spaces integrates with Microsoft Office and Windows Explorer to provide you with flexibility in managing files in a Space when the content repository is Oracle Content Server.




	
Note:

The Documents service is exposed on the Documents page and administration settings in a Space only with Oracle Content Server 11g. If the connected content repository is Oracle Content Server 10g, the Documents page is not shown in a Space, and the Documents service is not available in the Space administration settings (Services and Roles). To use the Documents service functionality in 10g, you can create a page in a Space and add Documents service task flows to the page.







The differences in Microsoft Office 2003, 2007, and 2010 mean that each version may support a particular feature in a different way, and one or more versions may not support some of the tasks described in this chapter. Each section in this chapter provides information about which Microsoft Office version supports the task described, and how that support is implemented, where there are differences.

This chapter includes the following sections:

	
Section 46.1, "What You Should Know About Microsoft Office and Explorer Integration"


	
Section 46.2, "Configuring Microsoft Office Integration with WebCenter Spaces"


	
Section 46.3, "Working with Microsoft Word, PowerPoint, and Excel Integration"


	
Section 46.4, "Working with Microsoft Windows Explorer Integration"





Audience

This chapter is intended for WebCenter Spaces users interested in using Microsoft Office applications and Windows Explorer to manage information in a Space.



46.1 What You Should Know About Microsoft Office and Explorer Integration

This following sections provide an overview of the added functionality that integration with Microsoft Office and Windows Explorer offers:

	
Section 46.1.1, "Understanding WebCenter Spaces Word, PowerPoint, and Excel Integration"


	
Section 46.1.2, "Understanding Microsoft Windows Explorer Integration"






46.1.1 Understanding WebCenter Spaces Word, PowerPoint, and Excel Integration

WebCenter Spaces integrates with the Microsoft Office shared document management functionality for working the with Microsoft Word, PowerPoint, or Excel files in a Space (the Home Space or a group Space). This functionality is available in Microsoft Office 2003 and later, when the backend content repository is Oracle Content Server.




	
Note:

The differences in Microsoft Office 2003, 2007, and 2010 mean that each version may support a particular feature in a different way, and one or more versions may not support some of the tasks described in this chapter. Each section provides information about which version supports the task described, and how that support is implemented, where there are differences.







Microsoft Office shared document management functionality offers alternate ways to perform tasks that can also be performed within WebCenter Spaces, as shown in Table 46-1.


Table 46-1 File Management Tasks

	Task	Microsoft Office Document Management	WebCenter Spaces Application
	
Opening a file.

	
See Section 46.3.2, "Opening and Editing a File."

	
See Section 41.10, "Opening a File."


	
Editing a file.

	
See Section 46.3.2, "Opening and Editing a File."

	
Section 41.12, "Editing and Updating a File."



	
Adding a new file to a Space.

	
See Section 46.3.4.1, "Adding a File."

	
See:

	
Section 41.14, "Copying and Pasting Folders and Files."


	
Section 41.8.1, "Uploading New Files."





	
Adding a new folder to a Space.

	
See Section 46.3.4.2, "Adding a New Folder."

	
See Section 41.7, "Creating a Folder."


	
Checking a file out and in.

	
See Section 46.3.4.3, "Checking a File Out" and Section 46.3.4.4, "Checking a File In."

	
See Section 41.12.1, "Checking a File Out."


	
Performing actions on the currently open file.

	
See Section 46.3.4.5, "Managing the Currently Open File."

	
See Chapter 41, "Working with the Documents Service Task Flows and Document Components."


	
Performing actions on other files in the current folder.

	
See Section 46.3.4.6, "Managing Other Files in the Current Space."

	
See Chapter 41, "Working with the Documents Service Task Flows and Document Components."


	
Performing actions on subfolders in the current folder.

	
See Section 46.3.4.7, "Managing Folders."

	
See Chapter 41, "Working with the Documents Service Task Flows and Document Components."


	
Viewing link targets.

	
See Section 46.3.4.8, "Viewing Link Targets."

	
See Section 63.2.3, "Accessing Link Targets."


	
Working with file version histories.

	
See Section 46.3.4.10, "Working with File Version History."

	
See Section 41.21, "Viewing and Deleting File Version History."


	
Adding new members to a Space.

	
See Section 46.3.4.11, "Adding Members to a Space."

	
See Section 51.14.4, "Granting WebCenter Spaces Users Access to a Space."


	
Sending a mail message.

	
See Section 46.3.4.12, "Sending a Message."

	
See:

	
Section 41.24.2, "Mailing the URL for a File"


	
Section 65.1, "What You Should Know About the Send Mail Feature"


	
Section 65.4.6, "Composing and Sending Mail Messages."















46.1.2 Understanding Microsoft Windows Explorer Integration

WebCenter Spaces integrates with Microsoft Windows Explorer to manage the folders and files in a Space when the backend content repository is Oracle Content Server. To use this functionality, you create a network place in Windows Explorer for the Space documents. See Section 46.4, "Working with Microsoft Windows Explorer Integration."








46.2 Configuring Microsoft Office Integration with WebCenter Spaces

Desktop integration of Microsoft Office with WebCenter Spaces requires the following configuration:

	
(All versions of Microsoft Office) If you access the WebCenter Spaces application through Oracle HTTP Server (OHS), you must modify system properties and server configuration files to allow for full integration of Microsoft Office with WebCenter Spaces. For more information, refer to "Configuring Microsoft Clients" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
(All versions of Microsoft Office) If you access the WebCenter Spaces application through Oracle HTTP Server (OHS), set up a virtual host for your application, as described in "Configuring SSO with Virtual Hosts" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.


	
(Microsoft Office 2010 only) If WebCenter is using Windows Integrated authentication, integration with WebCenter Spaces requires no additional configuration. If WebCenter is not configured to use Windows Integrated authentication, you need to modify the registry as described in http://support.microsoft.com/kb/2123563.









46.3 Working with Microsoft Word, PowerPoint, and Excel Integration

WebCenter Spaces integrates with the Microsoft Office shared document management functionality for working with Microsoft Word, Excel, or PowerPoint files that belong to a Space. This functionality is available in Microsoft Office 2003 and later, when the backend content repository is Oracle Content Server. For more information, see Section 46.1.1, "Understanding WebCenter Spaces Word, PowerPoint, and Excel Integration."

Many of the tasks you can perform using the Microsoft Office shared document management functionality can also be performed in WebCenter Spaces, as shown in Table 46-1, and described in Chapter 41, "Working with the Documents Service Task Flows and Document Components."

This section provides steps to perform the following tasks using Microsoft Office shared document management:

	
Section 46.3.1, "Creating a Space from a Microsoft Office Document"


	
Section 46.3.2, "Opening and Editing a File"


	
Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane"


	
Section 46.3.4, "Working with the Microsoft Office Task Pane"

	
Section 46.3.4.1, "Adding a File"


	
Section 46.3.4.2, "Adding a New Folder"


	
Section 46.3.4.3, "Checking a File Out"


	
Section 46.3.4.4, "Checking a File In"


	
Section 46.3.4.5, "Managing the Currently Open File"


	
Section 46.3.4.6, "Managing Other Files in the Current Space"


	
Section 46.3.4.7, "Managing Folders"


	
Section 46.3.4.8, "Viewing Link Targets"


	
Section 46.3.4.9, "Viewing Document Information"


	
Section 46.3.4.10, "Working with File Version History"


	
Section 46.3.4.11, "Adding Members to a Space"


	
Section 46.3.4.12, "Sending a Message"





	
Section 46.3.5, "Closing a File"







	
Note:

Oracle WebCenter does not implement administrative features of the Microsoft Office shared document management functionality, such as creating a workspace using the task pane, deleting a workspace, or changing a workspace title.









46.3.1 Creating a Space from a Microsoft Office Document




	
Note:

This feature is available only in Microsoft Office 2007. It is not available in Microsoft Office 2003 or 2010.







With Microsoft Office 2007, you can create a Space from a Microsoft Office document, as long as your permissions on the document are the same as your permissions in WebCenter Spaces.

To create a Space from a Microsoft Office document:

	
If you are using Internet Explorer as a browser, add WebCenter to your list of trusted sites in the browser settings.


	
In the Microsoft Office document, click the Office Button (Figure 46-1) in the top left corner of the Microsoft Office application.


Figure 46-1 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]



	
From the Publish menu, choose Create Document Workspace (Figure 46-2).


Figure 46-2 Creating a Space from an Office Document

[image: Creating a Space from an Office Document]



	
The Microsoft Office application displays the Document Management task pane, displaying the file name as the default workspace name.




	
Note:

If the pane does not display, see Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane."








Figure 46-3 Document Management Task Pane: Document Workspace

[image: Document Management Task Pane: Document Workspace]



	
In the Document Workspace name field, type a name for the Space if you want to change the default name.


	
In the Location for new workspace field, type the Explorer URL for the WebCenter Spaces instance. For example:


http://myserver.oracle.com:8888/wcsdocs/conn/myserver-ucm11g/spaces
/WebCenter/


You can find this URL in the About Space dialog for an existing Space, as described in Section 49.5, "Viewing Information About a Space."


	
Click Create.


	
At the prompt, enter your WebCenter Spaces login credentials.




WebCenter Spaces creates the new Space in WebCenter Spaces.

In Microsoft Office, the Status section of the Microsoft Office task pane (see Table 46-2) displays one of the following status messages:


This document is up to date.  If you have unsaved changes, you must save the document before you can update the workspace copy.

A copy of this document is stored in a Document Workspace.  Changes made to your document have not been udpated in the workspace copy.


If you update the document in Microsoft Office, you can simply click the Update Workspace Copy link to synchronize the document with the version in the Space (on the server).






46.3.2 Opening and Editing a File

When you open a Microsoft Office file from WebCenter Spaces, the file is automatically checked out of the Oracle Content Server repository. When you refresh the page in WebCenter Spaces, the Status column for the file shows a Checked Out icon. To make your changes available to other users, you can save and close it in Microsoft Office, or explicitly check the file in using the Microsoft Office task pane.

To open a Microsoft Word, Excel, or PowerPoint file from WebCenter Spaces in-place in its Microsoft Office application:




	
Note:

If you are using Windows 7 or a 64-bit machine with Firefox 3.6, you may need to install the Java plugin available at http://support.mozilla.com to edit a Microsoft Office file. This plugin is included in Java 6 Update 15 and above.







	
On the Documents page, or in a Documents service task flow on a page, click in the row of the file you want to edit, but not on the file name.

Alternatively, you can edit an open file in the Document Viewer preview pane.


	
Depending on your view and the file type, perform one of the following actions:

	
On the Documents page or in a Documents service task flow, from the File menu or the context (right-click) menu, choose the Edit action that opens the file in-place in its Microsoft Office application. For example, for Microsoft Word files, choose Edit with Word (Figure 46-4)


Figure 46-4 Open a File in Microsoft Word

[image: Open a Document in Microsoft Word]



	
In the Document Viewer preview pane, click the Edit action.







	
Note:

If the file is already checked out by another user, the File in Use dialog opens. See Section 46.3.2.1, "Opening a File Already Checked Out By Another User."








	
If prompted, enter the same credentials used to log in to WebCenter Spaces to open the file in-place in its corresponding application.




	
Note:

The user name and password must contain only ASCII characters. A user name or password containing multi-byte characters cannot be successfully authenticated.







	
In Microsoft Office 2003. The Microsoft Office application displays a Shared Workspace task pane by default (Figure 46-5).


	
In Microsoft Office 2007. The Microsoft Office application displays no task pane by default. To display the Document Management task pane, see Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane."





Figure 46-5 Microsoft Office 2003 Shared Workspace Task Pane

[image: Microsoft Office 2003 Shared Workspace Task Pane]



	
When the file opens, it is automatically checked out. In WebCenter Spaces, click the Refresh icon to show the Checked Out icon for the selected file (Figure 46-6).


Figure 46-6 Checked Out Icon in WebCenter Spaces

[image: Checked Out Icon in WebCenter Spaces]



	
Make required updates, then save and close the file.

The modified file is automatically checked back in.




You can use the Microsoft Office task pane to open other files in the Space directly from Microsoft Office, instead of from WebCenter Spaces. See Section 46.3.4.6, "Managing Other Files in the Current Space."



46.3.2.1 Opening a File Already Checked Out By Another User

If the file that you attempt to open is already checked out by another user, the File In Use dialog opens (Figure 46-7).


Figure 46-7 File in Use Dialog

[image: File in Use Dialog]



In the File In Use dialog, select the desired option:

	
Open a Read Only copy to open the file in its default application to view it.


	
Create a local copy and merge your changes later is not supported.


	
Receive notification when the original copy is available to open a read-only copy of the file until it is available for editing. When the file is available, the File Now Available dialog (Figure 46-8) notifies you; in the dialog, click Read-Write to change the read-only state to editable.


Figure 46-8 File Now Available Dialog

[image: File Now Available Dialog]












46.3.3 Displaying and Hiding the Microsoft Office Task Pane




	
Note:

The Microsoft Office task pane is available only in Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







In Microsoft Office 2003, the task pane displays by default when you open a file, whereas in Microsoft Office 2007, the task pane does not display by default.

You can manage the display of the Microsoft Office task pane as described in the following sections:

	
Section 46.3.3.1, "Displaying or Hiding the Task Pane Manually"


	
Section 46.3.3.2, "Displaying or Hiding the Task Pane By Default"






46.3.3.1 Displaying or Hiding the Task Pane Manually

To display or hide the Microsoft Office task pane manually:

In Microsoft Office 2003:

	
From the Tools menu, choose Shared Workspace to toggle between displaying and hiding the task pane.




In Microsoft Office 2007:

	
Click the Office Button (Figure 46-9) in the top left corner of the Microsoft Office application.


Figure 46-9 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]



	
From the Server menu, choose Document Management Information to toggle between displaying and hiding the Document Management task pane (Figure 46-10).


Figure 46-10 Microsoft Office 2007 Document Management Task Pane

[image: MS Office 2007 Document Management Task Pane]










46.3.3.2 Displaying or Hiding the Task Pane By Default

To display or hide the Microsoft Office task pane automatically by default every time you open a Microsoft Word, Excel, or PowerPoint file:

In Microsoft Office 2003:

	
From the Tools menu, choose Options.


	
In the Options dialog, on the General tab, click Service Options.


	
In the Shared Workspace category, select or clear the checkbox The document is part of a workspace or SharePoint site to respectively display or hide the task pane by default.




In Microsoft Office 2007:

	
At the bottom of the Microsoft Office task pane, click Options (Figure 46-11).


Figure 46-11 Options Link in Task Pane (Microsoft Office 2007)

[image: Options Link in Task Pane]



	
In the Service Options dialog, select or clear the checkbox The document is part of a workspace or SharePoint site to respectively display or hide the task pane by default.











46.3.4 Working with the Microsoft Office Task Pane




	
Note:

The Microsoft Office task pane is available only in Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







The Microsoft Office task pane provides information pertaining to the currently open file and access to tasks for all folders and files in the current Space, as described in Table 46-2.


Table 46-2 Microsoft Office Task Pane for Files in a Space

	Task Pane Area	Description
	
Top section in Microsoft Office 2003:

[image: Task pane top section 2003]
Top section in Microsoft Office 2007:

[image: Task pane top section 2007]
Dropdown menu:

[image: Task pane top section dropdown menu]	
For a file in the Home Space:

	
Shows the user name.


	
Open site in browser. Click to display the WebCenter Spaces Home page.




For a file in a Space:

	
Shows the Space name.


	
Open site in browser. Click to display the Space Home page.




Additionally, the top section provides a dropdown menu of actions available for the user or Space:

	
Open Site in Browser. See above.


	
Change Site Title. Not supported.


	
Change Site Settings. For the Home Space, displays the WebCenter Spaces Home page; for a Space, displays the Settings tab of the Space.


	
Disconnect from Workspace. Not supported.


	
Delete Workspace. Not supported.





	
Status section in Microsoft Office 2003:

[image: Task pane Status section 2003]
Status section in Microsoft Office 2007:

[image: Task pane Status section 2007]
Dropdown menu:

[image: Task pane Status section menu]	
Displays information only if the file is checked out.

Shows the following information:

	
The user who checked out the file.


	
Check in link. See Section 46.3.4.4, "Checking a File In."

After checking a file in, you can subsequently check the file out again. See Section 46.3.4.3, "Checking a File Out."




Additionally, the Status section provides a dropdown menu of actions available for the user:

	
Schedule a Meeting. Opens the Microsoft Outlook calendar scheduler.


	
Call. Not supported.


	
Send Mail. Opens a Microsoft Outlook message with the To field populated with the mail address that is specified for the user in WebCenter Spaces. See Section 46.3.4.12, "Sending a Message." This selection has the same effect as clicking the user name in the Members section.


	
Additional Actions. Not supported.


	
Add to Outlook Contacts. Opens the Microsoft Outlook Contacts page populated with contact information for the user.


	
Outlook Properties. Opens the Microsoft Outlook E-mail Properties dialog.





	
Members section:

[image: Task Pane Members section]
Dropdown menu:

[image: Task pane Members section menu]	
For a file in the Home Space:

	
Lists the current people connections.


	
Add new members. Not supported for Home Space.


	
Send e-mail to all members. See Section 46.3.4.12, "Sending a Message."




For a file in a Space:

	
Lists the user editing the file, followed by the user and group names of all Space members, up to the limit of 99 members. The distinction between Online and Not Online users is not supported; all Space members show in the list as Not Online.


	
Add new members. See Section 46.3.4.11, "Adding Members to a Space."


	
Send e-mail to all members. See Section 46.3.4.12, "Sending a Message."




Additionally, the Members section provides a dropdown menu of actions available for the listed member(s). The actions in this menu are not supported.

To send a message to any member, simply click the member's user name to open a Microsoft Outlook window with the To field populated with the mail address that is specified for the member in WebCenter Spaces.


	
Tasks section:

[image: Task pane Tasks section]	
Not supported.


	
Documents section:

[image: Task pane Documents section]	
Provides access to other files in the current Space directly from Microsoft Office.

Sort by. Choose from the menu to sort the list of documents by Creation Date, Modified Date, File Name, File Type, Ascending, or Descending.

	
Shows all folders and files in the folder where the open file resides. See Section 46.3.4.6, "Managing Other Files in the Current Space."

Note: Navigating upward in the folder hierarchy from the current document is not supported; you can drill down and then back up to the current level.


	
Provides a menu of actions available on the currently open file. See Section 46.3.4.5, "Managing the Currently Open File."


	
Provides a menu of actions available on other documents in the list. See Section 46.3.4.6, "Managing Other Files in the Current Space."


	
Provides a menu of actions for each folder listed. See Section 46.3.4.7, "Managing Folders."


	
Add new document. See Section 46.3.4.1, "Adding a File."


	
Add new folder. See Section 46.3.4.2, "Adding a New Folder."


	
Alert me about documents. Not supported. Opens the Home page in WebCenter Spaces.





	
Links section:

[image: Task pane Links section]	
The Links section shows all document and URL links defined in WebCenter Spaces to the currently open file.

Sort by. Choose from the menu to sort the list of links by Creation Date, Modified Date, URL, Ascending, or Descending.

	
Lists all links for the currently open file. See Section 46.3.4.8, "Viewing Link Targets." Click a link to navigate to the linked object.





	
Document Information section (Microsoft Office 2003 only):

[image: Task pane Document Info section]	
Provides information about the currently open document:

	
Document Information. See Section 46.3.4.9, "Viewing Document Information."


	
Restrict permission. Not supported.


	
Alert me about this document. Not supported. Opens the Home page in WebCenter Spaces.


	
Check out or Check in. See Section 46.3.4.3, "Checking a File Out" and Section 46.3.4.4, "Checking a File In."


	
Version history. See Section 46.3.4.10, "Working with File Version History."





	
Bottom section:

[image: Task pane bottom section]	
Includes:

	
Get Updates. Refreshes the files and associated information from the WebCenter Spaces server.


	
Options. Opens the Service Options dialog. Refer to the Microsoft Office online help for more information.


	
Shows the date and time that the file was last modified.











The following sections describe the tasks you can perform using the Microsoft Office task pane:

	
Section 46.3.4.1, "Adding a File"


	
Section 46.3.4.2, "Adding a New Folder"


	
Section 46.3.4.3, "Checking a File Out"


	
Section 46.3.4.4, "Checking a File In"


	
Section 46.3.4.5, "Managing the Currently Open File"


	
Section 46.3.4.6, "Managing Other Files in the Current Space"


	
Section 46.3.4.7, "Managing Folders"


	
Section 46.3.4.8, "Viewing Link Targets"


	
Section 46.3.4.9, "Viewing Document Information"


	
Section 46.3.4.10, "Working with File Version History"


	
Section 46.3.4.11, "Adding Members to a Space"


	
Section 46.3.4.12, "Sending a Message"






46.3.4.1 Adding a File

Using the Microsoft Office shared document management functionality, you can add a new file to the Oracle Content Server repository, exposing the file in a Space, as described in the following sections:

	
Section 46.3.4.1.1, "Saving a File As a New File in a Space" (Microsoft Word, Excel, or PowerPoint file only)


	
Section 46.3.4.1.2, "Adding a New File Using the Task Pane" (files of any type)







	
Note:

Other methods to add a file to the connected content repository are:
	
Create a network place to a Space, then use Windows Explorer to add files of any type when the backend content repository is Oracle Content Server, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
In WebCenter Spaces, copy and paste, upload, or create a file using the Rich Text Editor (RTE), as described in Section 41.14, "Copying and Pasting Folders and Files," Section 41.8.1, "Uploading New Files," and Section 41.12, "Editing and Updating a File."














46.3.4.1.1 Saving a File As a New File in a Space

To save a local Microsoft Word, Excel, or PowerPoint file to a Space:




	
Note:

This feature is supported in Microsoft Office 2003 and 2007 only.







	
Add the Space as a new network place in Windows Explorer, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Open the file in its Microsoft Office application.


	
(In Microsoft Office 2007 only) Set save options for shared documents:

	
Click the Office Button in the top left corner of the Microsoft Office application, then click Word Options (Figure 46-12) at the bottom of the menu.


Figure 46-12 Office Button Menu: Word Options

[image: Office Button Menu: Word Options]



	
In the Word Options dialog, select Save in the left pane (Figure 46-13).


	
Under Offline editing options for document management server files, select The web server (Figure 46-13).


Figure 46-13 Word Options Dialog

[image: Word Options Dialog]






	
Publish the file to the Space:

In Microsoft Office 2003. From the File menu, choose Save As.

In Microsoft Office 2007. Click the Office Button, then choose either:

	
Publish, then Document Management Server.


	
Or, Save As, then Application Document.





	
In the Save As dialog, select the Space network place, then click Save. For more information about Space network place URLs, see Section 46.4.1, "Adding a Space as a Network Place."


	
Enter login credentials for WebCenter Spaces, then click OK.


	
In WebCenter Spaces, on the Documents page of the Space, click the Refresh icon to confirm that the file was added.




	
Note:

To make the file visible to others, you must check the file in. See Section 46.3.4.4, "Checking a File In."








	
To display the Microsoft Office task pane in the open file, see Section 46.3.3, "Displaying and Hiding the Microsoft Office Task Pane."









46.3.4.1.2 Adding a New File Using the Task Pane

To add a new file to a Space using the Microsoft Office task pane:




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







	
Open a Microsoft Word, Excel, or PowerPoint file to use the Microsoft Office shared document management functionality (see Section 46.3.2, "Opening and Editing a File").


	
At the bottom of the Documents section of the task pane, click Add new document (Figure 46-14).


Figure 46-14 Task Pane Documents Section: Adding a New File

[image: Task Pane Documents Section: Bottom Area]



The Add New Document dialog opens (Figure 46-15).


Figure 46-15 Add New Document Dialog

[image: Add New Document dialog]



	
Browse to the file that you want to add to the current Space.




	
Note:

WebCenter Spaces supports files up to 2GB in size.







The checkbox Make workspace updates available when I open my copy is not supported.


	
Click OK.

The new file displays at the top of the document list in the Documents section of the Microsoft Office task pane. When you refresh the Documents page of the Space in WebCenter Spaces, the file appears in the document list in alphabetical order.











46.3.4.2 Adding a New Folder

Using the Microsoft Office shared document management functionality, you can add a new folder to the Oracle Content Server repository, exposing the folder in a Space.




	
Note:

Other methods to add a new folder to a Space are:
	
Create a network place to a Space, then use Windows Explorer to add a folder, as described in Section 46.4, "Working with Microsoft Windows Explorer Integration."


	
Use the WebCenter Spaces application to add a folder to any connected content repository, as described in Section 41.7, "Creating a Folder."












To add a new folder to a Space using the Microsoft Office task pane:

	
Open a Microsoft Word, Excel, or PowerPoint file in the Space to use the Microsoft Office shared document management functionality (see Section 46.3.2, "Opening and Editing a File").


	
At the bottom of the Documents section of the task pane, click Add new folder (Figure 46-16).


Figure 46-16 Task Pane Documents Section: Adding a New Folder

[image: Task Pane Documents Section: Adding a New Folder]



The Add New Folder dialog opens (Figure 46-17).


Figure 46-17 Add New Folder Dialog

[image: Add New Document Dialog]



	
Enter a name for the new folder, then click OK.




	
Note:

The rules for folder names follow the Windows Explorer standards.







The new folder displays at the top of the document list in the Documents section of the Microsoft Office task pane. When you refresh the Documents page of the Space in WebCenter Spaces, the folder appears in the folder list in alphabetical order.









46.3.4.3 Checking a File Out




	
Note:

To check any file out using the WebCenter Spaces application, see Section 41.12.1, "Checking a File Out."







When you open a Microsoft Office file in a Space using the Microsoft Office shared document management functionality, the file is automatically checked out from the Oracle Content Server repository. If you have been granted the appropriate permissions, you can open and check a file out in two environments:

	
From WebCenter Spaces. Open a file in-place (see Section 46.3.2, "Opening and Editing a File") to automatically check out the file.


	
(Microsoft Office 2003 and 2007) From the Microsoft Office task pane. In the Documents section of the task pane, click a file name to automatically check out the file and open it in its default Microsoft Office application.






46.3.4.3.1 Checking the Currently Open File Out Again After Checking It In

After you check a file in (see Section 46.3.4.4, "Checking a File In"), the file remains displayed in Microsoft Office until you close it (see Section 46.3.5, "Closing a File"). If you want to check in further changes to the file, it must be checked out again:

	
In Microsoft Office 2003. In the Document Information section of the Microsoft Office task pane, you can optionally click Check out to check the file out again (Figure 46-18). However, even if you do not explicitly check out the file, you can continue to edit the file, then save it, and the Status and Document Information sections of the task pane automatically provide a Check in link to check the changed file back in to the repository.


Figure 46-18 Checking Out a Checked In File

[image: Checking Out a Checked In File]



	
In Microsoft Office 2007 and 2010. When you check a file in, the Check In dialog (Figure 46-21) provides a checkbox labeled Keep the document checked out after checking in this version:

	
Select the checkbox to keep the file checked out after checking in the current version. This allows you to refresh the version of the file available to other users, yet still retain the checked out status to make further changes.


	
Clear the checkbox to check the file in and cancel the checked out status.




If you clear the checkbox, you can optionally check the file out again:

	
Click Edit Document in the area below the toolbar (Figure 46-19).

After you check a file in, Microsoft Office 2007 locks editing that file until you click Edit Document.


Figure 46-19 Checking Out and Editing the Current Document

[image: Checking Out and Editing the Current Doc]















46.3.4.4 Checking a File In

When you open a file using the Microsoft Office shared document management functionality, you can check it back in to the repository, whether or not you have made changes to it.




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.
In Microsoft Office 2010, you can find file checkin and checkout information on the Info tab (from the File menu, choose Info). When a file is opened in Microsoft Office 2010, it is automatically checked out, changes are (temporarily) applied when saved, and the file is automatically checked in when the file is closed, with a default checkin comment. There is no explicit Check in option in Microsoft Office 2010.












	
Note:

Intermittently saving the file saves it on the server, but changes are not visible to others until you check the file in. To update the file stored in the WebCenter Spaces repository, you must either save and close it, or explicitly check it in. If you close the Microsoft Office application and do not check the file in when prompted, your changes are lost.







To check a file in:

	
In the Status section of the Microsoft Office task pane, click Check in.




	
Note:

In Microsoft Office 2003, you can also find Check in in the Document Information section of the task pane.








	
In Microsoft Office 2003. In the Check In Comments dialog (Figure 46-20), optionally enter comments about the changes made to the file since it was last checked out.


Figure 46-20 Check In Comments Dialog (Microsoft Office 2003)

[image: Check In Comments Dialog (Office 2003)]



In Microsoft Office 2007. In the Check In dialog (Figure 46-21), optionally enter comments about the changes made to the file since it was last checked out, and select the state in which to leave the file:


Figure 46-21 Check In Dialog (Microsoft Office 2007 and 2010)

[image: Check In Comments Dialog (Office 2007)]



	
Select the checkbox to keep the file checked out after checking in the current version. This allows you to refresh the version of the file available to other users, yet still retain the checked out status to make further changes.


	
Clear the checkbox to check the file in and cancel the checked out status. To check the file out again, see Section 46.3.4.3.1, "Checking the Currently Open File Out Again After Checking It In."





	
Click OK.

If the file was modified since its prior version, it is automatically saved and checked in to WebCenter Spaces as a new version. If check in comments were entered in the Check In dialog, a new file revision is created with the new comments, which display as the file description in WebCenter Spaces (Figure 46-22).


Figure 46-22 Documents Listing in WebCenter Spaces after Check In

[image: Documents Listing in WebCenter Spaces after Check In]



	
After checking a file in, the file remains displayed in Microsoft Office until you close it (see Section 46.3.5, "Closing a File"). If you wish to make further changes to the file, see Section 46.3.4.3.1, "Checking the Currently Open File Out Again After Checking It In.":


	
When you have finished making changes and checking in the file, close the Microsoft Office application (see Section 46.3.5, "Closing a File").









46.3.4.5 Managing the Currently Open File




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To manage the currently open file using the Microsoft Office task pane:

	
In the Documents section of the task pane, click the dropdown menu icon to the right of the file name (Figure 46-23).


Figure 46-23 Task Pane Documents Section: Current File Menu

[image: Task Pane Documents Section: Current File Menu]



	
Select an available action, as described in Table 46-3:


Table 46-3 Dropdown Menu Actions for Currently Open File

	Menu Action	Description
	
Open in Microsoft Office Application

	
Not applicable.


	
Delete

	
Not supported. To delete a file in a Space, you must use the WebCenter Spaces application (see Section 41.16, "Deleting Folders and Files") or Windows Explorer (see Section 46.4, "Working with Microsoft Windows Explorer Integration").


	
Alert Me About This Document

	
Not supported. Opens the home page of the Space in WebCenter Spaces.


	
Check Status

	
Displays the Status section of the task pane.


	
Document Updates

	
Not supported.


	
Save Updatable Copy

	
Not supported.


	
Create Document Workspace

	
Not supported.


	
Publish Back to Source Location

	
Not supported.















46.3.4.6 Managing Other Files in the Current Space




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To manage a file other than the currently open file in the current Space using the Microsoft Office task pane:

	
In the Documents section of the task pane, navigate to the file.




	
Note:

Navigating upward in the folder hierarchy from the current document is not supported; you can drill down and then back up to the current level.








	
To open the file, click its name.

Depending on the file type, the file opens as described in Section 46.3.2, "Opening and Editing a File" for Microsoft Word, Excel, and PowerPoint files, or Section 41.10, "Opening a File" for other file types (such as HTML files or images).




	
Note:

If you have OpenOffice installed, an error may occur when attempting to open a file from the task pane. To resolve the error, uninstall OpenOffice.








	
To perform other actions, click the dropdown menu icon to the right of a file name (Figure 46-24):


Figure 46-24 Task Pane Documents Section: Other Files Menu

[image: Task Pane Documents Section: Other Fles Menu]



	
Select an available action, as described in Table 46-4:


Table 46-4 Dropdown Menu Actions for Other Files

	Menu Action	Description
	
Open in Microsoft Office Application

	
Attempts to check out the file: if checked out by another user, it opens read-only; if not checked out, the file opens in its Microsoft Office application for editing. For more information, see Section 46.3.2, "Opening and Editing a File."


	
Delete

	
Not supported. To delete a file in a Space, you must use the WebCenter Spaces application (see Section 41.16, "Deleting Folders and Files") or Windows Explorer (see Section 46.4, "Working with Microsoft Windows Explorer Integration").


	
Alert Me About This Document

	
Not supported. Opens the home page of the Space in WebCenter Spaces.















46.3.4.7 Managing Folders




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To manage a folder under the current folder using the Microsoft Office task pane:

	
In the Documents section of the task pane, navigate to the folder.




	
Note:

Navigating upward in the folder hierarchy from the current document is not supported; you can drill down and then back up to the current level.








	
To open the folder, click its name.


	
To perform other actions, click the dropdown menu icon to the right of the folder name (Figure 46-25):


Figure 46-25 Task Pane Documents Section: Folder Menu

[image: Task Pane Documents Section: Folder Menu]



	
Select an available action, as described in Table 46-5:


Table 46-5 Dropdown Menu Actions for a Folder

	Menu Action	Description
	
View Contents

	
Refreshes the list of files with the contents of the folder only (same effect as clicking the folder name). Click the folder name to refresh to the original list.


	
Delete

	
Not supported. To delete a folder in a Space, you must use the WebCenter Spaces application (see Section 41.16, "Deleting Folders and Files") or Windows Explorer (see Section 46.4, "Working with Microsoft Windows Explorer Integration").















46.3.4.8 Viewing Link Targets




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







The Links section of the Microsoft Office task pane lists the links defined in WebCenter Spaces that are associated with the currently open file (Figure 46-26). Files can have links to related documents, discussions, announcements, events, and notes; the Links section in the task pane shows the links to associated documents and notes.

Links are prefixed with the name of the service with which they are associated. For example, a link to another document is prefixed Document, a link to a note is prefixed URL.


Figure 46-26 Task Pane Links Section

[image: Task Pane Links Section]



To display the target of a link, simply click the link:

	
Document links open in the same way as files in the Document section, namely Microsoft Word, Excel, and PowerPoint files open in Microsoft Office with a task pane, and other file types open in their default viewer or a browser.


	
URL links open a browser window displaying the link target.









46.3.4.9 Viewing Document Information




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







In Microsoft Office 2003: The Document Information section of the Microsoft Office task pane shows the user who last modified the file and the modified date (Figure 46-27).


Figure 46-27 Task Pane Document Information Section (Microsoft Office 2003 Only)

[image: Task Pane Document Information Section]



In Microsoft Office 2007. Information about the user who last modified the file and the modified date is shown in the Version History. See Section 46.3.4.10, "Working with File Version History."






46.3.4.10 Working with File Version History

Whenever you check in a file or upload a file into a folder that already contains a file of the same name, WebCenter Spaces creates a new version of the file. When a file has multiple versions, it has a version history.




	
Note:

To use the WebCenter Spaces application to work with the version history of a file in any connected content repository, see Section 41.21, "Viewing and Deleting File Version History."







In Microsoft Office 2003: To view the version history of the currently open file using the Microsoft Office task pane:

	
In the Document Information section of the task pane, click Version history (Figure 46-28).


Figure 46-28 Task Pane Document Information Section: Version History

[image: Task Pane Document Information Section: Version History]



The version history dialog for the file opens (Figure 46-29):


Figure 46-29 Version History for Currently Open File in Microsoft Office 2003

[image: Version History for Currently Open File]



In the version history dialog, select a file version, then select the desired action:

	
Open to open the selected file version read-only.


	
Restore is not supported.


	
Delete to delete the selected file version (inactive for the most recent version).


	
View Comments to display the comments entered for the selected file version (most useful when the comments are especially long).





	
To open the Documents page in the current Space, click Modify settings for document versions.




In Microsoft Office 2007: To view the version history of the currently open file:

	
Click the Office Button (Figure 46-30) in the top left corner of the Microsoft Office application.


Figure 46-30 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]



	
From the Server menu, choose View Version History.

The version history dialog for the file opens (Figure 46-31):


Figure 46-31 Version History for Currently Open File in Microsoft Office 2007

[image: Version History for Current File in Office 2007]



	
In the version history dialog, select a file version, then select the desired action:

	
Open to open the selected file version read-only.


	
Compare to compare the selected file version with the currently open file.


	
Restore is not supported.


	
Delete to delete the selected file version (inactive for the most recent version).





	
To view the check in comments for a file version, click the link under Comments.


	
To open the Documents page in the Space, click the link next to Versions saved to.




In Microsoft Office 2010: To view the version history of the currently open file:

	
From the File menu, choose Info.

The Info tab shows version history information on the Info tab in the Versions section. Refer to the Microsoft Office online help for more information.









46.3.4.11 Adding Members to a Space




	
Note:

To add members to a Space using the WebCenter Spaces application, see Section 52.3, "Managing Members and Assigning Roles."







If you are granted the moderator role or Manage All permissions in a Space, you can add new members to a Space using the Microsoft Office task pane. The currently open file must be a Space document.




	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.







To add members to a Space when the currently open file is a Space document:

	
In the Members section of the task pane, click Add new members.

The Add New Members dialog opens (Figure 46-32).


Figure 46-32 Add New Members Dialog

[image: Add New Members dialog]



	
Enter the login names or mail addresses of the users you want to add to the Space, separated by semicolons.




	
Note:

Users who are already members of the Space cannot be added again. The user names that you enter must have an associated mail address defined in WebCenter Spaces.








	
From the site group dropdown list, select the role to be given to the listed users. The listed roles are those defined for the current Space. The permissions granted to each role are defined by the WebCenter Spaces administrator or Space moderator. For more information about Space roles, see Section 52.2, "Managing Roles and Permissions for a Space."




	
Note:

To define different roles to different users, limit the list of users to those who should be assigned the same role, finish this assignment, then click Add new members again to assign a different role to one or more different users.








	
Click Next.


	
Confirm or modify the member information, then click Finish.


	
In the Add New Members dialog (Figure 46-33), select or clear the checkbox to send an invitation to the new members to join the Space, then click OK.


Figure 46-33 Add New Members Dialog

[image: Add New Members Dialog]










46.3.4.12 Sending a Message

From the Microsoft Office task pane, you can send a message to any user who has a mail address defined in WebCenter Spaces:

	
Section 46.3.4.12.1, "Sending a Message to the Current User"


	
Section 46.3.4.12.2, "Sending a Message to Your Connections"


	
Section 46.3.4.12.3, "Sending a Message to Members of a Space"







	
Note:

This feature is available with Microsoft Office 2003 and 2007. Microsoft Office 2010 does not include a task pane.










	
Note:

To send messages using the WebCenter Spaces application, see Section 51.15, "Sending Mail to Space Members or Moderators", Section 65.1, "What You Should Know About the Send Mail Feature", and Section 65.4.6, "Composing and Sending Mail Messages."









46.3.4.12.1 Sending a Message to the Current User

To send a message to the user who has the currently open document checked out:

	
In the Status section of the Microsoft Office task pane, click the dropdown menu icon next to the user name, and choose Send Mail (Figure 46-34).


Figure 46-34 Send a Message to the Current Document User

[image: Send a Message to the Current User]



A Microsoft Outlook message composition window opens with the To field populated with the mail address that is specified for the user in WebCenter Spaces.









46.3.4.12.2 Sending a Message to Your Connections

To send a message to your connections when you are working with a document in the Home Space:

	
In the Members section of the Microsoft Office task pane:

	
To send a message to an individual who is one of your connections, click the user name in the Members list (Figure 46-35):


Figure 46-35 Send a Message to a Connection

[image: Send Mail to Individual Connection]



	
To send a message to all of your connections, click Send e-mail to all members (Figure 46-36).


Figure 46-36 Send a Message to All Connections

[image: Send a Message to All Connections]





A Microsoft Outlook message composition window opens, where the Home Space name is the subject, and the To field is populated with the mail address(es) specified for the people connection(s) in WebCenter Spaces.


	
Modify the addresses and content of the message as desired, then click Send.









46.3.4.12.3 Sending a Message to Members of a Space

To send a message to the members of a Space when you are working with a document in a Space:

	
In the Members section of the Microsoft Office task pane:

	
To send a message to an individual who is a member of the Space, click the user name in the Members list (Figure 46-37):


Figure 46-37 Send a Message to an Individual Space Member

[image: Send Mail to Individual in People Connections]



	
To send a message to all members of the Space, click Send e-mail to all members.


Figure 46-38 Send a Message to All Space Members

[image: Send a Message to All Group Space Members]





A Microsoft Outlook message composition window opens, where the Space name is the subject, and To field is populated with the mail address(es) specified for the Space member(s) in WebCenter Spaces


	
Modify the addresses and content of the message as desired, then click Send.













46.3.5 Closing a File

You can close a file opened in a Microsoft Office application with or without checking it in, as described in the following sections:

	
Section 46.3.5.1, "Closing a File After Checking It In"


	
Section 46.3.5.2, "Closing a File Before Checking It In"






46.3.5.1 Closing a File After Checking It In

After checking a file in, the file remains open in the Microsoft Office application until you close it.

To close a file after you have checked it in (see Section 46.3.4.4, "Checking a File In"):

	
From the File menu, choose Close.









46.3.5.2 Closing a File Before Checking It In

If you attempt to close a file or the Microsoft Office application before you have checked the file in, the Check In dialog provides the opportunity to check it in or cancel the check out and discard changes to the file. The selections in the Check In dialog are dependent on whether or not the file has been modified since the last time it was checked in.



46.3.5.2.1 Closing an Unchanged File

In Microsoft Office 2003: To close a file that has not been modified since the last time it was checked in:

	
From the File menu, choose Close.


	
In the Check In dialog (Figure 46-39), select one of the following actions:


Figure 46-39 Check In Dialog for File with No Changes (Microsoft Office 2003)

[image: Check In Dialog for File with No Changes]



	
Check in file to check the file in with no changes. In the Check In Comments dialog (Figure 46-20), optionally enter new comments, then click OK.


	
Keep checked out to close the file, but keep it in a checked out and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out."


	
Discard changes and undo check out to cancel the checked out status.





	
Click OK.




In Microsoft Office 2007: To close a file that has not been modified since the last time it was checked in:

	
Click the Office Button (Figure 46-40) in the top left corner of the Microsoft Office application, then choose Close.


Figure 46-40 Office Button in Microsoft Office

[image: Office Button in Microsoft Office]





Microsoft Office 2007 does not prompt you to first check the file back in again, so the file remains in a checked out state and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out."






46.3.5.2.2 Closing an Updated File

In Microsoft Office 2003: To close a file that has been modified since the last time it was checked in:

	
From the File menu, choose Close.


	
In the Check In dialog (Figure 46-41), select one of the following actions:


Figure 46-41 Check In Dialog for File with Changes (Microsoft Office 003)

[image: Check In Dialog for File with Changes]



	
Save changes and check in to save the changes since the last check in and check the file in.


	
Save changes only to save changes since the last check in, but keep the file checked out and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out."


	
Discard changes and undo check out to retain the prior saved version of the file and cancel the checked out status.


	
Discard changes only to retain the prior saved version of the file and keep the file checked out.





	
Click OK.




In Microsoft Office 2007: To close a file that has been modified since the last time it was checked in:

	
Click the Office Button (Figure 46-42) in the top left corner of the Microsoft Office application, then choose Close.


Figure 46-42 Office Button in Microsoft Office
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If you have not already saved the changes, respond to the confirmation prompt to save or discard your changes.


	
In the confirmation dialog (Figure 46-43), respond to the prompt:


Figure 46-43 Close File Confirmation Prompt (Microsoft Office 2007)

[image: Close File Confirmation in Office 2007]



	
Yes to display the Check In dialog where you can enter version comments and select whether or not you want the file to remain checkout out (see Section 46.3.4.4, "Checking a File In"). If you choose to keep the file checked out and locked to changes by other users, see Section 41.12.1, "Checking a File Out" to later cancel the checked out status.


	
No to keep the file checked out and locked to changes by other users. To later cancel the checked out status, see Section 41.12.1, "Checking a File Out." 


















46.4 Working with Microsoft Windows Explorer Integration

WebCenter Spaces integrates with Microsoft Windows Explorer to manage the folders and files in the Home Space or a group Space when the backend content repository is Oracle Content Server.

In WebCenter Spaces, the most useful feature of Windows Explorer integration is the ability to add multiple files at once to a Space, rather than uploading up to 10 files at a time (see Section 41.8.1, "Uploading New Files"). It is important to be aware that Windows Explorer is not designed as a content repository, so if you try to open, delete, or rename a file that is checked out by another user, an error message displays to notify you that the operation failed, but the error message will not be specific as to the cause of the failure.

To expose the folders and files in a Space in Windows Explorer, you create a new Windows network place to work with the files, as described in the following sections:

	
Section 46.4.1, "Adding a Space as a Network Place"


	
Section 46.4.2, "Working with Files Using Windows Explorer"






46.4.1 Adding a Space as a Network Place

To expose the folders and files in a Space using Windows Explorer, you can add the Space as a Windows network place.

To add a Space as a Windows network place:

	
In Microsoft Windows, open My Network Places and click Add Network Place. Refer to the Microsoft Windows online help for more information.


	
In the Add Network Place wizard, enter the network address using the following format:

	
To access all Spaces in your WebCenter Spaces application through Windows Explorer:

http://hostname:port/wcsdocs/conn/repository_server/spaces/

For example:

http://myserver:8888/wcsdocs/conn/myserver-ucm/spaces/


	
To access the Home Space through Windows Explorer:

http://hostname:port/wcsdocs/conn/repository_server/spaces/PersonalSpaces/username

For example:

http://myserver:8888/wcsdocs/conn/myserver-ucm/spaces/PersonalSpaces/wcsadmin


	
To access a specific Space through Windows Explorer, open the About Space dialog, and copy the Explorer URL. See Section 49.5, "Viewing Information About a Space."

http://hostname:port/wcsdocs/conn/repository_server/spaces/instance/spacename

For example:

http://myserver:8888/wcsdocs/conn/myserver-ucm/spaces/WebCenter/philatelists







	
Tip:

The host name and port is shown in the browser URL for your WebCenter Spaces application.
To find the name of the repository server, view the information for any Space in the WebCenter Spaces application, and note the name of the content repository specified by the Explorer URL. See Section 49.5, "Viewing Information About a Space."










	
At the prompt, enter your WebCenter Spaces login credentials.


	
Optionally enter a name for the Space network place, then click Finish.

Windows Explorer displays a drive for all Spaces or the folders and files of Space, depending on the URL you entered.









46.4.2 Working with Files Using Windows Explorer

Once you have created a Windows network place to a Space (see Section 46.4.1, "Adding a Space as a Network Place"), you can manage the folders and files using Windows Explorer.




	
Note:

If you change the internal name of a Space (see Section 51.14.2, "Changing a Space URL"), the original network place to that individual Space is no longer accessible. You will need to add the Space as a Windows network place again using the new Space internal name. Changing the internal name of a Space has no effect if you create a network place to the parent URL for all Spaces (http://hostname:port/wcsdocs/conn/repository_server/spaces/).







In Windows Explorer, navigate to the network place for the Space to perform any of the following actions:

	
Copy and paste folders and files from your local file system.


	
Create folders and files.


	
Delete folders and files if not checked out by another user.


	
Open Microsoft Word, Excel, and PowerPoint files using the Microsoft Office shared document functionality. See Section 46.3, "Working with Microsoft Word, PowerPoint, and Excel Integration."


	
Open other file types in their default applications.




When you open a file, an attempt is made to check the file out. If it is checked out by another user, or you do not have permissions to update the file, it will open read-only. A file remains checked out until you check it back in (see Section 46.3.4.4, "Checking a File In").

The changes you make in Windows Explorer are reflected in WebCenter Spaces, and vice versa.




	
Note:

To use the WebCenter Spaces application to manage folders and files in a Space in any connected content repository, see Chapter 41, "Working with the Documents Service Task Flows and Document Components."
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65 Working with the Mail Service

This chapter describes how to use the Send Mail feature and also the features provided through the Mail service. The Send Mail feature does not require the Mail service. That is, even if the Mail service has not been configured in your application, you can use the Send Mail feature with your local mail client. 

This chapter includes the following sections:

	
Section 65.1, "What You Should Know About the Send Mail Feature"


	
Section 65.2, "What You Should Know About the Mail Service"


	
Section 65.3, "Selecting Your Preferred Mail Connection"


	
Section 65.4, "Working with the Mail Service Task Flow"


	
Section 65.5, "Setting Mail Service Task Flow Properties"





Audience

This chapter is intended for users who want to use and manage mail, as well as WebCenter Spaces administrators with the Application-Manage Configuration permission and individual Space moderators who want to configure mail within their Spaces. For more information, see Section 52.2.1.2, "Understanding Permissions and Permission Models in a Space."




	
Note:

Tasks discussed in this chapter are not available if the Mail service is not enabled in the current Space.









65.1 What You Should Know About the Send Mail Feature

Throughout the WebCenter application, you can click the Send Mail icon to mail directly from that resource (Figure 65-1).


Figure 65-1 Send Mail Icon

[image: Send Mail icon]



For example, Figure 65-2 shows a discussion topic with the Send Mail icon.


Figure 65-2 Send Mail Icon in a Discussion Topic

[image: Description of Figure 65-2 follows]






Click the Send Mail icon to open a mail compose window prepopulated with information including the discussion topic title, author, date created, topic text, and links to the discussion and the Space. You can edit and add to the mail, as necessary.


Figure 65-3 Mail Compose from a Discussion Topic

[image: Description of Figure 65-3 follows]






The way the mail window is prepopulated depends on the resource sending it. For example, from a wiki, Send Mail opens a mail window prepopulated with the name of the wiki, the size, who created it and when, who modified it and when, and a URL link to the wiki.

With Spaces, the mail can be addressed to all members of the Space. Space moderators (and anyone granted the Manage Configuration permission on the Space) set this through the Services page in the Space administration settings. For more information, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List."

If the number of recipients is so large that the mail cannot be prepopulated with the addresses, then you must either enter the addresses manually or set up a distribution list for the Space.




	
Tips:

With the Microsoft Outlook local mail client, you must configure Outlook to support comma-delimited mail addresses; that is, choose the Allow comma as address separator checkbox on the Tools - Options - Preferences - E-mail Options - Advanced E-mail Options page.









65.1.1 Configuring the Send Mail Feature

The Send Mail feature does not require the WebCenter Mail service. That is, even if the Mail service has not been configured in your application, the Send Mail feature is available using your local mail client.

Your administrator determines the mail client that the Send Mail feature uses: either the WebCenter Mail service or a local mail client. The default value is a local mail client. If your administrator enabled users to override this mail client setting, then you can choose to use a different mail client on the Mail Preferences page (Figure 65-4).


Figure 65-4 Mail Preferences for Send Mail

[image: Mail Preferences]









65.2 What You Should Know About the Mail Service

The Mail service conveniently exposes familiar mail functionality in your WebCenter application interface. The Mail service runs against the same mail server that provides your regular business mail, and the mail messages exposed in your WebCenter application are the same messages you would see in your mail inbox. Many of the same actions are also supported. For example, you can send messages with attachments, forward messages, and so on. The Mail service does not replace your company mail, but rather enhances it by making it accessible within WebCenter.

The Mail service enables users to perform simple mail functions, such as view, read, create and create with attachments, reply, forward, and delete. All mail is stored in your inbox and can be accessed from there through a link.

The Mail service fetches mails from the inbox folder only. It does not support fetching mails from other folders or moving messages.

The Mail service supports any mail server based on IMAP4 and SMTP protocol. A WebCenter Spaces application provides access to multiple mail connections. You can use a different mail connection by selecting it in the application's Preferences settings. For more information, see Section 65.3, "Selecting Your Preferred Mail Connection."




	
Note:

You can add a Mail task flow to your page from the Catalog dialog in Oracle Composer. For information about adding a task flow, see Section 17.5, "Adding Resource Catalog Components to Pages."
However, all instances of the Mail task flow in an application run against the same mail server and it serves no purpose to add multiple Mail task flow instances. This is true for all service task flows that require connections to back-end servers, for example, task flows from Discussions, Announcements, and IMP services.









The Mail service exposes features from your mail server through the Mail task flow, available to both WebCenter Portal applications and WebCenter Spaces (Figure 65-5).


Figure 65-5 The Mail Task Flow

[image: Mail task flow]






The Mail task flow presents the following features:

	
A menu for specifying which messages to display


	
A Compose icon for starting the process of creating a new message


	
A Refresh icon for updating the task flow with new messages




A Space moderator can configure the Mail service to automatically create a mailing list of all Space members. Once configured, as members are added to or deleted from the Space, the mailing list is updated automatically. For more information, see Section 51.10.2, "Configuring a Custom Space Mail Distribution List." All mails sent to a Space mailing list are also posted to the Space discussion forum.

Use the Mail service to mail other WebCenter application users or any user recognized by the back-end server that supports the Mail service.

The Mail service is integrated with the Instant Messaging and Presence (IMP) service to provide additional options for contacting others. Each mail message includes the sender's user name and status icon (Figure 65-6), which you can click to open a context menu with options for starting a chat session or sending a new mail.




	
Note:

If the IMP service is not configured in your application, the status icons are grayed out.








Figure 65-6 User Name and Status Icon

[image: User name and status icon]






For more information, see Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)."

Users with page-edit privileges can access the task flow's region parameter through the Component Properties dialog in Oracle Composer. For more information about setting the Mail service task flow properties, see Section 65.5, "Setting Mail Service Task Flow Properties."






65.3 Selecting Your Preferred Mail Connection

When your WebCenter Spaces application provides access to multiple mail connections, it also provides a way for you to choose which connection to use. This section describes how.

To choose your preferred mail connection:

	
Click the Preferences link at the top of the application.


	
Click Mail to open the Mail Preferences panel (Figure 65-7).


Figure 65-7 The Mail Preferences Panel

[image: Mail Preferences panel in Preferences dialog box]



	
From the Connection dropdown list, choose the mail connection you want to use for accessing your mail through WebCenter Spaces.

The options available on this list depend on the connections your system administrator makes available to your WebCenter Spaces application. The No Preference option uses your system-level active mail connection.


	
Under Default mail client for 'Send Mail' action, choose an option to identify the mail application to open when the SendMail command is invoked.

Choose from:

	
Local mail client—Choose to specify that the local mail client you normally use, such as Microsoft Outlook or Mozilla Thunderbird, should open a compose message window when the SendMail command is invoked.


	
WebCenter Mail Service—Choose to specify to open a WebCenter Mail service compose message window when the SendMail command is invoked.





	
Click OK to save your change and exit the Preferences dialog.


	
Log out of WebCenter Spaces.


	
Log in to WebCenter Spaces.


	
If you previously saved your credentials for this mail connection to the WebCenter Spaces credential store, you are logged in to the new mail connection automatically.

If you have not previously saved your credentials, log in to this mail connection using Preferences (see Section 35.7, "Providing Login Information for External Applications") or using the login link in a Mail task flow (see Section 65.4.2, "Logging in to Mail").









65.4 Working with the Mail Service Task Flow

The Mail task flow exposes your company's mail server features within the context of your application. Use the Mail task flow to view, respond to, and manage your personal mail.

This section provides information on how to use the Mail task flow. It contains the following subsections:

	
Section 65.4.1, "Adding the Mail Service Task Flow to a Page."


	
Section 65.4.2, "Logging in to Mail"


	
Section 65.4.3, "Personalizing Your View of the Mail Task Flow"


	
Section 65.4.4, "Opening Mail Messages"


	
Section 65.4.5, "Downloading Mail Attachments"


	
Section 65.4.6, "Composing and Sending Mail Messages"


	
Section 65.4.7, "Sending Mail with Attachments"


	
Section 65.4.8, "Removing Attachments from the Add Attachment Window"


	
Section 65.4.9, "Replying to and Forwarding Mail"


	
Section 65.4.10, "Refreshing Mail"


	
Section 65.4.11, "Deleting Mail"






65.4.1 Adding the Mail Service Task Flow to a Page

For the steps to add a Mail service task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."






65.4.2 Logging in to Mail

Before you can access your mail in a WebCenter application, you must provide your mail login credentials. The first time you access a Mail task flow, it displays the message depicted in Figure 65-8.


Figure 65-8 Login Message in a Mail Task Flow

[image: Login message in a Mail task flow]






To log in to a Mail task flow:

	
Go to a Mail task flow, and click the Login to Mail link (Figure 65-8) to open an External Application Login dialog (Figure 65-9).


Figure 65-9 External Application Login Dialog

[image: External Application Login dialog box]









	
Note:

The External Application Login dialog may include additional fields and information, depending on the requirements of the service that provides it. For more information about external applications and storing your login credentials in a WebCenter Spaces application, see Section 35.7, "Providing Login Information for External Applications."








	
Enter your user name and password and any other login credentials that your mail application requires.

Required fields are marked with an asterisk (*).


	
Optionally, choose Remember my login information to store your credentials.

The next time you log in to the application, your mail credentials are retrieved from storage and you are logged in.


	
Click OK, and the Mail task flow displays mails from your inbox.









65.4.3 Personalizing Your View of the Mail Task Flow

You can personalize your view of the Mail task flow by filtering the number of displayed messages. For example, you can choose to display only the messages that were delivered Today, Since Yesterday, This Week, or This Month. Additionally, you can choose to display All messages in your inbox.




	
Note:

By default, the Mail service displays the 50 most recent mail messages from your mail server inbox folder. However, if required, your Fusion Middleware administrator can configure this to a higher value, if your server supports the increase in memory cache that fetching additional mail requires. Care should be taken to have a value suitable to your environment. This value impacts all users. That is, if the Mail service is configured to read 200 recent mail messages, then the Mail service reads 200 recent mail messages for all users.







Personalizations affect only your view of the Mail task flow. No other user's view is changed because of your selection.

To personalize your view of the Mail task flow:

	
Go to the Mail task flow.


	
Open the menu at the top of the task flow (Figure 65-10).


Figure 65-10 The Mail Personalization Menu

[image: Mail personalization menu]






	
Choose a display option. Choose from:

	
All—to show all messages


	
Today—to show all messages received today


	
Since Yesterday—to show all messages received yesterday and today


	
This Week—to show all messages received in this calendar week


	
This Month—to show all messages received in this calendar month




The Mail task flow redraws, displaying only those messages that match your selection.









65.4.4 Opening Mail Messages

The messages that display in your Mail task flow are the same messages that display in your regular mail application inbox. You open them in much the same way, too.

To open a mail message:

	
Go to a Mail task flow, and click the link to the message you want to open (Figure 65-11).


	

Figure 65-11 A Mail Message Link

[image: Mail message link]






The message opens (Figure 65-12).


Figure 65-12 A Mail Message

[image: A Mail message]






	
After reading the message click Cancel to close the message (Figure 65-13).


Figure 65-13 Cancel a Mail Message

[image: Close button on a mail message]











	
Note:

HTML reports, tables, images that are inlined (copy paste), and fonts viewed in a mail message may not render correctly. The Mail service requires HTML data to be well-formed to display as expected in a mail message.
The mail should show everything that your browser supports. However, some tags, like <script>, are encoded and disabled from execution.














65.4.5 Downloading Mail Attachments

Attachments display in mail messages as links (Figure 65-14).


Figure 65-14 Mail Attachments

[image: Mail attachments]






Accessing files associated with attachments is the same as accessing a file from any browser window: simply click the link. Clicking an attachment link opens a download dialog that gives you the option of viewing the file in its native application or saving the file to a local drive. This is browser behavior, so the way you follow through depends on the browser you use.






65.4.6 Composing and Sending Mail Messages

Composing and sending messages through the Mail service in a WebCenter portal application is very much like doing so in your regular mail.

To compose and send a mail message:

	
In a Mail task flow, click the Compose icon (Figure 65-15).


	

Figure 65-15 The Compose Icon on a Mail Task Flow

[image: Compose icon on a Mail task flow]






	
In the Compose window (Figure 65-16), enter recipients in the To field. Separate multiple addresses with a comma (,).


Figure 65-16 Compose Window

[image: Compose window]






Click the Options dropdown list to include Cc, Bcc, or Reply-to fields in the message. The Reply-to field is prepopulated with the user composing the mail, but it can be changed to any address. From this dropdown list, you also can select to compose the message in plain text, instead of the Rich Text Editor.

The selected options persist until they are changed.

Figure 65-3 shows the compose window with the Cc, Bcc, and Reply-to fields added as well as the Rich Text Editor removed.


Figure 65-17 Mail Compose Window with Different Options Selected

[image: Description of Figure 65-17 follows]






The Compose window is directly connected to your mail server, so you can use the Find User icons (Figure 65-18) to find mail addresses and contacts.


Figure 65-18 Find User Icons in a Compose Window

[image: Find user icons in a Compose window]






Click the Find User icon and, in the resulting dialog, enter—minimally—the first two characters of the user name for which you are searching. Click Search, and all names matching your search criteria appear in the results area.


Figure 65-19 Select User Dialog

[image: Description of Figure 65-19 follows]






	
In the Subject field, enter a subject for your message.

Enter up to 255 characters.


	
Compose your message.


	
Click Send.









65.4.7 Sending Mail with Attachments

Just like your regular mail, you can use the Mail task flow to send messages with attachments.

To send a mail with attachments:

	
Create a mail message as described in Section 65.4.6.


	
In the Compose window, click the Attach Files link (Figure 65-20).


Figure 65-20 The Attach Link

[image: Attach button]






The Add Attachment window opens (Figure 65-21).


Figure 65-21 The Add Attachment Window

[image: Add Attachment window]






	
Click Browse to locate and choose an attachment.


	
Click Attach to attach the selected file.

The file size must be greater than zero bytes but less than 2 MB. Zero-byte files do not get attached.




	
Note:

It is recommended that you avoid attaching large files, as this causes the server to slow down or not respond. If you attach large files (greater than 2MB), then because of how the HTTP protocol handles attachments, the system reports an error only after reading all of the 2MB characters.








	
Repeat steps 3 and 4 to add additional attachments.

Attachments are listed under the Attachments heading in the Add Attachment window (Figure 65-22).


Figure 65-22 Attachments in the Add Attachment Window

[image: Attachments in the Add Attachment window]






A Remove Attachment icon appears next to each attachment (Figure 65-22). Click this to remove a selected attachment from the window.


	
Click the Back to Compose link to go back to the Compose window.


	
Click Send.









65.4.8 Removing Attachments from the Add Attachment Window

You can remove attachments from the Add Attachment window and from the Compose window:

	
To remove mail attachments from the Add Attachment window, click the Remove Attachment icon next to the attachment you want to remove (Figure 65-23).


Figure 65-23 Attachments in the Add Attachment Window

[image: Attachments in the Add Attachment window]






For information about accessing the Add Attachment window, see Section 65.4.7, "Sending Mail with Attachments."


	
To remove mail attachments from the Compose window, click the Remove Attachment icon next to the attachment you want to remove (Figure 65-24).


Figure 65-24 Remove Attachment Icon in the Compose Window

[image: Remove Attachment icon in the Compose window]






For information about accessing the Compose window, see Section 65.4.6, "Composing and Sending Mail Messages."









65.4.9 Replying to and Forwarding Mail

When you reply to or forward a mail, the mail content is sent as an attached HTML file instead of being displayed in the mail message window. Replying to and forwarding mail is as straightforward as in your regular mail application.

To reply to or forward a mail message:

	
Go to a Mail task flow.


	
Click the link to the message you want to reply to or forward (Figure 65-25).


Figure 65-25 A Mail Message Link

[image: Mail message link]






The message opens (Figure 65-26).


Figure 65-26 A Mail Message

[image: A Mail message]






	
Choose one from the following options:

	
Click Reply to reply to the sender. Figure 65-27 shows the Reply Mail window.


Figure 65-27 A Reply Mail Message Window

[image: Description of Figure 65-27 follows]






	
Click Reply All to reply to all recipients (including users who received a blind copy).


	
Click Forward to send the message on to a third party. Figure 65-28 shows the resulting window.


Figure 65-28 A Forwarded Mail Message Window

[image: Forwarded mail message window]









	
In the resulting Compose window, enter recipients in the To field as you require. Separate multiple entries with a comma (,)

Click the Options dropdown list to add Cc, Bcc, or Reply-to fields or to remove the Rich Text Editor and use plain text..

The Compose window is directly connected to your mail server, so you can use the Find User icon to find mail addresses and contacts. Click the Find User icon and, in the resulting dialog, enter—minimally—the first two characters of the user name for which you are searching. Click Search, and all names matching your search criteria appear in the results area.


	
Optionally, revise the subject in the Subject field.


	
In the Mail's message area, enter your reply or any forwarding message before or after the original message.


	
Optionally, add attachments as described in Section 65.4.7, "Sending Mail with Attachments."


	
Click Send.

The message is sent, and the original message reappears.


	
Click Cancel at the bottom of the original message to close the window (Figure 65-29).


Figure 65-29 Cancel Message

[image: Close button]













65.4.10 Refreshing Mail

You must perform a refresh to check for new mail messages. Because the refresh operation triggers an event to the server to check for new mails, it may take a while to get new messages. Therefore, you may have to refresh a couple of times to display new mails in the Mail task flow.

To refresh Mail:

	
Go to the Mail task flow.


	
Click the Refresh icon (Figure 65-30) on the task flow.


Figure 65-30 The Refresh Icon on the Mail Task Flow

[image: Refresh icon on the Mail task flow]






The Mail task flow displays the latest mails.









65.4.11 Deleting Mail

You can easily remove a message from your inbox.

To delete a Mail message:

	
Open the message you want to delete as described in Section 65.4.4, "Opening Mail Messages."


	
Click Delete at the top of the message (Figure 65-31).


Figure 65-31 Delete Message

[image: Delete Message button]












65.5 Setting Mail Service Task Flow Properties

The Mail service task flow has associated properties, which users with sufficient privileges can access from the Component Properties dialog in Oracle Composer (Figure 65-32).


Figure 65-32 Mail Task Flow Component Properties

[image: Description of Figure 65-32 follows]






For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Mail service task flow and describe the properties on the Parameters tab.

	
Section 65.5.1, "What You Should Know About the Mail Service Task Flow Properties"


	
Section 65.5.2, "Mail Service Task Flow Parameters"






65.5.1 What You Should Know About the Mail Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 65.5.2, "Mail Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For more information, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The content of the Events tab depends on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Section 17.5.2.6, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






65.5.2 Mail Service Task Flow Parameters

The Mail task flow has one associated region parameter: Tabular. Using the EL value type, enter a value of true to display the information associated with a mail message, such as its subject, sender, and, date sent, in a tabular format. Figure 65-33 illustrates a tabular format Mail task flow.


Figure 65-33 A Mail Task Flow where the Region Parameter Tabular Is Set to True

[image: Mail task flow where tabularView is set to true]
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55 Analyzing Usage and Performance Metrics

The Analytics service offers real-time usage and activity reporting for your portal. This chapter describes how to use the pages and task flows provided through the Analytics service. It includes the following sections:

	
Section 55.1, "What You Should Know About the Analytics Service"


	
Section 55.2, "Working with Analytics Task Flows"


	
Section 55.3, "Setting Analytics Task Flow Properties"




For Analytics task flows to work, the Analytics schema(ACTIVITIES) must be installed and configured, and a connection set up between your application and the Analytics Collector. For more details on the Analytics schema and information on managing the Analytics service backend, see “Managing the Analytics Service” in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter. This chapter describes how to add Analytics task flows to application pages at runtime; to learn how to add Analytics task flows at design time, using Oracle JDeveloper, see Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.


Audience

This chapter is intended for WebCenter Spaces administrators with the Application-Manage Configuration permission and individual Space moderators who want to analyze activity within their Spaces.



55.1 What You Should Know About the Analytics Service

The Analytics Service allows WebCenter Spaces administrators and moderators to track and analyze WebCenter Spaces traffic and usage. The Analytics Service provides the following basic functionality:

	
Usage Tracking Metrics: The Analytics Service collects and reports metrics of common WebCenter Spaces functions, including community and portlet traffic.


	
Behavior Tracking: The Analytics Service can be used to analyze WebCenter Spaces metrics to determine usage patterns, such as page visit duration and usage over time.


	
User Profile Correlation: The Analytics Service can be used to correlate metric information with user profile information. Usage tracking reports can be viewed and filtered by user profile data such as country, company or title.




This section contains the following topics:

	
Understanding the Analytics Administration Page in WebCenter Spaces


	
Understanding Analytics Task Flows in WebCenter Spaces


	
Access to Analytics Task Flows in WebCenter Spaces






55.1.1 Understanding the Analytics Administration Page in WebCenter Spaces

An analytics console that displays metrics for the entire WebCenter Spaces application is available to WebCenter Spaces administrators with the Manage Configuration permission. The console consists of four pages, grouping several different reports:

	
Summary Metrics - portal traffic, page views, and login metrics


	
Space Metrics - Space usage and response times


	
Portlet Metrics - portlet views and response times


	
Service Metrics - Usage of searches, documents, wikis, blogs and discussions





Figure 55-1 Analytics Console for Administrators

[image: Analytics Console for Administrators]



Out-of-the-box, this console is available through a business role page named Analytics. It is the WebCenter Spaces administrator's responsibility to grant people permissions to see the Analytics page. This page is intended for anyone who needs to analyze access and usage statistics; this could include administrators, sales or marketing managers or directors, business analysts, and so on.

Just like other business role pages, the Analytics page is pushed to all the users to whom it is assigned, appearing in the Home Space. Once the Analytics page is available in the Home Space, users can show and hide the page through the Manage Page dialog.

See also, Section 7.1.4, "Specifying the Target Audience for a Business Role Page".






55.1.2 Understanding Analytics Task Flows in WebCenter Spaces

This section lists and describes all the Analytics task flows that are provided with WebCenter Spaces. The following task flows are available out-of-the-box:


Application Analytics:

	
WebCenter Traffic


	
Page Traffic


	
Login Metrics





Space Analytics:

	
Space Traffic


	
Space Response Time





Portlet Analytics:

	
Portlet Traffic


	
Portlet Instance Traffic


	
Portlet Response Time


	
Portlet Instance Response Time





Service Analytics:

	
Search Metrics


	
Discussion Forum Metrics


	
Document Metrics


	
Wiki Metrics


	
Blog Metrics







	
Note:

The images shown in the following sections represent one view of each report. However each report can be customized to display the data in different ways (for example, a bar chart, a pie chart, a line chart, or a table). For information on customizing reports, see Section 55.2.2, "Customizing Analytics Reports" and Section 55.2.3, "Personalizing Your Analytics Report View."









55.1.2.1 WebCenter Traffic

The WebCenter Traffic task flow (Figure 55-2) displays a summarized view for common events within the portal.

Use this task flow to track application-wide events—Space views, page views, portlet views, logins, number of searches, wiki views, blog views, discussion forum views, and document views.


Figure 55-2 Analytics Task Flow - WebCenter Traffic

[image: Analytics Task Flow - WebCenter Traffic]







55.1.2.2 Page Traffic

The Page Traffic task flow (Figure 55-3) displays the number of page hits and the number of unique users that have visited any portal page.

Use this task flow to quickly see the most visited pages (top pages) and/or the least visited pages (bottom pages). You can view page data by hits (total number of page views) and/or users (unique number of users who viewed pages). You can filter the report to show data only for specific pages (in the Display options list, select Specify, then click Select, select pages, then click OK) or pages from specific Spaces (in the Spaces query options).


Figure 55-3 Analytics Task Flow - Page Traffic

[image: Analytics Task Flow - WebCenter Traffic]






	
Note:

Pages belonging to the Home Space are excluded by default but there is an option to include this information if you want to do so.












55.1.2.3 Login Metrics

The Login task flow (Figure 55-4) reports the number of times users log in to WebCenter Spaces.

Use this task flow to see the total number of portal logins and/or the number of times unique users logged into the portal.


Figure 55-4 Analytics Task Flow - Login Metrics
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55.1.2.4 Space Traffic

The Space Traffic task flow (Figure 55-5) displays usage information—the number of page hits, number of unique users, and the number of unique visits (multiple consecutive page views within the same Space during the same WebCenter session is treated as one visit)—for individual Spaces.

Use this task flow to quickly see the most popular Spaces (top), and the least popular Spaces (bottom). You can filter the data to only show specific Spaces or show all Spaces.


Figure 55-5 Analytics Task Flow - Space Traffic
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Note:

The Home Space is not included in the data.












55.1.2.5 Space Response Time

The Space Response Time task flow (Figure 55-6) displays page performance information—average, minimum, or maximum response time—for individual Spaces over any time period you specify.

Use this task flow to quickly see the slowest Spaces (bottom), and the fastest Spaces (top). You can filter the data to only show specific Spaces or show all Spaces.


Figure 55-6 Analytics Task Flow - Space Response Time
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Note:

The Home Space is not included in the data.












55.1.2.6 Portlet Traffic

The Portlet Traffic task flow (Figure 55-7) displays portlet usage information—the number of portlet hits (the number of times a portlet is displayed) and number of unique users that access a portlet.

Use this task flow to quickly see the most popular portlets (top), and the least popular portlets (bottom). You can filter the data to only show specific portlets or show all portlets. Similarly, you can filter the portlet data by Space.


Figure 55-7 Analytics Task Flow - Portlet Traffic
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Note:

The Home Space is not included in the data.












55.1.2.7 Portlet Instance Traffic

The Portlet Instance Traffic task flow (Figure 55-8) displays usage information—the number of portlet hits (the number of times a portlet is displayed) and number of unique users that access a portlet—for individual portlet instances. If the same portlet displays on several different pages, each placement is considered as a portlet instance.

Use this task flow to quickly see the most popular portlet instances (top), and the least popular portlet instances (bottom). You can filter the data to only show specific portlet instances or show all portlet instances. Similarly, you can filter the portlet data by Space.


Figure 55-8 Analytics Task Flow - Portlet Instance Traffic
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Note:

The Home Space is not included in the data.












55.1.2.8 Portlet Response Time

The Portlet Response Time task flow (Figure 55-9) displays performance information—average, minimum, and maximum response time—for individual portlets.

Use this task flow to quickly see the slowest portlets (bottom), the fastest portlets (top), and compare performance data. Portlet response times are important because there is often a direct link between page performance and the slowest portlets. When troubleshooting poor performance within a Space, it is important to identify the worst performing portlets. You can filter the data to only show specific portlets or show all portlets. Similarly, you can filter the portlet data by Space.


Figure 55-9 Analytics Task Flow - Portlet Response Time
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55.1.2.9 Portlet Instance Response Time

The Portlet Instance Response Time task flow (Figure 55-10) displays performance information—average, minimum, and maximum response time—for individual portlet instances. If the same portlet displays on several different pages, each placement is considered as a portlet instance.

Use this task flow to quickly see the slowest portlet instances (bottom), the fastest portlet instances (top), and compare performance data. You can filter the data to only show specific portlet instances or show all portlet instances. Similarly, you can filter the portlet data by Space.


Figure 55-10 Analytics Task Flow - Portlet Instance Response Time
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55.1.2.10 Search Metrics

The Search Metrics task flow (Figure 55-11) tracks searches performed within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) search phrases.


Figure 55-11 Analytics Task Flow - Search Metrics
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55.1.2.11 Document Metrics

The Document Metrics task flow (Figure 55-12) tracks how often a document is accessed.

Use this task flow to quickly see the most popular (top) and least popular (bottom) documents. You can filter the data to only show specific Spaces or show all Spaces.




	
Note:

Documents in the Home Space are included in this report.










	
Note:

If you have two different documents with the same name, they are treated as two separate documents. The metrics include the parent folder for context.








Figure 55-12 Analytics Task Flow - Document Metrics
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55.1.2.12 Wiki Metrics

The Wiki Metrics task flow (Figure 55-15) tracks how often wikis are accessed within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) wikis. You can filter the data to only show specific Spaces or show all Spaces.


Figure 55-13 Analytics Task Flow - Wiki Metrics
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55.1.2.13 Blog Metrics

The Blog Metrics task flow (Figure 55-14) tracks how often blogs are accessed within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) blogs. You can filter the data to only show specific Spaces or show all Spaces.


Figure 55-14 Analytics Task Flow - Blogs Metrics
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55.1.2.14 Discussion Forum Metrics

The Discussion Forum Metrics task flow (Figure 55-15) tracks discussion forums within the portal.

Use this task flow to quickly see the most popular (top) and least popular (bottom) discussions. You can filter the data to only show specific Spaces or show all Spaces.


Figure 55-15 Analytics Task Flow - Discussion Metrics
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55.1.3 Access to Analytics Task Flows in WebCenter Spaces

In WebCenter Spaces, Resource Catalogs only display analytics task flows to users with appropriate permissions:

	
Administrators - Users with the Administrator role have access to all the analytics task flows


	
Moderators - Within a Space, members with the Moderator role can only access task flows specific to that Space




After a task flow is added to a page, anyone with access to the page can see the task flow.








55.2 Working with Analytics Task Flows

This section contains the following topics:

	
Adding Analytics Task Flows to a Page


	
Customizing Analytics Reports


	
Personalizing Your Analytics Report View






55.2.1 Adding Analytics Task Flows to a Page

The process of adding an Analytics task flow to a page is the same as for any other task flow (for more information, see Section 17.5, "Adding Resource Catalog Components to Pages"). The process varies only in where you can find these task flows in the Resource Catalog. All the Analytics task flows are under the Analytics folder.


Figure 55-16 Analytics Folder in Resource Catalog

[image: Analytics Folder in Resource Catalog]






	
Note:

When you add an Analytics task flow to a Space, it displays information for that Space, not for all Spaces.












55.2.2 Customizing Analytics Reports

If you want to set defaults for Analytics reports, you can do so by editing the report settings in page Edit mode. Any changes you make while in Edit mode will become the default report settings for all users in page View mode. For example, you can edit the Analytics page, changing the following settings on the Summary Metrics page in the Traffic report: set the report type to pie chart, set the time frame to this week, and remove Discussion Forums from the display. When users visit the Analytics page, those settings will be applied by default. Users can then edit the report as necessary for their needs. This can be useful if there are particular settings you know are commonly used by your users, or to customize a particular instance of an Analytics task flow on a group-specific page.

You can also configure the report settings to determine the controls available to users in View mode. In page Edit mode, click the Configure report preferences icon to display the Report Settings popup. In this popup, you can specify whether to show or hide the following report settings:

	
Chart

	
Chart Style list allows you to select a color scheme for reports


	
Chart Type Options allows you to show or hide the chart types (bar, pie, line, table) at the top of the report





	
Data Selection

	
Report Summary allows you to show or hide the Report Summary section to the left of the report


	
Metrics Selector allows you to show or hide the list of metrics (Hits, Unique Users, and such)


	
Display Options (not available with Logins) allows you to show or hide the list of display options (Spaces, Pages, Portlets, and such)


	
Selection Button (not available with Traffic, Logins, Space Traffic, Space Response Time, Search Metrics, Document Metrics, Wiki Metrics, Blog Metrics, Discussion Forum Metrics) allows you to show or hide the Specify option in the Display list and the Select button at the top of the report


	
Additional Options (not available with Traffic, Logins, Space Traffic, Space Response Time, Portlet Traffic, Portlet Instances Traffic, Portlet Response Time, Portlet Instances Response Time, Search Metrics, Document Metrics, Wiki Metrics, Blog Metrics, Discussion Forum Metrics) allows you to show or hide the Additional Options section to the left of the report





	
Filtering

	
Time Frame Filters allows you to show or hide the Time Frame section to the left of the report


	
User Property Filters allows you to show or hide the User Property section to the left of the report


	
Space Filter (not available with Traffic, Logins, Search Metrics) allows you to show or hide the Spaces section to the left of the report





	
Grouping

	
Group By Options allows you to show or hide the Grouping Options section to the left of the report












55.2.3 Personalizing Your Analytics Report View

Analytics task flows include display options at the top of the report and query options to the left of the report. These options enable you to personalize the report for your needs by changing the metrics included in the report and the way the report is presented. Most options are the same for all Analytics task flows.



55.2.3.1 Report Display Options

The report display options at the top of the report enable you to select the type of report, select the type of metrics to include, and, for some task flows, control the top/bottom range to display.


Report Types

You can display your report as a bar chart, pie chart, line chart, or table depending on the display and query options you select. To choose your report type, click the associated icon.

Table 55-1 lists the report types available for different display and query options. It includes the following columns:

	
Selected Metrics specifies what has been selected in the list of metrics, a single metric or multiple metrics. Note: Search Metrics and Document Metrics task flows show only those single metrics; there is no list to select metrics.


	
Group By Options specifies what has been selected in the Grouping Options section to the left of the report, No Selection or one of the available selections.


	
Bar, Pie, Line, and Table specify whether you can view that type of report with the specified selections.





Table 55-1 Display Options for the Analytics Task Flows

	Selected Metrics	Group By Option	Bar	Pie	Line	Table
	
Single metric

Login Traffic task flow

	
No selection

	
N

	
N

	
N

	
Y


	
Single metric

All other task flows

	
No selection

	
Y

	
Y

	
N

	
Y


	
Single metric

	
Time interval, user property, or Both*

	
Y

	
N

	
Y

	
Y


	
Multiple metrics

WebCenter Traffic and

Login Traffic task flows

	
No selection

	
Y

	
Y

	
N

	
Y


	
Multiple metrics

All other task flows

	
No selection

	
Y

	
N

	
Y

	
Y


	
Multiple metrics

WebCenter Traffic and Login Traffic task flows

	
Time interval or user property

	
Y

	
N

	
Y

	
Y


	
Multiple metrics

All other task flows

	
Time interval or user property

	
N

	
N

	
N

	
Y


	
Multiple metrics

Login Traffic task flow

	
Both*

	
N

	
N

	
N

	
Y








* The grouping option Both is available only for the Login Traffic task flow.


Metrics

You can select which type of metrics to include in your report. Your metrics options differ depending on the task flow you are using:

	
WebCenter Traffic: Spaces, Pages, Portlets, Logins, Searches, Wikis, Blogs, Discussion Forums, Documents


	
Page Traffic: Hits, Unique Users


	
Login Metrics: Logins, Unique Users


	
Space Traffic: Hits, Unique Users, Visits


	
Space Response Time: Average Response Time, Minimum Response Time, Maximum Response Time


	
Portlet Traffic: Hits, Unique Users


	
Portlet Instance Traffic: Hits, Unique Users


	
Portlet Response Time: Average Response Time, Minimum Response Time, Maximum Response Time


	
Portlet Instance Response Time: Average Response Time, Minimum Response Time, Maximum Response Time


	
Search Metrics: This task flow shows only search metrics, so it does not include an option to select metrics.


	
Document Metrics: This task flow shows only document metrics, so it does not include an option to select metrics.


	
Wiki Metrics: Views, Unique Users


	
Blog Metrics: Views, Unique Users


	
Discussion Forum Metrics: Views, Unique Users




To select which metrics to include in your report, select the metrics from the list above the report.


Figure 55-17 Analytics Task Flow - Metrics Selection
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Top, Bottom, or Custom Ranges

With some task flows you can specify whether you want to see the top, bottom, all, or a custom ranges of metrics in your report. Use these options to see the most and least popular items in your portal.

To display the top or bottom ranges of metrics in your report, in the lists above the report, select Top or Bottom, and then select a number to define the range.

To display a custom range, in the list above the report, select Specify, then click Select.

The top and bottom options are available for Pages, Portlet Traffic, Portlet Instances Traffic, Response Time, Portlet Response Time, Portlet Instances Response Time.

The custom range option is available for Pages, Traffic, Response Time, Portlet Traffic, Portlet Instances Traffic, Response Time, Portlet Response Time, Portlet Instances Response Time, Search Metrics, Document Metrics, Wiki Metrics, Blog Metrics, Discussion Forum Metrics.






55.2.3.2 Query Options

Analytics task flows include the following query options to the left of the report:

	
Report Summary

Displays a summary of the selected display and query options shown in the report.


	
Time Frame

Enables you to specify the date range for the metrics displayed in the report. You can select from the following options: Yesterday, Today, This Week, Last Week, This Month, Last Month, Last Three Months, Last Six Months, This Year, Last Year, or you can specify your own date range.


	
User Property

Enables you to filter your report by user property. After selecting a property from the list, you can specify a value that the property must contain or must not contain, and only metrics that apply to the filtered property display in the report.

	
Property: Select a property on which to filter the report. You can select City, Company, Country, Department, Display Name, Employee ID, IM User, Manager, Phone, State or Province, Street, Title, or ZIP code


	
Operator: Select how you want to filter the property. You can select Contains or Does Not Contain.


	
Value: Type a value on which to filter the property.







	
Note:

To search using a wildcard (for example, % or ?), you must prefix the wildcard with a forward slash (\). For example, to search for give or giving, type giv\% in the Value box.








	
Additional Options

Enables you Include Home Space Pages. These options are available with the Pages task flow.


	
Spaces

When Analytics task flows display in the Home Space or on a business role page, you can choose which Spaces to include in your report. When Analytics task flows are used within a particular Space, only metrics only for that Space display; the Spaces option is unavailable (grayed out).

To specify the Spaces to include in your report, click the Space Filter icon to display the Specify Spaces popup. Select the Spaces you want to include in your report, using CTRL+click and SHIFT+click to select multiple Spaces.

This option is not available with the Traffic, Logins, or Search Metrics task flows.


	
Grouping Options

Enables you to select an option by which to group the metrics in your report. You can group by a time interval (Hour, Day, Week, Month, or Year), a user property, or, with the Logins task flow, both.




	
Note:

This setting affects the available display options for the report (see Table 55-1.



















55.3 Setting Analytics Task Flow Properties

The Analytics service task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 55-18).


Figure 55-18 Analytics Task Flow - Component Properties
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Events service task flows and describe the properties on the Parameters tab:

	
Section 55.3.1, "What You Should Know About the Analytics Service Task Flow Properties"


	
Section 55.3.2, "Analytics Service Task Flow Parameters"






55.3.1 What You Should Know About the Analytics Service Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 55.3.2, "Analytics Service Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Section 17.5.2, "Setting Properties on Page Components."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Section 17.5.2.8, "Working with Component Contextual Events."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Edit icon next to a property field to open the editor.






55.3.2 Analytics Service Task Flow Parameters

Table 55-2 describes the parameters that are unique to the Analytics service task flows.


Table 55-2 Analytics Task Flow Parameters

	Parameter	Description
	
Analytics Report Title

	
Specifies the display title that appears above the analytics data.

Note:

	
Use the Analytics Report Title rather than the Text property on the Display Options page. Changing the Text value has no effect on Analytics task flows.


	
You cannot change the report titles in the Analytics console.





	
Analytics Resource Id

	
Specifies the MDS document used to store user customizations/application customizations for the task flow instance in MDS.

Warning: Do not edit this value.


	
Application Name*

	
Specifies the WebCenter application for which you want to display analytics data. For WebCenter Spaces, this is always webcenter.

The analytics database can be used to store event data from multiple applications so this parameter is required to identify which application data to display.

If omitted, the task flow displays analytics data for all applications.


	
Max Data Points Per Series

	
Indicates the maximum number of data points to be displayed in a bar or line chart. The default value is 25. Valid values are between 1 and 1000.

Note: Increasing the number of data points might increase the time it takes to render the report.













69 Working with the Recent Activities Service

The Recent Activities service provides a means of tracking recent activities within a WebCenter application. For example, the Recent Activities task flow tracks the changes you and other users make to application pages, documents, discussion forums, lists, and the like (Figure 69-1).


Figure 69-1 The Recent Activities Task Flow

[image: Recent Activity task flow]






This chapter provides information about the Recent Activities service. It contains the following sections:

	
Section 69.1, "What You Should Know About the Recent Activities Service"


	
Section 69.2, "Working with the Recent Activities Task Flow"


	
Section 69.3, "Setting Recent Activities Task Flow Properties"







	
Note:

You can track recent activities through your favorite RSS reader. For more information, see Chapter 68, "Working with the RSS Service."








Audience

This chapter is intended for users interested in understanding and using the features of the Recent Activities service.

The WebCenter Spaces application administrator has the authority to expose or hide task flows from a particular service. Tasks discussed in this chapter are not available to you if the relevant service is hidden.




	
Note:

For information about WebCenter Spaces seeded user roles, see Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.









69.1 What You Should Know About the Recent Activities Service

The Recent Activities service provides the Recent Activities task flow, which links to the additions and revisions to some services available to your application (Figure 69-2).


Figure 69-2 The Recent Activities Task Flow
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Tracked changes include additions and revisions to pages, documents, discussion forums, lists (WebCenter Spaces only), and events.

By default, the Recent Activity list displays 25 recent activities for a given service. If more than 25 activities have occurred, the Recent Activity list displays the 25 most recent. Your application administrator can change the default value, so your limit may be more or less than 25.

The level of information provided in the Recent Activity list depends on the context in which the list is placed. For example, in a WebCenter portal application, changes are tracked on all applicable services across the entire application.

In a WebCenter Spaces Space page, the Recent Activity list summarizes changes occurring in that Space. In a WebCenter Spaces personal space, the Recent Activities task flow must have a Space specified (see Section 69.3, "Setting Recent Activities Task Flow Properties"). The Recent Activity list summarizes changes occurring in the specified Space.

You can use the Recent Activity list as an access point to new and revised content. The Recent Activity list displays new and revised content as links, which you can click to go directly to the content.






69.2 Working with the Recent Activities Task Flow

With the Recent Activities task flow, there is very little to do to make the most of its features. It automatically detects recent activities on other WebCenter services and reports on its findings.

There are, nonetheless, a few recent-activity-centered actions you can take on the task flow. For example, you can personalize your view of recent activities, access a changed item, and refresh your view to update the task flow with the latest changes. This section tells you how. It contains the following subsections:

	
Section 69.2.1, "Adding the Recent Activities Task Flow to a Custom Resource Catalog"


	
Section 69.2.2, "Adding the Recent Activities Task Flow to a Page"


	
Section 69.2.3, "Personalizing the Recent Activities Task Flow"


	
Section 69.2.4, "Accessing Recently Acted-On Items"


	
Section 69.2.5, "Refreshing the Recent Activities Task Flow"






69.2.1 Adding the Recent Activities Task Flow to a Custom Resource Catalog

WebCenter Spaces provides rich Resource Catalogs that expose components and connections that WebCenter Spaces users can add to their pages. You can use a Resource Catalog to populate resources such as page templates, navigation models, pages, and task flows.

As a Spaces administrator or a Space moderator, you can make the Recent Activities task flow available in a custom Resource Catalog so that users can add the task flow to their pages and use it for keeping track of recent activities.

To make the Recent Activities task flow available in a custom Resource Catalog:

	
Create a Resource Catalog or make a copy of an existing one. Creating a Resource Catalog follows the same procedure as any other resource. For information about creating a blank Resource Catalog, see Section 10.2, "Creating Resources." For information about copying an existing Resource Catalog, see Section 10.4.1, "Copying a Resource."


	
To add the Recent Activities task flow to the Resource Catalog, on the Resources page, select your newly created Resource Catalog.


	
From the Edit menu, choose Edit.


	
If you have created folders (see Section 16.3.1.1, "Creating a Folder") and want to add resources inside a particular folder, select the folder in the Edit dialog.


	
In the Edit dialog, select Add, and then Add From Library.


	
In the Add Resource Catalog Item dialog, click Task Flows on the left.


	
From the list on the right, select Recent Activities (Figure 69-3).


Figure 69-3 Adding the Recent Activities Task Flow to a Resource Catalog
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Click Add.

The Recent Activity task flow displays in your Resource Catalog.


Figure 69-4 Recent Activities Task Flow in a Resource Catalog

[image: Notes Task Flow in a Resource Catalog]






	
Click OK to close the Edit dialog of your Resource Catalog.


	
Configure the application or Space to use the new catalog as the default one. For information, see Section 16.10, "Configuring Resource Catalogs in Your Application."









69.2.2 Adding the Recent Activities Task Flow to a Page

To add the Recent Activities task flow to a page, you need to add Recent Activities using the Resource Catalog (Figure 69-5).


Figure 69-5 Selecting the Recent Activities Task Flow from the Resource Catalog
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The procedure for adding the Recent Activities task flow to a page is same as adding any component from the Resource Catalog. For the generic procedure, see Section 17.5.1, "Adding a Component to a Page."






69.2.3 Personalizing the Recent Activities Task Flow

The Recent Activities task flow provides a way to specify the range of time within which to view changes and additions to other services. These time-range options display on the Show menu in the Recent Activities task flow toolbar (Figure 69-6).


Figure 69-6 Time-Range Options on the Recent Activity List
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Select an option from the Show menu to view recent activities occurring within the selected time range. The time range you select is applicable only to that task flow instance. If you have more than one Recent Activities task flow instance on the page, you can display activities from a different time range in each task flow instance.




	
Tip:

Ensure that your application Preferences reflect your own local time zone. To access your time zone preference in the WebCenter Spaces application, click the Preferences link at the top of the application and then select General. For more information, see Section 35.3, "Setting Date and Time Preferences."







The default options on the Show menu include:

	
Today—The task flow displays all activities that have taken place between 12:00AM (2400 hours) and now.


	
Since Yesterday—The task flow displays all activities that have taken place between now and yesterday at 12:00AM (2400 hours).


	
Last 7 days—The task flow displays all activities that have taken place in the last 7 days.


	
Last 30 days—The task flow displays all activities that have taken place in the last 30 days.







	
Note:

These options are described according to their default meanings. In some instances, an advanced user can provide alternative definitions for them. For more information, see Section 69.3, "Setting Recent Activities Task Flow Properties."












69.2.4 Accessing Recently Acted-On Items

The Recent Activities task flow groups the different services it reports on into nodes that are named for each service (Figure 69-7).


Figure 69-7 Service Nodes in the Recent Activities Task Flow

[image: Service nodes on a Recent Activity task flow]






Expand a node, and access the changed item directly by clicking its link (Figure 69-8).


Figure 69-8 Recent Discussion Link in the Recent Activities Task Flow

[image: Accessing a changed service from Recent Activity]






The targets of linked items open on dynamically-generated pages, or in the WebCenter Spaces application, on dynamically-generated, top-level tabs. Link targets display according to their parent service. For example, click a Discussions service link to access a forum or a specific topic under a forum; click a Lists service link to access an updated list of lists or a specific updated list; click an event to display event details; and so on.






69.2.5 Refreshing the Recent Activities Task Flow

If you prefer not to wait for an automatic refresh of the Recent Activities task flow, you always have the option of refreshing the task flow yourself by clicking its Refresh icon (Figure 69-9).


Figure 69-9 The Refresh Icon on a Recent Activities Task Flow
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The task flow updates and indicates the number of recently-changed items by increasing the value displayed in parenthesis next to each affected service.








69.3 Setting Recent Activities Task Flow Properties

For the steps to add a Recent Activities task flow to a page, see Section 17.5, "Adding Resource Catalog Components to Pages."

The Recent Activities task flows have associated properties, which users with sufficient privileges can access through the Component Properties dialog in Oracle Composer (Figure 69-10).


Figure 69-10 Recent Activities Task Flow Component Properties
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For information about accessing the Component Properties dialog, see Section 17.5.2.3, "Setting Component Properties."

The following sections provide information about properties of the Recent Activities task flow and describe the properties on the Parameters tab:

	
Section 69.3.1, "What You Should Know About the Recent Activities Task Flow Properties"


	
Section 69.3.2, "Recent Activities Task Flow Parameters"






69.3.1 What You Should Know About the Recent Activities Task Flow Properties

The properties on the Parameters tab of the Component Properties dialog control the default task flow content. For descriptions of the parameters on this tab, see Section 69.3.2, "Recent Activities Task Flow Parameters." For some task flows, parameters on this tab facilitate the wiring of the task flow to page parameters and page definition variables. These properties are unique to the task flow type. For more information, see Chapter 17, "Setting Properties on Page Components." For information about wiring pages and components, see Chapter 19, "Wiring Pages, Task Flows, Portlets, and UI Components."

Changes to the properties on the Display Options, Style, and Content Style tabs affect the appearance and behavior of the task flow for all users. These properties are common to all task flows. For more information, see Chapter 17, "Working with Style and Content Style Properties."

The contents of the Events tab depend on the events supported by the task flow. For more information, see Chapter 17, "Working with Component Contextual Events."

The Child Components tab displays all of the components contained within the current component. It provides controls for rearranging, showing, and hiding child components. Not all components contain children. So you may find this tab devoid of content. For more information, see Chapter 17, "Working with Child Components."

All properties on the Parameters and Display Options tabs provide access to an Expression Language (EL) editor, which you can use to select or specify a variable value instead of a constant value. Click the Expression Builder icon next to a property field to open the editor. For more information about using the editor and for descriptions of common EL expressions, see Appendix B, "Expression Language Expressions."






69.3.2 Recent Activities Task Flow Parameters

Table 69-1 describes the parameters that are unique to the Recent Activities task flow.


Table 69-1 Recent Activities Task Flow Parameters

	Parameter	Description
	
Group Space Name

	
Applicable in WebCenter Spaces only. Leave this field blank if the task flow is on a WebCenter portal application page.

Use this parameter to specify the Space for which to display recent activities. On a personal space page, use this to narrow the range of displayed activities. Rather than tracking activities application-wide—the default behavior—you can, for example, set a Constant value of a particular Space's display name.

On a Space page, use this parameter to display some other Space's recent activities or to display recent activities for all Spaces.

Valid values include:

	
The display name or GUID of the Space to search


	
null (empty), to search according to the contextual default

Use for Space pages only. An empty value on a Space page searches the current Space.

Note: Always specify a value on a personal space page. An empty value does not return any results. If no value is specified, then the following message displays in the Recent Activities task flow:


Recent Activity in the Personal Space requires a groupSpace taskflow parameter value to use for the search.


	
defaultScope (or the defaultScope GUID), to search all Spaces





	
Medium Time Period in minutes

	
Defaults to Yesterday on the Recent Activity Show menu. For defining the time range between Short and Long within which activities are displayed on the Recent Activity list.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")


	
Long Time Period in minutes

	
Defaults to Last 7 Days on the Recent Activity Show menu. Used for defining the time range between Medium and Longest within which activities are displayed on the Recent Activity list.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")


	
Longest Time Period in minutes

	
Defaults to Last 30 Days on the Recent Activity Show menu. For defining the longest range of time within which activities are displayed on the Recent Activity list.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")


	
Shortest Time Period in minutes

	
Defaults to Today on the Recent Activity Show menu. Used for defining the shortest range of time within which activities are displayed on the Recent Activity list. Today is measured from midnight in your selected time zone.

Valid values include:

	
TODAY—Activities that have occurred since midnight in the currently selected time zone display on the Recent Activity list.


	
YESTERDAY—Activities that have occurred since midnight yesterday in the currently selected time zone display on the Recent Activity list.


	
A number of minutes—Activities that have occurred within the specified number of minutes display on the Recent Activity list. For example, a value of 60 renders as Last Hour on the Show menu. A value of 1440 is rendered as Last Day.




Example values:


Constant: TODAY (Displays all activity since midnight)
Constant: 2880 (Displays all activity within the last 2880 minutes. This is displayed as Last 2 Days on the Show menu.)
EL Expression: ${myAppBean.timePeriod} (Displays based on the value from the given Bean property "timePeriod")
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Part XV


Services: Announcements through Links

Part XV of the User's Guide provides overview and usage information about services from Announcements through Links.

Part XV includes the following chapters:

	
Chapter 59, "Working with the Announcements Service"


	
Chapter 60, "Working with the Discussions Service"


	
Chapter 61, "Working with the Events Service"


	
Chapter 62, "Working with the Instant Messaging and Presence Service (IMP)"


	
Chapter 63, "Working with the Links Service"






10 Working with the Resources that Compose a Portal or Community

Out-of-the-box, WebCenter Spaces provides a range of built-in resources that you can use to define and enrich your application and Spaces. If these resources do not meet your specific requirements, you can create your own custom resources.

This chapter provides an introduction to WebCenter Spaces resources and describes how you can create and manage them. It includes the following sections:

	
Section 10.1, "What You Should Know About Resources"


	
Section 10.2, "Creating Resources"


	
Section 10.3, "Editing Resources"


	
Section 10.4, "Managing Resources"


	
Section 10.5, "Using JDeveloper to Build WebCenter Spaces Resources"







	
Note:

For detailed information about a particular resource, refer to the resource-specific chapter listed in Table 10-1.









10.1 What You Should Know About Resources

Though WebCenter Spaces comes with an out-of-the-box application framework, it is a constantly evolving application. Users with appropriate privileges can continue to customize it by creating and applying various types of resources that define the structure, look and feel, and the content of the entire Spaces application or a particular Space. Users can customize WebCenter Spaces without redeploying resources or restarting the application.

This section provides an overview of the various resources and the permissions required to work with them, and describes how you can access resources. It includes the following subsections:

	
Section 10.1.1, "Introducing Resources"


	
Section 10.1.2, "Understanding Application-Level and Space-Level Resources"


	
Section 10.1.3, "Permissions Required to Work with Resources"


	
Section 10.1.4, "Accessing Resources"


	
Section 10.1.5, "Viewing Information About a Resource"






10.1.1 Introducing Resources

WebCenter Spaces categorizes resources under the following categories: Structure, Look and Layout, and Mashups. Figure 10-4 shows the various types of resources available under each of these categories.


Figure 10-1 Resources Available in WebCenter Spaces

[image: Resources available in WebCenter Spaces]






Table 10-1 describes the various types of resources, and provides links to the chapters where you can find more information about each resource.


Table 10-1 Resources Available in WebCenter Spaces

	Resource	Description	Documentation
	
Structure

	
Resources under this category help you define templates, navigation, and catalogs

	

	
Page Templates

	
Define how individual pages and groups of pages display on a user's screen.

	
See Chapter 12, "Working with Page Templates"


	
Navigations

	
Define how to link together information from multiple sources, such as Spaces, pages, content repositories, and even external web pages.

	
See Chapter 11, "Working with Navigation"


	
Resource Catalogs

	
Define the components and connections that users can add to their pages, page templates, and task flows.

	
See Chapter 16, "Working with Resource Catalogs"


	
Look and Layout

	
Resources under this category help you define the appearance and layout

	

	
Skins

	
Define the appearance and look and feel, including colors and fonts, of a specific Space or the entire application.

	
See Chapter 14, "Working with Skins"


	
Page Styles

	
Define the layout of a newly created page, and may also dictate the type of content the page supports.

	
See Chapter 15, "Working with Page Styles"


	
Content Presenter

	
Manage Content Presenter templates for presenting content.

	
See Chapter 40, "Publishing Content Using Content Presenter"


	
Mashup Styles

	
Manage the templates available for creating task flows.

	
See Section 26.3.4, "Managing Mashup Styles"


	
Mashups

	
Resources under this category help you define task flows and data controls

	

	
Data Controls

	
Create and manage data controls, which connect to and read data from external repositories, particularly for use in business mashups. WebCenter Spaces does not provide any built-in data controls.

	
See Section 26.2, "Creating and Managing Data Controls"


	
Task Flows

	
Create and manage task flows based on a selected mashup style. WebCenter Spaces does not provide any built-in task flows.

	
See Section 26.3, "Creating and Managing Task Flows"












10.1.2 Understanding Application-Level and Space-Level Resources

Out-of-the-box, WebCenter Spaces provides various built-in resources at the application level and the Space level (Home Spaces or any other Spaces). You cannot modify or download built-in resources.

To meet your business requirements, you can create custom resources at the application level or at the Space level. At both these levels, the resources available and their functionality are the same. The difference between application- and Space-level resources is that of scope:

	
Application-level resources are available for use to all Spaces, unless a Space has been specifically excluded.


	
Space-level resources are available for use only in the Space in which they are created.




By default, application-level resource settings, such as the page template, skin, resource catalog, and navigation model, are applied to all Spaces. However, in a Space, you can choose to use the default application-level resource settings or specify your own resource settings. If your Space uses application-level settings, any changes to an application-level setting are reflected in your Space too. For example, consider that your application uses the Fusion FX skin, and there are two Spaces in your application, SpaceA and SpaceB. By default, both your Spaces will use the Fusion FX skin. Consider that you configure the application to use the skin named Dew, and SpaceB to use the Mist skin. Now, SpaceA, which is still using an application-level setting for its skin, is automatically updated to use the Dew skin; however SpaceB continues to use Mist.

When you create and publish a custom, application-level resource, it automatically becomes available to all Spaces. However, an application-level resource can be edited only at the application level.






10.1.3 Permissions Required to Work with Resources

To create and manage resources, you require appropriate application-level and Space-level permissions.

To create and manage application-level resources, you must be a WebCenter Spaces administrator. Or, you must have either of the following permissions:

	
Application-Manage All (Figure 10-2)


	
Application-Manage Configuration and the permission to create, edit, and delete the required resource. For example, the Create, Edit, and Delete Page Styles permission for page styles (Figure 10-3).





Figure 10-2 Manage All Permission for Application

[image: Manage All permission for the entire Spaces application]







Figure 10-3 Permissions Required to Manage Resources at the Application Level

[image: Permissions required to manage resources]






To create and manage a resource for a particular Space, you must be granted the following permissions:

	
Standard Permission Model: You must be granted the Resources-Create, Edit, and Delete Resources (Figure 10-4) and either Manage All or Manage Configuration for Space Administration (Figure 10-5).


Figure 10-4 Role with the Create, Edit, and Delete Resources Permission for a Space

[image: Create, Edit, and Delete Resources permission]






	
Advanced Permission Model: You must be granted the permission to create, edit, and delete the desired resource. For example, you require the Create, Edit, and Delete Content Presenter permission to create and manage content presenter templates. You must also be granted either Manage All or Manage Configuration for Space Administration (Figure 10-5).


Figure 10-5 Permissions Required for Creating Content Presenter Templates in a Space

[image: Description of Figure 10-5 follows]













10.1.4 Accessing Resources

You use the Resources page to manage resources. This section describes how to access resources in your application and in a specific Space. It includes the following subsections:

	
Section 10.1.4.1, "Accessing Application-Level Resources"


	
Section 10.1.4.2, "Accessing Space-Level Resources"






10.1.4.1 Accessing Application-Level Resources

To access the application-level Resources page:

	
Log on to WebCenter Spaces with administrative privileges.


	
After you log on as the application administrator, you can access the Resources page in either of the following ways:

	
Use the following URL:


http://host:port/webcenter/spaces/admin/resources


Where, host and port refer to the host name and the port number of the server where WebCenter Spaces is deployed.




	
See Also:

For more information about WebCenter Spaces user interface URLs, see Appendix A, "WebCenter Spaces User Interface URLs."








	
Click the Administration link (Figure 10-6). If you use this option, proceed to step 3.


Figure 10-6 Administration Link

[image: Administration Link]









	
In WebCenter Spaces Administration, click the Resources tab.

The application-level Resources page opens, as shown in Figure 10-7.


Figure 10-7 Application-Level Resources Page

[image: Resources page in Spaces Administration]













10.1.4.2 Accessing Space-Level Resources

To access the Resources page of a Space:

	
Log on to WebCenter Spaces with Space moderator privileges.


	
You can access the Resources page in either of the following ways:

	
Use the following URL:


http://host:port/webcenter/spaces/spaceName/admin/resources


Where, host:port refer to the host name and the port number of the server where WebCenter Spaces is deployed.




	
See Also:

For more information about WebCenter Spaces user interface URLs, see Appendix A, "WebCenter Spaces User Interface URLs."








	
Use the Spaces navigation. For details, proceed to step 3.





	
In your Home Space, click Spaces.




	
Tip:

The way you access this page depends on the page template in use. For example, in a top navigation template, you may access it through a Spaces menu (Figure 10-8).
See also Section 29.3.1, "Opening Spaces."










Figure 10-8 Accessing a Space

[image: Accessing a Space]






	
On the Spaces page, select the required Space.


	
Display the Space administration page.




	
Tip:

The way you access the Space administration pages depends on the page template in use. For example, in a top navigation template, you may access Space administration pages through a Manage menu (Figure 10-9).
You can also navigate to these pages using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."










Figure 10-9 Manage Menu in a Top Navigation Template

[image: Manage Menu in a Top Navigation Template]






	
Click the Resources tab.

The Resources page for the selected Space displays, as shown in Figure 10-10.


Figure 10-10 Resources Page of a Space

[image: Resources page of a Space]















10.1.5 Viewing Information About a Resource

Each resource has an associated About dialog that summarizes useful information about it. For information about the properties displayed in the About dialog, see Section 10.4.2.1, "What You Should Know About a Resource's Properties."

You cannot edit the properties displayed in the About dialog of a resource.

To access the About dialog of a resource:

	
Navigate to the Resources page of the application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the navigation panel on the left, select the resource type.


	
From the list of resources displayed on the right, select the resource whose details you want to view.


	
On the menu bar, click About.

The About dialog displays, showing the properties related to the selected resource (Figure 10-11).


Figure 10-11 About Dialog of a Resource

[image: About dialog of a resource]















10.2 Creating Resources

This section includes the following subsections:

	
Section 10.2.1, "What You Should Know About Resource Creation"


	
Section 10.2.2, "Creating a Resource"






10.2.1 What You Should Know About Resource Creation

In WebCenter Spaces, you can create certain resources from scratch, and there are certain resources that you can create only by making a copy of an existing resource. For example, you can create a task flow from scratch, but you can create a skin only by making a copy of an existing skin. Further, there are certain resources, such as Content Presenter templates, that WebCenter Spaces restricts you from creating.

Table 10-1 describes the support available for creating various resources in WebCenter Spaces.


Table 10-2 Support for Creating Resources in WebCenter Spaces

	Resource	Can You Create the Resource in WebCenter Spaces?	How can the Resource be Created?
	
Page Templates

	
Yes

	
Only by extending another page template


	
Navigations

	
Yes

	
From scratch or by extending another navigation resource


	
Resource Catalogs

	
Yes

	
From scratch or by extending another Resource Catalog


	
Skins

	
Yes

	
Only by making a copy of another skin


	
Page Styles

	
No

	
(Not applicable)


	
Content Presenter templates

	
No

	
(Not applicable)


	
Mashup styles

	
No

	
(Not applicable)


	
Data Controls

	
Yes

	
Only from scratch


	
Task flows

	
Yes

	
Only from scratch












10.2.2 Creating a Resource

To create a resource in WebCenter Spaces:




	
Note:

The procedure for creating a data control is different than other resources. For information about how to create a data control, see Chapter 26, "Creating Business Mashups."







	
Navigate to the Resources page of your application or the Space in which you want to create a resource, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
On the menu bar, click Create.


	
In the Create dialog, in the Name field, enter the name of the resource.


Figure 10-12 Creating a Resource

[image: Creating a Resource]






	
In the Description field, enter a description of the resource.


	
From the Copy from list, select the existing resource that you want to extend for creating a new resource.




	
Note:

The Copy From list is available only for page template, navigation, Resource Catalog, and skin resources. It is not available for a data control or task flow resource.
For a task flow resource, you need to select the page layout. For information, see Section 26.3.1, "Creating a Task Flow."










	
Click Create.

The newly created resource is listed on the Resources page. The gray icon next to a resource indicates that it is not yet published and hence not available to users for use. For information about publishing resources, see Section 10.4.3, "Showing and Hiding Resources."











10.3 Editing Resources

This section includes the following sections:

	
Section 10.3.1, "What You Should Know about Resource Editing"


	
Section 10.3.2, "Editing the Source Code of a Resource"


	
Section 10.3.3, "Editing a Resource by Using the Edit Dialog"






10.3.1 What You Should Know about Resource Editing

WebCenter Spaces enables you to edit custom resources. WebCenter Spaces supports two types of resource editing:

	
Simple editing - provides a simple means of editing a resource's basic settings. Use the Edit dialog to perform simple editing.


	
Source editing - enables you to work with the source code of a resource. Use the Edit Source dialog to perform source editing.

You may want to edit a resource's source file to make advanced edits to its code without having to download the file, edit it in JDeveloper, and upload it back into WebCenter Spaces. You can even use the Edit Source option to create a resource from the beginning—by creating a resource and then replacing its default source code with your own original code. Note, however, that, due to the heavy hand-coding requirement, this scenario is not recommended.




You cannot edit built-in resources. If you want to modify a built-in resource, consider creating a copy of the resource and then editing the copy according to your preferences.

Oracle WebCenter supports round-trip development of resources. To get enhanced functionality for your resources, you can download your resource, edit it in JDeveloper, and then upload it back into Spaces. For information, see Section 10.5, "Using JDeveloper to Build WebCenter Spaces Resources."






10.3.2 Editing the Source Code of a Resource

Use the Edit Source dialog to get more control over resource editing at runtime. You can edit the underlying source code of any custom resource except data controls. Changes made to a resource are saved to the MDS, and are made available immediately.

To edit the source code of a resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
On the Resources page, from the navigation panel on the left, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource whose code you want to edit.


	
From the Edit menu, choose Edit Source.

The Edit Source dialog displays the resource definition.


	
Edit the code as required.

The XML syntax in the code is validated and an error message is displayed if you miss any tags or add them incorrectly. Validation is not performed for non-XML files, such as a CSS file.

Figure 10-13 shows the sample source code of a skin's CSS file.


Figure 10-13 Editing the Source Code of a Resource

[image: Editing the source of a resource]






	
Click OK.









10.3.3 Editing a Resource by Using the Edit Dialog

Use the Edit dialog to make simple changes to your resource. The properties displayed in the Edit dialog vary from resource to resource. For information about editing a resource, refer to the resource-specific chapter listed in Table 10-1.








10.4 Managing Resources

This section includes the following subsections:

	
Section 10.4.1, "Copying a Resource"


	
Section 10.4.2, "Setting Properties on a Resource"


	
Section 10.4.3, "Showing and Hiding Resources"


	
Section 10.4.4, "Setting Security for a Resource"


	
Section 10.4.5, "Deleting a Resource"


	
Section 10.4.6, "Previewing a Resource" 


	
Section 10.4.7, "Querying for a Resource Through the Expression Builder"


	
Section 10.4.8, "Applying Resources Dynamically Using EL Expressions"






10.4.1 Copying a Resource

WebCenter Spaces enables you to create a copy of a resource. This feature is useful when you want to:

	
Create a backup of a resource.


	
Update a resource while keeping the original in use.


	
Use a built-in resource as a sample to build a new resource. Built-in resources cannot be edited, but you can create a copy of a resource to use it as a starting point for further refinement.




You can create a copy of all types of resources except Content Presenter templates. When you create a copy of a resource, the copy is marked as hidden.

To make a copy of a resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource whose copy you want to create.


	
From the Edit menu, choose Copy.


	
In the Copy dialog, in the Display Name field, enter a name for the resource copy (Figure 10-14).


Figure 10-14 Copying a Resource

[image: Copying a resource]






	
In the Description field, enter a description of the resource copy.


	
Click OK.









10.4.2 Setting Properties on a Resource

Each resource has certain associated properties that define its display properties, availability, and attributes. This section describes how to access and modify these properties for custom resources. It includes the following sections:

	
Section 10.4.2.1, "What You Should Know About a Resource's Properties"


	
Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource"


	
Section 10.4.2.3, "Renaming, Describing, and Categorizing a Resource"


	
Section 10.4.2.4, "Associating an Icon with a Resource"


	
Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces"


	
Section 10.4.2.6, "Working with the Attributes of a Resource"






10.4.2.1 What You Should Know About a Resource's Properties

Use the Edit Properties dialog to edit the properties associated with custom resources. The Edit Properties dialog contains these sections: General, Exclude Resource Usage, and Attributes.


General Section

The General section displays details such as the resource's name, location, and internal ID. These properties are common across all resources.

Table 10-1 describes the properties listed in the General section.


Table 10-3 Properties in the General Section of the Edit Properties Dialog

	Property	Description
	
Display Name

	
Specify the name of a resource.


	
Description

	
Enter the description of a resource.


	
Icon URI

	
Specify the URI of the icon that you want to associate with a resource.


	
Category

	
Specify the category, like Sales, that you want to associate with a resource.


	
Resource Type

	
Displays the type of the resource. For example, for a page style resource, the resource type is pageStyle.


	
Internal ID

	
Displays the unique internal identification number assigned to a resource in WebCenter Spaces.


	
Content Directory

	
Displays the path where dependent objects of a resource, such as images, are stored on the managed server to which WebCenter Spaces is deployed.


	
JSPx File

	
Displays the path to the .jspx file of a resource.


	
Page Definition

	
Displays the path where the page definition (.xml file) of a resource is stored on the WebCenter Spaces server. Page definitions are used for page templates, task flows, page styles, and mashup styles.


	
Metadata File

	
Displays the path where metadata files, if any, of a resource are stored on the WebCenter Spaces server.


	
Created By

	
Displays the name of the user who created a resource.


	
Date Created

	
Displays the date and time when a resource was created.


	
Modified By

	
Displays the name of the user who last modified the resource.


	
Date Modified

	
Displays the date and time when a resource was last modified.









Exclude Resource Usage Section

When an application-level resource is marked as available, it becomes available to all Spaces and a Home Space. WebCenter Spaces gives you the control to choose whether that resource is available in a Home Space and all Spaces, or only in selected Spaces. Use the controls in the Exclude Resource Usage section to prevent or promote the display of a selected custom resource (Figure 10-15).

You can set availability of custom resources only at the application level. The Exclude Resource Usage section is not available in a Home Space and Spaces.


Figure 10-15 Setting Availability of a Resource in Other Spaces

[image: Setting availability of a resource in other Spaces]







Attributes Section

The Attributes section (Figure 10-16) lists the attributes associated with a resource. The attributes displayed in the Attributes section vary from resource to resource. For example, while a page template does not have any default attributes, skins have the following default attributes: skinFamily, skinId, and skinExtends.


Figure 10-16 Attributes of a Resource

[image: Custom attributes of a resource]






Attributes determine the behavior of a resource. For example, editPageAfterCreation is a custom attribute of the page style resource and controls whether a newly created page opens in edit or view mode. It takes a value of true or false. When you associate this attribute with a particular page style, every time a user creates a page based on the selected style, the attribute value is considered and the page behaves accordingly.

You can add, edit, or delete attributes as described in Section 10.4.2.6, "Working with the Attributes of a Resource." For information about resource-specific attributes, if any, refer to the relevant chapter listed in Table 10-1.






10.4.2.2 Accessing the Edit Properties Dialog of a Resource

To access the Edit Properties dialog of a resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
From the left navigation panel, select the type of resource you want to edit.


	
From the list displayed on the right, select the relevant resource, and from the Edit menu, choose Edit Properties.

The Edit Properties dialog opens (Figure 10-17).


Figure 10-17 Edit Properties Dialog of a Resource

[image: Edit Properties dialog of a resource]











	
See Also:

The next thing you do depends on what you want to accomplish. For more information, see:
	
Section 10.4.2.3, "Renaming, Describing, and Categorizing a Resource"


	
Section 10.4.2.4, "Associating an Icon with a Resource"


	
Section 10.4.2.5, "Setting the Availability of an Application-Level Resource in Other Spaces"


	
Section 10.4.2.6, "Working with the Attributes of a Resource"

















10.4.2.3 Renaming, Describing, and Categorizing a Resource

Resources, whether built-in or custom, are sorted on the Resource page according to their display names. To maintain a well-organized set of resources, consider developing a standard naming scheme and method of description. This is not a required step, but it may be useful in identifying and clarifying your intended purpose for a given resource.

You can classify your resources into relevant groups. For example, all page styles associated with Sales could have a sales category. This value is available and exposed only in the Edit Properties dialog.

To provide a name, description, and category for a resource:

	
Open the Edit Properties dialog for the desired resource as described in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Display Name field, edit the display name for the resource, if required.


	
Optionally, in the Description field, enter a description of the resource.


	
Optionally, in the Category field, enter a category name.


	
Click OK to save your changes and exit the dialog.









10.4.2.4 Associating an Icon with a Resource

You can associate an icon with a resource. In the current version of WebCenter Spaces, the associated icon is visible only for page styles when you create a page using the Create dialog.

To associate an icon with a resource:

	
Open the Edit Properties dialog for the desired resource as described in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Icon URI field, enter a standard URI path to the icon.




	
Note:

You can either specify an absolute URL (where the URL should also work if entered in a browser address field), or a relative URL that points to an image located somewhere in WebCenter Spaces. To store an image in Spaces, you must upload the required file using the Documents service, as described in Section 41.8.1, "Uploading New Files." You can then obtain the image's URL by copying the Download URL value as described in Section 41.24.1, "Retrieving the URL for a Folder or File."








	
Click OK to save your changes and exit the dialog.









10.4.2.5 Setting the Availability of an Application-Level Resource in Other Spaces

Use the Exclude Resource Usage section of the Edit Properties section to set the availability of an application-level resource in a Home Space or a Space. The Exclude Resource Usage section is available only at the application level, and not in a Home Space or any other Spaces.

To set the availability of an application-level resource in Home Spaces and other Spaces:

	
Open the Edit Properties dialog for the desired resource as described in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
Under Exclude Resource Usage:

	
For the Exclude From Home Space checkbox:

	
Select to hide the resource on the Resources page of Home Spaces


	
Clear to show the resource on the Resources page of Home Spaces





	
For Exclude From Space(s), choose:

	
Include in All Spaces - to make the resource available on the Resources page of all Spaces


	
Exclude from All Spaces - to exclude the resource from being listed on the Resources page of all Spaces


	
Exclude from Selected Spaces - to specify the Spaces on whose Resources page the resource will not be listed

When you select this option, an Add/Choose link appears (Figure 10-18).


Figure 10-18 Exclude Resource Usage Section

[image: Exclude Resource Usage section]






Clicking this link displays the Add Space dialog. Select the Spaces from which to exclude the resource and click OK (Figure 10-19).

A list of the selected Spaces is displayed in the Edit Properties dialog.


Figure 10-19 Excluding a Resource from Selected Spaces

[image: Excluding a resource from selected spaces]












	
Click OK to save your changes and exit the Edit Properties dialog.









10.4.2.6 Working with the Attributes of a Resource

This section describes how to associate a custom attribute with a resource and how to remove a custom attribute. It contains the following sections:

	
Section 10.4.2.6.1, "Associating an Attribute with a Resource"


	
Section 10.4.2.6.2, "Deleting an Attribute of a Resource"






10.4.2.6.1 Associating an Attribute with a Resource

To associate an attribute with a resource:

	
Follow the steps outlined in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Attributes section, in the Name field, enter the attribute name (Figure 10-20).


Figure 10-20 Adding an Attribute

[image: Adding an Attribute]






For information about the attributes, if any, that can be associated with a resource, refer to the resource-specific chapter listed in Table 10-1.


	
In the Value field, enter the value of the attribute.


	
Click Add More if you want to add more attributes.

This adds a new row. You can then enter the required details in the Name and Value fields.


	
Click OK to save your changes and exit the dialog.









10.4.2.6.2 Deleting an Attribute of a Resource

To remove an attribute associated with a resource:

	
Follow the steps outlined in Section 10.4.2.2, "Accessing the Edit Properties Dialog of a Resource."


	
In the Attributes section, click the Remove icon displayed next to the attribute you want to delete.


	
Click OK to save your changes and exit the dialog.













10.4.3 Showing and Hiding Resources

This section includes the following subsections:

	
Section 10.4.3.1, "What You Should Know About Showing and Hiding Resources"


	
Section 10.4.3.2, "Showing a Resource"


	
Section 10.4.3.3, "Hiding a Resource"






10.4.3.1 What You Should Know About Showing and Hiding Resources

All resources, whether built-in or custom, can be marked as hidden or available. For all resources that are available for use, a green tick mark and the word "Available" appear next to the resource's name on the Resources page. A gray icon and the word "Hidden" next to a resource's name indicates that the resource is marked as hidden, as shown in Figure 10-21.


Figure 10-21 Showing or Hiding a Resource

[image: Showing or hiding a resource]






When you create or upload a resource, by default the resource is marked as hidden. A hidden application-level resource is not available for selection in the resource picker in the application, Spaces, or Home Spaces. Similarly, a hidden Space-level resource is not listed in the resource picker in that Space. For a resource to become available in the resource picker, it must be published.

You can use a hidden resource for creating a new resource. For example, Figure 10-22 shows that the page template MySpaceTemplate is marked as hidden. But it is listed in the Copy from list when you create a new page template. Figure 10-23 shows the list of all page templates that are available for use. Note that MyTemplate is not listed there.


Figure 10-22 A Hidden Resource Available for Creating a New Resource

[image: A Hidden Resource Available for Creating a New Resource]







Figure 10-23 A Hidden Resource Not Listed in the Resource Picker

[image: A Hidden Resource Not Listed in the Resource Picker]










10.4.3.2 Showing a Resource

To mark a hidden resource as available:

	
Navigate to the Resources page of the application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
From the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource that you want to mark as available.


	
From the Edit menu, choose Show.

A green checkmark and the word "Available" appear next to the resource's name, indicating that the resource is available for use.









10.4.3.3 Hiding a Resource

To hide a resource:

	
Navigate to the Resources page of the application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource that you want to hide.


	
From the Edit menu, choose Hide.

A gray icon and the word "Hidden" appear next to the resource's name, indicating that the resource is now hidden and is not available to users.











10.4.4 Setting Security for a Resource

You can control whether all users or only specific users or groups can access the custom resources that you created in the application. By default, resource access is controlled by application-level permissions (see Section 10.1.3, "Permissions Required to Work with Resources"). After you define resource-specific permissions, the permissions defined at the application or Space level no longer apply.

To set access permissions for a resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired type of resource.


	
From the list of resources displayed on the right, select the resource for which you want to set access permissions.


	
From the Edit menu, choose Security Settings.


	
In the Security Settings dialog, specify an access method by selecting either of the following (Figure 10-24):

	
Use Custom Permissions - Select this option to define who can manage and update the selected resource. When you select this option, the other controls in the dialog become available. Proceed to step 6.




	
Note:

When you choose Use Custom Permissions, ensure that at least one user or group is granted the Manage access.








	
Use Spaces Security Settings - Select this option to inherit the selected resource's access settings from those defined for the application. After selecting this option, click OK to save your changes and exit the dialog.




	
Note:

Selecting Use Spaces Security Settings removes any custom permissions that you may have set.











Figure 10-24 Setting Security for a Resource

[image: Setting security for a resource]






	
If you selected, Use Custom Permissions, specify the user or group to whom you want to grant resource access. In the Security Settings dialog:

	
Click Add Users to open a dialog that you can use to search for and select individual users available in your identity store. Enter the characters from the name of your search target. For example, the search term 'do' finds all user names starting with 'do' such as 'don' and 'doug'. If you wish to search for a user name like 'condoleeza', then use '*' in the beginning, like '*do'.

Select the required user(s), and click OK to close the dialog.


	
Click Add Groups to open a dialog that you can use to search for and select groups of users available in your identity store. Select the required group(s), and click OK to close the dialog.





	
For each user or user group listed in the Role or User column, specify the level of access you want to grant:

	
Select the Manage checkbox to grant full access on the resource. Such users can perform tasks such as edit, delete, grant access, show or hide, and the like.


	
Select the Update checkbox to grant the permission to edit the resource. Such users can edit the resource, but they cannot delete it.





	
If you want to revoke permissions from any user or user group, select that entity and click Delete Access.


	
Click OK.









10.4.5 Deleting a Resource

When a resource is no longer required, you may want to remove it. In WebCenter Spaces, you can delete custom resources, but not built-in resources.




	
Note:

Before you use delete a resource, you must ensure that the resource is not in use. If you mark a resource for deletion, WebCenter Spaces will delete it even if it is in use.







To delete a custom resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired resource type.


	
From the list of resources displayed on the right, select the resource you want to delete.


	
From the Edit menu, choose Delete.


	
In the Delete confirmation dialog, click Delete to delete the resource.









10.4.6 Previewing a Resource

WebCenter Spaces provides a means of previewing certain resources—page templates, mashup styles, and task flows. You can use the Preview option to preview a resource and make adjustments, if required.

To preview a resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
From the left navigation panel, select the desired resource type.


	
From the list of resources on the right, select the resource you want to preview.


	
Click Preview.




	
Note:

The Preview option is not available for all resources. For information about a particular resource, refer to the resource-specific chapter listed in Table 10-1.















10.4.7 Querying for a Resource Through the Expression Builder

You can access any resource anywhere in WebCenter Spaces through Expression Language (EL) expressions.

For example, the following EL expression returns the first template resource found with a display name myPage:

#{srmContext.resourceType['siteTemplate'].displayName['myPage'].singleResult}

You must set query parameters in the format .property['value'], where property is the name of the resource property, for example, it can be id or resourceScope, and value is the value of that property you want to search for.

For information about EL expressions that you can use to query resources, see Section B.3.5, "EL Expressions Relevant to Resources."






10.4.8 Applying Resources Dynamically Using EL Expressions

WebCenter Spaces provides a way to dynamically apply certain resources at runtime based on some criteria. For example, you can present content or shape the way content is presented by using Personalization-related ELs to select and apply a page template based on whoever is the current user.

Consider an example where you want the top-navigation page template to be displayed to Space moderators, and a side-navigation page template to be displayed to other users. Figure 10-25 shows a sample EL expression that you can use in such scenario. The EL expression uses the resource IDs of the page templates.


Figure 10-25 Specifying an EL Expression for Applying a Page Template Based on User Role

[image: Specifying the Expression Builder statement]






Instead of using the exact resource ID of the resource that you want to apply, you can also include queries in an EL expression as shown in the following example.


#{WCSecurityContext.userInScopedRole['Moderator'] ?  srmContext.resourceScope['space_name'].resourceType['siteTemplate'].displayName['Top'].singleResult.id :
 srmContext.resourceScope['space_name'].resourceType['siteTemplate'].displayName['Side'].singleResult.id}


Figure 10-26 shows how a Space may appear to a Space Moderator, and Figure 10-27 shows how the Space may appear to other users.


Figure 10-26 A Page Template Dynamically Applied for Space Moderators

[image: A Page Template Dynamically Applied for Space Moderators]







Figure 10-27 A Page Template Dynamically Applied for Other Users

[image: A Page Template Dynamically Applied for Other Users]






You can also use EL expressions to execute personalization server scenarios, as described in Appendix B, "EL Expressions Relevant to the Personalization Conductor." For information about common EL expressions that you can use, see Appendix B, "Expression Language Expressions."

To dynamically apply a resource at runtime:

	
Note down the Internal ID of the required resource from its About dialog. For information about how to access this dialog, see Section 10.1.5, "Viewing Information About a Resource."


	
Access the WebCenter Spaces Administration page as described in Section 4.1, "Accessing the WebCenter Administration Page," and open the General sub page of the Configuration page. Or, access the Space administration page as described in Section 51.3, "Accessing Space Administration Pages," and open the General page.




	
Tip:

You can use "pretty URLs" to navigate to the settings page:
	
Application-level Configuration page:


http://host:port/webcenter/spaces/admin/general


	
Space-level General page:


http://host:port/webcenter/spaces/spaceName/admin/general













	
Click the icon next to the desired resource field, then click Expression Builder to open the editor.


Figure 10-28 Using the Expression Builder for a Resource

[image: Using the Expression Builder for a Resource]






	
Select the Type a value or expression radio button, if not already selected.


	
Type the required expression builder statement.


Figure 10-29 Expression Editor Dialog

[image: Specifying the Expression Builder statement]






For example, if you want to display different page templates depending on whether the page is rendered in a browser on a Windows platform or on a mobile device, you can use the following EL expression:

#{requestContext.agent.platformName=='windows' ? 'gsr3396194a_3a72_44d6_90b4_57fd6efe4ff7' : 'gsr1472d17b_8f10_4689_89fb_7431f561567f'}

This EL expression is an 'if-then-else' statement. The EL requestContext.agent.platformName retrieves the platform information. The page template IDs are the ones noted down from the About dialog.


	
Click Apply.











10.5 Using JDeveloper to Build WebCenter Spaces Resources

This section includes the following subsections:

	
Section 10.5.1, "What You Should Know About Building Spaces Resources in JDeveloper"


	
Section 10.5.2, "Downloading a Resource"


	
Section 10.5.3, "Uploading a Resource"






10.5.1 What You Should Know About Building Spaces Resources in JDeveloper

You may find yourself in a situation where you want to edit or create resources beyond the capabilities of WebCenter Spaces. Oracle WebCenter provides features for round-trip development of WebCenter Spaces resources. To further enhance your existing resources, you can download them from WebCenter Spaces, edit them at a really fine level of granularity in an IDE like JDeveloper, and then upload the updated resources back into WebCenter Spaces. You can upload resources directly to WebCenter Spaces from within Oracle JDeveloper or through WebCenter Spaces.

In JDeveloper, you can also create resources from scratch for the purpose of using them in WebCenter Spaces. However, you do not necessarily need to start from scratch. An efficient way is to make a copy of an existing Spaces resource and refine it further in JDeveloper without worrying about the prerequisites involved in creating it from scratch in JDeveloper. Oracle WebCenter provides a special JDeveloper workspace (DesignWebCenterSpaces.jws) to help you develop and upload resources to WebCenter Spaces. For more information about editing custom resources and uploading them into WebCenter Spaces through JDeveloper, see "Designing WebCenter Spaces Resources in JDeveloper" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.

When you download a resource, its configuration is saved into an export archive (.ear file). You can save the export archive either to your local file system or a remote server file system.

When you upload resources to WebCenter Spaces:

	
Existing resources, that is, resources with the same internal ID, are overwritten.


	
Space-level resources are uploaded back only into their original Space. You cannot upload a Space-level resource into a different Space.


	
Resources must be in an export archive (.ear) format on your local file system or a remote server









10.5.2 Downloading a Resource

To download a resource:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired resource type.


	
From the list of resources displayed on the right, select the resource you want to download as an EAR file.


	
Click Download.


	
In the Download dialog, in the Archive Name field, enter the name of the export archive file.


	
Click Download.


	
In the Download dialog, specify where you want to save the export archive file. Use either of the following options (Figure 10-30):

	
Download - Click this if you want to save the export archive file to your local file system. Then, specify the path where you want to save the file.


	
Save to Server - Click this to save the export archive file to a remote server file system. In the Server Location dialog, in the Save to Location field, enter the server path and then click Save.


Figure 10-30 Download Dialog

[image: Download Dialog]














	
Note:

Space administrators can download resources using the WLST command, exportResources. For information, see section "Exporting WebCenter Resources Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.












10.5.3 Uploading a Resource

To upload a resource in WebCenter Spaces:

	
Navigate to the Resources page of your application or the desired Space, as described in Section 10.1.4, "Accessing Resources."


	
In the left navigation panel, select the desired resource type.


	
Click Upload.


	
In the Upload dialog, specify the location of the resource archive file. Depending on the location of your EAR file, select either of the following (Figure 10-31):

	
On Local File System: Select if the archive is located on your local file system. Enter the path to the EAR file or use the Browse button.


	
On Server: Select if the archive is located on a remote server. Enter the path to the EAR file.


Figure 10-31 Upload Dialog
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Click Upload.







	
Note:

Space administrators can upload resources using the WLST command, importResources. For information, see section "Importing WebCenter Resources Using WLST" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.













50 Working with Space Templates

If you have been granted the Spaces-Create permission by the WebCenter Spaces administrator, you can create a Space using one of the out-of-the-box Space templates, your own custom Space template, or a published Space template created by others. Space templates provide a consistent look and feel and an efficient way to get started creating a Space that is configured exactly as required by an organization.

This chapter includes the following sections:

	
Section 50.1, "What You Should Know About Space Templates"


	
Section 50.2, "Creating a Custom Space Template"


	
Section 50.3, "Managing Space Templates"





Audience

This chapter is intended for users who want to know more about Space templates, create custom Space templates, and manage Space templates.

The WebCenter Spaces administrator has the authority to expose or hide some Space features and services. Contact your WebCenter Spaces administrator if some tasks discussed in this chapter are not available to you.



50.1 What You Should Know About Space Templates

When you create a Space, you can base it on a template, either provided out-of-the-box by WebCenter Spaces or a custom template that you or the WebCenter Spaces administrator design, as described in the following sections:

	
Section 50.1.1, "Understanding Out-of-the-Box Space Templates"


	
Section 50.1.2, "Understanding Custom Space Templates"






50.1.1 Understanding Out-of-the-Box Space Templates

WebCenter Spaces provides several Space templates out-of-the box from which you can choose when creating a new Space. These templates are named according to their general purpose, and can be used as a starting point for developing your own custom templates.

The out-of-the-box Space templates are:

	
Blogger: Template for a Space where members can publish their opinions through blogs, and preconfigures announcements, discussions, documents, events, lists, and mail.


	
Discussion Site: Template for a Space where members can exchange ideas in discussion forums to quickly resolve issues, come up with new product ideas, resolve customer escalations, determine new service offerings, and more.


	
Document Exchange: Template for a Space centered around sharing and organizing documents to enable teams to quickly hone in on delivering agreed upon wording and messaging. This template also enables checkin and workflow around document approvals and working in teams.


	
Portal Site: Template for a Space appropriate for a large organization with several smaller groups or departments, each of which needs to store their own content, engage in discussions, and more. This template speeds enterprise portal construction and delivery and enables teams to easily provide their unique value to the company, promoting their group's charter to all other organizations while securely collaborating within their team or organization.

This template provides an essentially unpopulated, unconfigured starting point for building a Space exactly to your specifications. When you create a Space using this template, it results in a blank Home page. All Space services such as discussions, announcements, and so on, are disabled.


	
Project Site: Template for a Space where members can share information about a common project and maintain a common calendar. This template provides an optimal structure for supporting a core project team where members might come from different departments to work together toward reaching a common goal.

The focus of a Space based on this template is to streamline the process of starting a new project, defining the project team, and executing on project deliverables. Members can share documents, communicate with one other, keep up to date on status, and generally function better as a team than as individuals working side by side.


	
Team Site: Template for a Space that provides an optimal structure for supporting communities of people who are working together to achieve a common goal, collaborating through document sharing, team announcements, discussion forums, mail, wikis, and more.

The focus of a Space based on this template is to learn more about a subject area through the sharing of expertise, ideas, and content. Team Site Spaces provide a consistent, dynamic, timely, and interactive participant experience. For example, all the Java programmers responsible for supporting your customer-facing Web site might want a place to keep up with what's happening in the Java world using discussion forums, links to articles about upcoming patches, and so on.







	
Note:

The out-of-the-box Space templates available in prior releases (Basic, Community of Interest, and Group Project) are deprecated. However, if needed, you can expose them in your WebCenter Spaces application by following the steps in "Exposing WebCenter Spaces Templates From a Previous Release" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.












50.1.2 Understanding Custom Space Templates

A custom Space template may be simple, or may include robust functionality such as:

	
Preseeded data, such as discussions, documents, lists, member information (including roles), pages, or site resources. When you select such a template to build a new Space, the new Space includes all the preseeded data.


	
Custom java code that executes when you select the template for a new Space. For example, custom code may include logic to automatically create a mailing list for a new Space. For more information, see the chapter "Extending WebCenter Spaces Using JDeveloper" in Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.











50.2 Creating a Custom Space Template

You cannot modify or delete the out-of-the-box Space templates described in Section 50.1, "What You Should Know About Space Templates", but any user with Create Space Template or higher permission can create new Space templates.

To create a custom Space template, you start by creating a Space based on an existing template (see Section 51.2, "Creating a New Space"), and customize it according to your requirements. Then, you can create a new Space template based on the customized Space that you have developed. During the creation of a Space template, you can select to inherit the discussions, documents, lists, member information (including roles), pages, or site resources from the parent Space. The security settings for the parent Space are inherited by the template




	
Note:

When creating a new Space template, the template does not inherit announcements from a parent Space.







As a Space template creator, you can publish Space templates for others to use; otherwise, they remain private and hidden from others. To make the template public, you must be granted Space Templates-Manage All permission.




	
Note:

WebCenter Spaces administrators can also create Space templates to be made available at the application level, and import and export custom Space templates from and to other WebCenter Spaces applications, including seeded data. For more information, see Chapter 53, "Administering Spaces and Templates."







To create a Space template:

	
In the Home Space, go to the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates").


	
On the Space Templates page, click Create a Space Template.

The Create a Space Template dialog opens (Figure 50-1).


Figure 50-1 Create a Space Template Dialog: Setup Step

[image: Create a Space Template Dialog: Setup Step]






	
In the Setup step, enter a suitable Space Template Name and (optionally) Description. Choose a name that describes the Space template and other WebCenter Spaces users will recognize.

Space template names can contain alphanumeric characters, underscores, spaces, multi-byte characters, and special characters such as & and #. The maximum allowable length is 200 characters. The following reserved keywords are not allowed as the full Space template name either in upper or lowercase, or a combination of both—webcenter, pages, page, spaces, space, group, groups, Space, Spaces, webcenter space, webcenter spaces, webcenter administration, my Spaces, admin, last. These reserved words are allowable as part of a longer name (for example, Sales Group).


	
Click Next.


	
In the Spaces step, select a Space to use as the basis for your new Space template, then click Next.


	
In the Content step, select the services that contain data that you want the Space template to inherit from the parent Space (Figure 50-2).




	
Note:

Space templates can not inherit Announcements from a parent Space.
List definitions are always copied; checking Lists in this step specifies that you want to copy the list data, too.










Figure 50-2 Create a Space Template Dialog: Content Step

[image: Create a Space Template Dialog: Content Step]



	
Click Create.




	
Note:

If an error message notifies you that the template creation failed because selected services could not be provisioned, the most likely cause is that backend servers (such as UCM or JIVE server) are down. Contact your WebCenter administrator to resolve this issue.







The new Space template displays on your Space Templates page in the Home Space. By default, the template is private, which means that only you as the template creator can see the template on your personal Space Templates page in the Home Space. Other users will not see the private template on their personal Space Templates page in the Home Space, but users granted the Application-Manage Configuration permission can view and manage private templates on the application-level Space Templates page. For more information, see Chapter 53, "Administering Spaces and Templates."


	
To publish your Space template to make it available to all WebCenter Spaces users, you must be granted the Space Templates-Manage All permission by the WebCenter Spaces administrator. If you have this permission, select the template name, then click the Edit menu, and choose Make Public.

The template is published and displays on the Space Templates page in the Home Space for all users.









50.3 Managing Space Templates

You cannot modify or delete the out-of-the-box Space templates provided by WebCenter Spaces (see Section 50.1.1, "Understanding Out-of-the-Box Space Templates"), but any user with Create Space Template or higher permission can create new Space templates, based on Spaces that they own (see Section 50.2, "Creating a Custom Space Template"), and manage the Space templates that they own.

The Space Templates page in the Home Space displays the out-of-the-box Space templates, Space templates created by the current user, and published templates available for general use.

The following sections describe the management tasks available to Space template creators, WebCenter Spaces administrators, and users granted the Space Templates - Manage All permission by the WebCenter Spaces administrator:

	
Section 50.3.1, "Viewing Available Space Templates"


	
Section 50.3.2, "Searching for a Space Template"


	
Section 50.3.3, "Renaming a Space Template"


	
Section 50.3.4, "Setting Up Access to a Space Template"


	
Section 50.3.5, "Publishing or Hiding Space Templates"


	
Section 50.3.6, "Deleting Space Templates"






50.3.1 Viewing Available Space Templates

To display the Space Templates page, showing the Space templates available to you for creating new Spaces:

	
In the Home Space, click Space Templates.




	
Tip:

The way you access this page depends on the page template in use. For example, in a side navigation template, you may access it through a Personalize Pages link.
You can also navigate to this page using the direct URL provided in Section A.3, "User Interface URLs for Space Pages."









If Space Templates is not exposed In the Home Space, refer to Section 29.3.4, "Showing Hidden Pages."









50.3.2 Searching for a Space Template

To search for a Space template by a string in the Name or Description:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), enter a search string in the Filter field.


	
Click the Filter icon (Figure 50-3).


Figure 50-3 Filter Icon

[image: Filter Icon]



The Space Templates page displays Space templates where the search string is found in the Name or Description.


	
To clear the current search string and display all Space templates, click the Clear Filter icon (Figure 50-4).


Figure 50-4 Clear Filter Icon
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50.3.3 Renaming a Space Template

To rename a Space template:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the Space template.


	
From the Edit menu, choose Rename Space Template.

The Rename Space Template dialog opens.


	
In the Display Name field, enter a new name for the Space template. Optionally, enter a Description.


	
Click OK.









50.3.4 Setting Up Access to a Space Template

You can grant specific users and groups read-only or manage access to a Space template.

To set up access to a Space template:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the Space template.


	
From the Edit menu, choose Set Template Access.

The Set Template Access dialog opens (Figure 50-5).


Figure 50-5 Set Template Access Dialog
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In the Set Template Access dialog:

	
Click Add Users to open the Search Users dialog where you can select from a list of users or search for a user name. Enter—minimally—two consecutive characters from the name of your search target, using an asterisk as a wild card for preceding or following characters (the search term *do finds both condoleeza and doug).


	
Click Add Groups to open the Search Groups dialog where you can search for a user group.





	
For each user or user group listed in the Set Template Access dialog, specify the level of access granted to grant:

	
Select the View checkbox to grant read-only access to the Space template.


	
Select the Manage checkbox to grant full access to the Space template.





	
Click OK.









50.3.5 Publishing or Hiding Space Templates

When you create a Space template (see Section 50.2, "Creating a Custom Space Template"), it is private by default. This means that only you as the template creator can see the template on your personal Space Templates page in the Home Space. Other users will not see the private template on their personal Space Templates page in the Home Space, but users granted the Application-Manage Configuration permission can view and manage private templates on the application-level Space Templates page. For more information, see Chapter 53, "Administering Spaces and Templates."

To publish or hide Space templates that you create to make them available to all WebCenter Spaces users, you must be granted the Space Templates-Manage All permission by the WebCenter Spaces administrator. If you have this permission:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the Space template(s).

To select multiple Space templates, Ctrl-click each template.


	
From the Edit menu, choose either of the following, depending on the template's current state:

	
Make Public to publish the template to all WebCenter Spaces users.


	
Remove Public Access to hide the template from all other WebCenter Spaces users (except yourself, as the template creator).




	
Note:

If you are in the process of creating a new Space (see Section 51.2, "Creating a New Space"), and the Space template you select for the Space is made private by another user before you have completed creating the Space, the template remains valid for your use while you are still creating the Space.


















50.3.6 Deleting Space Templates

To delete one or more Space templates:

	
On the Space Templates page (see Section 50.3.1, "Viewing Available Space Templates"), select the Space template(s).

To select multiple Space templates, Ctrl-click each template.


	
From the Edit menu, choose Delete Space Template.

In the confirmation prompt, click Delete.







	
Note:

Out-of-the-box Space templates cannot be deleted. However, WebCenter Spaces administrators and users granted the Space Templates-Manage All permission can hide the out-of-the-box templates from everyone's view by making them private on the application-level Space Templates page, if granted the Application-Manage Configuration permission by the WebCenter Spaces administrator. For more information, see Chapter 53, "Administering Spaces and Templates."













Part XIII


Searching WebCenter and Other Sources

Part XIII of the User's Guide provides information about searching both WebCenter Spaces and sources outside of WebCenter Spaces. It includes information about creating your own search terms using the Tags service.

Part XIII includes the following chapters:

	
Chapter 56, "Working with the Search Service"


	
Chapter 57, "Working with the Tags Service"






39 Introduction to Adding and Managing Content




	
See Also:

For an overview of content management in WebCenter Spaces, see Section 2, "Leveraging Content Management."







In a WebCenter Spaces application, you can add content from one or more connected content repositories to the application in a variety of ways. You can use the Content Presenter task flow to precisely customize the selection and presentation of content, or you can use a Documents service task flow that suits your purposes for presenting content management functionality. You can also add individual folders and files to a page using links, images, or previews.

This chapter introduces the functionality available to add and manage content in a WebCenter Spaces application in the following sections:

	
Section 39.1, "What You Should Know About Adding and Managing Content"


	
Section 39.2, "What You Should Know About Content Management Selections in the Resource Catalog"





Audience

This chapter is intended for WebCenter Spaces users who want to learn about the functionality available in WebCenter Spaces to add and manage content using Content Presenter and the Documents service.



39.1 What You Should Know About Adding and Managing Content

WebCenter Spaces provides the following types of containers in which to display and manage content:

	
Content Presenter. Enables you to precisely customize the selection and presentation of content in a WebCenter Spaces application. The Content Presenter task flow is available only when the connected content repository is Oracle Content Server and your WebCenter Spaces administrator has completed the prerequisite configuration. With Content Presenter, you can select an Oracle Site Studio file, a single item of content, multiple content items, query for content, or select content based on the results of a WebCenter Personalization Conductor scenario, and then select a template to render the content on a page in a WebCenter Spaces application. Content Presenter has no dependency on the Documents service for adding or managing the content it displays.




	
Learn More:

For more information about Content Presenter, see Chapter 40, "Publishing Content Using Content Presenter."








	
Documents service task flows. Provide a variety of formats to display one or more folders and files. You can choose the task flows appropriate for your application to provide features for accessing, adding, and managing folders and files; configuring file and folder properties; and searching file and folder content. The Documents service task flows are available when the connected content repository is Oracle Content Server, Oracle Portal, or SharePoint, and your WebCenter Spaces administrator has completed the prerequisite configuration. If the content repository is Oracle Content Server, you can use both the Documents service task flows and the Content Presenter task flow to add and preview Oracle Site Studio files.




	
Learn More:

For information about the Documents Service task flows available in WebCenter Spaces, and the unique characteristics of each task flow, see Section 41.1, "What You Should Know About the Documents Service Task Flows."








	
Document components. Display an individual file on a page as a linked document, an inline preview, or an image.




	
Learn More:

For information about document components you can add to a page in a WebCenter Spaces application, see Section 41.2, "What You Should Know About Document Components."








	
Wikis. Add wiki documents for end users to collaborate to create content that is relevant, useful, and up-to-date.




	
Learn More:

For information about including wikis in a WebCenter Spaces application, see Chapter 47, "Working with Wiki Documents."








	
Blogs. Add blogs for end users to add, edit, and manage blog posts.




	
Learn More:

For information about including blogs in a WebCenter Spaces application, see Chapter 48, "Working with Blogs"















39.2 What You Should Know About Content Management Selections in the Resource Catalog

WebCenter Spaces users with permissions to edit pages use the Oracle Composer Resource Catalog to add content to a page.




	
Note:

The presence or location of the content selections in the Resource Catalog depends on how the Resource Catalog is configured. In the default Oracle Composer Resource Catalog, the Content Management section includes the content task flows and document components, as shown in Figure 39-1 and Table 39-1.








Figure 39-1 Resource Catalog in WebCenter Spaces: Content Management Section (when editing a Space page)

[image: Documents service task flows in WebCenter Spaces]



Table 39-1 describes the selections available in the Content Management section of the default Oracle Composer Resource Catalog:


Table 39-1 Content Management Selections in the Default Oracle Composer Resource Catalog

	Item	Task Flow?	Description and Use
	
All Content

	
No

	
A virtual node that exposes a list of all folders and files to which you have access. Click Open to drill down, or enter a file name in the Search field. When you reach the target folder or file, click Add to display a menu where you can choose how to display the folder or file. See Section 41.3, "Adding a Selected Folder or File to a Page."


	
Content Presenter

	
Yes

	
Available only when the content repository is Oracle Content Server. Displays the selected folders or files in a predefined template. See Chapter 40, "Publishing Content Using Content Presenter."


	
Document Explorer

	
Yes

	
Displays folders and files in two panes, combining the functionality of the Document Navigator and Folder Viewer task flows. Provides in-place previewing and editing, and robust management capabilities. See Section 41.1.1, "Understanding the Document Explorer Task Flow."


	
Document List Viewer

	
Yes

	
Displays folders and files in a single pane as a flat listing. Provides preview and editing in a separate window, and some management capabilities. See Section 41.1.2, "Understanding the Document List Viewer Task Flow."


	
Document Manager

	
Yes

	
Shown in the default Resource Catalog only if it has been added by the WebCenter Spaces administrator. Displays folders and files as specified by its Layout property: Explorer, Table, or Tree Table. See Section 41.1.3, "Understanding the Document Manager Task Flow."


	
Document Navigator

	
Yes

	
Shown in the default Resource Catalog only if it has been added by the WebCenter Spaces administrator. Displays a simple listing of folders and files in a single pane, providing expand/collapse on folders to show the full hierarchy. There are no menu options available for this task flow. See Section 41.1.4, "Understanding the Document Navigator Task Flow."


	
Folder Viewer

	
Yes

	
Displays the contents of a folder in a single pane as a flat listing, providing in-place preview and editing, and robust management capabilities. See Section 41.1.5, "Understanding the Folder Viewer Task Flow."


	
Space Documents

Personal Documents

	
No

	
A shortcut that exposes a list of folders and files associated with the current Space or your personal documents in the Home Space. Click Open to drill down, or enter a file name in the Search field. When you reach the target folder or file, click Add to display a menu where you can choose how to display the folder or file. See Section 41.3, "Adding a Selected Folder or File to a Page."











22 Enabling Self-Registration

WebCenter Spaces administrators can enable self-registration for the application. Through self-registration, invited and uninvited users can create their own login and password for WebCenter Spaces. This chapter describes how to enable self-registration. It contains the following sections:

	
Section 22.1, "What You Should Know About Self Registration"


	
Section 22.2, "Enabling Self-Registration By Invitation-Only"


	
Section 22.3, "Enabling Anyone to Self-Register"





Audience

The content of this chapter is intended for WebCenter Spaces administrators with the Application-Manage All permission.



22.1 What You Should Know About Self Registration

Self-registration allows users to create their own login and password for WebCenter Spaces. A user who self registers is immediately and automatically granted access to WebCenter Spaces and a new user account is created in the application's identity store.

If anyone is allowed to self-register, that is any public user, a Register link or button displays below the WebCenter Spaces login form. To enable this feature, see Section 22.3, "Enabling Anyone to Self-Register".

Self-registration by invitation is available too. This feature allows Space moderators to send out membership invitations to people who are not currently registered with WebCenter Spaces but might be interested in their Space. Before accessing the Space, invitees must create an account with WebCenter Spaces and their account details are added to the application's identity store. If approval is required, the moderator must approve their subscription request before gaining access to the Space. If the Space is public or further approval is not required, then new user gains access to the Space immediately he logs in for the first time. See also, Section 22.2, "Enabling Self-Registration By Invitation-Only".




	
Note:

If self-registration is not enabled in WebCenter Spaces, identity store management takes place through the WLS Administration Console (or directly into embedded LDAP identity stores using LDAP commands) and is the responsibility of your systems administrator. See also, "Adding Users to the Embedded LDAP Identity Store" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.







A self-registration page is supplied out-of-the-box. Users with the Administrator role can add new components to the page and change the page layout if required. See, Section 7.3, "Working with System Pages".

The self-registration page provided with WebCenter Spaces offers to send a "user name reminder email" to anyone who tries to register with an email address that has already been used (Figure 22-1).


Figure 22-1 Email Address Already Registered

[image: Email Address Aleady Registered]



This feature only works if public credentials are defined for the external application that is providing authentication for the Mail service in WebCenter Spaces. If users experience issues with this feature, ask your Fusion Middleware Administrator to check the mail server connection and its associated external application connection are configured correctly and that public credentials are defined. See also, "Registering Mail Servers" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter.






22.2 Enabling Self-Registration By Invitation-Only

Out-of-the-box, only existing WebCenter users are candidates for Space membership. While this might meet the needs of most WebCenter Spaces applications it is likely that some Spaces will want to recruit members outside of the WebCenter Spaces community.

The WebCenter Spaces administrator can extend Space membership to users outside of WebCenter Spaces by allowing them to self-register on an invitation-only basis. When this facility is enabled, moderators can invite anyone to join their Space by sending them a customizable invitation by mail. The invitation includes a secure, self-registration URL which the invited party clicks to accept Space membership.

New members recruited in this way must create an account with WebCenter Spaces before gaining access to the Space. Users who self-register by invitation are added to the identity store, and to the Space's member list.




	
Note:

Users who self-register by invitation will be assigned the default application role too—Authenticated-User. Out-of-the box, users with the Authenticated-User role have access to their own Home Space, pages that they create, and public pages. They are also allowed to view public Spaces, join any Space that allows self-subscription, and create Spaces of their own. When you enable self-registration, consider modifying Authenticated-User permissions to suit your exact requirements. See also, Section 21.2.3, "Modifying Application Role Permissions".







To allow external users to join Spaces:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages.".


	
Click Configuration, then General.


	
Select Allow Self-Registration Through Invitations (Figure 22-2).

When you deselect this option, only existing WebCenter users are candidates for Space membership.


Figure 22-2 Allowing Self-Registration Through Invitations

[image: Extending Group Space Subscription to Non-WebCenter Users]



	
Click Apply.




Moderators may invite non-WebCenter users to become members of their Space. See "Inviting a Non-WebCenter Spaces User" in Oracle Fusion Middleware User's Guide for Oracle WebCenter Spaces.






22.3 Enabling Anyone to Self-Register

When anyone is allowed to self-register, that is any public user, a Register link or Register button displays on the WebCenter Spaces login page (Figure 22-3).


Figure 22-3 Self-Registration Available on Login Form

[image: Self-Registration Available on Login Form]



New users must create an account before gaining access to the WebCenter Spaces application.

Users who self-register are added directly to the WebCenter Spaces identity store and assigned the Authenticated-User application role. Out-of-the-box, users with Authenticated-User role have access to their own Home Space, pages that they create, and public pages. They are also allowed to view public Spaces, join any Space that allows self-subscription, and create Spaces of their own. If you enable self-registration, consider modifying Authenticated-User permissions to suit your exact requirements. See Section 21.2.3, "Modifying Application Role Permissions".

To allow anyone to self-register with WebCenter Spaces:

	
Open WebCenter Spaces Administration.

For details, see Chapter 4, "Accessing WebCenter Spaces Administration Pages.".


	
Click Configuration, then General.


	
Select Allow Public Users to Self-Register (Figure 22-4).

When you deselect this option, public users cannot self-register with WebCenter Spaces. You still enable self-registration on an invitation-only basis if you want. See Section 22.2, "Enabling Self-Registration By Invitation-Only".


Figure 22-4 Allowing Self-Registration Through Invitations

[image: Extending Group Space Subscription to Non-WebCenter Users]



	
Click Apply.




See also, Section 29.2, "Registering Yourself with WebCenter Spaces".





44 Creating and Managing Content at Runtime

End users of a WebCenter Spaces application can create and manage content at runtime through the content task flows:

	
The Documents service task flows offer capabilities to create, open, edit, delete, copy, rename, move, share, search, view, and manage information about folders and files in any connected content repository. For more information about the Documents service task flows, see Section 41.1, "What You Should Know About the Documents Service Task Flows."


	
In a Content Presenter task flow, end users can edit wiki documents, HTML files, or Site Studio files in-context, and create new Site Studio files in the connected Oracle Content Server content repository. For more information about the Content Presenter task flow, see Section 40.1, "What You Should Know About the Content Presenter Task Flow."




This chapter offers pointers to the information that will assist you in creating and managing content at runtime using the content task flows.

To create and manage content at runtime using one of the Documents service task flows, refer to the steps in the following sections:

	
Section 41.6, "Personalizing Your View"


	
Section 41.9, "Opening a Folder"


	
Section 41.10, "Opening a File"


	
Section 41.7, "Creating a Folder"


	
Section 41.8.1, "Uploading New Files"


	
Section 41.8.2, "Creating a Wiki Document"


	
Section 41.12.1, "Checking a File Out"


	
Section 41.12.2, "Downloading a File"


	
Section 41.13, "Renaming a Folder or File"


	
Section 41.14, "Copying and Pasting Folders and Files"


	
Section 41.15, "Moving Folders and Files"


	
Section 41.16, "Deleting Folders and Files"


	
Section 41.17, "Refreshing Folder Contents"


	
Section 41.18, "Hiding and Showing Folders"


	
Section 41.19, "Working with Related Items (Tags, Links, and Recommendations)"


	
Section 41.20, "Viewing, Entering, and Deleting Comments on a File"


	
Section 41.21, "Viewing and Deleting File Version History"


	
Section 41.22, "Viewing and Modifying Folder and File Properties"


	
Section 41.23, "Opening or Saving PDF Files"


	
Section 41.24, "Sharing the URL for a Folder or File"


	
Section 41.25, "Setting Security Options on a Folder or File"


	
Section 41.26, "Subscribing to a File"


	
Section 41.27, "Liking and Unliking a File"


	
Section 41.29, "Running Document Searches"




To create and manage content at runtime using Content Presenter, refer to the steps in the following sections:

	
Section 40.9, "Creating or Editing Site Studio Content in the Content Presenter Configuration Dialog"


	
Section 40.10.1, "Editing Wiki Documents or HTML Files In-Context"


	
Section 40.10.2, "Editing Site Studio Files In-Context"


	
Section 40.10.3, "Creating New Site Studio Content In-Context"





